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This is the manual for VIRTINS Multi-Instrument. It contains manuals for:











VIRTINS Oscilloscope
VIRTINS Spectrum Analyzer
VIRTINS Signal Generator
VIRTINS Multimeter
VIRTINS Data Logger
VIRTINS Spectrum 3D Plot
VIRTINS Device Test Plan
VIRTINS LCR Meter
VIRTINS Derived Data Point (DDP) Viewer
VIRTINS Derived Data Curve (DDC)

If you have only purchased a subset of the full functions, then only the relevant
portions of this document are applicable.
Note: VIRTINS TECHNOLOGY reserves the right to make modifications to this manual at any time without notice.
This manual may contain typographical errors.
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1 Introduction
1.1 Overview

VIRTINS Multi-Instrument is a powerful multi-function virtual instrument software.
It is a professional tool for time, frequency and time-frequency domain analyses. It
supports a variety of hardware ranging from sound cards which are available in
almost all computers to proprietary ADC and DAC hardware such as NI DAQmx
cards, VT DSO, VT RTA, VT IEPE, VT CAMP, RTX6001 and so on. It consists of
the following instruments and functions.
(1) Dual-channel Oscilloscope
It provides five types of views:
 Real time waveform of Channel A and Channel B
 Real time waveform of Channel A + Channel B
 Real time waveform of Channel A - Channel B
 Real time waveform of Channel A  Channel B
 Real time Lissajous Pattern for Channel A and Channel B
Statistical data such as Maximum, Minimum, Mean, Root Mean Square values are
also calculated and displayed. Each frame of data is time stamped with an
accuracy of 1 ms and the time stamp is shown at the lower left corner of the
Oscilloscope view.
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The acquired signal can be inter-frame averaged (synchronously averaged), time
aligned, demodulated (AM, FM, PM), DC removed, half-wave or full-wave
rectified, and digitally filtered before any other analyses. The types of digital
filters supported are: Low Pass, High Pass, Band Pass, Band Stop and Arbitrary.
The class of the filter can be FFT, FIR or IIR. Reverberation, speech
intelligibility, waveform discontinuity, step response, echo, damping ratio
analyses are supported.
The displayed waveform can be played (output) or cyclically played (output) via
the default computer sound card, if the sampling rate and bit resolution of the
waveform is compatible with it.
The Oscilloscope also provides a Record Mode which can be used to record data
to the hard disk continuously until the recording process is stopped manually or 2
gigabytes of data have been recorded, whichever is earlier. The display of the
Oscilloscope can also work in Roll Mode, with which the screen will be updated
in real time even if the sweep time is long.
The Oscilloscope can perform waveform conversion among acceleration, velocity
and displacement when acceleration, velocity or displacement sensors are used.
The Oscilloscope can display both analog and digital signals in one window and
thus can be used as a MSO (Mixed Signal Oscilloscope) when used with a
hardware MSO.
The Oscilloscope supports digital persistence display mode, Equivalent Time
Sampling (ETS) mode, SINC interpolation between samples.
(2) Dual-channel Spectrum Analyzer
It provides seven types of views:
 Real time Amplitude Spectrum / Power Spectrum Density / Impedance
Spectrum
 Real time Phase Spectrum
 Real time Auto Correlation Function (Linear or Circular)
 Real time Cross Correlation Function (Linear or Circular, Original or
Generalized)
 Real time Coherence / Non-Coherence Function
 Real time Transfer Function (Bode Plot, Frequency Response, or Gain and
Phase Plot) / Impedance Analyzer
 Real time Impulse Response
with adjustable FFT size ranging from 128 to 4194304, adjustable window
overlap percentage (0%~99.9%), and 69 selectable window functions such as
Rectangle, Triangle, Hann, Hamming, Blackman, Kaiser and so on. It supports
display in logarithmic scale for both X axis and Y axis (dBr, dBV, dBu, dBFS,
dB), octave analysis (1/1, 1/3, 1/6, 1/12, 1/24, 1/48, 1/96), frequency
compensation, frequency weighting (flat, A weighting, B weighting, C weighting,
ITU-R 468 weighting), moving average smoothing (linear or 1/1~1/96 octave),
DC removal, peak hold, linear average, exponential average, and parameter
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measurements (THD, THD+N, SINAD, SNR, Noise Level, IMD-SMPTE/DIN,
IMD-CCIF2, IMD-CCIF3, DIM, Crosstalk, Bandwidth, Harmonics, Peaks,
Energy in user defined frequency bands, Wow & Flutter, Sound Loudness &
Sharpness, Total Non-Coherent Distortion + Noise ， GedLee Metric, Total
Distortion + Noise), etc.
(3) Dual-channel Signal Generator (Sweep/Arbitrary/Function/Burst Generator)
It provides the following types of waveforms/tones:
 Sine
 Rectangle (with adjustable duty cycle)
 Triangle
 Saw Tooth
 White Noise
 Pink Noise
 Multi-Tones
 Arbitrary waveform via user-configurable waveform library (WFLibrary)
 Maximum Length Sequence (MLS), with adjustable length (127~16777215)
 Dual Tone Multi-Frequency (DTMF)
 Unit Impulse
 Unit Step
 Musical Scale
 Wave File (*.WAV)
at either a fixed frequency, or a frequency that sweeps linearly or logarithmically
within a specified frequency range and time duration.
The output signal can be looped back partially (i.e. only one channel while the
other channel can be used for field input) or fully (i.e. both channels), via the
software itself, to the input of the Oscilloscope for display and analysis in real
time. Synchronized operation between the Signal Generator and the Oscilloscope
with a timing accuracy in the same order of the sampling frequency is supported.
Amplitude sweeping, burst signal generation, output signal fade in/out and
modulation (AM, FM, PM) are also supported. In addition to the streaming mode,
the software supports DDS (Direct Digital Synthesis) mode when the hardware
used supports DDS.
(4) Dual-channel Multimeter
It provides the following types of digital displays:
 RMS
 dBV
 dBu
 dB
 dB(A)
 dB(Z)
 dB(C)
 Frequency Counter
 RPM (Revolutions Per Minute)
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Counter
Duty Cycle
F/V (Frequency Voltage Conversion)
Cycle RMS
Cycle Mean
Pulse Width
Vibrometer (RMS, Peak/PP, Crest Factor values for acceleration, velocity and
displacement)

The above items from Frequency Counter to Pulse Width involve a pulse counting
process, and the software allows you to configure the counter trigger level and
trigger hysteresis in order to shape the analog signal to rectangular pulses before
counting. It also allows you to specify the frequency dividing ratio of the counter.
(5) Dual-channel Data Logger
It provides long time data logging function for 246 Derived Data Points (DDP)
and 16 User Defined Data Points (UDDP), including RMS value, Peak Frequency,
Sound Pressure Level, RPM, THD, etc. Up to 8 data logger windows can be
opened and each window can trace up to 8 variables. The logged data files can be
reloaded into the data logger for review.
Three logging methods are supported: Fastest (i.e. take one record whenever new
data are available), Time Interval (i.e. take one record whenever new data are
available and the specified time duration has elapsed since the last update),
Update Threshold (i.e. take one record whenever new data are available and the
change compared with the last update exceeds the specified update threshold).
(6) Dual channel Spectrum 3D Plot
It is used to trace the spectrum variation with time. Two types of plots are
provided:
 Waterfall, with an adjustable tilt angle of T axis, an adjustable height of Y axis,
and selectable color palettes.
 Spectrogram, with selectable color palettes and a smoothing option
The Spectrum 3D Plot can be generated by multiple frames of data (Inter-frame
Mode) or one single frame of data (Intra-frame Mode). The former supports Short
Time Fourier Transform (STFT) only while the latter supports both STFT and
Cumulative Spectral Decay (CSD).
(7) Device Test Plan
Device Test Plan provides a mechanism for you to configure and conduct your
own device test steps. It takes the advantage of the sound card’s (or other
ADC/DAC hardware’s) capability of simultaneous input & output, to generate a
stimulus to the Device Under Test (DUT) and acquire the response from that
device at the same time. Different stimuli can be generated and the response can
be analyzed in different ways. The DUT can be marked as Pass or Fail after a
sequence of test steps and a test report can be generated. Device Test Plan
www.virtins.com
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supports 25 instructions with corresponding parameters. Test results (e.g. Gain vs
Frequency, Phase vs Frequency, etc.) can be plotted in up to 8 X-Y plots and
reported in one textual log window in real time. Device Test Plan supports
connection with external systems through serial communication.
Device Test Plan can also be used to perform other functions such as data file
batch processing, batch signal event capturing and storing, etc.
(8) LCR Meter
It is used to measure the value of an inductor, a capacitor, a resistor, or the
impedance of a network of them. Two types of external connections are supported:
 Serial connection for high impedance measurement
 Parallel connection for low impedance measurement
(9) Derived Data Point (DDP) Viewer
It is used to display the value of a DDP (Derived Data Point) in a dedicated window
with a bigger font size. It is possible to specify the DDP’s high-high, high, low, lowlow limits for alarming. Different alarm sounds can be configured for different types
of alarms. Alarm acknowledgement is supported. Up to 24 DDP viewers can be
opened.
DDP viewer can also be used to define and display a UDDP (User Defined Data
Points). Various math functions can be used in the mathematical expression defining
the UDDP.
A DDP array viewer is also provided. It can be used to display a report consisting of
multiple DDPs or DDP arrays. The supported reports include:






(10)

Harmonic Frequencies, RMS, Phases
Octave Bands, RMS
Peak Frequencies, RMS, Phases
Frequency Bands, RMS
Reverberation / Speech Intelligibility (1/1 Octave)
Reverberation / Speech Intelligibility (1/3 Octave)
Derived Data Curve (DDC)

It is used to derive a dedicated data curve from one or multiple frames of sampled
data and display it in a dedicated graph window. Up to 8 DDC windows can be
opened. The supported DDCs include:







Energy Time Curve (Log-Squared)
Energy Time Curve (Envelop)
Energy Time Curve (dBSPL)
Impulse Response Schroeder Integration Curve
Step Response Curve (via Impulse Response Integration)
Frequency Time Curve

www.virtins.com
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X-Y Plot
Shock Response Spectrum

The above instruments (1)~(6) are basic instruments and can run simultaneously,
while (7) and (8) ride on the top of the basic instruments and require the cooperation
of some or all the basic instruments to achieve the specified functions.
A/D and D/A
For a basic configuration, the sound card is used as the signal input and output device
and no additional A/D and D/A hardware is required. The sampling frequency
depends on the capability of the sound card. The software allows you to select a
sampling frequency of up to 768 kHz and a sampling bit resolution of 8 bits, 16 bits or
24 bits, as long as they are supported by the sound card used. Both the sound card
MME driver (Windows default) and the sound card ASIO driver (often used in Pro
Audio, ASIO is a trademark and software of Steinberg Media Technologies GmbH)
are supported by the software.
The software is able to interface to other ADC and DAC hardware based on the
standard data acquisition software interface specification (vtDAQ and vtDAO)
developed by Virtins Technology. In this case, the sampling capability is determined
by the respective hardware. The ADC and DAC hardware can be selected
independently in the software. For example, you can run a DSO (Digital Storage
Oscilloscope) hardware for ADC and a sound card for DAC simultaneously.
Triggering
The software supports both software trigger and hardware trigger.
For sound card based data acquisition, it is possible to specify a software trigger
condition for collecting a frame of data. A negative or positive trigger delay can be
specified so that collecting data can be started before or after the trigger event. The
software features a specially designed data acquisition approach which is able to
monitor the input signal continuously without missing any trigger event, before a
frame of data is collected into the PC memory after the trigger event is found. This
makes the software suitable for transient signal recording. Both level triggering and
differential triggering are supported.
Calibration
For sound card based data acquisition, the software supports the calibration of input
and output channels so that absolute values in engineering units can be used for
display, analysis or export. It is able to take into account the change of the sound card
internal gain settings (e.g. Mic gain, Mic Boost, Line In gain) automatically so that
the calibration will not change with these gain settings. It also allows accounting for
the external attenuation ratio if an external attenuation circuit is used.
Graph Operation
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Zooming and Scrolling is supported in all graphs, enabling you to investigate the fine
details of the data. This is very important when a large amount of data are displayed
on one screen.
A cursor reader is provided in each graph to show the x and y readings of the actual
measurement point. For Spectrum 3D Plot, the cursor reader supports the readout of x,
y, t values of the actual measurement point.
Two markers are provided in each graph to get the x and y readings of the actual
measurement points nearest (in horizontal direction) to the points of the mouse clicks.
The differences in the readings of the two markers are also displayed.
Five chart types are supported: Line, Scatter, Column, Bar, and Step. Line width and
colors of the graph are configurable. Options are provided to either display all data
points (slow) or only display one data points per vertical raster line (fast).
The data in any graph can be copied into the clipboard as text and later pasted into
other software such as Microsoft Excel for further analysis. The image of the graph
can be copied into the clipboard as Bitmap image and later pasted into other software
such as Microsoft Word.
Reference Curves
Up to five reference curves can be set for each channel in each graph. The reference
curve can be configured by either copying the current curve, or loading a properly
formatted text file or a previously saved reference file from the hard disk. The
reference curves can be defined as high-high, high, low, low-low limits for the realtime curves, and the alarm statuses can be obtained through the respective DDPs.
File Import and Export
The collected frame of data can be saved as a wave file (*.wav) or exported as a text
file (*.txt). All analysis results can be exported as text files (*.txt). All graphs can be
exported as bitmap files (*.bmp) or printed out directly. A long wave file can be
imported frame by frame either manually or automatically.
Wave files with PCM format or properly formatted text files can be imported for
analysis. The signal generated by the Signal Generator can be saved as a wave file
(*.wav) or a text file (*.txt) for a given duration of up to 1000 seconds as long as the
spare space on the hard disk is sufficient. The saved files can be in turn imported for
display and analysis or used by other software.
Data Merging and Extraction
Combining data from individual channels of different wave files and extracting part of
data from a wave file are supported.
Save/Load, Lock/Unlock Panel Setting
You can save the current instrument panel setting either as default or as a customized
panel setting for later use. You can configure up to 20 most frequently used panel
settings in the Hot Panel Setting Toolbar so that these settings can be loaded by just a
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single mouse click. You can also lock the panel setting so that only authorized users
can unlock it and then modify the setting.
Controls/Options Enabling and Disabling
Graphical User Interface items such as menu items, buttons, combo boxes, edit boxes,
radio boxes, checkboxes are enabled/disabled based on context, so as to void any misunderstanding and mis-operation.
Displayed Precision for Numerical Values
The precision (decimal places) of the numerical values displayed on the screen are
automatically adjusted based on the precision of their sources.
Multilingual User Interface
The software supports Multilingual User Interface under Windows 2000, XP, 2003,
Vista, 7, 8, 8.1, 10, 11 and above. The currently supported languages are English,
French, German, Italian, Portuguese, Spanish, Russian, Simplified Chinese,
Traditional Chinese, Japanese and Korean.
Function Allocation in Different Licnese Levels
A complete Multi-Instrument software package consists of basic and add-on modules
with all features in each of them. The basic modules include Oscilloscope, Spectrum
Analyzer, Signal Generator, Multimeter, Derived Data Point Viewer, Derived Data
Curve, and General Functions. The add-on modules include Spectrum 3D Plot, Data
Logger, LCR Meter, Device Test Plan, Vibrometer, and Dedicated Hardware Support.
There are six license levels to access the basic modules: Sound Card Oscilloscope,
Sound Card Spectrum Analyzer, Sound Card Signal Generator, Multi-Instrument Lite,
Multi-Instrument Standard, and Multi-Instrument Pro. The add-on modules need to
be purchased separately. They can only run with Multi-Instrument Lite, Standard, or
Pro, except that Vibrometer can only run with Multi-Instrument Standard or Pro. The
following table shows the function allocation among different license levels. Please
note that a license of Multi-Instrument Full Package contains Multi-Instrument Pro
and all add-on modules.

www.virtins.com

21

Copyright © 2006-2022

Virtins Technology

VIRTINS Multi-Instrument 3.9 Manual

Virtins Technology

Graph
Operation

Calibration

Sampling
Settings

Trigger Settings

Data Export

File Operation

ADC / DAC
Hardware

Legend:  - Function available * - Function available in Multi-Instrument Full Package only
Sound Card Sound
Sound
MultiMultiOscilloscope Card
Card
Instrument
Instrument
Spectrum
Signal
Lite
Standard
Analyzer
Generator
General Functions
Sound Card MME





Sound Card ASIO
Other Hardware



MultiInstrument
Pro




vtDAQ,
vtDAO
software
development kit

License automatically activated with the presence of the corresponding hardware, e.g. a
USB hardkey or a VT DSO.

Load WAV File
Load TXT File
Load WAV File
Frame by Frame
(fore Long WAV
File)
Combine
WAV
Files
Extract Data and
save them into a
new WAV File
Save/Load
Panel
Setting
Copy
Text
to
Clipboard
Copy
BMP
to
Clipboard
Print Preview
Print
Export as TXT File
Export as BMP File
Trigger Mode
Trigger Source
Trigger Edge
Trigger Level
Trigger Delay
High
Frequency
Rejection
Noise Rejection
Sampling Rate
Sampling Channels
Sampling
Bit
Resolution
Record Length
Input
Output
Probe



























































































































































































Sound
Pressure
Level
F/V Conversion
Latency for Sync.
Output/Input
Sensor Sensitivity
Load Factor for
Power Calculation
Zoom
Scroll
Cursor Reader
Marker
Chart Type











































www.virtins.com































22

Copyright © 2006-2022

Virtins Technology

VIRTINS Multi-Instrument 3.9 Manual

Sound Card
Oscilloscope

Sound
Card
Signal
Generator




MultiInstrument
Lite

MultiInstrument
Standard

MultiInstrument
Pro





Sound
Card
Spectrum
Analyzer





























































































































































































(offline)

(offline)

(offline)

(offline)

(offline)







Linear Average





Exponential
Average









AM





FM





PM





IntraFrame

Inter-Frame
Processing

Type

Others

Line Width
Color
Fast/Slow Display
Mode
Refresh Delay
Font Size
Roll Mode
Reference Curves &
Limits
Gain Adjustment
Input Peak Indicator
Sound
Card
Selection
Sampling Parameter
Auto Setting
Multilingual GUIs
Show/Hide Toolbar
Lock/Unlock Panel
Setting
Hot Panel Setting
Toolbar
ActiveX
Automation Server
AutoRanging
AutoScaling
Input
Channel
Operation
Oscilloscope
Individual
Waveform
Waveform
Addition
Waveform
Subtraction
Waveform
Multiplication
Lissajous Pattern

Demodulation
(Intra-Frame)

Virtins Technology

Time
Removal

www.virtins.com

Delay

23

Copyright © 2006-2022

Virtins Technology

VIRTINS Multi-Instrument 3.9 Manual

Others

Parameter
Measurement
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(Intra-Frame Processing)
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Others

Settings

Type

Legend: Blank - Function available if purchased Shaded Blank - Function NOT available in that license level
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Variables
Vibrometer
RMS, Peak/PP, Crest Factor
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displacement
(in
Multimeter)
Waveform
conversion
among
acceleration,
velocity and displacement
(in Oscilloscope)
SI / English units
Dedicated Hardware Support
RTX6001 Remote /Local
Control

The Dedicated Hardware Support add-on module is intended for a seamless
integration with some third-party hardware devices. The following third-party
hardware devices are under this category:


RTX6001 Audio Analyzer
Note that without this add-on module, RTX6001 will work as a sound card
only and is still supported by Multi-Instrument’s generic sound card drivers.
With this add-on module, the input and output data will be scaled properly by
the software without calibration, and RTX6001 is fully controllable from PC.

1.2 System Requirement
Microsoft Windows 2000 or greater. Both 32-bit and 64-bit Windows are supported.
Screen resolution is recommended to be greater than 1024 × 600 pixels.
For a sound card based data acquisition system, an 8, 16 24 or 32 bit Windows
compatible sound card is required.

1.3 Quick Start Guide
1.3.1 Start Multi-Instrument
To start Multi-Instrument, on the Windows desktop,
Programs]>[Multi-Instrument]>[VIRTINS Multi-Instrument].

select

[Start]>[All

If the software license has not been activated and the trial period has not expired, the
software will work in trial mode. Under this mode, the software will have the full
functionality of the full package of the software except that a text “trial” will be
shown in the center of every graph window.
If the software license has not been activated and the trial period has expired, the
software will refuse to run.
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If the software license has been activated, by a softkey (activation code), a USB
hardkey, or a VT device, the software will work in licensed mode. Under this mode,
the software will have the functionality corresponding to the license level activated.
1.3.1.1 Default Device Selection
If the software is started for the very first time after installation, it will prompt the
user to select a default device. The default device can also be changed later via
[Setting]>[ADC Device], [Setting]>[DAC Device], and [Setting]>[Configure Hot
Panel Setting Toolbar], or simply [Setting]>[Restore to Factory Default]. However, if
[Restore to Factory Default] command is executed, all calibration data entered
manually via [Setting]>[Calibration] after software installation will be reset to
the default values of the selected product. To avoid the loss of the manually
entered calibration data, you can save them as a calibration file first.

1.3.1.2 Default Skin Selection
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If the software is started for the very first time after installation, it will prompt the
user to select a default color scheme (Skin) and theme (visual style). The default skin
can also be changed later via [Setting]>[Display].

1.3.1.3 Run Multiple Instances
It is possible to launch multiple instances of the software on the same computer. Each
instance has its own default configuration. It is possible to use different ADC/DAC
devices or different channels of the same device in different instances. This
effectively increases the total number of channels supported. The location of each
instance on the screen is memorized by the software.

Each instance except the first one has a unique number in the brackets [] in the title bar of the main
window to differentiate itself from others (see figure below).
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If multiple instances point to the same hardware device (either the same or different
channels), the device driver must support multi-client applications, otherwise, clash
will occur. Sound card MME drivers and some sound card ASIO drivers support
multi-client applications, but VT DSO drivers do not.
1.3.1.3.1 Sticky Move

“Sticky Move” option can be accessed by clicking the software icon at the upper left
corner of the main window. It is ticked by default. With this option selected, all screen
components belonging to the same software instance will move together if you drag
the title bar of the main window. Otherwise, only the Oscilloscope, Spectrum
Analyzer, Spectrum 3D Plot, and Multimeter will move together with the main
window.
1.3.2 Screen Layout and Components
The main window of the software is divided into the following eight areas: (1)~(8).

www.virtins.com

32

Copyright © 2006-2022

Virtins Technology

VIRTINS Multi-Instrument 3.9 Manual

Virtins Technology

(1) Title bar

It is located at the top of the screen. It contains software title, software version
number, add-on modules activated, file name opened (if any), ADC device being used,
Panel Setting File name loaded (if any, when the Panel Setting is locked), and
instance no.
Depending on the license level activated, the software title can be:







Sound Card Oscilloscope
Sound Card Spectrum Analyzer
Sound Card Signal Generator
Multi-Instrument Lite
Multi-Instrument Std (i.e. Standard)
Multi-Instrument Pro

Depending on the license level activated, the add-on modules activated can be:







3DP (i.e. Spectrum 3D Plot)
DLG (i.e. Data Logger)
LCR (i.e. LCR Meter)
UDP (i.e. Device Test Plan)
VBM (i.e. Vibrometer)
DHS (i.e. Dedicated Hardware Support)

(2) Menu bar
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It is located at just below the title bar. Different instruments may have different menu
items in each submenu.
(3) Sampling Parameter Toolbar

It is located just below the menu bar. It contains three parts:


File Input & Output



Trigger Parameters
It contains (from left to right):
Trigger Mode, Trigger Source, Trigger Edge, Trigger Level, and Trigger
Delay, Trigger Frequency Rejection



Sampling Parameters (for ADC)
It contains (from left to right):
Sampling Frequency, Sampling Channels, Sampling Bit Resolution, Record
Length per sweep, Roll Mode Checkbox, Record Button, and Sampling
Parameter Auto Setting Button.

This toolbar is common for all instruments. Note that the sampling parameters for
DAC are located in the Signal Generator panel.
(4) Instrument & Miscellaneous Toolbar

It is located just below the Sampling Parameter Toolbar, consisting of the following
two parts:


Instrument Toolbar (left hand side)
It contains buttons for (from left to right):
Oscilloscope Run/Stop, Oscilloscope, Spectrum Analyzer, Multimeter,
Spectrum 3D Plot, Signal Generator, Device Test Plan, Data Logger, DDP
Viewer, Derived Data Curve (DDC).



Miscellaneous Toolbar (right hand side)
It contains (from left to right):
Invert Input Signal button, Channel A Zeroing button, Channel B Zeroing
button, Windows Recording Control, Windows Volume Control, Waveform
Play button, Waveform Cyclic Play Button, ADC Channel A Coupling Type,
ADC Channel B Coupling Type, ADC Channel A Range, ADC Channel B
Range, Probe A Current Switch Position, Probe B Current Switch Position,
and Input Peak Level Indicators for Channel A and Channel B.
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This toolbar is common for all instruments.
(5) Long Wave File Navigation Toolbar (Hidden by default)

It is located just below the Instrument and Miscellaneous Toolbar, and is visible only
when a WAV file is opened with [File]>[Open Frame by Frame] command. It
contains the following controls (from left to right):
Frame Up button, Frame Down button, Frame Auto Scroll button, Current Frame
Position Slider, Current Frame Position/Length of the File, Frame Overlap
Percentage.
(6) Hot Panel Setting Toolbar
It is a toolbar containing 20 configurable buttons. You can assign each button with a
frequently used panel setting file via [Setting]>[Configure Hot Panel Setting Toolbar],
so that that panel setting file can be loaded when the button is pressed. You can show
or hide this toolbar via [Setting]>[Show Hot Panel Setting Toolbar].
By default, when “Sound Card” is selected as the default device, the 20 buttons are
pre-configured as follows:
1. Home: Default setting.
2. OCT3: 1/3 Octave Analysis (Avg. 10)
Pink noise will be generated by pressing the start button of the Signal Generator.
The pink noise will be injected into the DUT (Device Under Test), and the
response of the DUT will be captured and analyzed by the Oscilloscope and
Spectrum Analyzer. A flat curve in the Spectrum Analyzer would indicate a flat
magnitude frequency response of the DUT.
3. Polarity: Polarity Test with Crest Factor Check
0.5 ms half-inverted sawtooth pulse will be generated every 100 ms by pressing
the start button of the Signal Generator. The signal will be injected into the DUT
(Device Under Test) such as a speaker, and the response of the DUT will be
captured and analyzed by the Oscilloscope. The polarity of the DUT can be seen
from the direction of the pulse displayed in the oscilloscope. In addition, a DDP
viewer is configured to display the measured polarity using its background color.
4. THD: THD,THD+N,SNR,SINAD,Noise Level, ENOB (Avg. 10 )
A 1 kHz sine wave will be generated by pressing the start button of the Signal
Generator. The sine wave will be injected into the DUT (Device Under Test), and
the response of the DUT will be captured and analyzed by the Oscilloscope and
Spectrum Analyzer. All the above parameters of the DUT will be measured and
displayed. This panel setting uses Kaiser 6 window function in the Spectrum
Analyzer to suppress spectral leakage.
5. THDa: THD,THD+N,SNR,SINAD,Noise Level, ENOB (A-Weighted) (Avg. 10)
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Similar to THD, but with A-weighting profile applied to the spectrum.
6. THDnsl: THD,THD+N,SNR,SINAD,Noise Level, ENOB (Avg. 10 )-No Spectral
Leakage
A 1 kHz (to be precise, a frequency very close to 1 kHz in order to avoid spectral
leakage) sine wave will be generated by pressing the start button of the Signal
Generator. The sine wave will be injected into the DUT (Device Under Test), and
the response of the DUT will be captured and analyzed by the Oscilloscope and
Spectrum Analyzer. All the above parameters of the DUT will be measured and
displayed. This panel setting should be used only if the same sound card is used
for signal input and output. In case different sound cards are used for signal input
and output, you should change the Window Function in the Spectrum Analyzer
from Rectangle to Kaiser 6.
7. THDres: 1kHz Sine wave vs Its Duplicate with Fundamental attenuated by 179
dB via FIR
A 1 kHz sine wave will be generated by pressing the start button of the Signal
Generator. The sine wave will be injected into the DUT (Device Under Test), and
the response of the DUT will be captured and analyzed by the Oscilloscope and
Spectrum Analyzer. [Setting]>[ADC Device]>“Channel Operation” is set to
“A=iA, B=iA” to duplicate the same single-channel response from the DUT into
both Ch. A and Ch. B. A band-stop linear-phase FIR filter is applied to Ch. B
only to attenuate the 1kHz fundamental by 179 dB, leaving only the residual
harmonics and noises in Ch. B for waveform comparison with the original signal
in Ch. A. The FIR time delay in Ch. B is removed so that the two waveforms in
both channels are time aligned. In case the amplitude of the waveform in Ch. B is
too small, right click the Oscilloscope and select “AutoScaling”. DDP Array
viewer is used to show the harmonic frequencies, amplitudes, phase information.
Please note that the phase information will only be available if [FFT
Size]<=[Record Length]< 2×[FFT Size] and there is no inter-frame average. Peak
Markers are used to indicate the harmonic peaks. They will show the correct peak
heights even when spectral leakage occurs.
8. IMDsmp: IMD SMPTE (60 Hz + 7 kHz, 4:1) (Avg. 10)
A 60 Hz and a 7 kHz sine waves mixed at an amplitude ratio of 4:1 will be
generated by pressing the start button of the Signal Generator. The mixed signals
will be injected into the DUT (Device Under Test), and the response of the DUT
will be captured and analyzed by the Oscilloscope and Spectrum Analyzer. The
SMPTE IMD value of the DUT will be measured and displayed.
9. IMDdin: IMD DIN (250 Hz + 8 kHz, 4:1) (Avg. 10)
A 250 Hz and an 8 kHz sine waves mixed at an amplitude ratio of 4:1 will be
generated by pressing the start button of the Signal Generator. The mixed signal
will be injected into the DUT (Device Under Test), and the response of the DUT
will be captured and analyzed by the Oscilloscope and Spectrum Analyzer. The
DIN IMD value of the DUT will be measured and displayed.
10. IMDccif: IMD CCIF2 (19 kHz + 20 kHz, 1:1) (Avg. 10)
A 19 kHz and a 20 kHz sine waves mixed at an amplitude ratio of 1:1 will be
generated by pressing the start button of the Signal Generator. The mixed signal
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will be injected into the DUT (Device Under Test), and the response of the DUT
will be captured and analyzed by the Oscilloscope and Spectrum Analyzer. The
CCIF2 IMD value of the DUT will be measured and displayed.
11. CrossTlk: Crosstalk A->B, THD, THD+N, SNR, SINAD, ENOB (Avg. 10)
A 1 kHz sine wave will be generated by pressing the start button of the Signal
Generator. The generated signal will be injected into Channel A of the DUT
(Device Under Test) and the input of Channel B of the DUT will be grounded.
The response of the DUT will be captured and analyzed by the Oscilloscope and
Spectrum Analyzer. All the above parameters of the DUT will be measured and
displayed.
12. FRwhite: Magnitude Frequency Response (White Noise, Avg. 30)
White noise will be generated by pressing the start button of the Signal Generator.
The white noise will be injected into the DUT (Device Under Test), and the
response of the DUT will be captured and analyzed by the Oscilloscope and
Spectrum Analyzer. The curve in the Spectrum Analyzer indicates the magnitude
frequency response of the DUT.
13. FRpwn: Magnitude Frequency Response (Periodic White Noise)
Periodic white noise will be generated by pressing the start button of the Signal
Generator. The periodic white noise will be injected into the DUT (Device Under
Test), and the response of the DUT will be captured and analyzed by the
Oscilloscope and Spectrum Analyzer. The curve in the Spectrum Analyzer
indicates the magnitude frequency response of the DUT. One advantage of using
periodic white noise is that its spectrum is ideally flat even without averaging.
14. FRswph: Magnitude Frequency Response (Frequency Sweep, Peak Hold forever)
A frequency linearly swept sine wave (chirp) will be generated by pressing the
start button of the Signal Generator. The chirp signal will be injected into the
DUT (Device Under Test), and the response of the DUT will be captured by the
Oscilloscope and Spectrum Analyzer. The curve in the Spectrum Analyzer
indicates the magnitude frequency response of the DUT. Glitches may appear if
the sweep time is reduced or FFT size is increased.
15. FRswlog: Magnitude Frequency Response (Frequency Log Sweep+1/96 Octave
Analysis)
A frequency logarithmically swept sine wave (chirp) will be generated by pressing
the start button of the Signal Generator. The chirp signal will be injected into the
DUT (Device Under Test), and the response of the DUT will be captured by the
Oscilloscope and Spectrum Analyzer. The curve in the Spectrum Analyzer
indicates the magnitude frequency response of the DUT. The trigger level should
be set properly such that the oscilloscope will capture the entire swept sine signal.
Logarithmic sweep and octave analysis is used to provide sufficient SNR at lower
frequency range. If linear sweep is used, narrow-band FFT analysis should be
used instead.
16. BodePlot: Bode Plot (Transfer Function, Frequency Response) (White Noise,
Avg. 50)
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White noise will be generated by pressing the start button of the Signal Generator.
The generated white noise will be split into two: one injected into the DUT
(Device Under Test), and the other injected directly into Channel B of the
Oscilloscope. The response of the DUT will be injected into Channel A of the
Oscilloscope. The curve in Channel A of the Spectrum Analyzer will show the
gain vs frequency plot of the DUT, and the curve in Channel B of the Spectrum
Analyzer will show the phase shift vs frequency plot of the DUT.
17. THD~f: THD, THD+N, SNR, Magnitude Response vs Frequency Plot
Please refer to Section 8.8.3.
18. THD~P: THD, THD+N vs Magnitude, Power Plot
Please refer to Section 8.8.4.
19. IMD~P: SMPTE IMD vs Magnitude, Power Plot
Please refer to Section 8.8.5.
20. AudioTst: Automated Audio Parameter Test
Please refer to Section 8.8.7.
Note: In the above tests, it is assumed that the performance of the test set-up itself (e.g.
the sound card that is used as the measurement instrument) is better than that of the
DUT (preferably one order better), so that the measurement errors introduced by the
test set-up itself can be ignored. The test set-up’s specifications can be obtained from
the hardware manufacturers. A test set-up with a low noise level, high bit resolution,
wide bandwidth, flat frequency response, and low distortion should be used. The
parameters of the test set-up can also be obtained by directly looping back its output
to its input, and then performing the above tests. Some of the imperfection of the test
set-up can be compensated by software, such as the non-flat magnitude frequency
response. But some cannot, such as distortion and noises.
Please refer to the following documents for some sound card loop back test examples:


EMU Tracker Pre Test Report using Multi-Instrument
Download link:
http://www.virtins.com/doc/D1004/EMU_Tracker_Pre_Report_D1004.pdf



M-Audio Mobile TrackerPre Test Report using Multi-Instrument
Download link:
http://www.virtins.com/doc/D1005/M-Audio_MobilePre_Report_D1005.pdf



VT XLR-to-USB Pre Test Report using Multi-Instrument
Download link:
http://www.virtins.com/doc/D1006/VT_XLR-to-USB_Pre_Report_D1006.pdf



EMU 0204 Test Report using Multi-Instrument
Download link:
http://www.virtins.com/doc/D1007/EMU_0204_Report.pdf



Focusrite Scarlett Solo Test Report using Multi-Instrument
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Download link:
http://www.virtins.com/doc/Focusrite-Scarlett-Solo-Test-Report-using-Multi-Instrument.pdf

(7) Display area
It is positioned in the middle of the screen. It is used to display various instrument
views and panels. Multiple views and panels can be displayed in this area
simultaneously. This area is intentionally designed as big as possible in order to
accommodate multiple views/panels and display the fine details of the data.
Compared with conventional instrument, one distinct advantage of virtual instrument
is that it utilizes the computer screen for display, which is much bigger than the screen
of a conventional oscilloscope. However, this advantage has not yet been fully taken
in many other virtual instrument software applications in the market, as they simply
mimic the conventional instrument panel on the computer screen and thus only a
small portion of the computer screen is used for the display of the measurement data.
In contrast, Multi-Instrument gives priority to the display of the measurement data on
the screen and at the same time maintains a user friendly human machine interface
(HMI) by using common Windows gadgets.
(8) View Parameter Toolbar
It is located at the bottom of the screen. It is used to adjust those display-related
parameters. Each view (e.g. Oscilloscope view, Spectrum Analyzer view, Multimeter
view, Spectrum 3D Plot view) has its own View Parameter Toolbar and only the one
for the foremost view will be shown, in order to save screen space. Clicking anywhere
within an instrument view will bring forward its respective View Parameter Toolbar
and make it visible.


View Parameter Toolbar for Oscilloscope

It contains (from left to right):
T Range, T Multiplier, A Range, A Multiplier, Oscilloscope Type, B Range, B
Multiplier.


View Parameter Toolbar for Spectrum Analyzer

It contains (from left to right):
Horizontal Axis Range, Horizontal Axis Multiplier, A Range, A Multiplier, Spectrum
Analyzer Type, B Range, B Multiplier, FFT Size, Window Function, Window Overlap
Percentage.


View Parameter Toolbar for Multimeter

It contains (from left to right):
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Display/Hide A, Counter A Trigger Level, Counter A Trigger Hysteresis, A Divider,
Multimeter Type, Display/Hide B, Counter B Trigger Level, Counter B Trigger
Hysteresis, B Divider.


View Parameter Toolbar for Spectrum 3D Plot

It contains (from left to right):
F Range, A Range, Spectrum 3D Plot Type, B Range, T Range, Tilt Angle of T,
Height Percentage of Y, Processing Mode, Analyzing Mode.
(a) Cursor Reader (left mouse click)
Please refer to the section “Cursor Reader and Markers” in the next chapter for
details.
(b) Marker (double left mouse click, with or without CTRL or SHIFT)
Please refer to the section “Cursor Reader and Markers” in the next chapter for
details.
(c) Context Menu (right mouse click)
Please refer to the section “Context Menu” in the following chapters for details.
(d) Horizontal Scrollbar (put the mouse cursor just below the horizontal axis till it
becomes a magnifying glass, then left click to zoom in, right click to zoom out,
and move the scroll box to scroll horizontally. Zoom in/out can also performed
using the mouse wheel.)
Please refer to the sections about the multiplier for horizontal axis in the following
chapters for details.
(e) Channel A Scrollbar (put the mouse cursor on the left side of A axis till it
becomes a magnifying glass, then left click to zoom in, right click to zoom out,
and move the scroll box to scroll vertically for Channel A. Zoom in/out can also
performed using SHIFT + mouse wheel.)
Please refer to the section “Channel A Multiplier” in the following chapters for
details.
(f) Channel B Scrollbar (put the mouse cursor on the right side of A axis till it
becomes a magnifying glass, then left click to zoom in, right click to zoom out,
and move the scroll box to scroll vertically for Channel B. Zoom in/out can also
performed using CTRL + mouse wheel.)
Please refer to the section “Channel B Multiplier” in the following chapters for
details.
(g) Text display area of a graph window
It displays the DDP (Derived Data Point) values of that graph window. When the
cursor reader / marker is shown, it will also display the cursor / marker readings.
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1.3.3 Change ADC/DAC device
You can change the ADC device being used via [Setting]>[ADC Device]>[Device
Model].
You can change the DAC device being used via [Setting]>[DAC Device]>[Device
Model].
1.3.4 Basic operations
To get familiar with the basic operation of the software quickly, it is recommended to
use your computer’s sound card with a built-in or external microphone. You can go
to [Setting]>[ADC Device], and choose “Sound Card MME” as the Device Model,
and choose a sound card (for Windows before Vista) or an input source of a sound
card (for Windows after Vista) in the Device No. field. You can adjust the
microphone gain of your sound card via the Recording Control under Windows
Control Panel. You can also access the Recording Control via the Recording Control
button in the Instrument & Miscellaneous Toolbar.
Now, if you start the oscilloscope and speak before the microphone, you should see
the waveform and spectra of your voice. To get real time display of your voice, it is
recommended to set the sweep time of the oscilloscope to be 5 ms ~100 ms. To
change the sweep time, click anywhere within the oscilloscope window and change
the sweep time at the bottom left corner. You can change the trigger parameters and
sampling parameters in the sampling parameter toolbar and observe their effects. The
trigger level and trigger delay can also be changed by dragging the respective markers
along A axis and the horizontal axis at the top in the Oscilloscope window.
If the oscilloscope sweep time is too long (e.g. greater than 1s), the screen update will
become slow, then you can tick the “Roll” checkbox at the upper right corner of the
screen to get real time but partial update of the screen.
You can record your voice continuously by stopping the oscilloscope, uncheck the
“Roll” checkbox if it is checked, and then press the “Record” button at the upper right
corner of the screen. Press the “Record” button again to stop recording, and the
recorded WAV file will be opened automatically. To get out of the Record Mode,
click anywhere within the oscilloscope window and change the sweep time at the
bottom left corner of the screen from “Record” to something else.
To get familiar with the operation of the Signal Generator, it is recommended to use
your computer’s sound card with a speaker. You can go to [Setting]>[DAC Device],
and choose “Sound Card MME” as the Device Model, and choose a sound card (for
Windows before Vista) or an output destination of a sound card (for Windows after
Vista) in the Device No. field. You can adjust the volume of the sound card via the
Volume Control under Windows Control Panel. You can also access the Volume
Control via the Volume Control button in the Instrument & Miscellaneous Toolbar.
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Clicking the Signal Generator button in the Instrument and Miscellaneous Toolbar
will open the Signal Generator panel. The basic operation of the Signal Generator is
straight forward. Please refer to Chapter Signal Generator for details.
Whenever you want to revert back to the default panel setting, stop the oscilloscope
and go to [File]>[New], or simply press “Home” in the Hot Panel Setting Toolbar.
If you want to see some more basic tests with the software, please refer to: Basic
Oscilloscope, Spectrum Analyzer, Multimeter and Signal Generator Functional Tests
using Multi-Instrument and Pocket Multi-Instrument with Sound Cards
Download link:
http://www.virtins.com/doc/D1001/Basic_Oscilloscope_Spectrum_Analyzer_Multimeter_and_Sig
nal_Generator_Functional_Tests_using_Multi-Instrument_and_Pocket_MultiInstrument_with_Sound_Cards_D1001.pdf

1.4 Input & Output Connection for Sound Card Based Systems
For sound card based systems, signals to be tested should be connected to either the
"MIC" jack or the "Line in" jack, and the generated signals will be output via the
"Speaker" jack or the "Line out" jack.
Typically, the "MIC" jack of a sound card has an input impedance in the range of 600
Ω ~ 50 kΩ (card dependent). Its ADC full-scale input voltage (1/2 Vpp) is in the
range of 1 mV ~ 500 mV (card dependent), and is adjustable through the Recording
Control under Windows Control Panel or hardware gain control (if any) provided by
the sound card. Most built-in sound cards have only one mic input and the same mic
signal is split and fed into the two input channels.
The "Line In" jack of a sound card has an input impedance typically around 1 kΩ ~ 50
kΩ (card dependent). The ADC full-scale input voltage (1/2 Vpp) of this connection
is in the range of 500 mV ~ 2 V (card dependent), and is adjustable through the
Recording Control under Windows Control Panel or hardware gain control (if any)
provided by the sound card. Generally, the "Line In" should be used as the primary
input connection as it offers better Signal-to-Noise Ratio (SNR) and bandwidth.
The "Line Out" connection of a sound card has an output impedance typically in the
range of 20 Ω ~ 500 Ω (card dependent) and can output signal up to 2 V typically
(card dependent). It has better SNR than the "Speaker" connection.
The "Speaker" connection of a sound card has a typical output impedance of 4Ω ~ 8 Ω
(card dependent) and output power of 2 W (card dependent). The headphone
connection of a sound card has a typical output impedance of 4Ω ~ 100 Ω and output
power of 100 mW.
For input connection, the simplest way is to directly connect the signal under test to
the sound card "Line In" or "MIC" jack (see the figure below). However, this kind of
connection requires the tester to be extremely careful to ensure the input signal is
within the allowable range before connecting. Otherwise the sound card or even the
www.virtins.com
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PC may be damaged. The maximum allowable input voltage is about 3V (card
dependent).

In order to prevent the sound card from excessive input voltage, the following limiter
circuit can be added. The two Silicon diodes will clamp the input voltage at about 2 ×
0.65 = 1.3 (V). If the sound card ADC full scale is affected, one more Silicon diode
can be added in series to clamp the input voltage at about 3 × 0.65 = 1.95 (V) instead.
The protection is limited to ± 50 V maximum (also depending on the resister's value
and maximum allowable current, and the diode's maximum allowable current). If the
amplitude of the signal to be measured exceeds the allowable range of the sound card,
it must be attenuated before connecting. The simplest way to attenuate the input signal
is to add a resistor in series to the sound card’s input. This resistor and the sound
card’s input impedance form a voltage divider, the higher the resistor’s value, the
higher the attenuation ratio, and the higher the input impedance of this measurement
circuit.

In order to get good measurement result, the output impedance of the circuit under
test must be lower than the input impedance of the sound card’s measurement circuit.
Otherwise the signal cannot be properly transmitted from the circuit to the sound card.
If necessary, you can add a pre-amplifier before the sound card’s input. The preamplifier is responsible for impedance conversion, signal amplification or attenuation,
and input protection.
The following figure shows the output connection for the Signal Generator. The
resistor is used to prevent accidental short circuit of the output. It can be omitted if
you are careful enough. As the output impedance of a sound card is very low, there
should not be any impedance matching problem when connected to external circuits.
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It should be noted that for many sound cards (typically the internal sound card of a
desktop PC or a laptop PC with built-in AC power supply adapter), the ground line of
input and output is connected to the mains earth. This is not a problem if the circuit
under test is floating (i.e. isolated from the mains earth). Otherwise, you must make
sure that the ground line is connected to a point on the circuit that is also at earth
potential.
The above mentioned connection circuits and pre-amplifiers are NOT supplied with
the software unless otherwise stated explicitly during purchasing.
For non-sound-card based systems, please refer to the respective hardware manual for
the input & output connection.

1.5 Specifications
1.5.1 Oscilloscope
1 ADC Hardware Related Specifications
Sound Card based systems:
1) Sweep Time: 100 µs~500 s (computer memory dependent).
2) Bandwidth: 1 Hz - 200 kHz (sound card dependent).
3) Maximum Allowable Input Voltage (if connected directly): about 3 V (sound
card dependent).
4) Selectable sampling frequency (up to 768kHz), sampling bit resolution (8, 16
or 24 bits) and sampling channels (one or two) (sound card dependent)
5) Four trigger modes: Auto, Normal, Single and Slow.
6) Support triggering by rising edge, falling edge, or both at a specified trigger
level or for a specified amount of change, in the selected input channel.
Support trigger frequency rejection.
7) Support pre-triggering and post triggering from 0 to 100% of the specified
record length.
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8) Continuously monitor the input signal such that no trigger event is missed
before data collection
9) Support calibration of the input channels with the input gain setting
automatically being taken into account. Re-calibration is not necessary even if
the gain setting changes.
Non Sound Card based systems:
Please refer to the respective hardware manual.
2 Can be used as a transient signal recorder to capture and store raw data
continuously into a sequence of WAV files in the hard disk.
3 Five view types: Real time waveform of Channel A and Channel B, Real time
waveform of Channel A + Channel B, Real time waveform of Channel A Channel B, Real time waveform of Channel A  Channel B, Real time Lissajous
Pattern for Channel A and Channel B.
4 Independent X axis and Y axis zooming and scrolling.
5 WAV files and properly formatted TXT files can be imported for display and
analysis.
6 Collected measurement data can be saved as WAV files or exported as TXT files.
7 Data curve can be print-previewed, printed out directly or saved as BMP files.
8 Support adding notes to the measurement data.
9 Fast display refresh rate: about 50 frames per second (tested with a sound card
under Windows XP SP2 on IBM ThinkPad R51 Laptop PC with Intel Pentium M
processor 1.60 GHz, with sweep time=10 ms and FFT size=1024 and both the
Oscilloscope and the Spectrum Analyzer running under "Auto" trigger mode).
Thus data are displayed and analyzed in "true" real time.
10 The colors of display, font size, screen refresh rate are configurable.
11 Number of points (samples) to be collected per sweep can be fine tuned at one
point's resolution.
12 Display the Maximum, Minimum, Mean, RMS values of the data per sweep.
Therefore it can be used as a voltmeter.
13 Support one cursor reader and two markers which stick to the measurement data.
14 Five chart types: Line, Scatter, Column, Bar, and Step. Line width is adjustable.
Support SINC interpolation between samples.
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15 Support combining data from individual channels of different wave files and
extracting part of data from a wave file.
16 Support normal and inverted display of a waveform.
17 Up to five reference curves can be set for each channel. The reference curve can
be configured by either copying the current curve, or loading a properly formatted
text file or a previously saved reference file from the hard disk. Reference curves
can be assigned as High-High, High, Low, Low-Low limits.
18 Support digital filtering (intra-frame processing) such as low pass, high pass, band
pass, band stop and arbitrary. The filter class can be FFT, FIR or IIR. Support
inter-frame processing including linear and exponential average. Support
demodulation (AM, FM, PM), DC removal and rectification. Support removal of
time delay between two channels. Support time domain parameter measurements
including reverberation and speech intelligibility, waveform discontinuity, step
response, echo, and damping ratio.
19 Support loading long WAV file frame by frame, either manually or automatically.
20 Each frame of data is time stamped with an accuracy of 1 ms.
21 The data in the graph can be copied into the clipboard as text and later pasted into
other software such as Microsoft Excel for further analysis. The image of the
graph can be copied into the clipboard as Bitmap image and later pasted into other
software such as Microsoft Word.
22 The waveform displayed in the Oscilloscope can be played or cyclically played
via the default computer sound card, if the sampling rate and bit resolution of the
waveform is compatible with that sound card.
23 The screen display can work in “Roll” mode.
24 Support waveform conversion among acceleration, velocity and displacement.
Support both SI and English unit systems.
25 Support engineering unit conversion.
26 Support auto setting of sampling parameters such as sampling frequency, sweep
time and full-scale ADC range. Support Auto Ranging and Auto Scaling.
27 Support digital persistence (phosphorescent, rainbow) mode and equivalent time
sampling mode.
28 Support mixed signal (analog and digital) display.
29 Supports Multilingual User Interface under Windows 2000, XP, Vista, 7, 8, 8.1,
10, 11 and above. Currently supported languages are English, French, German,
Italian, Portuguese, Spanish, Russian, Simplified Chinese, Traditional Chinese,
Japanese and Korean.
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1.5.2 Spectrum Analyzer
1 Seven view types: Real time Amplitude Spectrum, Real time Phase Spectrum,
Real time Auto Correlation Function, Real time Cross Correlation Function, Real
time Coherence/Non-Coherence Function, Real time Transfer Function /
Impedance Analyzer, Real time Impulse Response.
2 Independent X axis and Y axis zooming and scrolling.
3 In Amplitude Spectrum, Y axis supports relative modes in linear and dBr scale,
and absolute mode in RMS voltage, dBV, dBu, dB, dBFS scale. X axis supports
linear, logarithmic and octave scale (1/1, 1/3, 1/6, 1/12, 1/24, 1/48, 1/96). Support
amplitude / power spectrum density display. Y axis can be converted to
impedance display.
4 Analysis results can be exported as TXT files.
5 Data curves can be print-previewed, printed out directly or saved as BMP files.
6 Fast display refresh rate: about 50 frames per second (tested with a sound card
under Windows XP SP2 on IBM ThinkPad R51 Laptop PC with Intel Pentium M
processor 1.60 GHz, with sweep time=10 ms and FFT size=1024 and both the
Oscilloscope and the Spectrum Analyzer running under "Auto" mode). Thus data
are displayed and analyzed in "true" real time.
7 The colors of display, font size, screen refresh rate are configurable.
8 FFT size can be adjusted from 128 to 4194304 points.
9 Allow record length to be different from FFT size. If the FFT size is greater than
the record length, then zero(s) will be added at the end of the actual measurement
data during FFT computation. If the FFT size is less than the record length, then
the measurement data will be split into different segments with the size of each
segment equal to the FFT size. Segment overlap percentage can be selected in the
range of 0%~99.9%. The final result will be obtained by averaging the FFT results
from all segments.
10 Support 69 window functions: Rectangle, Triangle (or Fejer), Hann, Hamming,
Blackman, Exact Blackman, Blackman Harris, Blackman Nuttall, Flat Top,
Exponential, Gaussian, Welch (or Riesz), Cosine, Riemann (or Lanczos), Parzen,
Tukey, Bohman, Poisson, Hann-Poisson, Cauchy, Bartlett-Hann, Kaiser, etc.
11 Display peak frequency with a sub-FFT-bin-size accuracy in Amplitude Spectrum
display, second peak time delay and corresponding coefficient in Auto Correlation
Function display, peak time delay and corresponding coefficient in Cross
Correlation Function display, peak frequency and corresponding coefficient in
Coherence Function display, peak frequency and corresponding gain and phase in
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Transfer Function display, peak time and corresponding value in Impulse
Response display.
12 Allow the measurement of Total Harmonic Distortion (THD), THD+Noise
(THD+N), Signal in Noise and Distortion (SINAD), Signal-to-Noise Ratio (SNR),
Noise Level (NL), Total Non-Coherent Distortion+Noise (TNCD), and GedLee
Metric in a specified frequency range.
13 Allow the measurement of IMD-SMPTE/DIN, IMD-CCIF2, IMD-CCIF3, DIM,
Crosstalk, Bandwidth (-3dB), Harmonics, Energy in user defined frequency bands,
Peaks, Total Distortion+Noise (TD+N), Wow & Flutter, sound loudness, loudness
level, sharpness & articulation index.
14 In THD measurement and harmonics analysis, the fundamental frequency can be
detected automatically based on the highest frequency peak or another variable
such as the RPM reading from a tachometer (e.g. for the purpose of order
tracking). It can also be specified manually.
15 Support one cursor reader and two markers which stick to the measurement data.
Support peak markers.
16 Intra-frame processing includes: Remove DC Component, Frequency
Compensation, Frequency Weighting (flat, A weighting, B weighting, C
weighting, ITU-R 468 weighting), and Smooth via Moving Average (linear or
octave). Frequency compensation is achieved via loading a user configurable
text-based Frequency Compensation File (*.fcf).
17 Four inter-frame processing methods: None, Peak Hold, Linear Average,
Exponential Average. The number of frames (2~200, forever) for peak hold or
linear averaging can be specified. The process can be reset during runtime if
“forever” is chosen.
18 Five chart types: Line, Scatter, Column, Bar, and Step. Line width is adjustable.
19 Up to five reference curves can be set for each channel. The reference curve can
be configured by either copying the current curve, or loading a properly formatted
text file or a previously saved reference file from the hard disk. Reference curves
can be assigned as High-High, High, Low, Low-Low limits.
20 The data in the graph can be copied into the clipboard as text and later pasted into
other software such as Microsoft Excel for further analysis. The image of the
graph can be copied into the clipboard as Bitmap image and later pasted into other
software such as Microsoft Word.
21 Supports Multilingual User Interface under Windows 2000, XP, Vista, 7, 8, 8.1,
10, 11 and above. Currently supported languages are English, French, German,
Italian, Portuguese, Spanish, Russian, Simplified Chinese, Traditional Chinese,
Japanese and Korean.
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1.5.3 Signal Generator (Sweep/Arbitrary/Function/Noise/Burst Generator)
1 DAC Hardware Related Specifications
Sound Card Based Systems:
1) Bandwidth: 1 Hz - 200 kHz (sound card dependent).
2) Maximum Output Voltage: about 2 V (sound card dependent).
3) Selectable sampling frequency (up to 768 kHz), sampling bit resolution (8, 16
or 24 bits) and sampling channels (one or two) (sound card dependent).
4) Support calibration of the output channels.
Non Sound Card Based Systems:
Please refer to the respective hardware manual.
2 Support predefined waveforms: Sine, Rectangle, Triangle and Saw Tooth. The
duty cycle for a rectangle wave is adjustable.
3 Support non-repetitive pink noise and white noise generation. It is possible to
generate the identical or different noises across channels.
4 Support multi-tones generation. A Multi-Tones is a combination of predefined
waveforms with different amplitudes, frequencies, and phases. Pink noise and
white noise with specified amplitude can also be added into the multi-tones.
Maximum 200 tones can be combined in each channel. In addition to the manual
configuration method, automatic configuration method is provided to generate
multitones that are aligned to FFT bands or fractional octave bands within a
specified frequency range. When the multitones are aligned to FFT bands, it is
possible to specify the signal’s frequency response: white noise (flat), pink noise
(1/f) or arbitrary (a frequency response file *.frf).
5 Support arbitrary waveform generation through user defined waveform library. A
waveform library is a TXT file containing the coordinates of each point in one
cycle of the waveform. There is no limit as to how many points can be used to
define a waveform. Two types of libraries are supported: Waveform Library and
Bit Perfect Library.
6 Support Maximum Length Sequence (MLS) generation. The length can be
selected from 127 to 16777215.
7 Support Dual Tone Multi-Frequency (DTMF) generation.
8 Support musical scale tone generation.
9 The predefined waveform, multi-tones and user-defined waveform can be
generated at a frequency that sweeps linearly or logarithmically within a specified
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frequency range and time duration. Option is provided to allow a reverse sweep
after a forward sweep.
10 The predefined waveform, white noise, pink noise, multi-tones, user-defined
waveform and MLS can be generated at an amplitude that sweeps linearly or
logarithmically within a specified amplitude range and time duration. Option is
provided to allow a reverse sweep after a forward sweep.
11 Allow specifying the phase difference between the two channels if the output
signals have the same frequency.
12 The amplitude of the output signal is adjustable. Support Auto Ranging.
13 The generated signal can be saved as a WAV file or a TXT file for a duration of
up to 1000 s.
14 The output signal can be looped back partially (i.e. only one channel while the
other channel can be used for field input) or fully (i.e. both channels), via the
software itself, to the input of the oscilloscope for display and analysis in real time.
Synchronized operation between the Signal Generator and the Oscilloscope with a
timing accuracy in the same order of the sampling frequency is also supported. It
is possible to specify when to start the Oscilloscope after the Signal Generator is
started.
15 It is possible to add a mask with specified periodic on/off timing to the signal to
be output so that a burst-type signal can be generated. You can choose whether to
phase-lock each burst. The mask can be specified as a window function in order to
shape the envelop of the output signal. It is also possible to specify the off/on
amplitude ratio.
16 Support fade in/out and modulation (AM, FM, PM) of the output signal.
17 Support DDS mode for those devices that supports DDS mode.
18 Support DC offset adjustment for those devices that support it.
19 Supports Multilingual User Interface under Windows 2000, XP, Vista, 7, 8, 8.1,
10, 11 and above. Currently supported languages are English, French, German,
Italian, Portuguese, Spanish, Russian, Simplified Chinese, Traditional Chinese,
Japanese and Korean.
1.5.4 Multimeter
1 Display the RMS voltage value of the current frame of data in Vrms, dBV or dBu.
2 Display the sound pressure level of the current frame of data in dB, dB(A), dB(Z)
or dB(C).
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3 Display frequency (via the Frequency Counter), RPM (Revolutions Per Minute),
total counts (via the Counter), duty cycle, F/V voltage (via the Frequency Voltage
Converter), Cycle RMS, Cycle Mean, Pulse Width for the current frame of data.
You are allowed to configure the counter trigger level and the counter trigger
hysteresis in order to rectify the analog signal to rectangular pulses before these
analyses.
4 A frequency divider can be configured for each channel for the Frequency
Counter, RPM meter, Counter, F/V converter.
5 Display the RMS, Peak/PP, Crest Factor values for acceleration, velocity,
displacement if acceleration, velocity or displacement sensors are used.
6 Supports Multilingual User Interface under Windows 2000, XP, Vista, 7, 8, 8.1,
10, 11 and above. Currently supported languages are English, French, German,
Italian, Portuguese, Spanish, Russian, Simplified Chinese, Traditional Chinese,
Japanese and Korean.
1.5.5 Data Logger
1 Provide long time data logging function for 246 Derived Data Points (DDP) and
16 User Defined Data Point (UDDP), including RMS value, Peak Frequency,
Sound Pressure Level, RPM, THD, etc.
2 Up to eight data logger windows can be opened and each window can trace up to
8 variables. You can configure which derived variables to be logged.
3 Color of each trace can be configured.
4 The range of Y axis can be configured. Y axis can be displayed in linear or
logarithmic scale.
5 X axis is always a time axis with an accuracy of 1ms. The span of X axis can be
configured. The screen automatically scrolls as new data are continuously fed into
the right of the window.
6 Data are logged in text format. Each log file contains a maximum 32767
(configurable) lines of data. The file name reflects the time stamp of that file. Log
files can be reloaded into the data logger window for display.
7 Three logging methods: Fastest (i.e. whenever new data are available), Time
Interval (i.e. whenever new data are available and the specified time duration has
elapsed since the last update), Update Threshold (i.e. whenever new data are
available and the change compared with the last update exceeds the specified
update threshold).
8 The data in the graph can be copied into the clipboard as text and later pasted into
other software such as Microsoft Excel for further analysis. The image of the
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graph can be copied into the clipboard as Bitmap image and later pasted into other
software such as Microsoft Word.
9 Recorded data can be exported as TXT files.
10 Data curves can be printed out directly or saved as BMP files.
11 Supports Multilingual User Interface under Windows 2000, XP, Vista, 7, 8, 8.1,
10, 11 and above. Currently supported languages are English, French, German,
Italian, Portuguese, Spanish, Russian, Simplified Chinese, Traditional Chinese,
Japanese and Korean.
1.5.6 Spectrum 3D Plot
1 Support Waterfall Plot and Spectrogram. It can be generated by multiple frames
of data (Inter-frame Mode) or one single frame of data (Intra-frame mode). The
former supports Short Time Fourier Transform (STFT) only while the latter
supports both STFT and Cumulative Spectral Decay (CSD).
2 For Waterfall Plot, the tilt angle of T axis and the height percentage of Y axis are
adjustable. Six color palettes are available: No Color, Rainbow, Bluish,
Yellowish, Grayscale, Inverted Grayscale.
3 For Spectrogram, five color palettes are available: Rainbow, Bluish, Yellowish,
Grayscale, Inverted Grayscale. A smoothing option is provided.
4 X axis can be displayed in linear, logarithmic, or 1/1 ~ 1/96 octave scale.
5 Y axis is displayed in absolute mode in RMS Voltage, dBV, dBu, dB or dBFS.
6 Number of spectral profiles can be set from 10 to 200.
7 Spectral profiles are time stamped with an accuracy of 1 ms.
8 A 3D cursor reader can be used to display the X, Y, T readings of an actual
measurement point. The X-Y profile at that point is highlighted and also displayed
in a separate X-Y plot.
9 The data in the graph can be copied into the clipboard as text and later pasted into
other software such as Microsoft Excel for further analysis. The image of the
graph can be copied into the clipboard as Bitmap image and later pasted into other
software such as Microsoft Word.
10 Analysis results can be exported as TXT files. The 3D data can be sliced by either
time or frequency.
11 Data curves can be print-previewed, printed out directly or saved as BMP files.
12 Independent X axis and Y axis zooming.
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13 Supports Multilingual User Interface under Windows 2000, XP, Vista, 7, 8, 8.1,
10, 11 and above. Currently supported languages are English, French, German,
Italian, Portuguese, Spanish, Russian, Simplified Chinese, Traditional Chinese,
Japanese and Korean.
1.5.7 Device Test Plan
1 Provides a mechanism for you to configure and conduct your own device test
steps. It takes the advantage of the sound card’s (or other ADC/DAC hardware’s)
capability of simultaneous input & output, to generate a stimulus to the Device
Under Test (DUT) and acquire the response from that device at the same time.
Different stimuli can be generated and the response can be analyzed in different
ways.
2 Supports 25 instructions with corresponding parameters. Support using variables
in scripts.
3 Parameters to be tested can be selected from 242 DDPs and 16 UDDPs, including
RMS value, Peak Frequency, Sound Pressure Level, RPM, Gain, THD, etc.
4 Test results (e.g. Gain vs Frequency, Phase vs Frequency, etc.) can be plotted in
up to 8 X-Y plots and reported in one textual log window called Device Test Plan
Log in real time. The data in X-Y Plots can be exported as TXT files or copied
into the clipboard as text and later pasted into other software such as Microsoft
Excel for further analysis. The graph of the X-Y plot can be copied into the
clipboard as Bitmap image and later pasted into other software such as Microsoft
Word. The graphs can also be printed out directly or exported as BMP files. The
data in the Device Test Plan Log can be saved as a TXT file.
5 Support batch file processing and batch signal event capturing and storing.
6 A device test plan can be created, edited, modified, saved, locked, reloaded, and
executed.
7 There are two types of device test plans: locked and unlocked. A locked device
test plan cannot be modified within the software after it has been created.
8 Support Pass/Fail check. Support connection with external systems through serial
communication.
9 Supports Multilingual User Interface under Windows 2000, XP, Vista, 7, 8, 8.1,
10, 11 and above. Currently supported languages are English, French, German,
Italian, Portuguese, Spanish, Russian, Simplified Chinese, Traditional Chinese,
Japanese and Korean.
1.5.8 LCR Meter
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1 Can measure the value of an inductor, a capacitor, a resistor, or the impedance of a
network of them in a wide range and display the result in a big font.
2 Two types of external connections are supported: serial connection for high
impedance measurement, and parallel connection for low impedance measurement.
Serial connection uses the sound card’s input impedance as reference, while
parallel connection uses an external resistor of a relatively small value as
reference.
3 Support the calibration of the sound card input impedance which may vary with
frequency.
4 The value of the external reference resistor (if any) can be entered.
5 The measurement range is displayed and updated when the relevant settings
change.
6 The LCR Meter is a special Device Test Plan with built-in LCR measurement
algorithm. The default LCR test plan uses 1 kHz sine wave as the test tone.
However, you can configure your own LCR test plans (e.g. with different test
tones) if necessary.
7 Same as Device Test Plan, the test results can be plotted in up to 8 X-Y plots. The
variables for X and Y axes can be configured.
8 Supports Multilingual User Interface under Windows 2000, XP, Vista, 7, 8, 8.1,
10, 11 and above. Currently supported languages are English, French, German,
Italian, Portuguese, Spanish, Russian, Simplified Chinese, Traditional Chinese,
Japanese and Korean.
1.5.9 Derived Data Point (DDP) Viewer
1 Display the value of a Derived Data Point (DDP) or User Defined Data Point
(UDDP) in a standalone window. Maximum 24 windows can be opened.
2 Allow High-High, High, Low, Low-Low alarming.
configured. Alarm acknowledgement is supported.

Alarm sounds can be

3 Displayed precision can be specified.
4 Allow the user to define a UDDP using a mathematical expression. Various math
functions are supported.
5 Support inter-frame processing including linear and exponential averaging.
6 Support DDP array viewer which can be used to generate the following reports:
•
•

Harmonic Frequencies, RMS, Phases
Octave Bands, RMS
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Peak Frequencies, RMS, Phases
Frequency Bands, RMS
Reverberation / Speech Intelligibility (1/1 Octave)
Reverberation / Speech Intelligibility (1/3 Octave)

1.5.10 Derived Data Curve (DDC)
1

Derive a dedicated data curve from a frame of sampled data and display it in a
standalone graph window. Maximum 8 DDC windows can be opened.

2

The DDC window is similar to the X-Y Plot in Device Test Plan except that its
context menu contains a [X-Y Plot Processing] menu item which is used to select
a predefined DDC and configure its relevant parameters. The supported DDCs
are:
•
•
•
•
•
•
•
•

Energy Time Curve (Log-Squared)
Energy Time Curve (Envelop)
Energy Time Curve (dBSPL)
Impulse Response Schroeder Integration Curve
Step Response Curve (via Impulse Response Integration)
Frequency Time Curve
X-Y Plot
Shock Response Spectrum
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1.6 Signal Flow
1.6.1 Intra-Frame Processing and Inter-Frame Processing
Physical quantities can be converted to electronic signals by sensors. The analog
electronic signals can be quantized by ADC devices and then processed and analyzed
by virtual instrument software. Generally, in Multi-Instrument, after quantization, the
signals flow from time domain (Oscilloscope) to frequency domain (Spectrum
Analyzer) and then time-frequency domain (Spectrum 3D Plot). The data are not
processed sample by sample but frame by frame instead. The number of samples
(Record Length) contained in a data frame equals to [Sampling
Frequency]×[Sampling Duration]. Processing performed within a data frame is called
Intra-frame Processing while that performed among multiple data frames is called
Inter-frame Processing. For example, when FFT size is less than Record Length, a
data frame will be divided into multiple partially-overlapped FFT segments and the
resulting spectrum will be based on their averaged results. This is intra-frame
averaging. If averaging is performed further among different data frames, then it is
inter-frame averaging.
A data frame can be acquired upon being triggered or by free run. During real time
processing, there is usually a gap between adjacent data frames unless the sampling
rate is sufficiently low compared to the data processing rate under free run mode (e.g.
Auto Trigger Mode for sound cards). In case multiple frames of data must be
sampled and processed without any gaps in between, record data continuously to the
hard disk first via the Record button at the upper right corner of the screen and then
post-process them via [File]>[Open Frame by Frame]. It is possible to specify a
frame overlap percentage in this case. Record Mode will be described later.

The Oscilloscope window always contains one data frame only. The data inside the
data frame are normally continuous without any gap. However, this may or may not
be true in Roll Mode where a data frame is formed by concatenating multiple
individually-sampled data segments. The data inside each data segment are
continuous without any gap, but there may be a gap between adjacent data segments
depending on the sampling rate and system throughput, etc. The length of the data
segment is called Roll Width which can be configured through [Setting]>[Display]>
“Roll Mode”> “Roll Width”. Roll Mode will be described later.
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1.6.2 Signal Flow Block Diagram
The following signal flow block diagram illustrates how the signal is processed and
analyzed in the software. It helps you to understand the behavior of the software, and
even configure your own signal processing and analysis algorithm for a particular
application, without programming using development tools such as LabVIEW and
MATLAB. For example, changing the oscilloscope’s SINC interpolation setting for
waveform rendering will not affect the Mean, Min., Max., RMS calculation of the
signal as these values are calculated before the SINC interpolation. Inter-frame
averaging and Intra-frame digital filtering in time domain (Oscilloscope) will affect
the subsequent spectral analysis in frequency domain (Spectrum Analyzer).
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1.7 Precautions
Signals with high voltage can easily burn your sound card (or your ADC/DAC
hardware) or even your computer. Be extremely careful and strictly follow your sound
card (or ADC/DAC hardware) Manufacturer's Manual when connecting to external
devices. Do not connect to signals with unknown amplitude. If the signal amplitude is
high, attenuate it first before connecting it to your sound card (or ADC/DAC
hardware).
To avoid personal injury, always follow the usual safety rules when working with
electric circuits.
IN NO CASE WILL THE AUTHOR AND THE PUBLISHER OF THE SOFTWARE
BE RESPONSIBLE FOR PERSONAL INJURY, HARDWARE AND/OR DATA
DAMAGE, PROPERTY DAMAGE OR PROFIT LOSS ARISING FROM USE OR
INABILITY TO USE THE SOFTWARE.
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2 Oscilloscope
2.1 Overview

This is a dual channel Oscilloscope, providing five types of views:






Waveform of Channel A and Channel B
Waveform of Channel A + Channel B
Waveform of Channel A - Channel B
Waveform of Channel A  Channel B
Lissajous Pattern for Channel A and Channel B

Statistical data such as Maximum, Minimum, Mean, Root Mean Square Values are
also calculated and displayed. Each frame of data is time stamped with an accuracy
of 1 ms and the time stamp is shown at the lower left corner of the Oscilloscope view.
The acquired signal can be inter-frame averaged (synchronously averaged), time
aligned, demodulated (AM, FM, PM), DC removed, half-wave or full-wave rectified,
and digitally filtered before any other analyses. The types of digital filters supported
are: Low Pass, High Pass, Band Pass, Band Stop and Arbitrary. The class of the filter
can be FFT, FIR or IIR. Reverberation, speech intelligibility, waveform discontinuity,
step response, echo, and damping ratio analyses are supported.
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The displayed waveform can be output directly via the default computer sound card
(if the sampling rate and bit resolution of the waveform is compatible with it) by
pressing the Play or Cyclic Play buttons in the Miscellaneous Toolbar.
The Oscilloscope also provides a Record Mode which can be used to record data to
the hard disk continuously until the recording process is stopped manually or 2
gigabytes of data has been recorded, whichever is earlier. The oscilloscope display
can also work in Roll mode, with which the screen will be updated in real time even if
the sweep time is long.
The Oscilloscope can perform waveform conversion among acceleration, velocity and
displacement when acceleration, velocity or displacement sensors are used.
The Oscilloscope can display both analog and digital signals in one window and thus
can be used as a MSO (Mixed Signal Oscilloscope) when used with a hardware MSO.
The Oscilloscope supports digital persistence display mode, Equivalent Time
Sampling (ETS) mode, SINC interpolation between samples.

2.2 Trigger Parameters

The above toolbar contains (from left to right):
Trigger Mode, Trigger Source, Trigger Edge, Trigger Level, Trigger Delay, Trigger
Frequency Rejection.
The software supports both hardware trigger and software trigger. For hardware
trigger, the triggering capacity is determined by the hardware. Different hardware
may have different contents in the above parameters.
For sound card based data acquisition, it is possible to specify a software trigger
condition for collecting a frame of data. There are two concurrent processes in this
context, one is data sampling and collecting, the other is data analysis and display.
Once a frame of data is collected into the PC memory, the software will start
immediately to search for the next trigger event in order to collect the next frame of
data. Meanwhile, the collected data will be analyzed and then displayed. With the fast
PCs nowadays, normally data analysis and display will take less time than data
sampling and collecting as the latter one is constrained by the sweep time and cannot
benefit from the fast speed of the PCs. In case that the data sampling and collecting
process is faster than the data analysis and display process, the latest frame of data
will overwrite the previous one even if it has not yet been analyzed and displayed.
This is to ensure that data analysis and display will always be performed on the latest
collected frame of data.
In order to obtain a stable display for a periodic signal, the trigger parameters must be
set properly such that there is only one such trigger condition in one cycle of the
signal. The software also features a specially designed algorithm which effectively
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eliminates the lateral shaking of waveform display due to limited sampling rate
compared with the signal frequency.
2.2.1 Trigger Mode

There are four trigger modes:
2.2.1.1 Auto
Depending on the ADC hardware used, the Auto mode here can be the “real” Auto
mode or actually the Free Run mode.
The real Auto mode is similar to the Normal mode (see the section below) in that all
trigger conditions specified are still in effect, except that a frame of data will be
collected even if no trigger has been found after a certain timeout period. In this
mode, the display might not be stable even if the signal under test is periodic, due to
the fact that each frame of data may not be started at the same trigger position.
In a Free Run mode, frames of data are collected, analyzed and displayed
continuously without a trigger. Very fast display refresh rate can be achieved in this
mode, however, the display may not be stable even if the signal under test is periodic,
due to the fact that each frame of data may not be started at the same trigger
position. In this mode, the selection of Trigger Source, Trigger Edge, Trigger Level
and Trigger Delay is disabled and these parameters are not used.
For sound card based data acquisition, the Auto mode means the Free Run mode.
2.2.1.2 Normal
A frame of data are collected, analyzed and displayed when the trigger condition
specified is met. This process will keep going until the oscilloscope is stopped.
For sound card based data acquisition, when the sweep time (record length) is very
short, the oscilloscope display may become unstable. It is recommended to use Slow
Trigger Mode when the sweep time (record length) is less than 500 µs for internal
sound cards, and 5 ms for external sound cards. Note that these recommended values
may vary with the sound card used.
2.2.1.3 Single
One frame of data are collected, analyzed and displayed upon the first trigger event.
The data acquisition process stops afterwards. This mode is ideal for transient signal
capturing.
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2.2.1.4 Slow
It is similar to the Normal mode, except that the data acquisition hardware will be
reinitialized and restarted automatically every time a new frame of data is collected.
The display refresh rate is thus slow in this mode.
For sound card based data acquisition, it is recommended to use this mode when the
sweep time (record length) is very short and the display becomes unstable in Normal
Trigger Mode.
2.2.2 Trigger Source

When only Channel A is sampled, the trigger source is fixed at Channel A and is not
selectable.
When both Channel A and Channel B are sampled, the trigger source is selectable,
either Channel A or Channel B.
The software also supports EXT (external) trigger and ALT (alternative) trigger if the
hardware used supports them. The EXT trigger can be an external digital trigger or an
external analog trigger with an adjustable trigger level. Under ALT trigger mode,
both channels are triggered independently on their own. You can use ALT trigger
mode to obtain stable waveform displays for two independent periodic signals.
2.2.3 Trigger Edge

Five types of Trigger Edge are available:
Up: When "Up" is selected, a trigger event is found when the signal is crossing the
specified Trigger Level from below to above.
Dn (Down): When "Dn" is selected, a trigger event is found when the signal is
crossing the specified Trigger Level from above to below.
UD (Up or Down): When “UD” is selected, a trigger event is found when the signal is
crossing the specified Trigger Level from below to above, or from above to below.
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JP (Jump): When “JP” is selected, a trigger event is found when the amount of change
of the signal is greater than the amount specified by the Trigger Level. When the
Trigger Level is positive, the change must be “Jump Up”. When the Trigger Level is
negative, the change must be “Jump Down”. For example, under this mode, “Trigger
Level=100%” means that the signal magnitude must increase by 100% of half of the
ADC full-scale voltage (1/2 Vpp) between two adjacent data points in order to be
qualified for a trigger, and “Trigger Level = -100%” means that the signal magnitude
must decrease by 100% of half of the ADC full-scale voltage (1/2 Vpp) between two
adjacent data points in order to be qualified for a trigger.
DF (Differential): When “DF” is selected, a trigger event is found when the absolute
amount of change of the signal is greater than the absolute amount specified by the
Trigger Level. Under this mode, Trigger Level can only be adjusted from 0~100%.
For example, “Trigger Level=100%” means that the signal magnitude must increase
or decrease by 100% of half of the ADC full-scale voltage (1/2 Vpp) between two
adjacent data points in order to be qualified for a trigger．
The last three trigger edges are generally only available with software trigger.
2.2.4 Trigger Level

Trigger Level is expressed as a percentage of half of the ADC full-scale voltage (1/2
Vpp). It is adjustable from -100% to 100%, except that when Trigger Edge is “DF”,
Trigger Level can only be adjusted from 0 to 100%. The up and down arrows provide
adjustment in a step of 1%. For finer adjustment, enter the value directly. Trigger
Level can also be adjusted via the Trigger Level Marker described in Section “Trigger
Marker”.
2.2.5 Trigger Delay

Trigger Delay spin box is located on the right hand side of the Trigger Level spin box.
It is expressed as a percentage of the Record Length Per Sweep and is adjustable from
-100% to 100%. A positive value means post-trigger while a negative value means
pre-trigger. Trigger Delay can also be adjusted via the Trigger Delay Marker
described in Section “Trigger Marker”. If you want the trigger point to be displayed
at the center of the Oscilloscope rather than the default leftmost end (Trigger Delay =
0%), like an ordinary oscilloscope, set the Trigger Delay to -50%.
2.2.6 Trigger Frequency Rejection
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Trigger Frequency Rejection can be used to filter out noises from the trigger signal to
prevent false triggering. Depending on the ADC hardware used, the available options
can be: NIL (All-Pass), HFR (High Frequency Rejection), NR0~NR4 (Noise
Rejection), HN0~HNX (High Frequency Rejection + Noise Rejection). There are
different levels of noise rejection. Generally, for Levels 0~4, the hysteresis values are
fixed while for Level X, it is user-configurable via [Setting]>[ADC Device]. Please
refer to the respective hardware manual for details.
For sound cards (MME and ASIO) and software triggered NI DAQmx cards, the
specification of each option is as follows:
Nil: No Rejection
HFR: High Frequency Rejection, cut off at 0.11×[Sampling Frequency]
NR0: Noise Rejection, hysteresis = 1% of half of full scale
NR1: Noise Rejection, hysteresis = 2% of half of full scale
NR2: Noise Rejection, hysteresis = 4% of half of full scale
NR3: Noise Rejection, hysteresis = 8% of half of full scale
NR4: Noise Rejection, hysteresis = 16% of half of full scale
HN0: HFR + NR0
HN1: HFR + NR1
HN2: HFR + NR2
HN3: HFR + NR3
HN4: HFR + NR4
HNX: selectable HFR + adjustable hysteresis = 0% ~ 25% of half of full scale
Note: The specified hysteresis may be modified internally to ensure [Trigger Level
(%)] – [Hysteresis (%)] ≥ -100% at rising edge, or [Trigger Level (%)] +
[Hysteresis (%)] ≤ 100% at falling edge.

2.3 Sampling Parameters

The above toolbar contains (from left to right):
Sampling Frequency, Sampling Channels, Sampling Bit Resolution, and Record
Length Per Sweep.
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Sampling Parameters together with the Trigger Parameters determine how the data are
sampled and collected. The sampling capability is fully dependent on the ADC
hardware used. Different hardware may have different contents in the above
parameters.
Once the sampling parameter is specified and "Run" button is clicked, it will attempt
to start sampling using the specified sampling parameters. An error message will pop
up if the specified sampling parameters are not supported by the ADC hardware.
Note that some sound cards may not generate an error message even if the sampling
frequency specified exceeds the limit. Please check your sound card manual before
you use a sampling frequency greater than 44100 Hz, otherwise measurement error
may be introduced.
2.3.1 Sampling Frequency

For a sound card based system, the following sampling frequencies can be selected:
2kHz, 4kHz, 8kHz, 11.025kHz, 16kHz, 22.05kHz, 32kHz, 44.1kHz, 48kHz, 64kHz,
88.2kHz, 96kHz, 176.4kHz, 192kHz, 384kHz, 768kHz. In addition, you can enter a
frequency value directly when the Oscilloscope is not running.
2.3.2 Sampling Channels

For a sound card based system, two options are available:


A
Only Channel A is sampled.

www.virtins.com

66

Copyright © 2006-2022

Virtins Technology

VIRTINS Multi-Instrument 3.9 Manual



Virtins Technology

A&B
Both Channel A and Channel B are sampled.

2.3.3 Sampling Bit Resolution

For a sound card based system, three options are available: 8Bit, 16Bit, 24Bit, 32Bit.
2.3.4 Record Length per Sweep

Record Length per Sweep (or per frame) determines how many points (samples) will
be captured per sweep for each channel. Normally you do not need to specify the
Record Length directly as it is implicitly determined by the Sweep Time and the
Sampling Frequency (Record Length = Sweep Time × Sampling Frequency). When
you change the Sweep Time or Sampling Frequency, the Record Length will be
automatically updated accordingly. Under some circumstance, you may want to
explicitly specify the record length, for example, you may want the Record Length to
be an integer multiple of 10 or a power of 2. Then you can either select or enter the
Record Length you want directly. The sweep time will then be automatically updated
accordingly so that all data points can be accommodated in one sweep.
There are 15 options available for you to select: 50, 100, 200, 500, 1000, 2000, 5000,
10000, 20000, 30000, 40000, 50000, 60000, 500000, 1000000.
Alternatively, you can enter any number for the Record Length as long as the sweep
time is less than 500 s and the computer memory allows.
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Changing Record Length directly is disabled at the very beginning in order to avoid
confusion to beginners. It can be enabled via [Setting]>[Display]>[Enable Record
Length change via "Point" in Sampling Parameter Toolbar].
The maximum Record Length that can be set is limited by the ADC hardware buffer
size. You should always keep this rule in mind when you change the Sweep Time or
Sampling Frequency which will change the Record Length indirectly or when you
change the Record Length directly. This rule is enforced by the software. For
example, if the requested Record Length exceeds the ADC hardware buffer size when
you change the Sweep Time, then the software will attempt to lower the Sampling
Frequency in order to keep the Record Length within the ADC hardware buffer size.
On the other hand, if the requested Record Length exceeds the ADC hardware buffer
size when you change the Sampling Frequency, then the software will attempt to
lower the Sweep Time in order to keep the Record Length within the ADC hardware
buffer size. If the software is unable to enforce the rule, an error message will pop up.
The software also enforces a minimum Record Length when you change the Sweep
Time or Sampling Frequency. This is to ensure that a sufficient number of data points
are acquired in one frame. If the requested Record Length is lower than the minimum
Record Length, then the software will adjust the Sampling Frequency or Sweep Time
in order to keep the Record Length above the minimum value. It should be noted that
changing the Record Length directly is considered as an intended action and thus is
not affected by this rule. Different ADC hardware may have different minimum
Record Length values which are set inside the software.

2.4 Miscellaneous Parameters

The above toolbar contains (from left to right):
Invert Input Signal button, Channel A Zeroing button, Channel B Zeroing button,
Windows Recording Control, Windows Volume Control, Play button, Cyclic Play
button, ADC Channel A Coupling Type, ADC Channel B Coupling Type, ADC
Channel A Range, ADC Channel B Range, Probe A Current Switch Position, Probe B
Current Switch Position, and Input Peak Level Indicators for Channel A and Channel
B.
2.4.1 Invert Input Signal
If the button
is depressed, the input signal will be inverted by the software just
after A/D conversion, e.g. +1V will become -1V after the inversion. All the
subsequent processing such as triggering, data analysis and display will be performed
based on the inverted signal.
The button is in released state by factory default.
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2.4.2 Zeroing
If the input of a channel is connected to its ground, the oscilloscope should display a
straight horizontal line at 0 V. However, this may not always be the case. Some ADC
hardware, if not compensated by software, may display an offset voltage when their
input is actually at the ground level. Therefore, there is a need to compensate this
offset for ADC hardware.
: This button will only be enabled when the oscilloscope is in running state and the
Trigger Mode is "Auto". Once pressed, a message box will pop up with three options:
Yes, No, Cancel. You will need to connect the input for Channel A to the ground
before you choose Yes, in order to set the ground level for Channel A to zero. If you
select No, then the ground level will be reset to its default value (i.e. no
compensation). You may choose Cancel to cancel the operation.

: This button will only be enabled when the oscilloscope is in running state, the
Trigger Mode is "Auto" and the Sampling Channels is "A&B". Once pressed, a
message box will pop up with three options: Yes, No, Cancel. You will need to
connect the input for Channel B to the ground before you choose Yes, in order to set
the ground level for Channel B to zero. If you select No, then the ground level will be
reset to its default value (i.e. no compensation). You may choose Cancel to cancel the
operation.

2.4.3 Windows Recording Control
2.4.3.1 Recording Control before Windows Vista
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A typical Recording Control of Windows XP (or other Windows versions before
Windows XP) is shown as above. Different sound cards may have different items in
the Recording Control.
2.4.3.1.1 Sound Card Selection
When accessing the Windows Recording Control from the Windows Control Panel,
you need to choose the sound card used for data acquisition first if multiple sound
cards exist.
When pressing the button
in the Miscellaneous Toolbar of the software, the
Recording Control of the sound card used by the software for data acquisition will be
opened.
For this software, the Recording Control is used to select the input source and adjust
its internal gain. The selection of sound card is done via [Setting]>[ADC
Device]>[Device No.].

2.4.3.1.2 Input Source Selection
From the Recording Control, you can configure the input sources for data acquisition.
The input source can be CD Player, Microphone, Line In, Wave Out Mix, etc,
depending on the sound card used. To test an external electrical signal, either Mic
Input or Line In should be used. Wave Out Mix (sometimes called “What U Hear” or
something similar) can be used to get the signal being output by the sound card. You
can select it as the input source for data acquisition in order to analyze and display
what is being output by the Signal Generator. This, in fact, switches the software into
simulation mode with the loopback at the sound card mixer level.
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2.4.3.1.3 Input Gain Adjustment
The input gain can be adjusted by moving the volume slider corresponding to the
input source selected for data acquisition. For Microphone, it is usually possible to
further adjust the gain by selecting/removing Mic Boost in the Advanced Controls for
Microphone as shown below. Normally selecting Mic Boost will increase the internal
gain by 10 times (i.e. 20dB).

2.4.3.2 Recording Control from Windows Vista Onward
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There are some changes of the Recording Control from Windows Vista onward.
Under Windows Vista, you do not select a sound card first and then open its
Recording Control which contains all its input sources and their gain controls. Instead,
you select a so-called input endpoint (i.e. a particular input source on a particular
sound card, for example, the microphone of a particular sound card) first in the
Windows Sound Recording control panel (see the figure above) and then open its
property window (see the figure below) to adjust its gain.

www.virtins.com

72

Copyright © 2006-2022

Virtins Technology

VIRTINS Multi-Instrument 3.9 Manual

Virtins Technology

2.4.3.2.1 Input Endpoint Selection
When pressing the button
in the Miscellaneous Toolbar of the software, the
Windows Sound Recording control panel will be opened.
For this software, the Windows Sound Recording control panel is used to adjust the
gain of the selected input endpoint. The selection of the input endpoint is done via
[Setting]>[ADC Device]>[Device No.]. Note that only the enabled input endpoints
will be available for selection, and any on-the-fly change (e.g. enable/disable, set as
default) of the input endpoints when the Oscilloscope is running may cause the
software to stop data acquisition. You will then need to restart the data acquisition if
necessary.

2.4.3.2.2 Input Gain Adjustment
The gain of the selected input endpoint can be adjusted by selecting the input
endpoints in the Windows Sound Recording control panel and then opening its
property window to adjust its gain.
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2.4.4 Windows Volume Control
2.4.4.1 Volume Control before Windows Vista

A typical Windows Volume Control is shown as above. Different sound cards may
have different items in the Volume Control.

2.4.4.1.1 Sound Card Selection
When accessing the Windows Volume Control from the Windows Control Panel, you
need to choose the sound card used for signal output first if multiple sound cards exist.
When pressing the button
in the Miscellaneous Toolbar of the software, the
Volume Control of the sound card used by the software for signal output will be
opened.
For this software, the Volume Control is used to select the output source and adjust
the output volume. The selection of sound card is done via [Setting]>[DAC
Device]>[Device No.].
2.4.4.1.2 Output Source Selection
From the Volume Control, you can configure the output sources for signal output. For
the Signal Generator of the software, all output sources for signal output should be
muted except the Volume Control and Wave, in order to minimize the unwanted
noises.

2.4.4.1.3 Output Volume Adjustment
The output volume can be adjusted via either the Volume Control slider or Wave
slider.
www.virtins.com

74

Copyright © 2006-2022

Virtins Technology

VIRTINS Multi-Instrument 3.9 Manual

Virtins Technology

2.4.4.2 Volume Control from Windows Vista Onward

Under Windows Vista, you select a so-called output endpoint (i.e. a particular output
destination on a particular sound card, for example, the “Speakers” of a particular
sound card) first in the Windows Sound Playback control panel (see the figure above)
and then open its property window (see the figure below) to configure its output
source and output volume.
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2.4.4.2.1 Output Endpoint Selection
When pressing the button
in the Miscellaneous Toolbar of the software, the
Windows Sound Playback control panel will be opened.
For this software, the Windows Sound Playback control panel is used to select the
output source and adjust its output volume. The selection of the output endpoint is
done via [Setting]>[DAC Device]>[Device No.].
2.4.4.2.2 Output Source Selection
From the property window of the selected output endpoint, you can configure the
output sources for signal output. For the Signal Generator of the software, all output
sources for signal output should be muted except the master Volume Control, in order
to minimize the unwanted noises.
2.4.4.2.3 Output Volume Adjustment
The output volume can be adjusted via the master Volume Control slider.

www.virtins.com

76

Copyright © 2006-2022

Virtins Technology

VIRTINS Multi-Instrument 3.9 Manual

Virtins Technology

2.4.5 Waveform Play
The waveform displayed in the Oscilloscope can be played (output) through the
default sound card by pressing the
button in the Miscellaneous Toolbar. Note that
this playback is possible only if the sampling rate and bit resolution of the waveform
is compatible with the Windows default sound card.
2.4.5.1 Play Speed Changing and Pitch Shifting
The default play speed is the original sampling frequency. If there is a need to adjust
this speed, click the
will pop up.

button with the CTRL key down, the following dialog box

The “Original” sampling frequency is always selected upon software restart. You can
select or enter a new sampling frequency directly and click OK. The software will
then create a temporary file “~temp.wav” in the software’s installation directory and
replay it. You can rename the file to keep a pitch-shifted and speed-changed WAV
file, in order to convert an inaudible signal to an audible one.
2.4.6 Waveform Cyclic Play
The waveform displayed in the Oscilloscope can be cyclically played (output) through
the default sound card by pressing the
button in the Miscellaneous Toolbar.
Releasing this toggle button will stop the cyclic playing. Note that this playback is
possible only if the sampling rate and bit resolution of the waveform is compatible
with the Windows default sound card.
2.4.6.1 Play Speed Changing and Pitch Shifting
Same as 2.4.5.1.
2.4.7 Coupling Type for ADC Channels A & B

The left one is for ADC Channel A and the right one is for ADC Channel B.
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Almost all sound cards are AC coupled. For other ADC hardware, the options can be
AC, DC or GND, depending on the hardware used.

2.4.8 Range for ADC Channels A & B

The left one is for ADC Channel A and the right one is for ADC Channel B.
For sound cards, calibration is normally required in order to determine their ADC
ranges, and their ADC ranges change with their input gain setting which is adjustable
via the Windows Recording Control.
Calibration is normally not required for other ADC hardware with the ADC ranges
explicitly specified. If the hardware supports multiple ADC ranges, the above combo
boxes will become selectable.

2.4.9 Current Switch Position for Probes A & B

The two combo boxes on the right hand side of "Probe" in the Miscellaneous Toolbar
allow you to select the probe attenuation factors corresponding to the current
attenuation switch position on your probes or test leads. The left one is for Channel A
and the right one is for Channel B. You can have at most 16 switch positions. The
dedicated sound card oscilloscope probe supplied by Virtins Technology is best suited
for sound card based systems.
Please refer to: VIRTINS Sound Card Oscilloscope Probe Manual.
Download link:
http://www.virtins.com/Virtins-Sound-Card-Oscilloscope-Probe-Manual.pdf

Note that these two combo boxes only allow you to select the corresponding
attenuation factors so that the sampled data can be scaled properly in the software.
They will not set the physical switch position on the probe for you. You have to set it
manually. More generally, this function can be very useful to properly scale the
sampled data for those ADC devices that have attenuation (gain) switches not
controllable from Multi-Instrument.
The actual labels and attenuation factors for different switch positions can be
configured via [Setting]>[Calibration]. This will be introduced later in this document.
2.4.10 Input Peak Level Indicator for ADC Channels A & B
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The above two Input Peak Level Indicators reflect the peak level of the frame of data
acquired, the upper one is for Channel A and the lower one is for Channel B. It is
expressed as a percentage of the ADC full-scale range. The color of the indicator
changes gradually from green to orange as the percentage goes from 0% to 100% (i.e.
0 dBFS).
If the Input Peak Level is equal to 100%, the indicator will be fully filled with red
color. Under this situation, it is recommended to lower the input gain of the hardware,
increase external attenuation, or lower the signal under test directly, in order to avoid
peak clipping from happening.

2.5 View Parameters

View Parameters determine how the collected data are displayed and analyzed.
2.5.1 Sweep Time (T)
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Unlike other view parameters, Sweep Time (T) is not only a view parameter, but also
a sampling parameter. It determines the number of samples to acquire in one sweep
(=[Sweep Time]×[Sampling Frequency]).
There are 49 options for Sweep Time. They are 1 ns, 2 ns, 4 ns, 5 ns, 10 ns, 20 ns, 40
ns, 50 ns, 100 ns, 200 ns, 400 ns, 500 ns, 1 µs, 2 µs, 4 µs, 5 µs, 10 µs, 20 µs, 40 µs, 50
µs, 100 µs, 200 µs, 400 µs, 500 µs, 1 ms, 2 ms, 4 ms, 5 ms, 10 ms, 20 ms, 40 ms, 50
ms, 100 ms, 200 ms, 400 ms, 500 ms, 1 s, 2 s, 4 s, 5 s, 10 s, 20 s, 40 s, 50 s, 100 s, 200
s, 400 s, 500 s, Record.
This parameter is applicable to all types of views in the Oscilloscope.
Note that if you select a longer sweep time, it will take a longer time for the acquired
data and analyzed results to be shown on the screen. When the sweep time is long,
you can tick the “Roll” checkbox in the Sampling Parameter Toolbar in order to get
real time update of the screen. Please refer to the section for Roll Mode for details.
If “Record” is chosen, the oscilloscope will enter into Record Mode. Please refer to
the section for Record Mode for details.
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2.5.2 Sweep Time Multiplier

The Sweep Time Multiplier is the zooming factor for T axis. There are 16 options
available: ×1, ×2, ×5, ×10, ×20, ×50, ×100, ×200, ×500, ×1000, ×2000, ×5000,
×10000, ×20000, ×50000, ×100000.
When "×1" is selected, the full range of the Sweep Time is displayed over the width
of the view.
If you change the Sweep Time Multiplier to "×N" which is greater than 1, then only
1/N of the full range of the Sweep Time is displayed over the width of the view, with
a horizontal scrollbar at the bottom which allows you to scroll over the full range of
the Sweep Time.
This parameter is applicable to all types of views in the Oscilloscope except Lissajous
Pattern display.
This multiplier can also be adjusted via the magnifying glass which will be shown if
you put the mouse cursor just below T axis. Left click to zoom in and right click to
zoom out. Zoom in/out can also be performed using the mouse wheel. Mouse wheel
down & scroll will reset the Multiplier to "×1".

2.5.3 Channel A Display Range
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You can specify the Display Range for Channel A. Available options are: Off, Auto,
±1pV, ±2pV, ±5pV, ±10pV, ±20pV, ±50pV, ±100pV, ±200pV, ±500pV,±1nV, ±2nV,
±5nV, ±10nV, ±20nV, ±50nV, ±100nV, ±200nV, ±500nV, ±1µV, ±2µV, ±5µV,
±10µV, ±20µV, ±50 µV, ±100µV, ±200µV, ±500µV, ±1mV, ±2mV, ±5mV, ±10mV,
±20mV, ±50mV, ±100mV, ±200mV, ±500mV, ±1V, ±2V, ±5V, ±10V, ±20V, ±50V,
±100V, ±200V, ±500V, ±1kV, ±2kV, ±5kV, ±10kV, ±20kV, ±50kV, ±100kV,
±200kV, ±500kV, ±1MV, ±2MV, ±5MV, ±10MV, ±20MV, ±50MV, ±100MV,
±200MV, ±500MV, ±1GV, ±2GV, ±5GV, ±10GV, ±20GV, ±50GV, ±100GV,
±200GV, ±500GV. Note that the engineering unit of the above options is determined
by the engineering unit of the sensor for Channel A, which can be set via
[Setting]>[Calibration]> "Sensor"> "Unit". For example, if the unit is "g" instead of
"V", then the unit in all the above options will be changed to "g".
When "Off" is selected, the signal in Channel A will not be displayed in the
Oscilloscope. When "Auto" is selected, the Display Range for Channel A will be set
automatically by the software based on the following formula:
Display Range = the nearest integer that is equal to or greater than the value of
[ADC Range] / [Sensor Sensitivity]
where the sensor sensitivity is set via [Setting]>[Calibration]> "Sensor">"Sensitivity".
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This parameter is applicable to all types of views in the Oscilloscope. It should be
noted that in "Channel A + Channel B" view, this voltage display range is for
"Channel A + Channel B". Similarly, In "Channel A – Channel B" view, it is for
"Channel A – Channel B", and in "Channel A  Channel B" view, it is for "Channel A
 Channel B".
2.5.4 Channel A Multiplier

The Multiplier for Channel A is the zooming factor for A axis. There are 9 options
available: Off, ×1, ×2, ×5, ×10, ×20, ×50, ×100, ×200.
When "Off" is selected, the full Display Range for Channel A is displayed over the
height of the view.
When "×1" is selected, initially the full range is displayed over the height of the view
with a vertical scroll bar on the left of the view. You can use the scroll bar to move
the data curve for Channel A up and down.
If you change the multiplier to "×N" which is greater than 1, then only 1/N of the full
range is displayed over the height of the view, with a vertical scrollbar on the left of
the view. You can use the scroll bar to scroll over the full Display Range.
This parameter is applicable to all types of views in the Oscilloscope except Lissajous
Pattern display. It should be noted that in "Channel A + Channel B" view, this
parameter is for "Channel A + Channel B". Similarly, In "Channel A – Channel B"
view, it is for "Channel A – Channel B", and in "Channel A  Channel B" view, it is
for "Channel A  Channel B".
This multiplier can also be adjusted via the magnifying glass which will be shown if
you put the mouse cursor on the left side of A axis. Left click to zoom in and right
click to zoom out. Zoom in/out can also be performed using SHIFT + mouse wheel.
SHIFT + mouse wheel down & scroll will reset the Multiplier to "Off".

2.5.5 View Type
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There are five types of views in the Oscilloscope: A&B, A+B, A-B, AB, A|B。
Changing the View Type will affect the calculation of the following Derived Data
Points (DDPs) of Channel A in the Oscilloscope:
(1) Max_A(EU): Maximum value for Channel A or combined
(2) Min_A(EU): Minimum value for Channel A or combined
(3) PP_A(EU): Peak-to-Peak value for Channel A or combined
(4) Mean_A(EU): Mean value for Channel A or combined
(5) RMS_A(EU): RMS value for Channel A or combined
(6) PWR_A(W): Power value (= RMS2 / Load Factor) for Channel A or combined
It will also affect the following DDPs of Channel A in the Multimeter:
(1) RMSDBV_A(dBEU): RMS value in dBEU for Channel A or combined
(2) RMSDBu_A(dBu): RMS value in dBu for Channel A or combined
(3) RMSDB_A(dB): RMS value in dB for Channel A or combined
However, it does not affect the calculation of other DDPs of Channel A in the
Oscilloscope, such as:
(1) PeakLevelPercent_A(%): Peak Level in Percentage for Channel A
(2) PeakLeveldBFS_A: Peak Level in dBFS for Channel A
(3) WaveformComparisonH_A: Waveform High or High-High Limit Alarm for
Channel A
(4) WaveformComparisonL_A: Waveform Low or Low-Low Limit Alarm for
Channel A
Channel B has all the above mentioned DDPs. The calculation of them is not affected
by the selection of View Type.
2.5.5.1 A&B
Waveform display of Channel A and Channel B
2.5.5.2 A+B
Waveform display of Channel A + Channel B
2.5.5.3 A-B
Waveform display of Channel A - Channel B
2.5.5.4 A×B
Waveform display of Channel A  Channel B.
As an example, the following figure shows how to use this function to measure power
factor. The instantaneous voltage and current are measured by Channel A and
Channel B respectively. The measured RMS voltage in Channel A is 707 mV while
the measured RMS current in Channel B is 707 mA. This results in an apparent power
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of 0.707(V)×0.707(A)=0.50(W). The real power is obtained by the mean value of
A×B and reads 0.354W here. Therefore the power factor is: 0.354/0.50=0.71. In this
example, the voltage and current are both sine waves and have a phase difference of
45°. Thus the power factor can also be calculated as: cos(45°)=0.71. The Panel
Setting File of this measurement can be found in the software’s installation
directory\psf\PowerFactor_FFT32768_SR48000.psf.

2.5.5.5 A|B (XY Mode, Lissajous Pattern)
Lissajous Pattern display for Channel A and Channel B.
The following figure illustrates the Lissajous Pattern of a 1 kHz sine wave in Channel
A and 4 kHz sine wave in Channel B.
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2.5.6 Channel B Display Range
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You can specify the Display Range for Channel B. Available options are: Off, Auto,
±1pV, ±2pV, ±5pV, ±10pV, ±20pV, ±50pV, ±100pV, ±200pV, ±500pV, ±1nV, ±2nV,
±5nV, ±10nV, ±20nV, ±50nV, ±100nV, ±200nV, ±500nV, ±1µV, ±2µV, ±5µV,
±10µV, ±20µV, ± 50µV, ±100µV, ±200µV, ±500µV, ±1mV, ±2mV, ±5mV, ±10mV,
±20mV, ±50mV, ±100mV, ±200mV, ±500mV, ±1V, ±2V, ±5V, ±10V, ±20V, ±50V,
±100V, ±200V, ±500V, ±1kV, ±2kV, ±5kV, ±10kV, ±20kV, ±50kV, ±100kV,
±200kV, ±500kV, ±1MV, ±2MV, ±5MV, ±10MV, ±20MV, ±50MV, ±100MV,
±200MV, ±500MV, ±1GV, ±2GV, ±5GV, ±10GV, ±20GV, ±50GV, ±100GV,
±200GV, ±500GV. Note that the engineering unit of the above options is determined
by the engineering unit of the sensor for Channel B, which can be set via
[Setting]>[Calibration]> "Sensor">"Unit". For example, if the unit is "g" instead of
"V", then the unit in all the above options will be changed to "g".
When "Off" is selected, the signal in Channel B will not be displayed in the
Oscilloscope. When "Auto" is selected, the Display Range for Channel B will be set
automatically by the software based on the following formula:
Display Range = the nearest integer that is equal to or greater than the value of
[ADC Range] / [Sensor Sensitivity]
where the sensor sensitivity is set via [Setting]>[Calibration]> "Sensor">"Sensitivity".
For single channel data, this control will be disabled.
This parameter is only applicable to two types of views: Channel A & Channel B and
Lissajous Pattern. It is disabled in the other two types of views.
2.5.7 Channel B Multiplier

The Multiplier for Channel B is the zooming factor for B axis. There are 9 options
available: Off, ×1, ×2, ×5, ×10, ×20, ×50, ×100, ×200.
When "Off" is selected, the full Display Range for Channel B is displayed over the
height of the View.
When "×1" is selected, initially the full range is displayed over the height of the view
with a vertical scroll bar on the right of the view. You can use the scroll bar to move
the data curve for Channel B up and down.
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If you change the multiplier to "×N" which is greater than 1, then only 1/N of the full
range is displayed over the height of the view, with a vertical scrollbar on the right of
the view. You can use the scroll bar to scroll over the full Display Range.
This parameter is only applicable to one types of view: Channel A & Channel B. It is
disabled in other types of views.
This multiplier can also be adjusted via the magnifying glass which will be shown if
you put the mouse cursor on the right side of B axis. Left click to zoom in and right
click to zoom out. Zoom in / out can also be performed using CTRL + mouse wheel.
CTRL + mouse wheel down & scroll will reset the Multiplier to "Off".

2.6 Menu
The Oscilloscope has its own menu and additional functions can be accessed through
the menu items in each submenu. Click anywhere within the Oscilloscope window
will switch the software’s main menu to the Oscilloscope menu.
2.6.1 File SubMenu

This submenu provides access to the file operation and printing functions.
2.6.1.1 New (File SubMenu) (ALT-F-N, CTRL-N)
The command is used to create a new, blank document for measurement, with the
system default panel setting fixed in the factory. The new document will be used to
hold the latest collected frame of data.
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This command is also available through the button
in the Instrument Toolbar.
When there is no Oscilloscope, Spectrum Analyzer and Multimeter opened, click the
above "Oscilloscope" button will open a new document without changing the current
Trigger and Sampling Parameters.

2.6.1.2 Open (File SubMenu) (ALT-F-O, CTRL-O)
The command is used to open an existing document. Only standard and extensible
WAV files in PCM format can be opened. An error message will pop up if the file
format is not recognizable. WAV files with PCM format are widely supported by
many software products. You can use a third-party software program such as "Sound
Recorder" provided in Windows to record the data and then use Multi-Instrument to
display and analyze the data.
This command is also available through the button
in the Sampling Parameter
Toolbar. Only one document can be opened at a time. It is possible to open a WAV
file through “Drag and Drop” when the Oscilloscope is not running.
If the file to be opened is too big to be held in one Oscilloscope frame, the software
will automatically open it frame by frame (see description below).

2.6.1.3 Open Frame by Frame (File SubMenu) (ALT-F-F)
The command is the same as the Open command described previously, except that it
opens a WAV file frame by frame. It is particularly useful for opening a long WAV
file. The frame width (i.e. Record Length Per Sweep) should be set first. The
following dialog box will pop up after the file to be opened is selected. You can either
specify the frame width in millisecond or number of points. The total file length in
millisecond and points are also displayed for reference.

For example (see figure below), if the frame width is 441 points and the WAV file has
44100 points in total, then the file will be split into 100 frames with each frame
contains 441 points. Under this mode, the Long Wave File Navigation Toolbar
becomes visible. The meaning of each component in this toolbar is listed as follows:
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: Frame Up, if pressed, the current frame position will move one frame backward
if the beginning of the file has not been reached yet.
: Frame

Down, if pressed, the current frame position will move one frame forward
if the end of the file has not been reached yet.
: Frame Auto Scroll, a toggle button, if pressed down, the current frame position
will move forward frame by frame with or without overlap automatically till the end
of the file is reached. Every frame will be analyzed and displayed according to the
current settings, and no frame will be skipped. This feature is very useful for
performing post-analysis such as Spectrum 3D Plot and Data Logging automatically
on a long WAV file. During the auto scrolling process, the Frame Up and Frame
Down buttons are disabled. If the Frame Auto Scroll button is released up, the auto
scrolling process will stop, and the Page Up and Page Down buttons will be enabled
again.
: Current Frame Position slider. It reflects the
position of the current frame with regards to the length of the file. It can also be used
to adjust the position of the current frame.
: Current Frame Position/Length of the File. For example,
0.08s/1s means that the current frame starts at 0.08 second and the length of the file is
1 second.
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: Frame Overlap Percentage. This parameter specifies the inter-frame
overlap percentage and has effect on Frame Down, Frame Up, Frame Auto Scroll
commands. It can be set from 0% to 99.9%. As a comparison, the Window Overlap
Percentage in the Spectrum Analyzer View Toolbar specifies the intra-frame overlap
percentage of FFT segments. You can combine the two overlap percentages to
achieve a certain overall overlap scheme for FFT analysis.

During frame navigation, it is possible to save the current frame of data as an
individual wave file.
2.6.1.4 Import (File SubMenu) (ALT-F-I)
This command is used to import data from a properly formatted TXT file. The
following illustrates the format of the TXT file for single channel and dual-channel
cases.
(1) Format for Single Channel:
Example:
;Data Points
;Sampling Frequency (Hz) = 44100
;Sampling Bit Resolution (Bits) = 16
;Sampling Channels = 1
;A:Full-scale Voltage (V) = 1
;A:Sensor Sensitivity (V/V) = 1
;Total Data Points = 441
;Digital Channels = 0
1,0
2,0.141968
3,0.281097
……
439,-0.41449
440,-0.281097
441,-0.141968
(2) Format for Dual Channels:
Example:
;Data Points
;Sampling Frequency (Hz) = 44100
;Sampling Bit Resolution (Bits) = 16
;Sampling Channels = 2
;A:Full-scale Voltage (V) = 1
;A:Sensor Sensitivity (V/V) = 1
;B:Full-scale Voltage (V) = 1
;B:Sensor Sensitivity (V/V) = 1
;Total Data Points = 441
;Digital Channels = 0
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1,0,0
2,0.141968,-0.141968
3,0.281097,-0.281097
……
439,-0.41449,0.41449
440,-0.281097,0.281097
441,-0.141968,0.141968
The first a few lines (start with “;”) form the header. The values on the right hand
side of “=” are important, they specify the Sampling Frequency (Hz), Sampling Bit
Resolution (Bits), Number of Sampling Channels (analog), Full-scale Voltage (V),
Sensor Sensitivity (V/V), Total Number of Data Points, and Number of Digital
Channels. Note that the unit of the Sensor Sensitivity is expressed as [ADC
Engineering Unit] / [Sensor Engineering Unit]. The software supports three kinds of
ADC Engineering Units, Voltage (V), Ampere (A), and Coulomb (C) depending on
the ADC hardware used. The Sensor Engineering Unit can be configured freely.
The header lines are followed by the data lines. Each data line contains two (single
channel) or three (dual channels) comma separated variables. The first variable is the
sequential number, and the second and third variables are the data for Channel A and
Channel B respectively. The absolute values of all the data must be lower than the
value of [Full-scale Voltage/Ampere/Coulomb] / [Sensor Sensitivity] specified in the
header lines. The software will still function correctly if the sequential numbers are
omitted. It is also possible to import bare data without header lines (see examples
below).
(3) Bare data for Single Channel (without header lines):
Example:
0
0.141968
0.281097
……
-0.41449
-0.281097
-0.141968
(4) Bare data for Dual Channels (without header lines):
Example:
0,0
0.141968,-0.141968
0.281097,-0.281097
……
-0.41449,0.41449
-0.281097,0.281097
-0.141968,0.141968
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Under the above situation, the following dialog box will pop up, requesting additional
information about the data, including sampling rate and engineering unit.

In addition to the standard format described above, the TXT files exported by the
Oscilloscope, Spectrum Analyzer (in Auto / Cross Correlation and Impulse Response
Modes) and Signal Generator, which have a slightly different format than the
aforementioned ones (i.e. one more column for time information), can also be
imported for analysis.
It is possible to import a TXT file through “Drag and Drop” when the Oscilloscope is
not running.
Some sample TXT files are provided in the WAV directory of the software and can be
used as templates.

2.6.1.5 Combine (File SubMenu) (ALT-F-B)
This command is used to combine data from individual channels of two WAV files.
One WAV file must be opened first. Then you can load the data from either channel
of the second WAV file and use them to replace/combine the data in either channel of
the currently opened WAV file.
WAV files that can be combined must have less than or equal to two channels' data,
with the same sampling frequency and sampling bit resolution. The record length of
the second WAV file must be less than or equal to that of the first WAV file.
2.6.1.6 Extract (File SubMenu) (ALT-F-T)
This command is used to extract data from the currently opened WAV file and save
them into a new WAV file.
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You can either specify the time range or the point number range to extract data. The
range can also be specified by placing two markers in the Oscilloscope. Pressing
"Save as" to store the extracted data to a WAV file.
2.6.1.7 Close (File SubMenu) (ALT-F-C)
This command is used to close an opened document. If the document content has been
changed and the change has not yet been saved, a message box will pop up to ask
whether you want to save the change or not.
2.6.1.8 Save (File SubMenu) (ALT-F-S, CTRL-S)
This command is used to save an opened document. If the document is new, then you
will be prompted to give a file name for the document.
This command is also available through the button
in the Sampling Parameter
Toolbar. This function is disabled when the document is empty.
2.6.1.9 Save As (File SubMenu) (ALT-F-A)
This command is used to save an opened document with a specified new file name.
This function is disabled when the document is empty.
2.6.1.10 Print Screen (File SubMenu) (ALT-F-R)
This command allows you to print the currently displayed content in the main window
of the software to a printer.
2.6.1.11 Oscilloscope Export (File SubMenu) (ALT-F-E)
This command is used to export either the measured data to a TXT file or the
currently displayed graph to a BMP file. When clicked, a "Save As" window will pop
up. You can specify whether you want to export as a TXT file or a BMP file by
selecting "Text File (*.txt)" or "Bitmap File (*.bmp)" in the "Save as type" combo box.
The exported text files can be imported into third party software such as Microsoft
Excel for further processing and analysis.
This function is disabled when the document is empty.
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2.6.1.12 Oscilloscope Print (File SubMenu) (ALT-F-P, CTRL-P)
This command allows you to print the currently displayed graph in the Oscilloscope
to a printer. This function is disabled when the document is empty.
2.6.1.13 Oscilloscope Print Preview (File SubMenu) (ALT-F-V)
This command allows you to have a preview before printing.
disabled when the document is empty.

This function is

2.6.1.14 Recent File (File SubMenu)
Up to four recently opened files will be remembered. You can directly open them
from the Recent File List.
2.6.1.15 Exit (File SubMenu) (ALT-F-X)
The program will exit upon this command.
2.6.2 Setting SubMenu

This submenu provides access to various setting functions.
2.6.2.0 Restore to Factory Default (Setting SubMenu) (ALT-S-U)
Refer to Section 1.3.1.1.
2.6.2.1 ADC Device (Setting SubMenu) (ALT-S-A)
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This dialog is used to select and configure the current ADC device used by the
software. You must make sure the device is already connected to the computer before
selection.
The device models available for selection are configured via [Setting]>[ADC Device
Database] which will be described later. Once you select a device model in the Device
Model combo box, the rest of parameters will be updated accordingly. If multiple
devices in the same device category exist in the system, then you can select one of
them via the Device No. combo box. You may also need to select the Trigger Type,
Device Channel, Range, Coupling Type and Terminal Type, etc., depending on the
device model selected. Please refer to Section “ADC Device Database” for detailed
description of these items. If the selected ADC device allows enabling / disabling
IEPE excitation at the input, then the IEPE selection boxes will be enabled. Select
“NIL” to disable IEPE excitation, and select or enter a non-zero excitation current
value (in mA) to enable it at the specified value (if the hardware supports that value).
Some ADC devices come with their own control panels, such as those with ASIO
drivers. If the control panel is available for the selected device, the Control Panel
button will be enabled. Clicking it will open the control panel.
The selection for Range and Coupling Type is also available in the Miscellaneous
Toolbar in the main window.
Multi-Instrument supports two logic ADC channels: A and B. If the device has more
than two physical ADC channels, then you need to assign two of them to the two
logic channels.
In addition to the analog input channels, some ADC devices such as VT DSO-2810
and VT DSO-2810E, have digital input channels. You can choose to display the
signals from the digital input channels in the oscilloscope view by checking the
respective checkboxes. It may be possible to adjust the thresholds for digitizing the
analog signals connected to the digital input channels, depending on the hardware
used. The figure below is an example of the mixed signal display.
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In the Miscellaneous section of the ADC Device Setting dialog, there are five options:
(1) Effective Bit Resolution Enhancement
(2) Trigger Master
(3) AutoRanging
(4) AutoScaling
(5) Auto Button for AutoRanging only
The above (1) and (2) are hardware-specific options, please refer to the respective
hardware manual for details.
The AutoRanging checkbox will be available for selection for those devices that
support multiple input ranges. If the AutoRanging checkbox is ticked, the software
will monitor the peak level in the sampled data frame continuously and step up/down
the input range based on the specified dBFS value. The specified dBFS value will also
affect the autoranging function performed by the Auto button in the Sampling
Parameter Toolbar in the main window. 0 dBFS is the default value, which is usually
good for SNR, but may not be good for other parameters such THD.
If the AutoScaling checkbox is ticked, the software will automatically and
continuously adjust the vertical scales of the Oscilloscope, Spectrum Analyzer and
Spectrum 3D Plot based on the peak level in the sampled data frame. The difference
between AutoRanging and AutoScaling is that AutoRanging changes the hardware
gain settings while AutoScaling changes the software display settings.
By default, the Auto button in the Sampling Parameter Toolbar performs on-demand
automatic adjustment of sampling rate, record length and input ranges. If the “Auto
Button for AutoRanging only” checkbox is ticked, it will perform on-demand
autoranging function only.
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In the Trigger Frequency Rejection HNX section, you can customize the HNX option
in the Trigger Frequency Rejection combo box in the Sampling Parameter Toolbar.
You can specify (1) whether to incorporate the high frequency rejection (2) the noise
rejection hysteresis in percentage. Please refer to the respective hardware manual for
details.
Seven options for channel operation are available as follows. They are selfexplanatory. These options are useful for some applications. For example, Option (2)
can be used to make a real time waveform comparison between a sine wave and its
residual harmonics (i.e. its fundamental is removed through digital filtering). Options
(3) and (4) can be used to convert a single-ended measurement to a differential
measurement and is useful in some I~V measurements.
(1)
(2)
(3)
(4)
(5)
(6)
(7)

Nil
A=iA, B=iA
A=iA-iB, B=iB
A=iA, B=iB-iA
A= (iA+iB)/2, B=(iA-iB)/2
A= (iA+iB)/2, B=iB
A= iA, B=(iA+iB)/2

The settings here will be applied and saved if the OK button is pressed. The
corresponding axis titles in the Oscilloscope window will be heighted if channel
operation is configured.

2.6.2.2 DAC Device (Setting SubMenu) (ALT-S-E)

This dialog is used to select and configure the current DAC device used by the
software. You must make sure the device is already connected to the computer before
selection.
The device models available for selection are configured via [Setting]>[DAC Device
Database] which will be described later. Once you select a device model in the Device
Model combo box, the rest of parameters will be updated accordingly. If multiple
devices in the same device category exist in the system, then you can select one of
them via the Device No. combo box. You may also need to select the Device Channel,
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Range, etc., depending on the device model selected. Please refer to Section “DAC
Device Database” for detailed description of these items.
Multi-Instrument supports two logic DAC channels, A and B. If the device has more
than two physical DAC channels, then you need to assign two of them to the two
logic channels.
Some ADC devices have a Probe CAL output for oscilloscope probe calibration. The
Probe CAL signal is normally a 1kHz ~ 10kHz square wave. During probe calibration,
the Probe CAL signal is injected into the oscilloscope via the probe. One can fine tune
the compensation trimmer on the probe such that the waveform displayed on the
oscilloscope screen is “square” and not distorted, i.e. neither over compensated nor
under compensated. You can choose to output either Rectangle or MLS signal. When
MLS is selected, the frequency value here refers to the clock frequency of the MLS
generator rather than the output signal frequency. Normally the Probe CAL signal
output is enabled. You can disable the signal output by un-ticking the checkbox.
Please refer to the respective hardware manual for details.
The DDS Interpolation and External Trigger options in the above dialog are also
hardware specific. A DDS DAC device uses a lookup table (i.e. DDS buffer) to hold
the shape of the signal to be generated. The DDS output suffers from the limited
number of entries in the lookup table. The output value “jumps” when going from
one entry to the next, introducing unwanted high frequencies in the output signal.
This adverse effect may not be discernible when the output signal frequency is high
(due to the output anti-aliasing low pass filtering and the fact that the limited entries
in the DDS buffer are anyway not fully utilized under this situation), but becomes
sensible as the output signal frequency goes down. DDS interpolation can be used to
fix or alleviate this problem. Instead of using the value stored in the lookup table
directly, it dynamically computes the output value through linear interpolation
between two successive lookup table values. This effectively enlarges many times the
DDS lookup table. Please refer to the respective hardware manual for details.
If the DAC device supports multiple output ranges, then the AutoRanging option will
be enabled for selection. If it is selected, the output range will be automatically
selected by the software based on the output amplitude specified in the Signal
Generator and the specified dBFS value here. 0 dBFS is the default value, which is
usually good for SNR, but may not be good for other parameters such THD.
Some DAC devices support both single-ended and differential outputs simultaneously.
The Differential option is used to indicate whether the output ranges are specified in
differential or single ended configuration. The output amplitudes in the Signal
Generator will follow the same configuration.
Some DAC devices come with their own control panels, such as those with ASIO
drivers. If the control panel is available for the selected device, the Control Panel
button will be enabled. Clicking it will open the control panel.
The settings here will be applied and saved if the OK button is pressed.
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2.6.2.3 Calibration (Setting SubMenu) (ALT-S-C)

This dialog provides the following parameters/functions:











Sound Card Input Calibration Factor
Sound Card Output Calibration Factor
Probe Calibration Factor
Input DC Offset Status
Sound Card Input Status
0dB Reference Vr
Frequency Voltage Conversion Calibration Factor
Latency for Synchronized Output / Input
Sensor Sensitivity and Unit
Load Factor for Power Calculation

During sound card calibration, Automatic Gain Control (AGC) (if any), Bass Boost (if
any), Treble Adjustment (if any) and so forth must be disabled to ensure that no
artificial modification on the input and output signal.
Most ADC devices measure voltage signals (unit: V), such as sound cards, VT DSOs,
VT IEPE-2G05. Some ADC devices measure electric current signals (unit: A). There
are also ADC devices that measure electric charge (unit: C), such as VT CAMP-2G05.
ADC devices normally come calibrated, such as VT DSOs, VT IEPE-2G05 and VT
CAMP-2G05. Their measurement range can be selected in the ADC Range selection
boxes in the Instrument & Miscellaneous Toolbar of the software. However, sound
cards are normally not voltage calibrated, and their internal gain adjustment (or range
selection, e.g. Mic 0%~100%, Line In 0%~100%, Mic Boost) is different from that of
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an ordinary ADC Device. This is why Sound Card Input Calibration Factors and
internal gain selections are listed separately here.
Sometimes, there is a need to use an external attenuation or amplification circuit (e.g.
a ×10 oscilloscope probe, a sound card hardware gain switch or knob) to expand the
measurement range of an ADC device. The external circuit is not controllable from
the software and thus it effects can only be taken into account by manually setting the
Probe Switch Position selection box in the Instrument & Miscellaneous Toolbar.
Each probe switch position has a probe attenuation factor associated with it. A value
less than 1 represents amplification instead of attenuation.
When a sensor with a known sensitivity is connected to the ADC device or its
external attenuation or amplification circuit, the data to be analyzed and displayed
will be in the sensor’s engineering unit. They will be calculated in the software
automatically according to the following formula:
[ADC Device Measured Value] × [Probe Attenuation Factor] × [Sensor Sensitivity]
2.6.2.3.1 Sound Card Input Calibration Factor
You can calibrate the input channels of a sound card by specifying a calibrated ADC
full-scale voltage (1/2 peak-to-peak) value, i.e. the “Range” in the Calibration Setting
dialog. The ADC full-scale voltage varies with the sound card internal gain, which is
continuously adjustable via the Recording Control described previously. It is not
practical to calibrate for every possible value of the gain. Instead, the software
divides the full range of the gain into five segments (0~20%, 20% ~ 40%, 40% ~ 60%,
60% ~ 80%, 80% ~ 100%) in each category (Microphone with Boost, Microphone,
Line In), with an assumption that the gain within each segment is linear. Therefore, at
most, you only need to perform calibration at 20%, 40%, 60%, 80%, 100% of the full
gain in each category and the ADC full-scale voltage at a particular gain value within
a gain segment can be calculated via interpolation or extrapolation without further
calibration. The calibration procedure is as follows:
Normal calibration procedure:
(1) Set the sound card internal gain to be calibrated by clicking the corresponding
radio box. The software will adjust the gain to that percentage for one time after
every such click. The current full-scale voltage value should not be touched.
(2) Input a sine wave (e.g. 1 kHz) with a known amplitude or RMS value to the input
channel to be calibrated. Adjust the signal source (not the sound card internal gain)
such that the Input Peak Level Indicator shows a value in the range of 80%~95%.
This is to ensure a sufficient calibration accuracy. The signal source can be the
calibrated Signal Generator of the software itself.
(3) In the Calculation pad, enter the amplitude/RMS value obtained from the
Oscilloscope into the Read Value field, and enter the actual amplitude/RMS value
of the signal into the Actual Value field. The actual value can be measured via
other instrument such as a conventional multimeter or oscilloscope. Then, press
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the Calculate button ONCE. The corresponding full-scale voltage field (i.e. the
Range field) will be filled automatically.
(4) Repeat (1)~(3) for other gain percentages.
For many sound cards, the gain is linear and Microphone with Boost provides exactly
20 dB’s gain over Microphone without Boost. Under this situation or assumption, you
only need to calibrate for one gain value and let the software to take care of the rest.
This simplifies the calibration procedure as follows:
Simplified calibration procedure for sound cards with linear gain and 20 dB’s
Mic Boost:
(1) Set the sound card internal gain to be calibrated (i.e. 80%) by clicking the
corresponding radio box. The software will adjust the gain to that percentage for
one time after every such click. The current full-scale voltage value should not be
touched.
(2) Input a sine wave (e.g. 1 kHz) with a known amplitude or RMS value to the input
channel to be calibrated. Adjust the signal source (not the sound card internal gain)
such that the Input Peak Level Indicator shows a value in the range of 80%~95%.
This is to ensure a sufficient calibration accuracy. The signal source can be the
calibrated Signal Generator of the software itself.
(3) In the Calculation pad, enter the amplitude/RMS value obtained from the
Oscilloscope into the Read Value field, and enter the actual amplitude/RMS value
of the signal into the Actual Value field. The actual value can be measured via
other instrument such as a conventional multimeter or oscilloscope. Then, press
the Calculate button ONCE. The corresponding full-scale voltage field will be
filled automatically.
(4) In the Calculation pad, click “Fill All (MIC)” button if Microphone is being
calibrated, or click “Fill All (Line In)” button if Line In is being calibrated. All the
corresponding full-scale voltage fields (i.e. the Range fields) will be filled
automatically.
If the software fails to detect the sound card’s input status or ASIO driver is used,
then you only need to calibrate the full-scale voltage value for the Other/ASIO field,
and bear in mind that any change of the sound card’s input gain after calibration may
invalidate the calibration.
You can leave the input calibration factors at their factory default values if absolute
magnitude measurement is not necessary.
2.6.2.3.2 Output Calibration Factor
You can calibrate the output channels of a sound card by specifying a DAC full-scale
voltage (1/2 peak-to-peak) value for a certain volume setting defined by yourself. The
volume setting is adjustable via the Volume Control described previously. Note that
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the calibration become invalid if the volume setting changes after calibration. The
calibration procedure is as follows.
(1) Set the sound card volume to be calibrated via the Volume Control. The current
full-scale voltage value should not be touched.
(2) Output a sine wave (e.g. 1 kHz) from the Signal Generator with an amplitude
within 80%~100% of the full-scale voltage (un-calibrated). This is to ensure a
sufficient calibration accuracy.
(3) In the Calculation pad, enter the above un-calibrated amplitude value into the
Read Value field, and enter the actual amplitude value of the output signal into the
Actual Value field. The actual value can be measured via other instrument such as
a conventional multimeter or oscilloscope. Then, press the Calculate button
ONCE. The full-scale voltage field (i.e. the Range field) will be filled
automatically. Note that normally a conventional multimeter only displays a RMS
value, you need to convert it into an amplitude value via the formula: Amplitude =
1.414  RMS.
2.6.2.3.3 Probe Calibration Factor
Up to 16 attenuation factors for external probe or attenuation switch positions can be
defined. Three of them can be specified in the main calibration page. The rest can be
accessed by clicking the “…” button to open the following page. An alias can be
defined for each switch position. If the alias is “empty”, then this switch position and
those after it will not be available in the probe switch position selection boxes in the
main window of the software. The configuration of these parameters helps to scale the
sampled data properly if the ADC device have gain or attenuation switches not
controllable from Multi-Instrument.
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For sound card based systems, you can make the probe by yourself using Section
"Input and Output Connection for Sound Card Based System" described previously as
a reference. If you want to purchase the probe off-the-shelf, it is highly recommended
to use the dedicated sound card oscilloscope probe supplied by Virtins Technology.
Please refer to Virtins Technology's website for the specification and calibration
procedure of the probe.

2.6.2.3.4 Input DC offset Status
The input DC offsets for Channel A and Channel B are displayed in two read-only
edit boxes. They are expressed as a percentage of the ADC full-scale voltage (1/2
Vpp). Ideally, the input DC offsets should be zero. A positive value means that there
exists a positive DC offset in that channel and it needs to be corrected by removing
that offset from the raw data by the software. The input DC offset is measured using
the “Zeroing” button in the Miscellaneous Toolbar. (refer to Section “Zeroing”
described previously for details).
The display of this parameter is more for diagnostic purpose.
2.6.2.3.5 0dB Reference Vr
This parameter is used only when displaying dB, dB(A), dB(Z), dB(C) in the
Spectrum Analyzer, Spectrum 3D Plot, and Multimeter. You can define your own
0dB reference or calibrate it according to a certain standard such as sound pressure
level.
Sound pressure is the pressure deviation from the local ambient pressure caused by a
sound wave. Sound pressure can be measured using a microphone in air and a
hydrophone in water. Sound Pressure Level (SPL) is a logarithmic measure of the
RMS sound pressure of a sound relative to a reference value, that is:
SPL (dB) = 20lg(prms/p0)
where p0 is the reference sound pressure and prms is the RMS sound pressure being
measured. The commonly used reference sound pressure in air is 20 µPa (rms). In
underwater acoustics, the reference sound pressure is 1 µPa (rms). The “0dB
Reference Vr” to be calibrated is the RMS voltage corresponds to the reference sound
pressure. It must be calibrated together with the microphone/hydrophone to be used.
The calibration procedure is as follows:
(1) Open the Multimeter and set its view type to “dB”.
(2) Put a calibrated conventional sound level meter at the same place with the
microphone. Note that the weighting profile used by this meter must be the same
as the one used by the software. (For better calibration accuracy, a sound level
calibrator should be used.)
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(3) Generate a reference sound signal (e.g. 1 kHz sine wave). Adjust the volume such
that the Input Peak Level Indicator shows a value in the range of 80%~95%. This
is to ensure a sufficient calibration accuracy.
(4) In the Calculation pad, enter the sound level obtained from the Multimeter (in dB)
into the Read Value field, and enter the actual sound level value obtained from the
conventional sound level meter into the Actual Value field. Then, press Calculate
button ONCE. The corresponding “0dB Reference Vr” field will be filled
automatically.
The input channels should be calibrated first before performing sound level
calibration. If both the sensor sensitivity and the input channel have been calibrated
separately, “0dB Reference Vr” can be filled directly with the standard reference level
without further calibration. For instance, for sound level in air, 0.00002 (Pa) should be
used.
2.6.2.3.6 Frequency Voltage Conversion Factor
This parameter is used only when converting frequency back to voltage in the
Multimeter. The software allows you to specify the frequency range and its
corresponding voltage range. The relationship between them is linear.

2.6.2.3.7 Latency for Synchronized Output/Input
This parameter is only applicable for the following two synchronized output / input
operation modes, i.e. “Sync. No Loopback” and “Sync. iB = oA”, in the Signal
Generator.
The latency is the time delay between the time when the Signal Generator is
commanded to start and the time when signal output actually starts. The latency needs
to be calibrated so that accurate synchronization can be achieved between the Signal
Generator and the Oscilloscope.
The calibration procedure is as follows:
(1) Set the latency value to zero during calibration.
(2) Loop back the output Channel A to the input Channel A via a cable with proper
attenuation if necessary.
(3) In the Signal Generator, select “Sync. iB = oA” mode, set "Start OSC after (s)" to
zero, prepare to output a 1 second’s sine wave at a frequency equal to roughly
1/10 of the sampling rate, e.g. 5kHz at a sampling rate of 48kHz.
(4) In the Oscilloscope, set “Trigger Mode” to “Single”, “Trigger Source” to “A”,
“Trigger Edge” to “DF”, “Trigger Level” to about “1%”, “Trigger Delay” to
“0%”. The measurement accuracy is directly affected by the “Sweep Time” of the
Oscilloscope. The shorter the “Sweep Time”, the higher the accuracy. It should
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be set to about “400µs” if the sampling rate is 48 kHz. These parameters together
with the sound card internal gain should ensure that the Oscilloscope is correctly
triggered at the very beginning of the signal.
(5) Stop the Oscilloscope if it is running.
(6) Start the Signal Generator.
(7) In the Oscilloscope, Channel A will display the captured signal which has gone
through the hardware (sound card output channel, loop back cable, sound card
input channel), and Channel B will display the signal generated by the Signal
Generator which has not gone through any hardware. On the bottom left corner of
the Oscilloscope window, the time stamp of the first data point in Channel A will
be displayed with an accuracy of 1 millisecond. On its right hand side, the time
difference between the Channel A and Channel B will be displayed in 1/1000 of a
millisecond. This time difference is normally a negative value, which means the
data in Channel B is earlier than the data in Channel A. Change the sign of this
value and assign it to the Latency being calibrated. Repeat the above procedure
for a few times to get the average value.
The following figure is an example of the above test.

2.6.2.3.8 Sound Card Input Status
Two statuses will be displayed here:
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Sound card input mixer status, including the input source as well as the gain
percentage



Sound card ADC full-scale voltage (Range) interpolated / extrapolated based on
the sound card input calibration factors and the current sound card input mixer
status

Note that if you change the sound card’s input mixer setting while the Calibration
Setting dialog is opened, you can click the Refresh button provided to capture those
changes.
2.6.2.3.9 Sensor Sensitivity and Unit
The unit of the Sensor Sensitivity is expressed as [ADC Engineering Unit] / [Sensor
Engineering Unit]. The software supports two kinds of ADC Engineering Units,
Voltage (V) and Ampere (A), depending on the ADC hardware used. The Sensor
Engineering Unit can be configured according to the sensor used. The software
provides 12 pre-configured options for the Sensor Engineering Unit: V (Voltage), A
(Ampere), g (for acceleration), m/s^2 (for acceleration), m/s (for velocity), m (for
displacement), i/s (for velocity in English unit), i (for displacement in English unit),
Pa (for pressure), C (for electric charge), N (for force), lbf (for force in English unit).
You can also enter your own sensor unit directly into the Unit edit box.
The value of the Sensor Sensitivity can be entered directly into the Sensitivity edit
box.
2.6.2.3.10 Load Factor for Power Calculation
There are a few power related Derived Data Points in the software (Please refer to the
chapter for Data Logger for details.). The power of the signal is calculated by:
Power = RMS2 / [Load Factor]
For example, if you measure the voltage across a resistor, then you can get the power
consumed by the resistor from the corresponding Derived Data Point by entering the
resistor’s value into the load factor field in the dialog; If you measure the current
through a resistor, then you can get the power consumed by the resistor from the
corresponding Derived Data Point by entering the reciprocal of the resistor’s value
into the load factor field.
2.6.2.3.11 Others
The functions of the buttons in the dialog are as follows:






: load a previously saved calibration file (*.cal).
: Save the current calibration data into a calibration file (*.cal).
Default: All parameters will be filled with the default values.
OK: Apply and save the changes and close the dialog.
Cancel: Cancel the changes and close the dialog.

www.virtins.com

107 Copyright © 2006-2022

Virtins Technology

VIRTINS Multi-Instrument 3.9 Manual



Virtins Technology

Advanced: Access to advanced hardware specific calibration function. Please
refer to the respective hardware manual for details.

2.6.2.4 Display (Setting SubMenu) (ALT-S-D)

2.6.2.4.1 Display Colors
For all views, the following display parameters are configurable:


Background Color
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Color of data curve for Channel A
Color of data curve for Channel B
Color of data curve for Channel EXT (digital input channel)
Grid Color
Other Text Color, such as the color for notes and horizontal axis label, etc.

Clicking on the color box will bring up a color selection window which allows you to
select the color you want. Skin 1 ~ Skin 8 are preconfigured color schemes.
2.6.2.4.2 Miscellaneous


Enable Record Length change via "Point" in Sampling Parameter Toolbar
If this checkbox is ticked, it allows advanced user to change the Record Length
directly. This is sometimes useful, e.g. when you want the Record Length to be
an integer multiple of the FFT size.
This checkbox is un-ticked by factory default.



Run oscilloscope automatically after startup
If ticked, the oscilloscope will run automatically with the default panel setting just
after startup.



Save Current Panel Setting on exit
If ticked, the current panel setting will be saved automatically as the default panel
setting when you exit the program.



Lock Panel Setting after startup
If ticked, the panel setting will be locked just after startup.



Hide Sampling Parameter Toolbar
If ticked, the Sampling Parameter Toolbar will be hidden.



Hide Instrument & Miscellaneous Toolbar
If ticked, the Instrument & Miscellaneous Toolbar will be hidden.



Hide View Toolbars
If ticked, all View Parameter Toolbars will be hidden.



Hide Menubar
If ticked, the menubar will be hidden. To access [Setting]>[Display] when the
menu bar is hidden, press CTRL+BREAK or CTRL+B.



Auto Layout after Loading a Panel Setting File
Three options are available:
(1) Nil: No auto layout, i.e. retain the original layout specified in the PSF file. A
PSF file can be saved with Nil, Tile Horizontally, Tile Vertically.
(2) Tile Horizontally: Equivalent to [Window]>[Tile Horizontally]
(3) Tile Vertically: Equivalent to [Window]>[Tile Vertically]
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ASIO Buffer Size
Selection of ASIO Buffer Size is enabled when ASIO driver is used and the ADC
and DAC have not been started. Three options are available: Auto, Max, Min,
Max should be used normally to avoid dropouts in the input and output signals.



Delegate Control to Local Panel
Some devices such as RTX6001 have their own local control panels and support
both local and remote (PC) control modes. This option is used to delegate the
control from PC to local control panel. Under local control mode, MultiInstrument will still be able to scale the input and output data properly according
to the settings on the local panel, however, all the controls (such as range selection)
from PC will not be disabled.

2.6.2.4.3 Language
You can change the language of the software user interface to your preferred language.
The software supports Multilingual User Interface under Windows 2000, XP, 2003,
Vista, 7, 8, 10 and above. Currently supported languages are English, French, German,
Italian, Portuguese, Spanish, Russian, Simplified Chinese, Traditional Chinese,
Japanese and Korean. The language change will take effect after your restart the
program.
2.6.2.4.4 Font Size
This parameter is used to adjust the font size of texts displayed in each view.
2.6.2.4.5 Refresh Delay
This parameter is used to adjust the delay time after the data analysis and display of
the current frame of data is finished and before the software starts to acquire the next
frame of data. To obtain the fastest screen refresh rate, set the Refresh Delay to 0%.
2.6.2.4.6 Roll Width under Roll Mode
This parameter specifies the Roll Width under the Roll Mode. Depending on the ADC
device used, it is expressed in either ms (millisecond) or pts (sampling points). Please
refer to the section for Roll Mode for more information.
2.6.2.4.7 Frame Width, Duration, No Auto Stop under Record Mode
These three parameters specify the Frame Width, Duration and No Auto Stop option
under the Record Mode. Depending on the ADC device used, the Frame Width is
expressed in either ms (millisecond) or pts (sampling points) while the Duration is
expressed in ms (millisecond) only. Frame Width specifies the buffer size of
streaming mode and Duration specifies the total time length of data to be recorded per
file. When Duration is 0, the recording process will only be stopped manually by
pressing the Record button again or after 2G bytes has been recorded. If “No Auto
Stop” is ticked, the recording process will record data into multiple files sequentially
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and can only be stopped manually. Please refer to the section for Record Mode for
more information.
2.6.2.4.8 Number of Records per Log File
This parameter specifies the number of records in a Data Logger log file. (Refer to
Section 6.2.4)
2.6.2.4.9 Line Width on Printer
Printers usually have a finer resolution than computer screens and thus the line width
on printer should usually be thicker than that on screen in order to make a graph look
similar on both devices. If the option here is ticked, you can assign a fixed line width
for all graphs plotted on printer. Otherwise, the line width on printer will be
automatically determined by:
[Line Width on Printer] = [Line Width on Screen] × [Printer Horizontal Resolution] /
[Graph Window Width]
The Line Width on Screen will be introduced later.
2.6.2.4.10 Theme
This selection box can be used to select a theme (visual style) for the software. The
change will take effect after software restart.
2.6.2.4.11 Check for Software Updates on Startup
If this check box is ticked, the software will check online to see if a new software
version is available for download during startup. If yes, it will prompt you for
confirmation for download. Please refer to [Help]>[Check for Software Updates] for
more information.
2.6.2.4.12 Others




Default: All parameters will be filled with the default values.
OK: Apply and save the changes and close the dialog.
Cancel: Cancel the changes and close the dialog.

2.6.2.5 Note (Setting SubMenu) (ALT-S-N)
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You can write down some notes for a measurement. The notes will be displayed if
you tick the "Display" checkbox. The notes will persist in the WAV file if saved.
2.6.2.6 ADC Device Database (Setting SubMenu) (ALT-S-B)

Multi-Instrument is able to interface to many ADC and DAC devices including sound
cards based on the standard data acquisition software interface specification
developed by Virtins Technology (vtDAQ for ADC and vtDAO for DAC). For
each category of devices, an intermediate interface DLL (dynamic link library) needs
to be developed according to this standard interface specification to bridge MultiInstrument and the device’s original driver or software interface. The software can
work with any device as long as the corresponding intermediate interface DLL is
provided. One interface DLL should contain either the ADC functions or DAC
functions, but not both if possible, even if all of these functions are supported by one
single device. This is to ensure that the ADC and DAC devices can be selected
independently in Multi-Instrument. For example, you can run a DSO (Digital Storage
Oscilloscope) hardware for ADC and the sound card for DAC simultaneously.
For details of the vtDAQ and vtDAO interface specifications, please refer to: vtDAQ
and vtDAO_Interfaces
Download link:
http://www.virtins.com/vtDAQ-and-vtDAO-Interfaces.pdf
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The ADC Device database contains a list of the supported ADC device models as well
as their specifications. You can add or remove the supported device models and
modify their specifications using this database configuration dialog.

2.6.2.6.1 Device Category
The ADC interface DLLs for the following categories of devices are provided in the
software package:


Sound Cards with MME driver
All Windows compatible sound cards fall into this category.



Sound Cards with ASIO driver
More and more sound cards, especially those used in the Pro-Audio field, support
ASIO (Audio Stream Input / Output) driver in addition to MME driver. Some
sound cards may have different functions / performance with their ASIO drivers
than with their MME drivers. MME driver and ASIO driver are exclusive with
each other. You can use only one of them at any time for a particular sound card.
Unlike other device categories, a single interface DLL is provided for both the
ADC and DAC functions for the ASIO driver due to the fact that the ADC and
DAC for the same sound card must work synchronously within the ASIO driver.
This implies that in Multi-Instrument, if you use the ASIO driver for ADC, you
must NOT use the MME driver for DAC for the same sound card, and vice versa.



NI DAQmx cards
Many data acquisition cards from National Instruments fall into this category.



VT DSO H1
Type H1 DSO cards from Virtins Technology. Please refer to the hardware
manual provided separately.



VT DSO F1
Type F1 DSO cards from Virtins Technology.
manual provided separately.

Please refer to the hardware



VT DSO H2
Type H2 DSO cards from Virtins Technology. Please refer to the hardware
manual provided separately.



VT DSO H3
Type H3 DSO cards from Virtins Technology. Please refer to the hardware
manual provided separately.



VT DAQ 1
Type 1 DAQ cards from Virtins Technology. Please refer to the hardware manual
provided separately.



VT DAQ 2
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Type 2 DAQ cards from Virtins Technology. Please refer to the hardware manual
provided separately.


My DAQ Device
User definable DAQ device. If you want to allow Multi-Instrument to interface to
your own DAQ device, then you can develop your own MyDAQ.dll according to
vtDAQ interface specifications. Please refer to vtDAQ and vtDAO Interfaces
provided separately.

2.6.2.6.2 Device Model
Each device category may contain one or more device models with possibly different
hardware specifications:


Device Model
You can specify a Device Model name. Note that if a Device Model name is
ended with “*”, it means that it supports enabling / disabling IEPE excitation.



Number of Channels



Trigger Type
Three types of trigger are supported:
 Hardware Trigger
You can further specify:
 whether the Trigger Level is adjustable
 whether Pre-Trigger is supported
 whether ALT-Trigger is supported
 Software Trigger
Software Trigger is possible for those ADC devices that support continuous
streaming, such as sound cards.
 External Trigger
You can further specify whether the External Trigger Level is adjustable and
its range.



Sampling Frequency
You can add up to 32 sampling frequencies for each device model. You can
further specify whether the maximum sampling frequency entered should be
shared among the channels used (i.e. Multiplexed).



Sampling Bit Resolution
You can add up to 32 sampling bit resolutions for each device model. Note that
the sampling bit resolution here refers to the original sampling bit resolution of the
ADC device. It will be converted to 8, 16, 24, 32 bit by the interface DLL and
thus only 8, 16, 24, 32 bit will be available for selection in the Sampling
Parameter Toolbar.



Range
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You can add up to 32 ADC ranges for each device model. Two types of ADC
devices are supported: Analog Voltage to Digital Conversion, Analog Current to
Digital Conversion, with respective engineering units V (Voltage) and A
(Ampere). The ADC range must be symmetric with regards to zero, i.e. it must be
 xxx.


Terminal Type
Five options are available: Default, Referenced Single End, Non Referenced
Single End, Differential, Pseudo Differential. You can choose more than one of
them for each device model.



Coupling Type
Three options are available: AC, DC, GND. You can choose more than one of
them for each device model. If the coupling type of each channel can be changed
independently, then you should tick the Per Channel checkbox.



Buffer Size
You can specify the buffer size per channel for each device model. The unit of this
parameter is Bytes/Channel. If the device supports continuous streaming, then the
number of continuous raw data points the ADC device can provide is not limited
by the physical buffer size of the device, and you should set the Buffer Size to the
maximum value 4294967295.

Note that the above specifications must be filled according to the ADC device’s
hardware specifications.
2.6.2.6.3 Auto Detect & Fill
Some ADC devices can provide their hardware specification information through
software interface when they are connected to the computer. The Auto Detect & Fill
button is used to attempt to acquire the hardware information and fill the above
hardware specification fields as many as possible when the device is connected to the
computer. You still need to fill those blank fields (if any) manually and amend the
auto-filled fields manually if necessary.
The Device No. combo box allows you to choose one device from a list of devices in
the device category present in the system.
Once you select a device category in the Device Category combo box, the rest of
parameters will be updated accordingly as if the Auto Detect & Fill button has been
pressed once.
2.6.2.6.4 Others



Add: Add a new device model with the set specifications into the ADC device
database.
Delete: Delete a selected device model from the ADC device database. Note that
the device models labeled “Sound Card MME” and “Sound Card ASIO” are not
allowed to be deleted.
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OK: Save the changes to the ADC device database and close the dialog.
Cancel: Cancel the changes to the ADC device database and close the dialog.

2.6.2.7 DAC Device Database (Setting SubMenu) (ALT-S-T)

The DAC Device database contains a list of the supported DAC device models as well
as their specifications. You can add or remove the supported device models and
modify their specifications using this database configuration dialog.

2.6.2.7.1 Device Category
The DAC interface DLLs for the following categories of devices are provided in the
software package:


Sound Cards with MME driver
All Windows compatible sound cards fall into this category.



Sound Cards with ASIO driver
More and more sound cards, especially those used in the Pro-Audio field, support
ASIO (Audio Stream Input / Output) driver in addition to MME driver. Some
sound cards may have different functions / performance with their ASIO drivers
than with their MME drivers. MME driver and ASIO driver are exclusive with
each other, and you can use only one of them at any time for a particular sound
card. Unlike other device categories, a single interface DLL is provided for both
the ADC and DAC functions for the ASIO driver due to the fact that the ADC and
DAC for the same sound card must work synchronously within the ASIO driver.
This implies that in Multi-Instrument, if you use the ASIO driver for ADC, you
must NOT use the MME driver for DAC for the same sound card, and vice versa.



NI DAQmx cards
Many data acquisition cards from National Instruments fall into this category.



VT DAO 1
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Type 1 DAO cards from Virtins Technology. Please refer to the hardware manual
provided separately.


My DAO Device
User definable DAO device. If you want to allow Multi-Instrument to interface to
your own DAO device, then you can develop your own MyDAO.dll according to
vtDAO interface specifications. Please refer to vtDAQ and vtDAO Interfaces
provided separately.

2.6.2.7.2 Device Model
Each device category may contain one or more device models with possibly different
hardware specifications:


Device Model
You can specify a Device Model name.



Number of Channels



Clock Type
Two clock types are supported:
 Hardware Clock
The sampling frequency is controlled by the hardware.
 Software Timed
The sampling frequency is controlled by the software.



Sampling Frequency
You can add up to 32 sampling frequencies for each device model.



Sampling Bit Resolution
You can add up to 32 sampling bit resolutions for each device model. Note that
the sampling bit resolution here refers to the original sampling bit resolution of the
DAC device. It will be converted to 8, 16, 24, 32 bit by the interface DLL and
thus only 8, 16, 24, 32 bit will be available for selection in the Signal Generator.



Range
You can add up to 32 DAC ranges for each device model. Two types of DAC
devices are supported: Digital to Analog Voltage Conversion, Digital to Analog
Current Conversion, with respective engineering units V (Voltage) and A
(Ampere). The DAC range can be either symmetric with regards to zero, i.e.  xxx,
or in the range from 0 to a positive value, i.e. xxx. You should tick the 
checkbox for the former case.



Buffer Size
You can specify the buffer size per channel for each device model. The unit of this
parameter is Bytes/Channel. If the device supports continuous streaming, then the
number of continuous raw data points the DAC device can provide is not limited
by the physical buffer size of the device, and you should set the Buffer Size to the
maximum value of 4294967295.
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Note that the above specifications must be filled according to the DAC device’s
hardware specifications.
2.6.2.7.3 Auto Detect & Fill
Some DAC devices can provide their hardware specification information through
software interface when they are connected to the computer. The Auto Detect & Fill
button is used to attempt to acquire the hardware information and fill the above
hardware specification fields as many as possible when the device is connected to the
computer. You still need to fill those blank fields (if any) manually and amend the
auto-filled fields manually if necessary.
The Device No. combo box allows you to choose one device from a list of devices in
the same device category present in the system.
Once you select a device category in the Device Category combo box, the rest of
parameters will be updated accordingly as if the Auto Detect & Fill button has been
pressed once.
2.6.2.7.4 Others





Add: Add a new device model with the set specifications into the DAC device
database.
Delete: Delete a selected device model from the DAC device database. Note that
the device models labeled “Sound Card MME” and “Sound Card ASIO” are not
allowed to be deleted.
OK: Save the changes to the DAC device database and close the dialog.
Cancel: Cancel the changes to the DAC device database and close the dialog.

2.6.2.8 Oscilloscope Processing (Setting SubMenu) (ALT-S-G)
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A signal is acquired by the Oscilloscope frame by frame. The sweep time of the
Oscilloscope is sometimes called Frame Width or Record Length. A data frame
contains multiple samples. These samples are normally continuous within the data
frame. But there may be a gap between two adjacent data frames. The acquired
frame of data will undergo the following processes in time domain sequentially:
(1) Inter-frame processing
(2) Intra-frame processing
(3) Parameter measurement
Then the processed signal is passed to the Spectrum Analyzer for further processing
and analysis in frequency domain.
“Persist” must be chosen if you want to persist the above inter-frame and intra-frame
processing results in the raw data. Affected commands are: File Save, File Save as,
Oscilloscope Export, File Extract, Play, Cyclic Play.
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2.6.2.8.1 Inter-frame Processing
Inter-frame processing in time domain is performed before intra-frame processing.
There are three options: None, Linear Average and Exponential Average. Averaging
is useful for removing noises from a repetitive signal. Inter-frame Averaging in time
domain must be synchronized in order to obtain meaningful results. Synchronization
can be achieved through proper triggering during data acquisition. The number of
frame averaged is displayed at the bottom left corner of the Oscilloscope window. It
can be accessed through DDP: NumberOfFrames.
2.6.2.8.1.1 Linear Average
If Linear Average is selected, the Oscilloscope will keep track of each data frame
acquired and only display the averaged waveform of a specified number of data
frames acquired most recently. The number of frames averaged will be displayed at
the bottom-left corner of the Oscilloscope view.
You can specify the number of contiguous frames to be processed. The available
options are: 2, 3, 4, 5, 6, 7, 8, 9, 10, 20, 30, 40, 50, 60, 70, 80, 90, 100, 120, 140, 160,
180, 200 and forever. You can also enter any number between 1 and 200 manually.
When “Forever” is selected, you can reset the process using the Reset button when
necessary.
2.6.2.8.1.2 Exponential Average
Unlike Linear Average where all data frames used for average are given equal
weights, in Exponential Average, the weighting factor for each data frame decreases
with time exponentially, giving much more importance to recent observations while
still not discarding older observations entirely. The degree of weighting decrease is
expressed as a constant  in percentage. The greater the , the faster the decrease.
Alternatively,  may be expressed in terms of N, where  = 2/(N+1), and N  [time
interval between the start times of two adjacent data frames] is called the time
constant.
2.6.2.8.2 Intra-frame Processing
Intra-frame processing in time domain is performed after inter-frame processing. The
frame of data undergoes the following processes sequentially:
(1) Time Delay Removal
(2) Demodulation: Nil, AM, FM or PM
(3) Remove DC, Rectification (or Detection) and then Digital Filtering
2.6.2.8.2.1 Time Delay Removal
Some measurements require the acquired signals in the two input channels to be time
aligned. This is usually not an issue if the signals travel within electric circuits
without any intentional digital delay, due to the lightning fast travelling speed of
electric signal in circuits. Time Delay Removal may be required for those systems
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that contain transducers which convert electric signals to other forms of energy (e.g.
sound) or vice versa. These systems usually involve a signal travelling path in which
the signal travelling time cannot be neglected in the measurements where time
alignment between the two input channels is required. This is the case for acoustic
transfer function measurement using dual-channel FFT (see figure below). In this
measurement, the signal output by the signal generator will go through two different
paths: one is connected directly to the input Channel B, the other contains an acoustic
path from the speaker to the microphone before going into the input Channel A. As
the sound travels much slower than the electric signal, the signal received in Channel
A will be delayed considerably compared with that in Channel B. Thus, it is normally
required to remove this delay in acoustic transfer function measurement as well as
Coherence / Non-Coherence function measurement.

To remove the time delay in Channel A, tick the Time Delay Removal option and
enter the time delay value (in ms) in Channel A with respect to Channel B. A positive
value means that the signal in Channel A is delayed and vice versa. If the time delay
is positive, after the time delay removal, the data in Channel A will be shifted left by
the time delay value so as to be time aligned with the data in Channel B. Then the
right most part of the data in Channels A & B with a length equal to the time delay
will be reset to zero. On the other hand, if the time delay is negative, after the time
delay removal, the data in Channel B will be shifted left by the time delay value so as
to be time aligned with the data in Channel A. Again, the right most part of the data in
Channels A & B with a length equal to the time delay will then be reset to zero. Keep
this in mind when configuring your own signal processing algorithm in the software.
In case the time delay between the two input channels is not readily available through
calculation, it can be measured using quite a few methods. Cross-correlation using
white noise, MLS or pink noise as stimulus is recommended. Cross-correlation
function will be introduced later.
The following two figures show the time delay measured using cross-correlation with
white noise before and after the time delay removal, respectively. It should be noted
that in the cross-correlation measurement, a positive time delay value means that the
signal in Channel A is delayed and vice versa. In this example, 2.979 ms is measured
in the cross correlation and thus 2.979 ms should be entered in the Time Delay
Removal edit box here. After this time delay removal, the cross correlation measures
a time delay of 0 µs meaning that the data in both channels are perfectly time aligned.
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2.6.2.8.2.2 Demodulation
Demodulation is performed after Time Delay Removal. It is processed within a frame
and thus there may be some “boundary effects” at the two ends of the frame. There
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are four demodulation options: None, AM, FM and PM. It is possible to let the signal
to pass through a bandpass filter first before demodulation. This simulates the
frequency tuning process in a radio system and is sometime important in order to
achieve better demodulation quality. The lower and upper frequency limits of the
band pass filter can be specified. The AM, FM, PM demodulation methods used here
are based on Hilbert Transform. Demodulation can be applied to Channel A, Channel
B, or both of them.

2.6.2.8.2.2.1 AM Demodulation
In Amplitude Modulation (AM), the amplitude of the carrier signal varies in
proportion to the instantaneous amplitude of the modulating signal. An AM signal is
demodulated here by detecting its envelope. The following is an example of an AM
signal (in blue) and its demodulated signal or envelop (in red). The carrier frequency
is 10 kHz and modulating frequency is 1 kHz. The modulation index is 50%.

“Remove DC” or a high pass filter (described later) can be used to remove the DC
component in the demodulated signal in the above figure. When AM demodulation is
applied to a channel, the symbol “AM” will be displayed beside the corresponding
axis label in the Oscilloscope view.
Demodulation of an AM signal can also be done through rectification followed by
low pass filtering (described later).

2.6.2.8.2.2.2 FM Demodulation
In Frequency Modulation (FM), the instantaneous frequency deviation from the
carrier frequency of the modulated signal varies in proportion to the instantaneous
amplitude of the modulating signal. A FM signal is demodulated here by calculating
the instantaneous frequency deviation through Hilbert Transform. The instantaneous
frequency deviation is then converted to the instantaneous amplitude of the
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modulating signal using the frequency modulation sensitivity which has a unit of
Hz/EU, where EU is the sensor’s unit which is usually Volt. For FM demodulation,
two parameters need to be manually entered by the users: the carrier frequency and
the frequency modulation sensitivity. When FM demodulation is applied to a channel,
the symbol “FM” will be displayed beside the corresponding axis label in the
Oscilloscope view.
The following is an example of a FM signal (in blue) and its demodulated signal (in
red). The FM signal has a carrier frequency of 10 kHz, a modulating frequency of 1
kHz, a maximum frequency deviation of 5 kHz, and a frequency modulation
sensitivity of 10 kHz/V. Thus the amplitude of the demodulated signal is ±0.5V.
“Remove DC” is used to remove the DC residual in the demodulated signal in the
figure below.

Multi-Instrument features unique FM demodulation algorithm which is able to
demodulate the FM signal accurately even when the sampling rate is not very high
compared with the FM signal spectrum.

2.6.2.8.2.2.3 PM Demodulation
In Phase Modulation (PM), the instantaneous phase deviation from the carrier phase
(i.e. the phase if no modulation on the carrier signal is applied) of the modulated
signal varies in proportion to the instantaneous amplitude of the modulating signal. A
PM signal is demodulated here by calculating the instantaneous phase deviation
through Hilbert Transform. The instantaneous phase deviation is then converted to the
instantaneous amplitude of the modulating signal through the phase modulation
sensitivity which has a unit of °/EU, where EU is the sensor’s unit which is usually
Volt. For PM demodulation, two parameters need to be manually entered by the users:
the carrier frequency and the phase modulation sensitivity. When PM demodulation is
applied to a channel, the symbol “PM” will be displayed beside the corresponding
axis label in the Oscilloscope view.
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The following is an example of a PM signal (in blue) and its demodulated signal (in
red). The PM signal has a carrier frequency of 10 kHz, a modulating frequency of 1
kHz, a maximum phase deviation of 90°, and a phase modulation sensitivity of
180°/V. Thus the amplitude of the demodulated signal is ±0.5V. “Remove DC” is
used to remove the DC residual in the demodulated signal in the figure below.

2.6.2.8.2.3 Digital Filtering
Digital filtering belongs to intra-frame processing and is performed after
demodulation. There may be some “boundary effects” at the two ends of the frame if
digital filtering is applied.
Six options are available: None, Low Pass, High Pass, Band Pass, Band Stop,
Arbitrary. The class of filter can be selected from FFT, FIR and IIR. These options
are performed after “Remove DC” and Rectification.
A Finite Impulse Response (FIR) filter, as the name suggested, has a finite impulse
response. It has no feedback and therefore is always stable. It is usually designed to
have symmetrical filter coefficients in order to achieve a linear phase response. It
should be noted that this filter will cause the signal to delay [FIR order]/2/[Sampling
Rate] seconds. It is possible to remove this delay by ticking the FIR Delay Removal
checkbox.
An Infinite Impulse Response (IIR) filter has an impulse response function which is
non-zero over an infinite length of time. It uses feedbacks from the output to the input
and thus may lead to instability. It does not have a linear phase response usually.
Unlike FIR and IIR filters, the filtering function of a FFT filter is not done in time
domain. Instead, the input signal is transformed from time domain to frequency
domain using FFT. Its spectrum is then multiplied with the filter’s frequency response
and the result is transformed back to time domain using inverse FFT. FFT filter has a
linear phase response and causes no delay (i.e. zero-phase response). Normally
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Rectangle window function should be used for FFT filter. If there is a need to
suppress the boundary effect (e.g. overshoot at both ends of the waveform), one of the
7 Tukey windows can be applied.
The software will force itself to use the FIR filter when the record length of data is
greater than ½ of the maximum allowable FFT size (i.e. 4194304), even if a FFT filter
is specified.
On the other hand, the software will force itself to use the FFT filter when the record
length of data is less than twice of the FIR filter order, even if a FIR filter is specified.
The software has a built-in FIR filter designer based on Window or Fourier Transform
method. The filter order must be even and in the range of 2~32766. Different window
functions can be used to fulfill different requirements for stopband attenuation and
transition bandwidth. The filter order determines the width of the transition band.
The higher the order, the narrower the transition between the passband and stopband,
and the slower the processing speed.
The software also supports the import of IIR or FIR filter coefficients designed
externally.
Digital filtering is performed frame by frame independently. It may cause
discontinuities at frame boundaries even if the data there are contiguous before the
filtering. For FIR and IIR filters, it is possible to perform continuous filtering across
frames if the “Across Frames” option is ticked. The prerequisite is that the original
data are continuous across frames. Auto trigger mode together with a low sampling
rate or Record mode can be used to ensure that.
Digital filter can be applied to Channel A, Channel B, or both of them.
2.6.2.8.2.3.1 Remove DC
“Remove DC” is performed before rectification (detection) and any digital filtering.
When this option is applied to a channel, the symbol will be displayed beside the
corresponding axis label in the Oscilloscope view.

2.6.2.8.2.3.2 Rectification (Detection)
Rectification (Detection) is performed right after “Remove DC” and before any
digital filtering. Three options are available: Nil, Half Wave, and Full Wave. When
rectification is applied to a channel, the symbol (Half Wave) or
(Full Wave) will
be displayed beside the corresponding axis label in the Oscilloscope view.
The following figure shows a sine wave before and after half-wave rectification.
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The following figure shows a sine wave before and after full-wave rectification.

2.6.2.8.2.3.3 None
No filtering will be performed.

2.6.2.8.2.3.4 Low Pass
A low pass filter is a filter that passes low frequencies and rejects (attenuates the
amplitude of) frequencies higher than the cutoff frequency. Two classes of low pass
filters are supported: FFT and FIR.
When a Low Pass filter is applied to a channel, the symbol
the corresponding axis label in the Oscilloscope view.

will be displayed beside

2.6.2.8.2.3.5 High Pass
A high pass filter is a filter that passes high frequencies and rejects (attenuates the
amplitude of) frequencies lower than the cutoff frequency. Two classes of high pass
filters are supported: FFT and FIR.
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When a High Pass filter is applied to a channel, the symbol
the corresponding axis label in the Oscilloscope view.

will be displayed beside

2.6.2.8.2.3.6 Band Pass
A band pass filter is a filter that passes frequencies within a certain range and rejects
(attenuates the amplitude of) frequencies outside that range. Two classes of band pass
filters are supported: FFT and FIR.
When a Band Pass filter is applied to a channel, the symbol
beside the corresponding axis label in the Oscilloscope view.

will be displayed

2.6.2.8.2.3.7 Band Stop
A band stop filter is a filter that rejects (attenuates the amplitude of) frequencies in a
certain range and passes the rest of frequencies. Two classes of band stop filters are
supported: FFT and FIR.
When a Band Stop filter is applied to a channel, the symbol
beside the corresponding axis label in the Oscilloscope view.

will be displayed

2.6.2.8.2.3.8 Arbitrary
An arbitrary filter is a filter that has an arbitrary frequency response. There are two
ways to define an arbitrary filter. One is to define its frequency response (magnitude).
The other is to define its filter coefficients.


Use Frequency Response File (*.frf) to define an arbitrary filter
A Frequency Response File is a Comma Separated Variable (CSV) TXT file
that defines the magnitude frequency response of a filter. It has the following
format:
Example:
1,0,0
2,1000,0
3,1000.1,-1000
4,100000,-1000
……
Each line contains three comma separated variables. The first variable is the
sequential number. The second one is the frequency value in Hz. And the
third one is the corresponding gain value in dB. Note that 0 dB represents a
unit gain. Any frequencies that fall outside the defined range will be given a
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gain of –1000 dB. The example shown above is a low pass filter with a cutoff
frequency of 1000 Hz.
Some sample files are provided in the FRF directory of the software and can
be used as templates.


Use IIR Coefficient File (*.iir) to define an arbitrary filter
An IIR filter is defined as:
y[n]=b0x[n]+b1x[n-1]+… +bMx[n-M]- a1y[n-1]- a2y[n-2]-…- aNy[n-N];
where:
x[n] is the input signal,
y[n] is the output signal,
bi is the so-called feedforward filter coefficients,
ai is the so-called feedback filter coefficients,
M is the feedforward filter order,
N is the feedback filter order.
An IIR Coefficient File is a Comma Separated Variable (CSV) TXT file that
contains the coefficients of the IIR filter. It has the following format
(assuming M>N):
Example:
0, b0, a0
1, b1, a1
2, b2, a2
……
N, bN, aN
……
M-1, bM-1, 0
M, bM, 0
where a0 (usually assigned a value of “1”) is just a placeholder and will
always be ignored by the software. For IIR filters, usually M and N are
designed to be equal. In the cases that they are not equal, zeros must be used to
fill up the gaps. The maximum order supported is 32766. If N = 0, then the
filter becomes a FIR filter.

It should be noted that the software is built with a limiter which will prevent the
output of any digital filter from going outside of the range defined by the input ADC
full-scale voltage.
Some sample files are provided in the IIR directory of the software and can be used as
templates.
When an Arbitrary filter is applied to a channel, the symbol
beside the corresponding axis label in the Oscilloscope view.
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The button
in this dialog can be used to open the selected Frequency Response
File or the IIR Coefficient File for viewing or editing via Microsoft Notepad.

2.6.2.8.3 Parameter Measurement
Parameter measurement is performed after inter-frame and intra-frame processing.
The following parameters can be measured.

2.6.2.8.3.1 Reverberation and Its Related Acoustic Parameters
Reverberation is the phenomenon of persistence of sound after it has been produced,
as a result of multiple reflections from surfaces such as walls, ceilings, floors,
furniture, and people in an enclosure. These reflections build up with each reflection
and decay gradually as they are absorbed by the reflecting surfaces. Reverberation
can enhance the perception of music but it can reduce speech intelligibility.
2.6.2.8.3.1.1 Reverberation Time
Reverberation can be quantitatively characterized by Reverberation Time. The time
taken for the sound pressure level to decay 60 dB after the source emission has
stopped is called the Reverberation Time (RT, or RT60). It is the most important
parameter describing the acoustic quality of a room or space. In a real environment, it
can be difficult to achieve a dynamic range of more than 60 dB to measure RT60
directly, due to the noisy background and other constraints. Therefore, RT60 is
usually evaluated based on a smaller dynamic range and extrapolated to a decay time
of 60 dB. It is then labelled accordingly. ISO3382 defines T20, T30 and Early Decay
Time (EDT) as follows.
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T20 is the RT60 derived from the decay curve between 5dB and 25dB below the
initial level. The initial level must be at least 35dB higher than the background noise
level.
T30 is the RT60 derived from the decay curve between 5dB and 35dB below the
initial level. The initial level must be at least 45dB higher than the background noise
level.
If the reverberation sound field is fully diffused after multiple reflections, the energy
decay rate will become exponential if linear scale is used, or linear if dB (logarithmic)
scale is used. This is implicitly assumed in the concept of Reverberation Time and is
the basis for the above extrapolation. However, the first few reflections (i.e. the
earliest, lowest-order reflections), which are often good facsimiles of the direct sound,
are likely to decay at a different rate. This “early” decay is strongly affected by the
directivity of the sound source and surface materials of the objects near it.
Early Decay Time (EDT) is derived from the decay curve between 0 dB and 10 dB
below the initial level. Similar to T20 and T30, it is also extrapolated to a decay time
of 60 dB.
2.6.2.8.3.1.2 Clarity C50 and C80, Definition D50, Center Time Ts
The reverberant characteristics of an enclosure can also be quantitatively described by
early-to-late energy ratio or Clarity. Clarity is defined as the ratio of the energy
arriving before the time t to the energy arriving after the time t within the reverberant
decay period, expressed in dB. The two most commonly used ones are C50 (for
speech) and C80 (for music), in which the energy is split at 50 ms and 80 ms after the
direct sound stops.
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Another parameter in this category is Definition D50. It is an early-to-total energy
ratio defined as the ratio of the energy in the first 50 ms to the total energy within the
reverberant decay period, expressed in percentage.
Center Time Ts is the time of the “center of gravity” of the energy within the
reverberant decay period.

2.6.2.8.3.1.3 Frequency Bands Selection
Reverberation is frequency dependent. Although reverberation time is often stated as
a single value if measured as a broadband signal (20Hz ~ 20kHz), it is more precisely
described in terms of frequency bands. Two options are available in the software: 1/1
octave and 1/3 octave. In 1/1 octave band analysis, the acquired data will be filtered
by 1/1 octave band pass filters centered at 63Hz, 125Hz, 250Hz, 500Hz, 1kHz, 2kHz,
4kHz and 8kHz first before reverberation analysis. If “1/3 octave” is chosen, the
acquired data will be filtered by 1/3 octave band pass filters centered at: 50Hz, 63Hz,
80Hz, 100Hz, 125Hz, 160Hz, 200Hz, 250Hz, 315Hz, 400Hz, 500Hz, 630Hz, 800Hz,
1kHz, 1.25Hz, 1.6Hz, 2kHz, 2.5kHz, 3.15kHz, 4kHz, 5kHz, 6.3kHz, 8kHz, 10kHz
instead. In both cases, the original data without filtering will also be analyzed and the
results will be tagged under “broadband”.

2.6.2.8.3.1.4 Measurement Methods
Both the sound source and the measurement microphone should be omnidirectional.
The measurements should be made with different microphone positions which are at
least 1.5 m apart, 2 m from any sound source and 1 m from any reflecting surfaces.
There are generally two methods to measure the reverberant decay curve: interrupted
noise method and integrated impulse response method. Multi-Instrument is able to
automatically differentiate these two based on the overall shape of the data curve in
the Oscilloscope. Therefore in the software there is no need to explicitly specify
which method is used. Beside the time domain analysis methods described here, it is
also possible to analyze reverberation in time-frequency domain, this will be
introduced later in the Chapter of Spectrum 3D Plot.
(1) Interrupted noise method
The decay curve can be obtained by direct recording of the decay of the sound
pressure level after exciting an enclosure with broadband or band-limited noise. Pink
noise is usually used in this method. The excitation signal should be sufficiently long
to produce a steady-state sound pressure level in all frequency bands or a particular
frequency band before it is switched off. In order to obtain steady-state conditions,
the excitation time shall be at least half of the estimated reverberation time.
Synchronized signal generator and oscilloscope operation of Multi-Instrument can be
used to facilitate the capture of the sound pressure decay process. A Panel Setting
File example can be found at \psf\Pro\RT60InterruptedNoise5s.psf.
The following figure shows an example of the instantaneous sound pressure variation
recorded using this method.
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During reverberation analysis, the directly recorded instantaneous sound pressure
variation will be band-pass filtered for each frequency band of interest and converted
to sound pressure level (dBSPL) with the integration time determined by the software
automatically (see figure below). EDT, T20 and T30 will then be calculated
automatically according to ISO3382. Note that the latter two are obtained through
linear regression.

The decay curve measured with this method may vary from one measurement to
another with no change in the characteristics of the enclosure and transmitting /
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receiving position. This is due to the randomness of the excitation signal (different
initial amplitudes and phases). Averaging 3 or more decay curves or reverberation
times measured at one transmitting / receiving position is mandatory in order to obtain
a suitable statistical repeatability.
A sample panel setting file for this method can be found at: psf\pro\
RT60InterruptedNoise5s.psf.
(2) Integrated impulse response method
Impulse response is the temporal evolution of the sound pressure observed at a point
in an enclosure as a result of the emission of a Dirac impulse at another point in the
enclosure. The following figure shows an impulse response example.

The decay curve can be obtained by reverse-time integration of the squared impulse
response (see figure below). This method is also known as Schroeder Integration
method. Dr. Manfred Schroeder has shown that the ensemble average of decay
curves from multiple measurements using the interrupted noise method can be
obtained from the backward integrated squared impulse response through one single
measurement. This method smooths the decay and provides a very clean maximum
level. Theoretically, the integration should start at the end of the time record and
work back to the beginning. However, due to the existence of the background noise
in the actual measurement, the integration curve will flatten out as the reverberant
decay slope runs into the noise floor. This will lead to overestimation of the
reverberation time if the impulse response has a limited dynamic range and a long
noise tail. To solve this problem, the integration should start at the point where the
decay slope meets the noise floor. This point is sometimes called “saddle point”.
Similarly, the backward integration should end at the point where the direct sound
arrives, excluding any background noise before that time. This ensures the correct
detection of the maximum level. The above integration range will be automatically
detected by Multi-Instrument. To standardize the rendering of the integration curve,
the Schroeder integration is normalized so that it peaks at 0 dB. Unlike the case of the
interrupted noise method in which the energy decay curve has a platform of the initial
level, the energy decay curve of an impulse response only has a peak at the time when
the direct sound arrives. This characteristic is used by the software to identify an
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impulse response. In case an impulse response has its peak at or very close to the
beginning of the time record, then the software will fail to recognize it as an impulse
response and it will then be treated as if it is measured with the interrupted noise
method.

The impulse response and frequency response of a LTI (Linear Time-Invariant)
system are a Fourier transform pair. They are the most important characteristics of a
LTI system. As the impulse response is a deterministic function and not prone to
statistical deviations, no averaging is necessary in this method. Beside the
reverberation time EDT, T20 and T30, Clarity C50 and C80, Definition D50 and
Center Time Ts will also be calculated in this method. Again, T20 and T30 are
obtained through linear regression.
There are direct and indirect methods to obtain the impulse response.
(i) Direct Method
It is impossible in practice to create and radiate a true Dirac impulse but short
transient sounds (e.g. a gunshot) can offer close enough approximations for practical
measurements.
The impulse response can be recorded directly using an impulse source such as a
pistol shot, balloon burst, spark gap, fire cracker, hand clap, or any other sound source
that produces an impulse with sufficient bandwidth and energy.
(ii) Indirect Method
The impulse response can be measured indirectly using broadband excitation signals
such as white noise, pink noise, linear / logarithmic swept sine, and MLS (Maximum
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Length Sequence). This will be introduced later in the impulse response section as
well as cross-correlation section in the Spectrum Analyzer chapter. The measured
impulse response can be exported as a TXT file from the Spectrum Analyzer and then
imported into the Oscilloscope via [File]>[Import] for reverberation analysis.
A sample panel setting file for this method can be found at: psf\pro\RT60STIImpulseResponse5s.psf.

2.6.2.8.3.1.5 Analysis Results
If the "Reverberation / Speech Intelligibility" option is ticked, the software will
perform reverberation and speech intelligibility analysis and store the results in two
DDP
arrays:
AcousticParameter_A_Array[?]
for
Channel
A
and
AcousticParameter_B_Array[?] for Channel B. When fetching a particular parameter,
“?” should be replaced by its array index. The following table shows the content of
each array element relevant to reverberation under 1/1 octave band analysis. For
example, AcousticParameter_A_Array[18] should be used to read T20 in broadband
in Channel A.
Broadband
0
9
18
27
36
45
54
63
72
81

EDT(s)
Reserved
T20(s)
rT20
T30(s)
rT30
C50(dB)
C80(dB)
D50(%)
Ts(s)

63Hz
1
10
19
28
37
46
55
64
73
82

125Hz
2
11
20
29
38
47
56
65
74
83

250Hz
3
12
21
30
39
48
57
66
75
84

500Hz
4
13
22
31
40
49
58
67
76
85

1kHz
5
14
23
32
41
50
59
68
77
86

2kHz
6
15
24
33
42
51
60
69
78
87

4kHz
7
16
25
34
43
52
61
70
79
88

8kHz
8
17
26
35
44
53
62
71
80
89

The following table shows the content of each array element under 1/3 octave band
analysis.
Broadband
50Hz
63Hz
80Hz
100Hz
125Hz
160Hz
200Hz
250Hz
315Hz
400Hz
500Hz
630Hz
800Hz
1kHz
1.25kHz
1.6kHz
2kHz
2.5kHz
3.15kHz
4kHz
5kHz
6.3kHz
8kHz
10kHz

EDT(s)
300
301
302
303
304
305
306
307
308
309
310
311
312
313
314
315
316
317
318
319
320
321
322
323
324
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Reserved
325
326
327
328
329
330
331
332
333
334
335
336
337
338
339
340
341
342
343
344
345
346
347
348
349

T20(s)
350
351
352
353
354
355
356
357
358
359
360
361
362
363
364
365
366
367
368
369
370
371
372
373
374

rT20
375
376
377
378
379
380
381
382
383
384
385
386
387
388
389
390
391
392
393
394
395
396
397
398
399

T30(s)
400
401
402
403
404
405
406
407
408
409
410
411
412
413
414
415
416
417
418
419
420
421
422
423
424

rT30
425
426
427
428
429
430
431
432
433
434
435
436
437
438
439
440
441
442
443
444
445
446
447
448
449

C50(dB)
450
451
452
453
454
455
456
457
458
459
460
461
462
463
464
465
466
467
468
469
470
471
472
473
474

C80(dB)
475
476
477
478
479
480
481
482
483
484
485
486
487
488
489
490
491
492
493
494
495
496
497
498
499
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rT20 and rT30 are the linear regression correlation coefficients for T20 and T30
respectively. If the result in a particular array element is invalid, a super large
negative value -1020 will be stored there. A result can be invalid if the dynamic range
of the decay curve is not enough, the linear regression correlation coefficient is
outside the range of -1~-0.4, or the interrupted noise method is used instead of the
integrated impulse response method.
The above parameters can be viewed through DDP viewer individually. They can also
be viewed together in the following four reports using DDP array viewer:
(1)
(2)
(3)
(4)

A-Reverberation / Speech Intelligibility (1/1 Octave)
B-Reverberation / Speech Intelligibility (1/1 Octave)
A-Reverberation / Speech Intelligibility (1/3 Octave)
B-Reverberation / Speech Intelligibility (1/3 Octave)

The following figure shows the 1/1 octave band results of an impulse response. Note
that it also contains the speech intelligibility analysis results which will be described
later.

The following figure shows the 1/3 octave band results of an impulse response. It
contains the reverberation analysis results only.
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It should be noted that for the interrupted noise method, only EDT, T20 and T30 will
be shown under both 1/1 and 1/3 octave band analyses. For T20 and T30, if the
corresponding linear regression correlation coefficient is greater than -0.6 for the case
of the interrupted noise method, or -0.95 for the case of the integrated impulse
response method, “~” will be displayed before the measured value to indicate that the
value may not be very reliable.
The reverberation and speech intelligibility analysis here calculates the acoustic
parameters in each frequency band one by one automatically and thus may take a little
while to complete. The data in the Oscilloscope should be kept small in size and
contain only the information relevant to reverberation decay in order to cut down the
computation time. If you are only interested in the acoustic parameters in a particular
frequency band, you can use the Derived Data Curve (DDC) function instead, where
Energy Time Curve (dBSPL) can be used for the interrupted noise method, and
Impulse Response Schroeder Integration Curve can be used for the integrated impulse
response method. These DDCs can also be used to manually verify the results of the
automatic parameter measurement in the Oscilloscope. DDC function will be
described later.
2.6.2.8.3.2 Speech Intelligibility
A transmission channel transmits speech from a talker to a listener through electrical,
acoustic, optical or other signal paths. The speech intelligibility characteristics of the
transmission channel can be quantified through either subjective listening tests or
objective measurements. The latter are faster and normally used.
Speech
Transmission Index (STI) is commonly used as an objective measure to predict the
intelligibility of speech transmitted by the transmission channel. It was originally
proposed by Houtgast and Steeneken, and standardized most recently by IEC 6028616:2011 in its fourth edition. The concept of STI is based on the empirical finding that
in speech signals the most relevant information to speech intelligibility is the intensity
fluctuations (or modulations), which result from the acoustic separation of sentences,
words, and phonemes, the fundamental elements of speech. Modulation transfer
function (MTF) is used to quantify how well the transmission channel preserves this
intensity modulation. A single-number STI value can be calculated after MTFs with
14 modulation frequencies (from 0.63Hz to 12.5Hz, 1/3-octave apart) and in seven
1/1 octave bands (from 125Hz to 8kHz) are obtained.

2.6.2.8.3.2.1 Modulation Transfer Function
In objective measurement, speech can be modeled as a noise carrier, with a speech
shaped frequency spectrum, intensity-modulated by a low-frequency sine wave. The
intensity here is equal to the square of the sound pressure. Modulation Transfer
Function (MTF) is defined as the ratio of the modulation index (or modulation depth)
of the received signal to that of the transmitted signal. Any reduction of the MTF by
the transmission channel, due to reverberation, echo, linear and nonlinear distortion,
and noise, is considered to result in some deterioration of speech intelligibility. The
definition of MTF is illustrated as follows.
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MTF is a function of the modulation frequency fm and the spectral content of the
carrier. To calculate STI, MTF is evaluated for 14 modulation frequencies: 0.63Hz,
0.8Hz, 1Hz, 1.25Hz, 1.6Hz, 2Hz, 2.5Hz, 3.15Hz, 4Hz, 5Hz, 6.3Hz, 8Hz, 10Hz,
12.5Hz. The lower modulation frequencies mimic sentence and word separation
while the higher modulation frequencies mimic phoneme separation within words.
The spectral content of speech itself is also important. Seven octave bands: 125Hz,
250Hz, 500Hz, 1kHz, 2kHz, 4kHz, 8kHz, within which the carrier’s overall spectral
shape matches the long-term averaged speech spectrum, are evaluated for each
modulation frequency. This gives a total of 7 × 14 = 98 combinations and thus 98
MTFs. The seven octave bands do not contribute equally to intelligibility. Although
low speech frequencies (vowels) contribute most to the power of a speech signal, it is
the higher speech frequencies (consonants) which contribute the most to speech
intelligibility. This is reflected in the frequency band weighting factors applied when
calculating the single-number STI from a matrix of MTFs. IEC 60286-16:2011
stipulates different weighting profiles for males and females. Both STI(M) for males
and STI(F) for females are calculated in Multi-Instrument.
2.6.2.8.3.2.2 Speech Transmission Index
FULL STI method requires 98 test signals to be applied sequentially, with each
measurement taking about 10 seconds. The overall measurement time is
approximately 15 minutes. This method is considered to be the most accurate of the
STI methods, but it is rarely used today because simplified methods which were
subsequently developed are faster and more practical. Three simplified methods are
popular: STIPA (STI for public address systems), STITEL (STI for
telecommunication systems), RASTI (Room Acoustical STI).
STIPA consists of a test signal with a predefined set of two modulations (1.6Hz &
8Hz, 1Hz & 5Hz, 0.63Hz & 3.15Hz, 2Hz & 10Hz, 1.25Hz & 6.25Hz, 0.8Hz & 4Hz,
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2.5Hz & 12.5Hz) per octave band (125Hz, 250Hz, 500Hz, 1kHz, 2kHz, 4kHz, 8kHz)
that are generated simultaneously giving a total of 14 modulation indices. One
measurement takes between 10s and 15s.
STITEL consists of a test signal with a predefined set of seven modulation
frequencies (1.12Hz, 11.33Hz, 0.71Hz, 2.83Hz, 6.97Hz, 1.78Hz and 4.53Hz), one per
octave band (125Hz, 250Hz, 500Hz, 1kHz, 2kHz, 4kHz, 8kHz), that are generated
simultaneously giving a total of seven modulation indices. One measurement takes
approximately 12s.
RASTI consists of a test signal with a predefined set of nine modulation frequencies
that are generated simultaneously, five (0.7Hz, 1.4Hz, 2.8Hz, 5.6Hz, 11.2Hz) for the
2000Hz octave band and four (1.0Hz, 2.0Hz, 4.0Hz, 8.0Hz) for the 500Hz octave
band. One measurement takes approximately 30s. RASTI is considered obsolete in
IEC-60286-16:2011.
The direct FULL STI method is generally now only used for background STI research.
However, indirect FULL STI method exists and is popular.

2.6.2.8.3.2.3 Measurement Methods
MTF is the basis of STI. There are two MTF measurement methods:
(1) Direct Method
This method uses modulated speech-shaped noises to measure MTF directly. It
accounts for non-linear distortion and can be used for both linear and nonlinear
systems.
It is possible to measure the modulation index and then MTF directly using User
Defined Data Point (UDDP) in Multi-Instrument. This will be described later in the
UDDP section. The derivation of STI from a matrix of MTFs obtained through the
direct method is however not directly supported in the software.
It is also possible to generate the modulated noise through the Signal Generator in
Multi-Instrument. Although the amplitude modulation function of the Signal
Generator supports only a sinusoidal carrier and thus cannot be used here, the
window-shaped mask function can be used instead to generate the modulated signal
using an arbitrary signal as the carrier, and one of the available window functions as
the modulation function. In particular, true or pseudo pink or white noise, MLS, or
speech-like noise can be used as the carrier and Cosine 1.0 window can be used as the
intensity modulation function. If amplitude modulation rather than intensity
modulation is required, Hann window (=Cosine 2.0) should be used instead.
(2) Indirect Method
This method uses the system’s impulse response to derive MTF. It should only be
used for linear time-invariant systems. Dr. Manfred Schroeder has shown that MTF
can be derived from the Fourier transform of the squared impulse response as follows.
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where:
mk(fm) is the MTF at modulation frequency fm in octave band k;
hk(t) is the impulse response of octave band k;
fm is the modulation frequency;
t is the integration variable for time;
hk(t) can be obtained by filtering the broadband impulse response with the respective
octave band filter. The length of the impulse response must not be less than half of
the reverberation time and 1.6s to ensure a reliable calculation of the modulation
indices for the lowest modulation frequency of 0.63 Hz. MTF is noise dependent. It
should be noted that the measuring process of the impulse response should not
involve averaging which would otherwise reduce artificially the background noise.
On the other hand, if the impulse response contains unrealistically low or no noise, the
measured MTF is called “Noise-free”MTF and the noise effect can be taken into
account subsequently as follows:

where SNRk is the signal-to-noise ratio in dB for octave band k.
The above formula shows that, when SNRk is greater than 15 dB, the reduction of
MTF due to noise is less than 3%.
During impulse response measurement, if the SNR in each octave band is at least 20
dB, no matter whether averaging is used or not, the impulse response is considered
“noise-free”. Impulsive signals such as the Dirac function are not generally suitable
here when background noise, pass-band limiting and non-linear distortion are
significant, since the average spectral distribution of typical speech is not represented
in the test signal. If the impulse response is measured through deconvolution of a
deterministic signal, such as a MLS or sweep signal, the measurement takes far less
time than with the modulated noise method for the same reproducibility (some 5 s on
average). If the measured impulse response is considered “noise-free”, and it is
necessary to take into account the noise effect, the background noise can be measured
separately. Compensation for the noise effect through a separate background noise
measurement is not currently supported in the software.
MTF can be further extended to include auditory effects such as level dependent
auditory masking and absolute speech reception threshold, as defined in IEC 6026816: 2011. These effects should only be taken into account when test signals are
obtained acoustically. Compensation for the auditory effects is currently not
implemented in the software.
Normally FULL STI is calculated in the indirect method, as the processing time is
quite short, unlike the direct method. There is no advantage to calculate other reduced
versions of STI in the indirect method. This method is adopted in the software. A
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sample panel setting file for this method can be found at: psf\pro\RT60STIImpulseResponse5s.psf.

2.6.2.8.3.2.4 Deriving STI from MTF
Once MTFs are obtained, either through direct method or through indirect method,
STI can be calculated using the same method as follows:
(1) MTFk,fm is transformed into an effective signal-to-noise ratio SNReff k,fm (dB) as
given by:

SNReff k,fm (dB) is limited to the range of -15dB ~ +15dB.
(2) SNReff k,fm (dB) is converted to a transmission index TIk,fm using:

(3) All TIk,fm in each octave band are arithmetically averaged to obtain a Modulation
Transfer Index (MTIk) for that octave band.
(4) All MTIk are combined using the following formula to get the STI(M) and STI(F).

where αk is the weighting factor for octave band k and βk the redundancy factor
between octave band k and octave band k+1.
STI is limited to the range of 0~1. Males and females have different weighting and
redundancy factors and thus different STI. Both STI(M) for males and STI(F) for
females are calculated.
STI can be labelled as “Excellent”, “Good”, “Fair”, “Poor” and “Bad” based on the
demarcation values: 0.75, 0.60, 0.45, 0.30. This relates it to the subjective ratings on
speech intelligibility. It can also be categorized under “A+”, “A”, “B”, “C”, “D”, “E”,
“F”, “G”, “H”, “I”, “J”, “U” according to the demarcation values: 0.76, 0.72, 0.68,
0.64, 0.60, 0.56, 0.52, 0.48, 0.44, 0.40, 0.36.

2.6.2.8.3.2.5 Articulation Loss of Consonants (%ALcons)
The %ALcons is originally based on the reception of words by listeners. It can also
be derived from STI through a widely used approximation formula:

The %ALcons values normally range from 0 (corresponding to an excellent speech
intelligibility) to 100 (corresponding to an extremely bad speech intelligibility), but
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the %ALcons value calculated from the abovementioned approximation formula, will
exceed 100 at a very low STI. In Multi-Instrument, %ALcons(M) for males
and %ALcons(F) for females will also be reported after the corresponding STIs are
obtained.

2.6.2.8.3.2.6 Analysis Results
If the "Reverberation / Speech Intelligibility" option is ticked, the software will
perform reverberation and speech intelligibility analysis and store the results in two
DDP
arrays:
AcousticParameter_A_Array[?]
for
Channel
A
and
AcousticParameter_B_Array[?] for Channel B. When fetching a particular parameter,
“?” should be replaced by its array index. The following table shows the content of
each array element relevant to speech intelligibility under 1/1 octave band analysis.
Note that if IN/IR>=0, it reflects that the data in the Oscilloscope have been
automatically detected as an impulse response and the speech intelligibility related
parameters have been calculated. There are no applicable parameters in the shaded
cells in the table.
MTF(0.63Hz)
MTF(0.8Hz)
MTF(1Hz)
MTF(1.25Hz)
MTF(1.6Hz)
MTF(2Hz)
MTF(2.5Hz)
MTF(3.15Hz)
MTF(4Hz)
MTF(5Hz)
MTF(6.3Hz)
MTF(8Hz)
MTF(10Hz)
MTF(12.5Hz)
MTI
STI(M)
STI(F)
%ALcons(M)
%ALcons(F)
IN/IR

Broadband
90
99
108
117
126
135
144
153
162
171
180
189
198
207
216
225
226
227
228
229

63Hz
91
100
109
118
127
136
145
154
163
172
181
190
199
208
217

125Hz
92
101
110
119
128
137
146
155
164
173
182
191
200
209
218

250Hz
93
102
111
120
129
138
147
156
165
174
183
192
201
210
219

500Hz
94
103
112
121
130
139
148
157
166
175
184
193
202
211
220

1kHz
95
104
113
122
131
140
149
158
167
176
185
194
203
212
221

2kHz
96
105
114
123
132
141
150
159
168
177
186
195
204
213
222

4kHz
97
106
115
124
133
142
151
160
169
178
187
196
205
214
223

8kHz
98
107
116
125
134
143
152
161
170
179
188
197
206
215
224

The above parameters can be viewed through DDP viewer individually. They can also
be viewed together in the following two reports using DDP array viewer:
(1) A-Reverberation / Speech Intelligibility (1/1 Octave)
(2) B-Reverberation / Speech Intelligibility (1/1 Octave)
2.6.2.8.3.3 Discontinuity
In Multi-Instrument, discontinuity is defined as the instantaneous abruptness on a
waveform. It is a function of time and rated in percentage. If the “Discontinuity”
option is ticked, the software will calculate the discontinuity at every sample of the
waveform and store the maximum value together with its occurring time in the
following DDPs: MaxDiscontinuityValue_A(%) and MaxDiscontinuityTime_A(s)
for Channel A, and MaxDiscontinuityValue_B(%) and MaxDiscontinuityTime_B(s)
for Channel B. The following three figures show a sine sweep with a normal
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waveform, a waveform with a single-side glitch, and a waveform with a double-side
glitch, respectively. It can be seen that the two glitches are detected correctly with
their discontinuity values (7.3812% and 9.4305%) much higher than the maximum
discontinuity value (0.0553%) of the normal case.

Normal
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With a single-side glitch

With a double-side glitch
Discontinuity measurement has its applications in detection of digital audio dropouts
and speaker rub & buzz, etc.. A dropout in digital audio is a brief loss of data that
causes a discontinuity in a data stream. It usually occurs during data transmission.
When it comes to analog domain, the discontinuity refers to the abruptness along a
data curve.
An ideal sine wave is perfectly smooth and has a discontinuity value of 0%
everywhere. A continuous sine sweep is very smooth and has very small
discontinuity values along its waveform. These values depend on the sweep speed.
The longer the sweep time, the narrower the sweep range, the lower the discontinuity
values. If the sweep speed changes linearly, the discontinuity is a constant. Digital
audio dropouts can be checked using a sine wave stimulus, while the speaker rub &
buzz is usually tested using a continuous sine sweep.
When a device under test (DUT) is excited with a sine wave or continuous sine sweep,
its output waveform will be very smooth if its regular harmonic distortions are low
and there is no irregular distortion occurs. Whether the regular harmonic distortions
will cause abrupt changes of waveform depends on their orders and amplitudes as
well as the phase response of the DUT. Higher order harmonic distortions contribute
more to waveform abruptness than lower ones. Regular harmonic distortions can be
quantized in frequency domain and this will be introduced later. On the other hand,
the distortions caused by digital audio dropouts and speaker rub & buzz, are usually
irregular and impulsive. They carry very little energy and thus do not show up very
discernibly in frequency domain that contains only time averaged information.
Traditional frequency domain methods like RMS-FFT and Total Harmonic Distortion
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(THD) are thus not useful. In many cases, it is easier and better to detect them
directly in time domain where the irregular distortions contribute much more to the
discontinuity peaks than the regular harmonic distortions.
A sample panel setting file can be found at: psf\pro\ DiscontinuityTest.psf.
2.6.2.8.3.4 Step Response
Step response is the time evolution of the outputs of a system when its input changes
from zero (low level) to one (high level) or one (high level) to zero (low level)
instantly. Ten parameters of a step response are measured in the software: Low Level,
High Level, Percentage Overshoot, Percentage Undershoot, Rise Time, Fall Time,
Peak Time, Peak Settling Time, Trough Time and Trough Settling Time. They can be
accessed through the following DDPs:
Channel A
StepResponseHighLevel_A(EU),
StepResponseHighLevel_A(EU),
StepResponseOvershoot_A(%),
StepResponseUndershoot_A(%),
StepResponseRiseTime_A(s),
StepResponseFallTime_A(s),
StepResponsePeakTime_A(s),
StepResponsePeakSettle_A(s),
StepResponseTroughTime_A(s),
StepResponseTroughSettle_A(s)
and a similar set of DDPs for Channel B. The following figure illustrates their
definitions.

Percentage Overshoot is defined as (Max-HighLevel)/(HighLevel-LowLevel)×100%.
Percentage Undershoot is defined as (LowLevel-Min)/(HighLevel-LowLevel)×100%.
Rise Time is the time for the signal to rise from 10% of (HighLevel-LowLevel) to
90% of (HighLevel-LowLevel).
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Fall Time is the time for the signal to fall from 90% of (HighLevel-LowLevel) to 10%
of (HighLevel-LowLevel).
Peak Time is the time for the signal to rise from 10% of (HighLevel-LowLevel) to its
peak value.
Peak Settling Time is the time for the signal to reach and remain within a given
tolerance band of the HighLevel from 10% of (HighLevel-LowLevel). The tolerance
used in the software is ±2% of (HighLevel-LowLevel).
Trough Time is the time for the signal to fall from 90% of (HighLevel-LowLevel) to
its trough value.
Trough Settling Time is the time for the signal to reach and remain within a given
tolerance band of the LowLevel from 90% of (HighLevel-LowLevel). The tolerance
used in the software is ±2% of (HighLevel-LowLevel).
HighLevel-LowLevel is called step height. For the step response analysis algorithm
to work properly, the waveform in the Oscilloscope must contain a rising edge, a
falling edge, both a rising edge and a falling edge, or a multiple of periods of them.
The following figure shows a measurement example. Percentage Overshoot is a
function of damping ratio. It could be used to derive the damping ratio directly using
User Defined Data Point (UDDP) introduced later.

A
sample
panel
setting
file
psf\VTDSO\StepResponseSR100MHz .psf.
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2.6.2.8.3.5 Echo
This option is used to analyze the data captured in the Oscilloscope intelligently and
measure the time delay between emission and echoes, if any. Together with the signal
generator function of the software, it can be used as an echo sounder for depth or
distance measurement, or time-domain reflectometer for cable discontinuity
localization.
The data should be long enough to contain the entire emission and one or multiple
echoes. Normally, the emission should be a short pulse such that the echoes can be
clearly separated from it in the time domain. It should be noted that the system under
test may alter the emitted waveform along the way and the echo waveform may
become totally different. One advantage of the pulse method is that it does not
require the emission and the echoes are similar in waveform. However, due to the
short duration of the pulse, the energy fed into the system is limited. As a result, this
method is not very immune to noises. In some systems where the linear and nonlinear
distortions are small and thus the emission and echoes have similar waveforms, it is
possible to use a continuous excitation signal with a broadband spectrum, such as
white noise, swept sine, and MLS. In this case, the emission and echoes may be
superimposed together and cannot be separated by eyes in the Oscilloscope, but the
time delay between them can still be accurately measured by the algorithm here. The
advantage of this method is that it is very immune to noises due to the large energy
pumped into the system. The measured echo times are reflected in DDPs:
EchoTime_A(s) for Channel A, and EchoTime_B(s) for Channel B. It is possible to
convert them to depth or distance using User Defined Data Point (UDDP) introduced
later.
The following screenshot shows an example of the pulse method where the emission
and the echoes are quite similar.
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The following screenshot shows an example of the pulse method where the emission
and the echoes are not similar.

The following screenshot shows an example of the continuous excitation method
using MLS.
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2.6.2.8.3.6 Damping Ratio
Damping ratio is a dimensionless measure describing how oscillations in a system
decay after a disturbance. It is a system parameter which can vary from undamped (=
0), underdamped (< 1), through critically damped (= 1), to overdamped (>1). It is
measured here using free vibration decay curve in time domain. This method is
applicable to vibration with single degree of freedom. The measured values are
reflected in DDPs: DampingRatio_A for Channel A, and DampingRatio_B for
Channel B. It is possible to convert them to Q factor by the formula:
[Q factor] = 0.5 / [Damping Ratio]
Another common method to measure the damping ratio is the so-called half-power
method. It measures the magnitude frequency response of the system first, and then
derives the damping ratio based on the following formula:
[Damping Ratio] ≈ [-3dB Bandwidth] / ([Peak Frequency] × 2)
In Multi-Instrument, the above formula can be used to define a UDDP for damping
ratio measurement (for Channel A) in frequency domain as follows:
([BandWidthHighLimit_A(Hz)]-[BandWidthLowLimit_A(Hz)])/2/[f1Freq_A(Hz)]
The Spectrum Analyzer should be set to bandwidth measurement mode in order for
the above formula to work. The half-power method, although strictly applicable only
to lightly damped single degree of freedom systems, is frequently applied to well-
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separated modes of multi-degree of freedom systems. It should be noted that the
frequency resolution must be set fine enough in order to achieve sufficient
measurement accuracy in this method.
With the damping ratio and damped natural frequency (i.e. peak frequency) measured,
the natural frequency of an underdamped system can be derived as follows:
[Natural Frequency] = [Damped Natural Frequency] / (1-[Damping Ratio]2)1/2
Using the above formula to define a UDDP for natural frequency measurement (for
Channel A) in Multi-Instrument, we have:
[f1Freq_A(Hz)]/SQRT(1- POW([DampingRatio_A],2))
The following screenshot shows an impulse response in the Oscilloscope and thus the
magnitude frequency response in the Spectrum Analyzer. It demonstrates that the
damping ratios measured using the free vibration decay method and the half-power
method match very well. The measured Q factor and natural frequency are also shown.

2.6.2.9 Oscilloscope Y Scale (Setting SubMenu) (ALT-S-Y)
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The options for Y Scale allow waveform conversion among acceleration, velocity and
displacement, when the raw data are acquired from acceleration (engineering units: g
or m/s^2), velocity (engineering unit: m/s or i/s) or displacement (engineering unit: m
or i) sensors. The statistical parameters of them are summarized in the vibrometer
function of the Multimeter. The Oscilloscope in the following figure shows the
velocity waveform obtained by integrating the raw acceleration data over time. A high
pass filter with a very low cut-off frequency (configurable) is used to remove the
errors accumulated during the integration process. The high pass filter may cause
some unwanted “boundary effects” at one or both ends of the data. These data are
disregarded by the vibrometer and marked with a cross.
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Both SI and English unit systems are supported. The software will automatically
choose the unit system according to the sensor sensitivity units entered via
[Setting]>[Calibration]>“Sensor”>“Unit”. Manual switching between the two unit
systems is only allowed when acceleration sensors are used.
“”
2.6.2.10 Oscilloscope Chart Options (Setting SubMenu) (ALT-S-O)
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2.6.2.10.1 Chart Type
Five chart types are supported: Line, Scatter, Column, Bar and Step. This function can
also be accessed by double clicking in the area on the top of the plot region.

2.6.2.10.2 Line Width
Line width can be adjusted from 1 to 10. The default value is 1.

2.6.2.10.3 Display Mode
There are two ways to display a frame of data:


Display all data points
In this mode, all data points will be plotted. When the total number of data points
to be plotted is greater than the total number of the horizontal pixels of the plot
region, multiple points may be plotted per vertical raster line. For example, if the
total number of data points to be plotted is 10000 and the horizontal length of the
plot region is 1000 pixels, then 10 points will be plotted per vertical raster line on
average. The advantage of this display mode is that you are able to see all peaks
in the data. However, the screen refresh becomes slow and the data curve becomes
clustered when the total number of data points is large.
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The following figure illustrates a ten-second sound record with a sampling
frequency of 44100 Hz under this display mode.



Display one data point per vertical raster line
In this mode, one data point is plotted per vertical raster line at most. The vertical
value of the data point is interpolated from the collected raw data. The advantage
of this display mode is that the screen refreshes very fast even if the total number
of data points to be plotted is very large. The disadvantage is that it might miss
some characteristics of the data such as peak values, and under some
circumstances gives you a wrong impression that something is wrong with the
waveform. This phenomenon is called screen aliasing.
The following figure shows the same sound record as the above one under this
display mode.
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It should also be noted that Lissajous Pattern View will always display all collected
data points irrespective of the display mode setting.
The software has an automatic display mode switching feature. In "Display one data
point per vertical raster line" mode, the software will switch to "Display all data
points" mode internally when the total number of data points in time domain is less
than twice of the horizontal length of the plot region in the Oscilloscope. In the
Spectrum Analyzer, the software will switch to "Display all data points" mode
internally when the total number of data points in frequency domain is less than 4
folds of the horizontal length of the plot region. The threshold value in the Spectrum
Analyzer is higher because the data curve in frequency domain tends to change more
abruptly (thus more likely to miss the peak values) than that in time domain. Note that
the horizontal length of the plot region is increased by multiple times with the
corresponding multiplier. Therefore, you are always able to see all data points if you
zoom in sufficiently irrespective of the display mode you set.
Due to the above automatic display mode switching feature, it is recommended that
the "Display one data point per vertical raster line" mode be used as the normal setting.
You can switch to "Display all data points" mode manually when necessary.
By factory default, the Oscilloscope and Spectrum 3D Plot are set in “Display one
data point per vertical raster line” mode and the Spectrum Analyzer is set in “Display
all data points” mode.
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2.6.2.10.4 Persistence
Under persistence mode, up to 200 most recent waveforms are kept in the computer
memory. These waveforms can be superimposed / drawn in the oscilloscope view in
three ways as follows. Note that the persistence mode affects the graphic rendering of
these waveforms in the oscilloscope view only and does not have impact on any other
aspects such as RMS values, spectrum analysis, data storing, etc..
(1) Phosphorescent
The most recent waveform is drawn in the selected color for that channel, the least
recent waveform is drawn in the background color, and the rest of waveforms are
drawn in colors interpolated between these two according to their ages. This emulates
the phosphor display of a conventional analog oscilloscope whereby the trace decays
over time.

(2) Rainbow
Waveforms are drawn in colors derived from a predefined rainbow color palette
according to their ages. Unlike the phosphorescent mode, the trace does not decay
over time.
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(3) Equivalent Time Sampling (ETS)
While a spectrum analyzer can analyze a signal correctly as long as the sampling
frequency is at least twice the highest frequency contained in the signal (Nyquist
Sampling Theorem), an oscilloscope, under linear interpolation mode (refer to the
next section), normally requires the sampling frequency to be at least 10 times the
signal frequency in order to acquire sufficient samples in one cycle to draw the
waveform in reasonably good shape. ETS can be used to greatly increase the number
of samples per cycle by accumulating samples over many cycles. It is most useful
when the number of samples per cycle acquired using real-time sampling is
inadequate. One prerequisite to use ETS is that the signal under test must be repetitive
and the sampling is properly triggered. The following two figures show a comparison
between real time sampling and ETS. The first one samples a 12MHz sine wave with
a 50MHz clock in real time sampling mode while the second one samples the same
signal with a 50MHz clock in ETS mode. The latter looks much better.
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2.6.2.10.5 Interpolation Mode
Interpolation is used when two adjacent samples span more than two pixels in
horizontal direction on the screen. That is, there is at least one pixel in between the
two samples horizontally. Interpolation mode determines the way to connect two
adjacent samples on the screen when plotting a waveform. It affects the rendering of a
waveform on the screen only and does not have impact on any other aspects such as
RMS values, spectrum analysis, data storing, etc.. Two methods are available: Linear
Interpolation and SINC Interpolation.
(1) Linear Interpolation
Linear interpolation is the most straightforward method. It connects two adjacent
samples using a straight line on the screen. When the sampling frequency is at least
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5~10 times the signal frequency, linear interpolation can gives reasonably good
waveforms. When the ratio of the sampling frequency to the signal frequency is less
than 5~10 (but still higher than 2 as dictated by Nyquist Sampling Theorem, i.e. the
spectral analysis results are still absolutely correct), the waveform plotted using linear
interpolation can be severely distorted. The following example samples a 20MHz sine
wave with a 50MHz clock in real time and then renders the waveform using linear
interpolation. The sampling-frequency-to-signal-frequency ratio is 2.5. The waveform
in the oscilloscope looks very distorted.

(2) SINC Interpolation
Nyquist-Shannon Sampling Theorem states that an analog signal that has been
sampled can be perfectly reconstructed from the samples if the sampling frequency is
greater than twice of the highest frequency in the original signal. If we know that the
signal is band-limited within the Nyquist frequency (1/2 of the sampling frequency),
then we can use SINC interpolation to reconstruct the original signal waveform on the
screen. A sampling-frequency-to-signal-frequency ratio greater than 2.5 would give
nearly perfect results while a ratio in the range of 2.1~2.5 would still give reasonably
good results. Many DAQ devices such as VT DSOs and sound cards are equipped
with anti-aliasing filters and satisfy the requirements of Nyquist-Shannon Sampling
Theorem, SINC interpolation is thus preferred as it produces much better curve fitting
results than linear interpolation. SINC interpolation is selected by default in the
software. If you want to display signals such as square waves, which ideally
contain frequencies higher than the Nyquist frequency, then de-selecting it to
enable linear interpolation will give the square waveforms a better look. When
SINC interpolation is applied, “SINC” will be displayed at the bottom middle of the
Oscilloscope window. It should be noted that SINC interpolation may have some
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“boundary effects” within a very short range (less than 32 samples) at both ends of the
waveform.
The following example samples a 20MHz sine wave with a 50MHz clock in real time
and then renders the waveform using SINC interpolation. The sampling-frequency-tosignal-frequency ratio is 2.5. The waveform in the oscilloscope looks nearly perfect.

2.6.2.11 Oscilloscope Reference (Setting SubMenu) (ALT-S-R)
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Reference curves are very useful for data comparison. The software allows you to
configure up to 5 reference curves for each channel. Reference curves can be
configured by copying the currently displayed data curve from Channel A or Channel
B, or loading a reference curve file from the hard disk.
Each line in the above figure consists of the parameters/controls for one reference
curve. From left to right, they are:


Display/Hide Checkbox
It is used to display/hide the respective reference curve. If the reference curve
has not been saved to the hard disk, hiding it will clear it from the computer
memory.



Color Selection Box
Clicking on it will bring up a color selection window which allows you to
select the color you want for that reference curve.
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Legend
The software will automatically assign a textual label for the reference curve,
such as “RefA0”, “RefB0”. You can overwrite it with your own preference.



File Name
If the reference curve is configured by copying the currently displayed data
curve from Channel A or Channel B and it has not yet been saved to the hard
disk, then it will be named as “Memory A0”, “Memory B0”….. If you save
the reference curve to the hard disk, then the saved file name will be displayed
here.
If the reference curve is loaded from the hard disk, then the file name will be
reflected here.



File Open
Use this command to load a reference file from the hard disk.



Copy from Channel A
Configure the reference curve by copying the currently displayed data curve
from Channel A.



Copy from Channel B
Configure the reference curve by copying the currently displayed data curve
from Channel B.



File Save
Use this command to save the reference curve data from the computer memory
to the hard disk.



File Edit
Use this command to edit an existing reference file or create a new reference
file.



High-High Limit, High Limit, Low Limit, Low-Low Limit, Similarity
If ticked, the reference curves are assigned as the respective limits for the realtime waveform. Whether the waveform breaks these limits and how much is
exceeded can be checked through the respective DDPs:
WaveformComparisonH_A:
0: waveform in Ch. A is normal.
<0: waveform in Ch. A exceeds the High Limit only. The absolute value
indicates how much is exceeded.
>0: waveform in Ch. A exceeds the High-High Limit. The absolute value
indicates how much is exceeded.
WaveformComparisonL_A:
0: waveform in Ch. A is normal.
>0: waveform in Ch. A falls below the Low Limit only. The absolute value
indicates how much is exceeded.
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<0: waveform in Ch. A falls below the Low-Low Limit. The absolute value
indicates how much is exceeded.
Similarly, WaveformComparisonH_B and WaveformComparisonL_B are
used for Ch. B. “Similarity” function and its respective DDPs:
WaveformSimilarity_A and WaveformSimilarity_B are reserved for future
development.
The reference file (*.ref) is a Comma Separated Variable (CSV) TXT file with the
following format:
Example:
1, 0.000108441, 0.103241
2, 0.000131117, 0.0823364
…….
Each row contains the coordinates of a point of the reference curve with three
variables: sequential number, X value, and Y value. Minimum two points must be
specified per reference curve.
Some sample files are provided in the REF directory of the software and can be used
as templates.
It is possible to enter a generic X offset value and a generic Y offset value for the
reference curves in each channel. Two additional options are provided particular for X
offset: (1) Align to Peak; (2) Align to Trough. If selected, each reference curve will
be shifted automatically such that its peak or trough is aligned to that of the captured
waveform. These two options are useful when there is only one peak or trough on the
reference curve and the captured waveform.
2.6.2.12 Save Current Panel Setting as Default (Setting SubMenu) (ALT-S-F)
When you start the software at the very first time, system default panel setting set in
the factory will be loaded. You can subsequently change the panel setting to whatever
you want, and then save the panel setting as default via this command. This default
setting will be loaded at startup next time. You can always go back to the system
default panel setting by clicking [File]>[New] command.
The panel setting here includes the following parameters:










Trigger Parameters
Sampling Parameters
Miscellaneous Parameters
Oscilloscope Parameters
Spectrum Analyzer Parameters
Multimeter Parameters
Spectrum 3D Plot Parameters
Signal Generator Parameters
Data Logger Parameters
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LCR Meter Parameters
Device Test Plan Parameters
DDP Viewer Parameters
DDP Array Viewer Parameters
DDC Parameters
Screen Layout, including which instrument to be shown and the position of
each instrument on the screen.

2.6.2.13 Save Current Panel Setting (Setting SubMenu) (ALT-S-S)
You can save the current panel setting into a Panel Setting File (*.psf) using this
command. The saved panel setting can be loaded at a later time. This will free you
from re-adjusting the panel setting for a particular type of tests again and again.

2.6.2.14 Load Panel Setting (Setting SubMenu) (ALT-S-L)
You can load a panel setting from a previously saved Panel Setting File (*.psf) using
this command. This will free you from re-adjusting the panel setting for a particular
type of tests again and again.
2.6.2.15 Configure Hot Panel Setting Toolbar (Setting SubMenu) (ALT-S-P)

You can configure up to 20 most frequently used panel settings in the Hot Panel
Setting Toolbar so that these settings can be loaded by just a single mouse click on
their respective buttons.
Each line in the above figure defines one button in the Hot Panel Setting Toolbar. The
parameters from left to right are:
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Button No.
The buttons are numbered from 1 to 20 from left to right in the Hot Panel Setting
Toolbar.



Panel Setting File
The path and file name of the panel setting file assigned to the button using the
File Load button below.



File Load
It is used to locate the panel setting file to be assigned to the button.



Text on Button
The text entered in this edit box will be shown on the button. The text should
preferably contain 3~5 characters and reflect concisely the function of the button.



Description
The description entered in this edit box will be shown as a tooltip when you rest
your mouse cursor on the button.



Clear
It is used to clear the button definition.

You can save the above configuration into a Hot Panel Setting Toolbar configuration
file (*.hps) by clicking the “Save As” button at the bottom of the above dialog. You
can load a Hot Panel Setting Toolbar configuration file by clicking the File Open
button at the bottom of the dialog. The current Hot Panel Setting Toolbar
configuration file used by the software is also displayed at the bottom.
The Hot Panel Setting Toolbar configuration file (*.hps) is a TXT file which can be
edited directly using Windows Notepad. Direct editing allows the configuration of
some special functions usually used for software customization. Panel Setting File
field supports the following predefined texts for special functions:
STARTSTOP: Start / Stop the oscilloscope.
SETTING: Different setting windows should be developed for different customized
software applications.
EXIT: Exit the software
HELP: Display a help file. The help file should be placed in the software’s root
directory. The file name should be put in the Description field.
In Pro edition and above, it is possible to change the placement of the Hot Panel
Setting Toolbar: Top, Bottom, Left, Right. It is also possible to change the button
appearance: Text (only a text is displayed), Text & Image (both a text and a
predefined icon are displayed), Image (only a predefined icon is displayed), Custom
Image (only a customized icon is displayed). These changes will take effect after
software restart.
STARTSTOP is a toggle button with “Running” state down and “Stop” state up.
SETTING、EXIT、HELP are push buttons. The rest of buttons for panel setting file
loading are push buttons when the panel setting is not locked, otherwise they are
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interlocked toggle buttons and only one of them will be in “down” state at any time.
In this case, the loaded panel setting file name will be indicated in the title bar of the
main window. When the panel setting is locked via [Help]>[Lock Panel Setting],
there is no way to modify the loaded panel setting, except that you can load another
preconfigured panel setting file through another button in the Hot Panel Setting
Toolbar. This arrangement is usually used by users with access right at operator level.
Those with engineer-level access right are normally allowed to modify various
settings.

2.6.2.16 Show Hot Panel Setting Toolbar (Setting SubMenu) (ALT-S-H)
It is a toggle command to show or hide the Hot Panel Setting Toolbar.

2.6.2.17 Change Password (Setting SubMenu) (ALT-S-W)

You can change the password for unlocking the panel setting here. No password is set
initially. If you want to add a password, you can leave the Current Password field
empty and enter and confirm the new password. For changing the existing password,
you need to enter the current password, enter and confirm the new password. To
delete the password, just enter the current password and leave the New Password and
New Password (Confirm) fields empty.
2.6.3 Instrument SubMenu

This submenu provides access to opening / closing each individual instrument
provided.
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2.6.3.1 Run (Instrument SubMenu) (ALT-I-R, CTRL-R or Enter)
This command will toggle between Run and Stop for data acquisition. The command
is also available through the button
in the Instrument Toolbar. The color of the
button will toggle between red and green to indicate "Stop" and "Run" status.

2.6.3.2 Oscilloscope (Instrument SubMenu) (ALT-I-O)
This command will toggle between Open and Close for the Oscilloscope. The
command is also available through the button

in the Instrument Toolbar.

2.6.3.3 Spectrum Analyzer (Instrument SubMenu) (ALT-I-S)
This command will toggle between Open and Close for the Spectrum Analyzer. The
command is also available through the button

in the Instrument Toolbar.

2.6.3.4 Multimeter (Instrument SubMenu) (ALT-I-M)
This command will toggle between Open and Close for the Multimeter.
command is also available through the button in the Instrument Toolbar.

The

2.6.3.5 Spectrum 3D Plot (Instrument SubMenu) (ALT-I-D)
This command will toggle between Open and Close for the Spectrum 3D Plot. The
command is also available through the button in the Instrument Toolbar.

2.6.3.6 Signal Generator (Instrument SubMenu) (ALT-I-G)
This command will toggle between Open and Close for the Signal Generator. The
command is also available through the button

in the Instrument Toolbar.

2.6.3.7 Device Test Plan (Instrument SubMenu) (ALT-I-P)
This command will toggle between Open and Close for the Device Test Plan. The
command is also available through the button
in the Instrument Toolbar.

2.6.3.8 Data Logger (Instrument SubMenu) (ALT-I-L)
This command will launch a Data Logger window. Up to 8 Data Logger windows
can be opened. The command is also available through the button in the Instrument
Toolbar.
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2.6.3.9 Derived Data Point Viewer (Instrument SubMenu) (ALT-I-V)
This command will launch a DDP viewer window. Up to 24 DDP viewer windows
can be opened. The command is also available through the button
in the
Instrument Toolbar.

2.6.3.10 Derived Data Curve (Instrument SubMenu) (ALT-I-C)
This command will launch a DDC window. Up to 8 DDC windows can be opened.
The command is also available through the button

in the Instrument Toolbar.

2.6.4 Window SubMenu

The Window submenu provides the access to window arrangement functions.

2.6.4.1 Cascade (Window SubMenu) (ALT-W-C)
This command will cascade the opened views and dialog boxes.

2.6.4.2 Tile Horizontally (Window SubMenu) (ALT-W-H)
This command will tile the opened views and dialog boxes horizontally. For example,
if both the Oscilloscope and the Spectrum Analyzer are opened, then this command
will make each of them take up half of the screen in vertical direction.

2.6.4.3 Tile Vertically (Window SubMenu) (ALT-W-V)
This command will tile the opened views and dialog boxes vertically. For example, if
both the Oscilloscope and Spectrum Analyzer are opened, then this command will
make each of them take up half of the screen in horizontal direction.
2.6.5 Help SubMenu
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The Help SubMenu provides access to the help function and software version and
license information. It also provides the function for locking/unlocking the panel
setting.

2.6.5.1 Lock Panel Setting (Help SubMenu) (ALT-H-L or Ctrl-K)
This command will toggle between locking and unlocking panel setting. If the panel
setting is locked, then only the following operations are allowed by the software:






Access to the Help SubMenu
Run / Stop the Oscilloscope and the Signal Generator.
Load a panel setting file via a button in the Hot Panel Setting Toolbar
Save a file
Invert Input Signal, Channel A Zeroing, Channel B Zeroing, Windows Recording
Control, Windows Volume Control, Waveform Play, Waveform Cyclic Play

You can add a password for unlocking the panel setting via [Setting]>[Change
Password], to allow only authorized persons to unlock the panel setting if it has been
locked. The software will start as locked if you tick “Lock Panel Setting after startup”
via [Setting]>[Display].
You can establish two levels of operation of the software by combining the lock panel
setting function with the Hot Panel Setting Toolbar. The two levels are: Engineer
Level and Operator Level. The engineers will be given the password to unlock the
panel setting, and they are able to access all functions provided by the software. The
engineers should assign the frequently used panel setting files to the Hot Panel Setting
Toolbar so that the operators can load them when the panel setting is locked.

2.6.5.2 Help Topics (Help SubMenu) (ALT-H-H or F1)
This command will open the Help window. You can use the Content Tab, Index Tab
or Search Tab to locate the help topic you want.
2.6.5.3 Software Manual (Help SubMenu) (ALT-H-S)
This command will open the software manual.
2.6.5.4 Hareware Manual (Help SubMenu) (ALT-H-M)
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This command will open the hardware manual of the ADC device. If the ADC device
is not a VT hardware device but the DAC device is, then the hardware manual of the
DAC device will be opened instead. If both the ADC and DAC devices are not a VT
hardware device, then this option will grey out.
2.6.5.5 Application Notes and Videos (Help SubMenu) (ALT-H-N)
This command will open the Application Notes and Videos page on the official
website of the software.
2.6.5.6 Check for Software Updates (Help SubMenu) (ALT-H-U)
This command will check online to see if a new software version is available for
download. If yes, it will prompt you for confirmation for download.
After download, you will need to install the software by yourself with the admin right.
If the software is installed into the same directory of an old installation without
performing uninstallation first, the old configuration such as the color scheme and
calibration data, etc. will be inherited. It is also possible for a brand-new
installation to inherit an old configuration if the old configuration file Scins.cfg,
before uninstallation, is kept and renamed to Scins.cfg.old and placed under the new
installation directory before the very first run of the new version.
2.6.5.7 About (Help SubMenu) (ALT-H-A)
This command will open the About window which displays the versions of the
software, firmware and driver as well as the license information.

2.7 Cursor Reader and Markers
2.7.1 Cursor Reader
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The cursor reader is shown when you left click and hold anywhere within the plot
region of a view. It will stick to the actual measurement point nearest to the cursor in
the horizontal direction and show its X and Y readings for both channels in the top
region of the view. The cursor reader moves with the cursor and remains active until
the left mouse button is released.
In Lissajous Pattern display, the cursor reader will show the X and Y readings at
exactly the cursor position and will not stick to the actual measurement point.
2.7.2 Marker
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Maximum two markers can be placed in the plot region of a view.
Double clicking the left mouse button anywhere within the plot region will place a
marker on the screen at the actual measurement point nearest to the position of mouse
click in the horizontal direction. Left double clicking places a marker for the left
vertical axis while CTRL-Left double clicking places a marker for the right vertical
axis. No marker will be placed if there is no corresponding vertical axis.
The second marker can be placed by Shift-Left double clicking or Shift-CTRL-Left
double clicking.
Clicking anywhere outside the plot region in the view will remove all markers placed
previously.
The horizontal and vertical readings of a marker will be displayed in the top region of
the view. If two markers are placed, the reading difference between them will also be
shown.
2.7.3 Combined Use of Marker and Cursor Reader
You can place a marker as a fixed reference point and then use the cursor reader to
read out the difference between the cursor and the reference point as the cursor moves.
This is very useful, for example, when you want to measure the pulse width, the rise
time or the fall time.
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2.8 Maximum, Minimum, Mean and RMS Values
The Oscilloscope will display the Maximum, Minimum, Mean and RMS values of
each frame of data. These parameters can also be accessed through the following
DDPs: Max_A(EU), Min_A(EU), Mean_A(EU), RMS_A(EU) for Channel A and
Max_B(EU), Min_B(EU), Mean_B(EU), RMS_B(EU) for Channel B.

2.9 Time Stamp
The time stamp displayed at the lower left corner of the Oscilloscope view represents
the time (with an accuracy of 1 millisecond) of the first data point (i.e. the leftmost
data point) of the current frame of data. In most cases, the two channels of data are
sampled at the same time and thus only one time stamp is displayed. However, there
are cases whereby Channel A is used for live input and Channel B is fed by the Signal
Generator directly at software level (refer to the manual of the Signal Generator). In
these cases, the time stamp for Channel A will be displayed and on its right hand side,
the time difference between Channel A and Channel B will also be displayed, with an
accuracy of one sampling interval between the raw data. A negative value of the time
difference means that the data of Channel B arrives earlier than that of Channel A.

2.10 Trigger Marker

Two markers will be displayed in the oscilloscope view to reflect the trigger
parameters. One marker will be displayed on the left vertical axis to reflect the current
Trigger Level (by the location of the marker on the vertical axis), Trigger Edge (by
the arrow direction of the marker) and Trigger Source (by the color of the marker).
The other marker will be displayed on the horizontal axis on the top to reflect the
Trigger Delay (by the location of the marker on the horizontal axis) as well as the
Trigger Source (by the color of the marker). Only a negative Trigger Delay (i.e. pretrigger) can be displayed. The trigger position on a waveform can be found based on
these two markers.
These markers are displayed only in one type of view: waveform display of Channel
A and Channel B. They will not be displayed when Trigger Edge is “JP” or “DF”.
When the trigger level marker is shown, if you rest the cursor on it, the cursor will
change from the Windows default one to
. If you then press down and hold the
left mouse button, you can adjust the Trigger Level by moving the marker. You can
adjust the Trigger Delay in a similar way. Some ADC hardware devices support ALT
trigger mode. Under ALT trigger mode, the trigger level for Channel B can be
adjusted by moving the trigger level marker on the right vertical axis.
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2.11 DAQ Progress Bar
A DAQ progress bar will be displayed at the lower left corner of the Oscilloscope
view under either of the following conditions:
 The Oscilloscope is started in non-Record mode and the specified trigger
condition has not been met for at least 5 seconds.
 The Oscilloscope is started in Record mode.
Black color is used to fill up the progress bar when no trigger event has been found,
the time elapsed since the start of the Oscilloscope will be displayed. The progress bar
will resets and changes to green color after a trigger event is found in the returned
DAQ buffer, the time elapsed since then will be displayed. The DAQ progress bar
will be hidden again after a frame of data is collected, analyzed and displayed.

2.12 Record Mode

There are two ways to enter into the Record Mode:



Press the above “Record” button in the Sampling Parameter Toolbar, or
Select “Record” in the Sweep Time combo box and then press the “Run” button of
the Oscilloscope.

Under the Record Mode, raw ADC data will be written into the hard disk
continuously in WAV file format. Meanwhile, data analysis and display will still be
performed in order to keep the screen updated in real time. Priority is given to the
former process in order to try the best to ensure uninterrupted data recording.
Whether the recorded data are continuous (i.e. the adjacent frames of data are
connected smoothly without missing any data in between) or not depends on whether
the ADC hardware supports continuous streaming, the system throughput, sampling
frequency, bit resolution, number of sampling channels, etc. It is generally possible to
record signals continuously without any interruption using sound cards. For VT DSOs
using USB2.0, the data rate limit would be a sampling rate of 10~20MHz, 8 bits and
single channel. Beyond this limit, discontinuity may occur. When the recorded data
are continuous, the DAQ progress bar at the bottom left corner of the Oscilloscope
window will be filled with green color. Once a discontinuity is detected, red color
will be used instead.
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The sweep time (for screen refresh purpose only) under this mode is defaulted to 100
ms (for the case of a sound card) and is adjustable via [Setting]>[Display]>"Record
Mode">"Frame Width". The record duration is set via [Setting]>[Display]>”Record
Mode”>”Duration”. By default, the Duration is set to zero, meaning that the
recording process will stop automatically only after 2 gigabytes of data have been
recorded. The recording process can also be stopped manually by pressing the Run /
Stop button in the Instrument Toolbar or the Record button in the Sampling Parameter
Toolbar. You can specify a duration value greater than zero so that the recording
process will stop automatically according to it. Only Auto Trigger Mode and Normal
Trigger Mode are allowed under the Record mode. Sampling parameters are
prevented from being changed during the recording process by the software. Upon
finishing recording, the recorded file will be opened automatically by the software in
one-frame mode if the length of the data is not too long, or in frame-by-frame mode
otherwise. It may take a little while if the file is big.
If you start recording without opening a file (in this case, no file name will be
displayed in the title bar of the main window of the software), then the software will
automatically use “Record1.wav” as the file name for this record. If you repeat the
recording process by stopping and starting the recording again and again, then the file
name will be incremented each time, e.g. Record2.wav, Record3.wav…. This file
name incrementing process will restart only if you restart the program.
If you start recording on an opened file which does not have a file name as
“Recordxxx.wav”, then the original file will be overwritten by the recorded data, and
the file name will not change even if you repeat the recording process.
If [Setting]>[Display]>”Record Mode”>”No Auto Stop” is ticked, then the recording
process can only be stopped manually. One WAV file will be recorded automatically
per Record Duration, or 2G bytes’ data if the duration is 0. The WAV file names will
be assigned automatically based on the time stamp of the first sample in the file in the
format of YYYY-MM-DD-HH-MM-SS-XXX.wav, with date and time in accuracy of
milliseconds. This function can be used to log the raw data continuously as long as the
storage space is allowed.

2.13 Roll Mode

Roll Mode is activated by ticking the above “Roll” checkbox in the Sampling
Parameter Toolbar. Under this mode, the Oscilloscope frame is split into many
segments with the length of each segment equal to the Roll Width, which is set via
[Setting]>[Display]> “Roll Mode”>“Roll Width”. The Roll Width is set to 50 ms (for
the case of a sound card) by default. Under the Roll Mode, the size of data acquisition
is based on the Roll Width rather than the Record Length per sweep. The data
displayed in the Oscilloscope view will shift left at a step of one Roll Width each time
when a new segment of data arrives. The newly arrived data will be shown in the
right most portion of the graph. You can consider using Roll Mode if the sweep time
is too long (e.g. greater than 1 s) to avoid long time waiting for screen update. You
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must use Roll Mode (if it is available) when the Record Length per sweep is greater
than the size of the ADC hardware buffer.
The Roll Mode checkbox is enabled when the Record Length per sweep is at least
four times as long as the Roll Width.
Under the Roll Mode, whether the acquired data are continuous (i.e. the adjacent
segments of data are connected smoothly without missing any data in between) or not
depends on whether the ADC hardware supports continuous streaming, the system
throughput, sampling frequency, bit resolution, number of sampling channels, etc.

2.14 Sampling Parameter Auto Setting

When a periodic signal is connected, you can let the software to automatically choose
proper sampling parameters such as Sweep Time and ADC Range by clicking the
above “Auto” button in the Sampling Parameter Toolbar. You are not allowed to
change any sampling parameters during this auto setting process. The auto setting
process will be stopped automatically after the proper sampling parameters are found
for the signal under test or timeout. Some detailed functions of this button can be
configured via [Setting]>[ADC Device]>“Auto Ranging” and “Auto Button for Auto
Ranging only”. Please refer to the respective sections introduced previously.

2.15 Magnifying Glass
The magnifying glass will show up when you put the cursor on the outer side of an
axis, if the axis has a multiplier associated with it. The magnifying glass has three
states:
: Only zoom in is available.
: Both zoom in and zoom out is available.
: Only zoom out is available.
Pressing the left mouse button will zoom in one step and pressing the right mouse
button will zoom out one step. Zoom in / out can also be performed using the mouse
wheel. Mouse wheel, SHIFT + mouse wheel, CTRL + mouse wheel can be used to
zoom in / out X, A, B axes respectively. Mouse wheel down & scroll, SHIFT +
mouse wheel down & scroll, CTRL + mouse wheel down & scroll will return X, A, B
axes to their default values respectively.
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2.16 Context Menu

The above context menu will be shown when right clicking anywhere within the
Oscilloscope view. It provides additional convenience to you. All menu items in the
context menu can also be found in the main menu of the Oscilloscope, except the
following items:


Copy As Bitmap
It is similar to the Oscilloscope Export (as Bitmap) function. Instead of saving the
bitmap image of the oscilloscope view to the hard disk, it copies the image to the
clipboard which can be subsequently pasted out into other programs such as
Microsoft Word.



Copy As Text
It is similar to the Oscilloscope Export (as Text) function. Instead of saving the
texts of the oscilloscope data to the hard disk, it copies the data to the clipboard
which can be subsequently pasted out into other programs such as Microsoft Excel.
Note the data in the clipboard is Tab separated instead of comma separated.



AutoScaling
It adjusts the vertical display scales based on the peak values in the sampled data
frame.



Separate Display
It separates the display of Channel A from that of Channel B vertically.



Merge Display
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It superimposes the displays of Channel A and Channel B.


Display Ch. A Only
It will display Ch. A only and hide other channels in all views.



Display Ch. B Only
It will display Ch. B only and hide other channels in all views.



Display All
It will display all channels in all views.
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3 Spectrum Analyzer
3.1 Overview

This is a dual channel Spectrum Analyzer, providing seven types of views:
 Real time Amplitude Spectrum / Power Spectrum Density / Impedance
Spectrum
 Real time Phase Spectrum
 Real time Auto Correlation Function (Linear or Circular)
 Real time Cross Correlation Function (Linear or Circular, Original or
Generalized)
 Real time Coherence / Non-Coherence Function
 Real time Transfer Function (Bode Plot, Frequency Response, or Gain and
Phase Plot) / Impedance Analyzer
 Real time Impulse Response
with adjustable FFT size ranging from 128 to 4194304, adjustable window overlap
percentage (0%~99.9%), and 69 selectable window functions such as Rectangle,
Triangle, Hann, Hamming, Blackman, Kaiser and so on. It supports display in
logarithmic scale for both X axis and Y axis (dBr, dBV, dBu, dBFS, dB), octave
analysis (1/1, 1/3, 1/6, 1/12, 1/24, 1/48, 1/96), frequency compensation, frequency
weighting (Flat, A weighting, B weighting, C weighting, ITU-R 468 weighting),
moving average smoothing (linear or 1/1/~1/96 octave), DC removal, peak hold,
linear average, exponential average, and parameter measurements (THD, THD+N,
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SINAD, SNR, Noise Level, IMD-SMPTE/DIN, IMD-CCIF2, IMD-CCIF3, DIM,
Crosstalk, Bandwidth, Harmonics, Peaks, Energy in user defined frequency bands,
Wow & Flutter, Sound Loudness & Sharpness, Total Non-Coherent Distortion +
Noise), GedLee Metric, Total Distortion + Noise, etc.
The Spectrum Analyzer shares the same Trigger Parameters, Sampling Parameters
and Miscellaneous Parameters with the Oscilloscope. Please refer to the relevant
sections in the Oscilloscope for details.

3.2 View Parameters
View parameters determine how the collected data are analyzed and displayed.

There are seven types of views in the Spectrum Analyzer:








Amplitude Spectrum
Phase Spectrum
Auto-Correlation
Cross-Correlation
Coherence
Transfer Function
Impulse Response

Spectrum Analyzer generates many DDPs. For a complete list of these DDPs, please
refer to Section 6.2.1.
3.2.1 View Parameters for Amplitude Spectrum Display

Selecting Amplitude Spectrum in the above View Type selection box switches the
Spectrum Analyzer to amplitude spectrum display mode, which shows the amplitude
vs frequency graph of the measured signal. It can also be used to show impedance vs
frequency graph. This will be described later.
The following figure illustrates the amplitude spectrum of a 1 kHz square wave with
X axis in linear scale and Y axis in normalized linear scale. It shows that a square
wave consists of a fundamental frequency and an infinite number of odd harmonics,
each of which has an amplitude equal to 1/N of that of the fundamental frequency,
where N is the order of the harmonic.
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The following figure illustrates the 1/6 octave amplitude spectrum of a 50-ms stereo
pop song replayed and then captured by a sound card. The X axis is in 1/6 octave
scale and the Y axis is in dBV scale.

3.2.1.1 Frequency Range (F)
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36 options are available for Frequency Range (F). They are: Auto, 1Hz, 2Hz, 5Hz,
10Hz, 20Hz, 50Hz, 100Hz, 200Hz, 500Hz, 1kHz, 2kHz, 5kHz, 10kHz, 20kHz, 25kHz,
50kHz, 100kHz, 200kHz, 500kHz, 1MHz, 2MHz, 5MHz, 10MHz, 20MHz, 50MHz,
100MHz, 200MHz, 500MHz, 1GHz, 2GHz, 5GHz, 10GHz, 20GHz, 50GHz, 100GHz.
When "Auto" is selected, the Frequency Range will be set automatically by the
software based on the following formula:
Frequency Range = the nearest integer that is equal to or greater than 1/2 of
[Sampling Frequency]
An important principle in digital signal processing is the "Nyquist-Shannon Sampling
Theorem" which states that an analog signal that has been sampled can be perfectly
reconstructed from the samples if the sampling frequency is greater than twice of the
highest frequency in the original signal. This means that if you wish to measure a
3,000 Hz signal, the sampling rate must be greater than 6,000 Hz, otherwise aliasing
will occur.
In Amplitude Spectrum Display, the horizontal axis can be displayed in linear,
logarithmic, 1/1, 1/3, 1/6, 1/12, 1/24, 1/48, or 1/96 octave scale, which can be selected
via [Setting]>[Spectrum Analyzer X Scale].

3.2.1.2 Frequency Multiplier
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The Frequency Multiplier is the zooming factor for the horizontal axis. There are 16
options available: ×1, ×2, ×5, ×10, ×20, ×50, ×100, ×200, ×500, ×1000, ×2000, ×5000,
×10000, ×20000, ×50000, ×100000.
When "×1" is selected, the full Frequency Range is displayed over the width of the
view.
If you change the Frequency Multiplier to "×N" which is greater than 1, then only 1/N
of the full Frequency Range will be displayed over the width of the view, with a
horizontal scrollbar at the bottom which allows you to scroll over the full range of the
Frequency.
This multiplier can also be adjusted via the magnifying glass which will be shown if
you put the mouse cursor just below the horizontal axis.

3.2.1.3 Channel A Display Range
In Amplitude Spectrum Display, there are two modes for the vertical axis, which can
be selected via [Setting]>[Spectrum Analyzer Y Scale]:
3.2.1.3.1 Absolute Display Mode
The vertical axis is scaled in engineering unit. All data points are plotted based on
their absolute values, in Vrms, dBV, dBu, dB, or dBFS. Note that by definition, the
reference voltages for dBV and dBu are 1 Vrms and 0.775 Vrms respectively. 1 dBu
in amplitude spectrum is equivalent to 1 dBm in power spectrum when the load is 600
ohms. The reference levels for dB for both channels are user definable. For example,
you can calibrate them to sound pressure level. Please refer to the section for 0dB
Reference Vr described previously. The reference voltage for dBFS is the ADC fullscale voltage (1/2 Vpp). More detailed explanation will be given later in the section
for Spectrum Analyzer Y Scale.
3.2.1.3.1.1 Linear Scale
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For linear scale such as Vrms, the available Display Range options are: Off, Auto,
1pV, 2pV, 5pV, 10pV, 20pV, 50pV, 100pV, 200pV, 500pV, 1nV, 2nV, 5nV, 10nV,
20nV, 50nV, 100nV, 200nV, 500nV, 1µV, 2µV, 5µV, 10µV, 20µV, 50µV, 100µV,
200µV, 500µV, 1mV, 2mV, 5mV, 10mV, 20mV, 50mV, 100mV, 200mV, 500mV,
1V, 2V, 5V, 10V, 20V, 50V, 100V, 200V, 500V, 1kV, 2kV, 5kV, 10kV, 20kV, 50kV,
100kV, 200kV, 500kV, 1MV, 2MV, 5MV, 10MV, 20MV, 50MV, 100MV, 200MV,
500MV, 1GV, 2GV, 5GV, 10GV, 20GV, 50GV, 100GV, 200GV, 500GV. Note that
the engineering unit of the above options is determined by the engineering unit of the
sensor for Channel A, which can be set via [Setting] > [Calibration] > "Sensor" >
"Unit". For example, if the unit is "g" instead of "V", then the unit in all the above
options will be changed to "g".
When "Off" is selected, the data in Channel A will not be displayed. When "Auto" is
selected, the Display Range for Channel A will be set automatically by the software
based on the following formula:
Display Range = the nearest integer that is equal to or greater than the value of
[ADC Range] / [Sensor Sensitivity]
where the sensor sensitivity is set via [Setting] > [Calibration] > "Sensor" >
"Sensitivity".
3.2.1.3.1.2 Logarithmic Scale
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For logarithmic scale such as dBV, the available Display Range options are: 1dB, 2dB,
5dB, 10dB, 15dB, 20dB, 25dB, 30dB, 35dB, 40dB, 45dB, 50dB, 60dB, 70dB, 80dB,
90dB, 100dB, 120dB, 150dB, 200dB, 250dB, 300dB, 350dB, 400dB, 450dB, 500dB.
Note that the bracket “<>” means that the value represents only the span of the axis,
the upper limit of the axis is determined by the ADC Range as well as the Sensor
Sensitivity, and the lower limit is equal to [Upper Limit] - [Span]. A Display Range
value without the bracket “<>” represents a range from 0 to the Display Range value,
which is the case for dBFS.
When "Off" is selected, the data in Channel A will not be displayed.
3.2.1.3.2 Relative Display Mode
The vertical axis is scaled in relative values, in either linear or dBr (logarithmic) scale.
All data points are plotted based on their relative values with regard to the maximum
value (or the value at a specified frequency) in the current measurement.
3.2.1.3.2.1 Linear Scale

In this mode, the vertical axis ranges from 0 to 1 where 1 corresponds to the highest
absolute vertical value in the measurement.
When "Off" is selected, the data in Channel A will not be displayed.
3.2.1.3.2.2 Logarithmic Scale (dBr)
(1) 0dB reference Vr = Peak
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In this mode, the vertical axis ranges from 0 to the Display Range value selected,
where 0 dB corresponds to the highest absolute vertical value in the measurement.
(2) 0dB reference Vr at a specified frequency

In this mode, the vertical axis covers ± [Display Range value] selected, where 0 dB
corresponds to the measured value at the specified frequency.
When "Off" is selected, the data in Channel A will not be displayed.

3.2.1.4 Channel A Multiplier
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The Multiplier for Channel A is the zooming factor for A axis. There are 9 options
available: Off, ×1, ×2, ×5, ×10, ×20, ×50, ×100, ×200.
When "Off" is selected, the full Display Range for Channel A is displayed over the
height of the View.
When "×1" is selected, initially the full range is displayed over the height of the view
with a vertical scroll bar on the left of the view. You can use the scroll bar to move
the data curve for Channel A up and down.
If you change the multiplier to "×N" which is greater than 1, then only 1/N of the full
range is displayed over the height of the view, with a vertical scrollbar on the left of
the view. You can use the scroll bar to scroll over the full Display Range.
This multiplier can also be adjusted via the magnifying glass which will be shown if
you put the mouse cursor on the left side of A axis.

3.2.1.5 Channel B Display Range
For single channel measurement, this control is disabled.
3.2.1.5.1 Absolute Display Mode
3.2.1.5.1.1 Linear Scale
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For linear scale such as Vrms, the available Display Range options are: Off, Auto,
1pV, 2pV, 5pV, 10pV, 20pV, 50pV, 100pV, 200pV, 500pV, 1nV, 2nV, 5nV, 10nV,
20nV, 50nV, 100nV, 200nV, 500nV, 1µV, 2µV, 5µV, 10µV, 20µV, 50µV, 100µV,
200µV, 500µV, 1mV, 2mV, 5mV, 10mV, 20mV, 50mV, 100mV, 200mV, 500mV,
1V, 2V, 5V, 10V, 20V, 50V, 100V, 200V, 500V, 1kV, 2kV, 5kV, 10kV, 20kV, 50kV,
100kV, 200kV, 500kV, 1MV, 2MV, 5MV, 10MV, 20MV, 50MV, 100MV, 200MV,
500MV, 1GV, 2GV, 5GV, 10GV, 20GV, 50GV, 100GV, 200GV, 500GV. Note that
the engineering unit of the above options is determined by the engineering unit of the
sensor for Channel B, which can be set via [Setting]>[Calibration]>"Sensor">"Unit".
For example, if the unit is "g" instead of "V", then the unit in all the above options
will be changed to "g".
When "Off" is selected, the data in Channel B will not be displayed. When "Auto" is
selected, the Display Range for Channel B will be set automatically by the software
based on the following formula:
Display Range = the nearest integer that is equal to or greater than the value of
[ADC Range] / [Sensor Sensitivity]
where the sensor sensitivity is set via [Setting]>[Calibration]>"Sensor">"Sensitivity".
3.2.1.5.1.2 Logarithmic Scale

www.virtins.com

189 Copyright © 2006-2022

Virtins Technology

VIRTINS Multi-Instrument 3.9 Manual

Virtins Technology

For logarithmic scale such as dBV, the available Display Range options are: 1dB, 2dB,
5dB, 10dB, 15dB, 20dB, 25dB, 30dB, 35dB, 40dB, 45dB, 50dB, 60dB, 70dB, 80dB,
90dB, 100dB, 120dB, 150dB, 200dB, 250dB, 300dB, 350dB, 400dB, 450dB, 500dB.
Note that the bracket “<>” means that the value represents only the span of the axis,
the upper limit of the axis is determined by the ADC Range as well as the Sensor
Sensitivity, and the lower limit is equal to [Upper Limit] - [Span]. A Display Range
value without the bracket “<>” represents a range from 0 and the Display Range value,
which is the case for dBFS.
When "Off" is selected, the data in Channel B will not be displayed.
3.2.1.5.2 Relative Display Mode
The vertical axis is scaled in relative values, in either linear or dBr (logarithmic) scale.
All data points are plotted based on their relative values with regard to the maximum
value (or the value at a specified frequency) in the current measurement.
3.2.1.5.2.1 Linear Scale

In this mode, the vertical axis ranges from 0 to 1 where 1 corresponds to the highest
absolute vertical value in the measurement.
When "Off" is selected, the data in Channel B will not be displayed.
3.2.1.5.2.2 Logarithmic Scale (dBr)
(1) 0dB reference Vr = Peak
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In this mode, the vertical axis ranges from 0 to the Display Range value selected,
where 0 dB corresponds to the highest absolute vertical value in the measurement.
(2) 0dB reference Vr at a specified frequency

In this mode, the vertical axis covers ± [Display Range value] selected, where 0 dB
corresponds to the measured value at the specified frequency.
When "Off" is selected, the data in Channel B will not be displayed.

3.2.1.6 Channel B Multiplier
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The Multiplier for Channel B is the zooming factor for B axis. There are 9 options
available: Off, ×1, ×2, ×5, ×10, ×20, ×50, ×100, ×200.
When "Off" is selected, the full Display Range for Channel B is displayed over the
height of the View.
When "×1" is selected, initially the full range is displayed over the height of the view
with a vertical scroll bar on the right of the view. You can use the scroll bar to move
the data curve for Channel B up and down.
If you change the multiplier to "×N" which is greater than 1, then only 1/N of the full
range is displayed over the height of the view, with a vertical scrollbar on the right of
the view. You can use the scroll bar to scroll over the full Display Range.
For single channel measurement, this control is disabled.
This multiplier can also be adjusted via the magnifying glass which will be shown if
you put the mouse cursor just on the right side of B axis.

3.2.1.7 FFT Size

This parameter is applicable to all types of views in the Spectrum Analyzer. 16
options are available: 128, 256, 512, 1024, 2048, 4096, 8192, 16384, 32768, 65536,
131072, 262144, 524288, 1048576, 2097152, 4194304.
The selected FFT size directly affects the resolution of the resulting spectrum. The
number of spectral points is always 1/2 of the selected FFT size plus one. Thus a
1024-point FFT produces 513 spectral points.
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The frequency resolution of each spectral point is equal to [Sampling
Frequency]/[FFT Size]. For instance, if the FFT size is 1024 and the Sampling
Frequency is 44100 Hz, the resolution of each spectral point would be:
44100 / 1024 = 43.07 Hz
A larger FFT size provides a finer spectral resolution but takes a longer time to
compute.
If the FFT size is greater than the number of data points per sweep (Record Length) in
the Oscilloscope, then zeros will be padded at the end of the actual measurement data
during FFT computation. It should however be noted that the real frequency
resolution is equal to [Sampling Frequency]/[Number of data points], although the
apparent FFT frequency resolution is determined by [Sampling Frequency]/[FFT
Size]. In other words, zero padding does not improve the real frequency resolution
although it does provide more spectral points via interpolation.
If the FFT size is less than the number of data points per sweep (record length) in the
Oscilloscope, then the measurement data will be split into different segments with the
size of each segment equal to the FFT size. The last segment of data will be dropped
if its size is not equal to the FFT size. The final result will be obtained by averaging
the FFT results from all segments. It should be noted that this approach is used for
Amplitude Spectrum, Auto Correlation Function, Cross Correlation Function,
Coherence Function, Transfer Function, and Impulse Response, except Phase
Spectrum where only the first segment of data is used. The average method here is
referred to as Intra-Frame Average in contrast to the Inter-Frame Average set through
[Setting]>[Spectrum Analyzer Processing]>[Inter-Frame Processing]. The following
table lists the average method used for each type of analysis:

IntraFrame
average
InterFrame
Average

Amplitude
Spectrum
Power
Average

Phase
Spectrum
No

Auto
Correlation
Power
Average

Cross
Correlation
Power
Average

Coherence
Function
Power
Average

Transfer
Function
Power
Average

Impulse
Response
Power
Average

Power
Average

Normal
Average

Normal
Average

Normal
Average

Normal
Average

Normal
Average

Normal
Average

Power Average: The averaging is performed in power spectrum, such as auto power spectrum or cross
power spectrum, during the computing process. For amplitude spectrum, it is often called “RMS
average”.
Normal Average: Arithmetic average.

You can adjust the number of data points per sweep (Record Length) before data
sampling such that it equals to an integer multiple of the FFT size, if necessary. When
both the Oscilloscope and Spectrum Analyzer are opened, the FFT Size and Record
Length are changed independently. However, when only the Spectrum Analyzer is
opened, changing the FFT size will change the Record Length and make it equal to
the FFT size.
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Both the number of FFT segments and the FFT frequency resolution are displayed at
the lower left corner of the Spectrum Analyzer view. If zero-padding is used, then the
real frequency resolution will also be displayed.
The following figure shows a 1-second white noise sampled at 48 kHz. Thus the
Record Length is 48000. The FFT size is 65536 and Rectangle window function (i.e.
No window function) is applied. The apparent FFT resolution is 48000/65536 =
0.732422 Hz and the real frequency resolution is 48000/48000 = 1 Hz. 6553648000=17536 zeros are padded at the end of the originally sampled data during FFT.
“Zero Padding, Resolution: 0.732422 Hz, 1Hz (real)” is thus displayed at the lower
left corner of the Spectrum Analyzer view to indicate the zero padding operation, and
the apparent and real frequency resolutions.

The following figure shows the amplitude spectrum of the same data as above. The
only difference is that the FFT size is changed from 65536 to 128. Thus the apparent
and real FFT resolutions are both 48000 Hz / 128 = 375 Hz. The number of FFT
segments is 48000 samples / 128 samples = 375 (segments). “FFT Segments: 375
Resolution: 375 Hz” is thus displayed at the lower left corner of the Spectrum
Analyzer view to indicate the intra-frame average over 375 FFT segments, and the
FFT frequency resolution. The average method here is power average. Due to this
averaging process and the coarser frequency resolution, the amplitude spectrum in the
figure below is much smoother than that in the figure above.
A white noise has a flat amplitude spectrum. Its power distributes uniformly across all
FFT bins. The amplitude level is around -26 dBFS in the figure below, which is about
27 dB higher than that in the figure above. The width of a FFT bin in the figure below
is 375 Hz while that in the figure above is 0.732422 Hz. Therefore each FFT bin in
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the figure below contains 10×lg(375/0.732422) = 27 dB ’s power more if the power is
distributed uniformly.

To know more about the basics of FFT, please refer to: FFT Basics and Case Study
using Multi-Instrument.
Download link:
http://www.virtins.com/doc/D1002/FFT_Basics_and_Case_Study_using_MultiInstrument_D1002.pdf
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3.2.1.8 Window Function

A window function can be used to suppress spectral leakage caused by a non-infinite
length of data in time domain. 69 window functions are supported: Rectangle,
Triangle (or Fejer), Hann, Hamming, Blackman 4, Exact Blackman, Blackman Harris
4, Blackman Nuttall, Flat Top, Exponential (Exponential 0.1), Gaussian (Gaussian 2.5,
Gaussian 3.0, Gaussian 3.5), Welch (or Riesz), Cosine (Cosine 1.0, Cosine 3.0,
Cosine 4.0, Cosine 5.0), Riemann (or Lanczos), Parzen, Tukey (Tukey 0.25, Tukey
0.50, Tukey 0.75), Bohman, Poisson (Poisson 2.0, Poisson 3.0, Poisson 4.0), HannPoisson (Hann-Poisson 0.5, Hann-Poisson 1.0, Hann-Poisson 2.0), Cauchy (Cauchy
3.0, Cauchy 4.0, Cauchy 5.0), Bartlett-Hann, Kaiser (Kaiser 0.5, Kaiser 1, Kaiser 2,
Kaiser 3, Kaiser 4, Kaiser 5, Kaiser 6, Kaiser 7, Kaiser 8, Kaiser 9, Kaiser 10, Kaiser
11, Kaiser 12, Kaiser 13, Kaiser 14, Kaiser 15, Kaiser 16, Kaiser 17, Kaiser 18,
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Kaiser 19, Kaiser 20, Blackman Harris 7, CosineSum 220, CosineSum 233,
CosineSum 246, CosineSum 261, Tukey 0.10, Tukey 0.05, Tukey 0.02, Tukey 0.01,
Dolph-Chebyshev 80, Dolph-Chebyshev 100, Dolph-Chebyshev 150, DolphChebyshev 200, Dolph-Chebyshev 250). The value behind the window name is the
parameter value of that window. Please refer to relevant reference books for the
definitions of these window functions.
Hann window is used by default. It should be noted that except Rectangle window,
the rest of window functions are not applicable to Auto Correlation Function and
Cross Correlation Function and thus are disabled accordingly under these two modes.
A 1024-point 24-bit WAV file is provided for each window function in the
WAV\window directory of the software. They can be used to evaluate the behavior
of these window functions in frequency domain. For this purpose, the following
changes to the system default settings for the Spectrum Analyzer are required after
loading a WAV file:




[Window]: Rectangle;
[FFT size]: >1024;
[Setting]>[Spectrum Analyzer Processing]>“Intra-Frame Processing”>
“Remove DC”: Unchecked;

The following changes to the system default settings for the Spectrum Analyzer are
recommended:



[Setting]>[Spectrum Analyzer Y Scale]: dBr
[Horizontal Axis Multiplier]:  20

The following figure shows the spectrum of a Rectangle window.
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The following figure shows the spectrum of a Hann window.
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The following figure shows the spectrum of a Hamming window.

The following figure shows the spectrum of a Blackman window.
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The following figure shows the spectrum of a Blackman-Harris (4 terms) window.

The following figure shows the spectrum of a Kaiser5 window.

www.virtins.com

200 Copyright © 2006-2022

Virtins Technology

VIRTINS Multi-Instrument 3.9 Manual

Virtins Technology

From the above six figures, some important characteristics of the six windows can be
readily obtained.
Window
Function

Rectangle
Hann
Hamming
Blackman
BlackmanHarris
(4 terms)
Kaiser5

Highest
Side
Lobe
Level
(dB)
-13
-32
-43
-58
-92

Side Lobe
Fall Off
Rate
(dB/Octave)

-6dB
Main
Lobe
Width
(bins)
1.21
2.00
1.81
2.29
2.66

Scallop
Loss
(dB)

Coherent
Gain

Equivalent
Noise
Bandwidth
(bins)

-6
-18
-6
-18
-6

-3dB
Main
Lobe
Width
(bins)
0.88
1.44
1.30
1.64
1.90

3.92
1.42
1.75
1.10
0.83

1
0.5
0.54
0.42
0.36

1
1.50
1.36
1.73
2.00

-120

-6

2.16

3.03

0.64

0.31

2.28

The following figure summarizes the behavior of the above six windows in both time
domain and frequency domain. The figure is obtained via the following steps:
Use “File Open” to open the WAV file of Rectangle window.
Use “File Combine” to open the WAV file of another window.
Set the settings for the Spectrum Analyzer properly as mentioned before
Copy both curves in the Oscilloscope and Spectrum Analyzer As Reference
Curves
5. Use “File Combine” to import another two WAV files
6. Copy both curves in the Oscilloscope and Spectrum Analyzer As Reference
Curves
7. Repeat 5~7.
1.
2.
3.
4.
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Spectral leakage is the result of the assumption in the FFT algorithm that the time
record in a FFT segment is exactly repeated throughout all time and that signals
contained in a FFT segment are thus periodic at intervals that correspond to the length
of the FFT segment. If the time record in a FFT segment has a non-integer number of
cycles, this assumption is violated and spectral leakage occurs. Spectral leakage
distorts the measurement in such a way that energy from a given frequency
component spreads to adjacent frequency lines or bins. In most cases, you cannot
guarantee that you are sampling an integer number of cycles in a FFT segment.
Choosing a window function correctly to suppress the spectral leakage for a certain
measurement is thus critical. To choose a window function, you must estimate the
signal frequency content first. If the signal contains strong interfering frequency
components distant from the frequency of interest, choose a window with a high side
lobe roll-off rate. If there are strong interfering signal near the frequency of interest,
choose a window with a low highest side lobe level. If the frequency of interest
contains two or more signals very near to each other, then frequency resolution is very
important. It is best to choose a window with a very narrow main lobe. If the
amplitude accuracy of a single frequency component is more important than the exact
location of the component in a given frequency bin, choose a window with a wide
main lobe. If the signal spectrum is rather flat or broadband in frequency content, use
the Rectangle window. In general, the Hann window has a good frequency resolution
and reduces spectral leakage. It is satisfactory in 95% of the cases.
To know the characteristics of more window functions, please refer to: Evaluation of
Various Window Functions using Multi-Instrument.
Download link:
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http://www.virtins.com/doc/D1003/Evaluation_of_Various_Window_Functions_using_MultiInstrument_D1003.pdf

3.2.1.9 Window Overlap Percentage

The window function suppresses greatly the data at the edges of the window. As a
result, these data contribute much less to the analysis result than the data at the center
of the window. To make full use of the acquired data, FFT segments can be
overlapped. The overlap ratio can be set via the Window Overlap Percentage combo
box, from 0% to 99.9%. This combo box is enabled only when the number of data
points per sweep (record length) is greater than the FFT size.
3.2.1.10 Impedance Measurement Mode
Amplitude Spectrum mode can be used to measure impedance variation with
frequency using the single-channel method described below. It is possible to use two
input channels of the measuring device to measure two impedances simultaneously.
Two connection methods are supported in the software (see figure below).
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where Zx is the impedance to be measured, Rr the reference resistor, Vo the output
voltage from the signal generator and Vi the input voltage fed by the voltage divider
formed by Zx and Rr. Both Vo and Vi are ground referenced, so measuring devices
with either ground referenced inputs or differential inputs can be used. The input
impedance of the measuring device must be much higher than Zx and Rr so that its
effect on the measurement accuracy can be ignored. The output impedance and
overall frequency response of the measuring device do not affect the measurement
accuracy directly, as the same input channel is used to measure Vo and Vi, but it is
still recommended for the measuring device to have a low output impedance and a flat
overall frequency response.
Rr is an external reference resistor. You need to find the resistor and make the
connection by yourself. It is recommended to have Rr’s value comparable to that of
Zx. The actual value of Rr should be entered into the Rr(Ω) edit box in [Spectrum
Analyzer Y Scale] dialog box. The actual connection used also needs to be selected
there. In Connection 1, Zx = Rr × (Vo-Vi) / Vi while in Connection 2, Zx = Rr × Vi /
(Vo-Vi). To achieve a good measurement accuracy, significant stimulus energy must
be present in the frequency range of interest. Commonly used signals are chirp signal
(frequency linearly or logarithmically swept sine) and multitones capable of
simultaneously stimulating all FFT/octave frequency bands in the frequency range of
interest. Unlike white and pink noises, they have a repeatable waveform. This is
important when Vo and Vi are measured in two separate steps. Various averaging
methods can be used to smoothen the result except the inter-frame peak-hold, linear
average with the “forever” option and exponential average.
Two steps are required:
(1) Step 1
Vo is measured and the Spectrum Analyzer Y scale MUST be set to Vrms. After
Vo’s amplitude spectrum (in Vrms) is obtained, right click anywhere within the
Spectrum Analyzer window and select “Spectrum Analyzer Export” to export it as
a TXT file. Then right click anywhere within the Spectrum Analyzer window
again and select “Spectrum Analyzer Y Scale”. Tick “Convert to Impedance”
checkbox and load the TXT file saved previously as the Reference Vo file (see
figure below).
(2) Step 2
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Vi is measured with exactly the same sampling, processing and analysis settings
as Step 1, except that the voltage measurement range can be changed if the
measuring device is voltage calibrated. In case the settings in Step 2 is different
from those in Step 1, the reference Vo file will be invalid and the “Convert to
Impedance” checkbox will be unticked automatically.

It should be noted that in most of the cases, Step 1 needs only to be conducted once as
long as the signal generator has a sufficiently low output impedance so that its output
voltage Vo does not virtually vary with Zx + Rr. For example, many audio power
amplifiers have an output impedance approaching 0 Ω, therefore they are very
suitable for this kind of tests. It is also possible to use the signal generator’s internal
resistance as the reference resistor Rr so as to simplify the connection. For example,
the signal generator of VT DSO-2810E, 2820E, 2A10E and 2A20E have an output
impedance (resistance) of 50Ω, thus they can be readily used to measure the
impedance of a Device Under Test such as a speaker. In this case, the reference Vo
can be measured through measuring Vi without the connection of Zx (refer to the
above Connection 2) given that the input impedance of the measuring device is high
enough. In other words, Step 1 is to measure Vi without the connection of Zx and
Step 2 is to measure Vi with the connection of Zx. This method is applicable to
Connection 2 only. The following figure shows the connection of this method.
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Under the impedance measurement mode, Channel A Display Range and Channel B
Display Range will be updated to display impedance in Ω. The display range of the
“Auto” option is about 5×Rr. The following DDPs are generated by this mode:
(1) f1Freq_A(Hz): Frequency at the peak impedance in Ch. A
(2) f1RMS_A(EU): Peak impedance in Ch. A
(3) InBandMinF_A(Hz): Frequency at which the minimum impedance is located in
the specified frequency band in Ch. A
(4) InBandMinRMS_A(EU): The minimum impedance in the specified frequency
band in Ch. A
(5) InBandMaxF_A(Hz): Frequency at which the maximum impedance is located in
the specified frequency band in Ch. A
(6) InBandMaxRMS_A(EU): The maximum impedance in the specified frequency
band in Ch. A
(7) oBandRMS_A(EU)_Array[?]: Impedance value in a particular octave band in
Channel A. “?” should be replaced by the actual band number starting from 0.
A similar set of DDPs are also generated for Channel B: f1Freq_B(Hz),
f1RMS_B(EU), InBandMinF_B(Hz), InBandMinRMS_B(EU), InBandMaxF_B(Hz),
InBandMaxRMS_B(EU), oBandRMS_B(EU)_Array[?].
The following examples use different stimuli and configurations to measure a 2.5” 8Ω
speaker’s impedance. The first three examples use VT DSO-2A20E as the ADC
device and a sound card as the DAC device, with an external 25Ω reference resistor
Rr using Connection 1. The latter three examples use VT DSO-2A20E as both the
ADC and DAC device, and its 50Ω output impedance (resistance) as the reference
resistor Rr, based on Connection 2. To avoid the interference from the automatically
generated oscilloscope probe calibration signal, switch it off via [Setting]>[DAC
Device]> “Probe CAL” before tests.
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(1) Multitone stimulus aligned to FFT bands (Periodic white Noise)
Oscilloscope:
ADC Device: VT DSO-2A20E,
Sampling Frequency: 50 kHz,
Trigger Mode: Normal,

Bit Resolution: 16
Record Length: 400 ms (20000 samples)
Trigger Level: 0%

Spectrum Analyzer:
FFT size: 32768,
Window Function: Rectangle
Intra-Frame Processing: Smooth via Moving Average: 10 points
Inter-Frame Processing: 200-frame Linear Average
X Scale: Log,
Y Scale: Vrms,
Max. and Min. Impedance Searching Range: 20 Hz ~ 5 kHz
Frequency Range of Interest: 20 Hz ~ 20 kHz
Signal Generator:
DAC Device: Sound Card Headphone Output,
Duration: Loop
Waveform: Multitones aligned to FFT,
Frequency Range: 10 Hz ~ 21 kHz
Sampling Frequency: 48 kHz
Step 1:

The above figure actually shows the overall frequency response of the setup. It mainly
reflects the fact that VT DSO-2A20E’s anti-aliasing filter has a cutoff frequency at
0.443 × [Sampling Frequency] = 0.443 × 50 kHz = 22.15 kHz under its 16-bit mode.
Note that there is no need to compensate the frequency response in this test.
Step 2:
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The measured resonant frequency is 397 Hz at the impedance peak 10.5 Ω. The
lowest impedance is 6.6 Ω at the lower frequency end.

(2) Multitone stimulus aligned to 1/24 Octave bands
Oscilloscope:
ADC Device: VT DSO-2A20E,
Sampling Frequency: 50 kHz,
Trigger Mode: Normal,

Bit Resolution: 16
Record Length: 400 ms (20000 samples)
Trigger Level: 0%

Spectrum Analyzer:
FFT size: 262144,
Window Function: Rectangle
Intra-Frame Processing: Smooth via Moving Average: 10 points
Inter-Frame Processing: 200-frame Linear Average
X Scale: 1/24 octave,
Y Scale: Vrms,
Max. and Min. Impedance Searching Range: 20 Hz ~ 5 kHz
Frequency Range of Interest: 20 Hz ~ 20 kHz
Signal Generator:
DAC Device: Sound Card Headphone Output,
Waveform: Multitones aligned to 1/24 octave,
Sampling Frequency: 48 kHz

Duration: Loop
Frequency Range: 10 Hz ~ 24 kHz

Step 1:
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The above figure actually shows the overall frequency response of the setup. It mainly
reflects the fact that VT DSO-2A20E’s anti-aliasing filter has a cutoff frequency at
0.443 × [Sampling Frequency] = 0.443 × 50 kHz = 22.15 kHz under its 16-bit mode.
The small undulation at the lower frequency end is due to the fact that octave bands
have a much higher resolution at lower frequencies. This calls for a longer record
length in the oscilloscope. Note that there is no need to compensate the frequency
response in this test.
Step 2:

The measured resonant frequency is 397 Hz at the impedance peak 10.7 Ω. The
lowest impedance is 6.5 Ω at the lower frequency end.

(3) Frequency logarithmically swept sine wave
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Oscilloscope:
ADC Device: VT DSO-2A20E,
Bit Resolution: 16
Sampling Frequency: 50 kHz,
Record Length: 400 ms (20000 samples)
Trigger Mode: Single,
Trigger Level: 1%
Spectrum Analyzer:
FFT size: 262144,
Window Function: Rectangle
Intra-Frame Processing: Smooth via Moving Average: 10 points
Inter-Frame Processing: None
X Scale: 1/96 octave,
Y Scale: Vrms,
Max. and Min. Impedance Searching Range: 20 Hz ~ 5 kHz
Frequency Range of Interest: 20 Hz ~ 20 kHz
Signal Generator:
DAC Device: Sound Card Headphone Output,
Duration: 400 ms
Waveform: Frequency logarithmically swept sine wave from 10 Hz to 21 kHz
Sampling Frequency: 48 kHz
Step 1:

The above figure actually shows the overall frequency response of the setup. It mainly
reflects the fact that VT DSO-2A20E’s anti-aliasing filter has a cutoff frequency at
0.443 × [Sampling Frequency] = 0.443 × 50 kHz = 22.15 kHz under its 16-bit mode.
The small undulation at the lower frequency end is due to the fact that octave bands
have a much higher resolution at lower frequencies. This calls for a longer record
length in the oscilloscope. Note that there is no need to compensate the frequency
response in this test.
Step 2:
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The measured resonant frequency is 386 Hz at the impedance peak 10.7 Ω. The
lowest impedance is 6.7 Ω at the lower frequency end.

(4) Multitone stimulus aligned to FFT bands (Periodic White Noise)
Oscilloscope:
ADC Device: VT DSO-2A20E,
Sampling Frequency: 50 kHz,
Trigger Mode: Normal,

Bit Resolution: 16
Record Length: 400 ms (20000 samples)
Trigger Level: 0%

Spectrum Analyzer:
FFT size: 32768,
Window Function: Rectangle
Intra-Frame Processing: Smooth via Moving Average: 10 points
Inter-Frame Processing: 200-frame Linear Average
X Scale: Log,
Y Scale: Vrms,
Max. and Min. Impedance Searching Range: 20 Hz ~ 5 kHz
Frequency Range of Interest: 20 Hz ~ 20 kHz
Signal Generator:
DAC Device: VT DSO-2A20E streaming mode,
Probe CAL: Disabled
Waveform: Multitones aligned to FFT,
Frequency Range: 10 Hz ~ 21 kHz
Sampling Frequency: 200 kHz,
Duration: Loop
Step 1:
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The above figure actually shows the overall frequency response of the setup. It mainly
reflects the fact that VT DSO-2A20E’s anti-aliasing filter has a cutoff frequency at
0.443 × [Sampling Frequency] = 0.443 × 50 kHz = 22.15 kHz under its 16-bit mode.
Note that there is no need to compensate the frequency response in this test.
Step 2:

The measured resonant frequency is 394 Hz at the impedance peak 10.6 Ω. The
lowest impedance is 6.8 Ω at the lower frequency end.

(5) Multitone stimulus aligned to 1/24 Octave bands
Oscilloscope:
ADC Device: VT DSO-2A20E,
Sampling Frequency: 50 kHz,

www.virtins.com

Bit Resolution: 16
Record Length: 400 ms (20000 samples)

212 Copyright © 2006-2022

Virtins Technology

VIRTINS Multi-Instrument 3.9 Manual

Trigger Mode: Normal,

Virtins Technology

Trigger Level: 0%

Spectrum Analyzer:
FFT size: 262144,
Window Function: Rectangle
Intra-Frame Processing: Smooth via Moving Average: 10 points
Inter-Frame Processing: 200-frame Linear Average
X Scale: 1/24 octave,
Y Scale: Vrms,
Max. and Min. Impedance Searching Range: 20 Hz ~ 5 kHz
Frequency Range of Interest: 20 Hz ~ 20 kHz
Signal Generator:
DAC Device: VT DSO-2A20E streaming mode,
Probe CAL: Disabled
Waveform: Multitones aligned to 1/24 octave,
Frequency Range: 10 Hz ~ 24 kHz
Sampling Frequency: 200 kHz,
Duration: Loop
Step 1:

The above figure actually shows the overall frequency response of the setup. It mainly
reflects the fact that VT DSO-2A20E’s anti-aliasing filter has a cutoff frequency at
0.443 × [Sampling Frequency] = 0.443 × 50 kHz = 22.15 kHz under its 16-bit mode.
The small undulation at the lower frequency end is due to the fact that octave bands
have a much higher resolution at lower frequencies. This calls for a longer record
length in the oscilloscope. Note that there is no need to compensate the frequency
response in this test.
Step 2:
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The measured resonant frequency is 397 Hz at the impedance peak 10.5 Ω. The
lowest impedance is 6.6 Ω at the lower frequency end.
(6) Frequency logarithmically swept sine wave
Oscilloscope:
ADC Device: VT DSO-2A20E,
Bit Resolution: 16
Sampling Frequency: 50 kHz,
Record Length: 400 ms (20000 samples)
Trigger Mode: Single,
Trigger Level: 1%
Spectrum Analyzer:
FFT size: 262144,
Window Function: Rectangle
Intra-Frame Processing: Smooth via Moving Average: 10 points
Inter-Frame Processing: None
X Scale: 1/96 octave,
Y Scale: Vrms,
Max. and Min. Impedance Searching Range: 20 Hz ~ 5 kHz
Frequency Range of Interest: 20 Hz ~ 20 kHz
Signal Generator:
DAC Device: VT DSO-2A20E streaming mode,
Probe CAL: Disabled
Waveform: Frequency logarithmically swept sine wave from 10 Hz to 21 kHz
Sampling Frequency: 200 kHz,
Duration: 400 ms
Step 1:
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The above figure actually shows the overall frequency response of the setup. It mainly
reflects the fact that VT DSO-2A20E’s anti-aliasing filter has a cutoff frequency at
0.443 × [Sampling Frequency] = 0.443 × 50 kHz = 22.15 kHz under its 16-bit mode.
The small undulation at the lower frequency end is due to the fact that octave bands
have a much higher resolution at lower frequencies. This calls for a longer record
length in the oscilloscope. Note that there is no need to compensate the frequency
response in this test.
Step 2:

The measured resonant frequency is 386 Hz at the impedance peak 10.3 Ω. The
lowest impedance is 6.8 Ω at the lower frequency end.
All the above tests obtain similar results. Among them, the frequency logarithmically
swept sine wave is the fastest method. Multitone stimuli should have converged
faster if a record length of 1 or multiple seconds had been chosen.
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The Panel Setting Files for Step 2 of the above Examples (4), (5) and (6) can be found
in the software’s installation directory:
psf\VTDSO\Impedance_MultiTones_FFT32768_2810E.psf,
psf\VTDSO\Impedance_MultiTones_Octave24_2810E.psf,
psf\VTDSO\Impedance_LogSweptSine_Octave96_2810E.psf , respectively.
They can be used directly to measure an impedance in the order of 50Ω using VT
DSO-2810E, 2820E, 2A10E, or 2A20E. General reference Vo files have already been
provided for these settings and thus Step 1 can be omitted. However, it is
recommended to perform Step 1 to re-calibrate the Reference Vo file for higher
accuracy. If the reference Rr in [Spectrum Analyzer Y Scale] is changed to 600Ω
instead, then the modified settings can be used to measure an impedance in the order
of 600Ω using VT DSO-2810, 2820, 2A10, or 2A20. The Signal Generators of these
DSOs have an output impedance of about 600Ω.
If a sound card is used as both the ADC and DAC devices for impedance
measurement, the following Panel Setting Files corresponding to Step 1 of the above
Examples (1), (2) and (3) can be used:
psf\Pro\Impedance_MultiTones_FFT65536_SoundCard.psf,
psf\Pro\Impedance_MultiTones_Octave24_SoundCard.psf,
psf\Pro\Impedance_LogSweptSine_Octave96_SoundCard.psf, respectively.
3.2.2 View Parameters for Phase Spectrum Display

Selecting Phase Spectrum in the above View Type selection box switches the
Spectrum Analyzer to phase spectrum display mode which shows the phase vs
frequency graph of the measured signal. Phase spectrum is normally used to compare
or read out the phase difference between the two channels rather than read out the
absolute phase information of each channel.
The following figure illustrates the phase spectrum of two 1 kHz sine waves with a
phase difference of 90 degrees. The cursor reader in the phase spectrum indicates a
90-degreee difference around 1 kHz.
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3.2.2.1 Frequency Range (F)
Same as Amplitude Spectrum.
3.2.2.2 Frequency Multiplier
Same as Amplitude Spectrum.
3.2.2.3 Channel A Display Range

Five options available: Off, ± 180D (i.e. ± 180 degree), 135D, 90D, 45D.
When "Off" is selected, the data in Channel A will not be displayed.
3.2.2.4 Channel A Multiplier
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Same as Amplitude Spectrum.
3.2.2.5 Channel B Display Range

Five options available: Off, ± 180D (i.e. ± 180 degree), 135D, 90D, 45D.
When "Off" is selected, the data in Channel B will not be displayed.
3.2.2.6 Channel B Multiplier
Same as Amplitude Spectrum.
3.2.2.7 FFT Size
Same as Amplitude Spectrum.
3.2.2.8 Window Function
Same as Amplitude Spectrum.
3.2.2.9 Window Overlap Percentage
Same as Amplitude Spectrum.
3.2.3 View Parameters for Auto Correlation Function Display

Selecting Auto Correlation in the above View Type selection box switches the
Spectrum Analyzer to auto correlation display mode which shows the auto correlation
coefficient (i.e. normalized auto correlation function) vs time delay graph of the
measured signal. The auto correlation function here is acyclic or linear by default. It
is symmetric and always has the highest auto correlation coefficient (=1) at [Time
Delay] =0. Therefore, there is no point for the software to display textual information
about this peak. The time delay and auto correlation coefficient of the second highest
peak are shown instead. They can also be accessed through these Derived Data Points
(DDPs): SecondPeakACFTimeDelay_A(s) and SecondPeakACFCoef_A for Channel
A, and SecondPeakACFTimeDelay_B(s) and SecondPeakACFCoef_B for Channel B.
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The highest auto correlation peak may be surrounded by a few sub-peaks. A
deadband (in milliseconds) is used to avoid detecting one of these surrounding subpeaks, within the deadband of the highest peak, as the second highest peak. The
deadband can be adjusted via [Spectrum Analyzer Processing]> “Parameter
Measurement” > “Deadband”. Its default value is 0.25 ms.
The following figure illustrates the linear auto correlation function of a 1 kHz sine
wave with [Sampling Frequency]=48kHz, Record Length=48000, FFT Size=1024. It
shows that the time interval between correlation function peaks is 1 ms, which is
equal to the period of the signal. The second highest peak is located at [Time
Delay]=1 ms with a coefficient of about 0.9.

The auto correlation function here is computed indirectly using FFT in order to save
time. The time delay range evaluated varies with the FFT size. To do a full-range
evaluation, select a FFT size equal to or greater than twice of the Record Length in
the Oscilloscope. This will yield 2×[Record Length]-1 auto correlation points
centered at [Time delay]=0. The following figure has the same parameters as the
above one except that the FFT size is changed to 131072 to evaluate the full-range of
the linear auto correlation of the 48000-point data.
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Linear auto correlation coefficient always decreases from 1 at [Time Delay]=0 to zero
at the maximum time delays (i.e. ± time length of the data). Its tendency to dwindle
with the time delay is due to the fact that linear correlation assumes that the data
outside the time length are all zeros. Multi-Instrument supports circular auto
correlation as well. It can be set via [Spectrum Analyzer Processing]>[Intra-Frame
Processing]>“Circular Correlation”. Unlike linear correlation, circular correlation
assumes that the data outside the time length are just circular replicas of the data
inside it. Therefore the circular auto correlation coefficient at the maximum time
delays may not be zeros, as illustrated in the following figure. It shows the circular
auto correlation function of a 1 kHz sine wave with [Sampling Frequency]=48kHz,
[Record Length]=48000, [FFT Size]=1024.
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In the above example, if the 1kHz signal frequency is changed to a “No Spectral
Leakage” frequency (this concept will be introduced later) such as 984.375 Hz, then
the circular auto correlation function becomes periodic with the same period as the
original one (see figure below). It should be noted, however, if the FFT size is greater
than the Record Length, then the software will pad [FFT Size]-[Record Length] zeros
at the end of the Record Length, reducing the effect of the circular arrangement.
When the FFT size is equal to or greater than twice of the Record Length, the circular
correlation will become the same as the linear correlation.
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The auto correlation function of a periodic signal has correlation peaks recurring at
the same interval as the signal period. Non-periodic signals, such as noises, songs and
music, usually only have one dominant auto correlation peak at zero time delay and
very small values elsewhere (zeros for the case of a white-noise like signal). This
feature has many applications. For example, auto correlation function can be used to
measure the echo delay time embedded in a non-periodic signal. The following figure
shows the linear auto correlation function of a 100-second song with an echo delay
time of 1.3s. The deadband is set to be 50ms. It can be seen that the echo delay time
is correctly detected at the second highest peak of the auto correlation function.
Similarly, this method can be used to check whether the same sounds from two
speakers arrive at a listening position at the same time.
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3.2.3.1 Time Delay Range (dT)
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This parameter is applicable to Auto or Cross Correlation Function Display. 49
options are available: Auto, ±1ns, ±2ns, ±4ns, ±5ns, ±10ns, ±20ns, ±40ns, ±50ns,
±100ns, ±200ns, ±400ns, ±500ns, ±1µs, ±2µs, ±4µs, ±5µs, ±10µs, ±20µs, ±40µs,
±50µs, ±100µs, ±200µs, ±400µs, ±500µs, ±1ms, ±2ms, ±4ms, ±5ms, ±10ms, ±20ms,
±40ms, ±50ms, ±100ms, ±200ms, ±400ms, ±500ms, ±1s, ±2s, ±4s, ±5s, ±10s, ±20s,
±40s, ±50s, ±100s, ±200s, ±400s, ±500s.
When “Auto” is selected, the Time Delay Range will be set by the software
automatically based on the following formula:
Time Delay Range = the nearest integer that is equal to or greater than the value of
0.5 × [FFT Size] / [Sampling Frequency]
Auto correlation and cross correlation functions are calculated using FFT in order to
achieve a faster speed. The computable range of the Time Delay for a frame of data is
thus ± 0.5 × [FFT size]/[Sampling Frequency].

3.2.3.2 Time Delay Multiplier
Same as Amplitude Spectrum display.

3.2.3.3 Channel A Display Range

Only two options available: Off, ± 1.
When "Off" is selected, the data in Channel A will not be displayed.
3.2.3.4 Channel A Multiplier
Same as Amplitude Spectrum display.
3.2.3.5 Channel B Display Range

Only two options available: Off, ± 1.
When "Off" is selected, the data in Channel B will not be displayed.
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3.2.3.6 Channel B Multiplier
Same as Amplitude Spectrum display.
3.2.3.7 FFT Size
Same as Amplitude Spectrum display.
3.2.3.8 Window Function
Disabled.
3.2.3.9 Window Overlap Percentage
Same as Amplitude Spectrum display.

3.2.4 View Parameters for Cross Correlation Function Display

Selecting Cross Correlation in the above View Type selection box switches the
Spectrum Analyzer to cross correlation display mode which shows the cross
correlation coefficient (i.e. normalized cross correlation function) between Channels
A and B vs time delay graph. The cross correlation function here is acyclic or linear
by default. The time delay and cross correlation coefficient of the peak are also
displayed as text above the graph. They can be accessed through these Derived Data
Points (DDPs): PeakCCFTimeDelay_AB(s) and PeakCCFCoef_AB.
The following figure illustrates the linear cross correlation function of two 1 kHz sine
wave signals, with the one in Channel A being 90º in phase ahead of the one in
Channel B. It shows that the cross correlation peak is at -250 µs, which means that the
signal in Channel A is 250 µs (i.e. 1/4 period) ahead of the signal in Channel B.
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Similar to the case of auto correlation function, the cross correlation function here is
also computed indirectly using FFT. The time delay range evaluated varies with the
FFT size. To do a full-range evaluation, select a FFT size equal to or greater than
twice of the Record Length in the Oscilloscope. This will yield 2×[Record Length]-1
cross correlation points centered at [Time delay]=0. Multi-Instrument supports
circular cross correlation as well.
It can be set via [Spectrum Analyzer
Processing]>[Intra-Frame Processing]>”Circular Correlation”. Again, it should be
noted that, if the FFT size is greater than the Record Length, then the software will
pad [FFT Size]-[Record Length] zeros at the end of the Record Length, reducing the
effect of the circular arrangement. When the FFT size is equal to or greater than
twice of the Record Length, the circular correlation will become the same as the linear
correlation.
Cross correlation can be used to measure signal transmission delay as introduced
previously in Section “Time Delay Removal” of Chapter “Oscilloscope”. It can also
be used to measure the impulse response of a LTI system using the same method (see
figure below). To do that, the stimulus fed into the DUT must satisfy one requirement:
its auto correlation function must be zero everywhere except at zero time delay. The
stimuli that meet this requirement are white noise, MLS and unit impulse, etc. Given
a white-noise-like stimulus, circular cross correlation between the output and the input
yields the impulse response of the DUT. In Multi-Instrument, Channel B must be fed
with the same stimulus sent to the DUT and Channel A must be fed with the response
from the DUT. Note that the signal path from the output to the input Ch. B can be
either a physically wired path or purely a software path (i.e. “iB=oA” loopback mode
of the Signal Generator that will be introduced later). The former is a two-channel
method while the latter is usually referred to as a single–channel method (it still
requires two channel operations in the software). More generally, both signal paths,
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from the single output channel to the two input channels, can be purely software paths
(i.e. “iA=oA, iB=oA” loopback mode of the Signal Generator that will be introduced
later). This is referred to as a simulation mode. It can be used to measure the impulse
response of, for example, a software digital filter, if the filter is applied to Channel A
only.

The following figure shows the impulse response of a 5513 Hz second order
Butterworth low pass filter, measured using circular cross correlation with a 65535point MLS stimulus.

The impulse response (or circular cross correlation) data in the above figure can be
exported to a TXT file by right clicking anywhere within the Spectrum Analyzer and
select [Spectrum Analyzer Export]. It can then be imported via [File]>[Import] into
the Oscilloscope in order to show its magnitude frequency response in the Spectrum
Analyzer (see figure below). It can be seen from the figure that the -3dB cutoff
frequency of the low pass filter is correctly measured to be 5513Hz.
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Impulse response contains phase response information as well. However, it is noted
that the impulse response loaded in the Oscilloscope does not start from time=0. As a
result, its phase response graph will usually look messy due to phase wrapping (i.e. all
phase values are constrained to the range -180º~180º). This issue can be resolved by
manually removing the time delay in the impulse response. The data from the start of
the impulse response to its end can be extracted and saved to a separate WAV file via
[File]>[Extract]. Then load that WAV file via [File]>[Open] and switch the Spectrum
Analyzer to phase spectrum display to show the phase response (see figure below). It
can be seen from the figure that the phase at the cutoff frequency 5513Hz is correctly
measured to be about 90º.
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Impulse response can also be used to derive other information such as reverberation
time and speech transmission index. This has been introduced previously. Some
sample panel setting files for impulse response measurements using cross correlation
are provide in the PSF subdirectory of the software.

www.virtins.com

229 Copyright © 2006-2022

Virtins Technology

VIRTINS Multi-Instrument 3.9 Manual

Virtins Technology

When cross correlation is used to measure signal transmission delay, the signal needs
to be “white” enough to ensure a single prominent correlation peak right at the time
delay. This condition may not be satisfied if the signal is not generated intentionally
by the testing equipment or when there are strong background noise and reverberation.
The above figure shows a music signal (from the same sound source) captured by two
microphones. Cross correlation is used to find the Time Difference of Arrival (TDOA)
between them. It can be seen that the “true” cross correlation peak is surrounded by
many interfering sub-peaks. These sub-peaks are caused by the periodic components
of the music signal. They may outweigh the “true” correlation peak under some
conditions and lead to a wrong TDOA measurement. Generalized Cross Correlation
(GCC) can be used to improve the signal-to-noise ratio in this type of measurements.
The most commonly used GCC technique is called GCC Phase Transform (GCCPHAT). It whitens the cross power spectrum in the frequency domain before the
conversion back to the time domain to get the cross correlation. In Multi-Instrument,
the GCC flag can be set via [Spectrum Analyzer Processing]>[Intra-Frame
Processing]>“Generalized Cross Correlation”. The following figure shows the
generalized cross correlation of the signal in the above example. A significant
improvement on the measurement SNR can be observed. This method is often used
with a microphone array to locate a sound source.

3.2.4.1 Time Delay Range (dT)
Same as Auto Correlation Function.
3.2.4.2 Time Delay Multiplier
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Same as Auto Correlation Function.
3.2.4.3 Channel A&B Display Range
Same as Channel A Display Range in Auto Correlation Function.
3.2.4.4 Channel A&B Multiplier
Same as Channel A Multiplier in Amplitude Spectrum.
3.2.4.5 Channel B Display Range
Not applicable and disabled.
3.2.4.6 Channel B Multiplier
Not applicable and disabled.
3.2.4.7 FFT Size
Same as Amplitude Spectrum.
3.2.4.8 Window Function
Disabled.
3.2.4.9 Window Overlap Percentage
Same as Amplitude Spectrum.

3.2.5 View Parameters for Coherence / Non-Coherence Function Display

Selecting Coherence Function in the above View Type selection box switches the
Spectrum Analyzer to coherence function display mode which shows the coherence
coefficient between Channels A and B vs frequency graph. The coherence function is
defined as the ratio of the magnitude of the cross-power spectrum between the input
and output signals of a system to the square root of the product of their auto-power
spectra. It has a value between 0 and 1. If the signals are ergodic and the system is
linear, the coherence function can be used to estimate the causality between the input
and output signals. Its square value reflects the percentage of the output power that is
contributed by the input. Thus the coherence function is often used to examine the
www.virtins.com
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quality of a measured transfer function. The peak coherence coefficient and its
corresponding frequency will be shown as text above the graph. They can also be
accessed through these Derived Data Points (DDPs): PeakCHFCoef_AB and
PeakCHFFreq_AB(Hz).
The following figure illustrates the coherence function of two independent white
noise signals. It shows that the coherence value at each frequency is well below 1
after 42 times of intra-frame averaging (Number of data points in time domain: 44100,
FFT size: 1024, number of FFT segments: 44100/1024 = 43). The values should
converge to zero at all frequencies if an infinite number of times of intra-frame
averaging is performed. Note that if there is only one FFT segment (i.e. no intraframe averaging), the coherence values will always be 1 even if the two signals are
fully independent and un-correlated. Thus, to get a valid coherence function, at least
one time of intra-frame averaging must be performed. In other words, the Record
Length of the Oscilloscope must be at least twice the FFT size of the Spectrum
Analyzer. The software will show a warning message inside the Spectrum Analyzer if
this requirement is not met.

The following figure illustrates the coherence function of a white noise stimulus (in
Channel B) and the corresponding response (in Channel A) from a 5513 Hz second
order Butterworth low pass filter. The figure shows that the coherence value
maintains at nearly 1 from 0 Hz to about 15 kHz and then starts to drop towards zero
quickly. The reason why the high frequencies tend to be un-correlated is that their
energy in the response signal is greatly suppressed by the low pass filter, resulting in a
very poor signal-to-noise ratio at these frequencies.
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The coherence function is often used in conjunction with the transfer function as an
indication of the quality of the transfer function measurement. It indicates how much
of the response energy is correlated to the stimulus energy.

3.2.5.1 Frequency Range (F)
Same as Amplitude Spectrum.
3.2.5.2 Frequency Multiplier
Same as Amplitude Spectrum.
3.2.5.3 Channel A&B Display Range

Only two options available: Off, 1.
When "Off" is selected, the data in Channel A will not be displayed.
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3.2.5.4 Channel A&B Multiplier
Same as Channel A Multiplier in Amplitude Spectrum.
3.2.5.5 Channel B Display Range
Not applicable and disabled.
3.2.5.6 Channel B Multiplier
Not applicable and disabled.
3.2.5.7 FFT Size
Same as Amplitude Spectrum.
3.2.5.8 Window Function
Same as Amplitude Spectrum.
3.2.5.9 Window Overlap Percentage
Same as Amplitude Spectrum.
3.2.5.10 Non-Coherence Function and Total Non-Coherent Distortion and Noise
The coherence function can be seen as the square root of the ratio of coherent output
power to output power against frequency. Coherent output power is the part of output
power that is linearly related to the input. The remainder of the output power is called
non-coherent output power, which is caused by all kinds of non-linear distortions (e.g.
THD, IMD, etc..) and noise. The non-coherence function is thus defined as the square
root of the ratio of non-coherent output power to output power against frequency. It
equals to the square root of (1-[Coherent Function]2). To switch to non-coherence
function display mode, right click anywhere within the Spectrum Analyzer window
and select [Spectrum Analyzer Processing] in the pop-up menu, then tick “Non
Coherence” checkbox.
Non-Coherence function can be used to indicate the variation of the non-coherent
distortion and noise with frequency. The non-coherent distortion takes into account all
kinds of non-linear distortions. Integrating the non-coherent output power against
frequency gives the total non-coherent output power. Total Non-Coherent Distortion
and noise (TNCD) is a single value defined as the square root of the ratio of the total
non-coherent output power to the total output power. It is displayed in percentage (%).
This value will be shown on the top of the non-coherence coefficient vs frequency
graph. It can also be accessed through the Derived Data Point (DDP): TNCD_AB(%).
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It is possible to specify a frequency range in which the TNCD is calculated. The
default range is from 20 Hz to 20 kHz.
The following figure illustrates the non-coherence function of two independent white
noise signals. It shows that the non-coherence coefficient at each frequency
approaches 1 after 687 times of intra-frame averaging (Number of data points in time
domain: 44100, FFT size: 128, window overlap: 50%, number of FFT segments: 688).
The values should converge to 1 at all frequencies and the TNCD should be 100% if
an infinite number of times of intra-frame averaging are performed. Note that if there
is only one FFT segment (i.e. no intra-frame averaging), the non-coherence
coefficients will always be zero even if the two signals are completely independent
and un-correlated. Thus, to get a valid non-coherence function, at least one time of
intra-frame averaging must be performed. In other words, the Record Length of the
Oscilloscope must be at least twice the FFT size of the Spectrum Analyzer. However,
if the non-coherence function and TNCD are used to quantify the non-coherent
distortion + noise, then a much greater number of times of intra-frame averaging
should be performed, in order to minimize its artifact on the measurement accuracy
and allow a small value of non-coherent distortion + noise to show up. This requires
a longer record length of the Oscilloscope.

Unlike those traditional non-linear distortion measurements, such as THD, IMD, and
TD+N, whereby a single tone, dual-tone, or multi-tone stimulus is used as the input
signal, non-coherent distortion measurement can use any broad-band stimulus such as
white noise, pink noise, multitones, broadband music, or broadband speech.
For Coherence and Non-Coherence Function measurement using the software,
Channel B must be fed with the same stimulus sent to the Device Under Test (DUT)
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and Channel A must be fed with the response from the DUT (see figure in the next
section).
3.2.6 View Parameters for Transfer Function Display / Impedance Analyzer

Selecting Transfer Function in the above View Type selection box switches the
Spectrum Analyzer to transfer function display mode under which the system’s gain
& phase shift vs frequency graph is shown. Transfer function is a convenient
representation of a Linear Time Invariant (LTI) system. It describes the relationship
between the system’s input and output. Frequency response is a transfer function
expressed in frequency domain. It is a measure of magnitude and phase of the output
as a function of frequency, in comparison to the input. Frequency response includes
magnitude frequency response and phase frequency response. A graph that shows
both are called Bode plot or gain and phase plot.
For transfer function measurement using the software, Channel B must be fed with the
same stimulus sent to the Device Under Test (DUT) and Channel A must be fed with
the response from the DUT (see figure below). To achieve a good measurement
accuracy, significant stimulus energy must be present in the frequency range of
interest. Commonly used test signals are chirp signal and white noise as well as
multitones capable of simultaneously stimulating all FFT frequency bands within the
frequency range of interest. Transfer function measurement requires that the two
input channels themselves have the same frequency response in the frequency range
of interest. This can be verified by feeding the stimulus to both input channels directly
and measuring the transfer function. The measured gain and phase shift in the
frequency range of interest should be very close to 0 dB and 0°. If not, you can
generate a gain and phase compensation file and load it to compensate the disparity
between the two input channels. This will be described later in this chapter.

The following figure illustrates the transfer function of the aforementioned 5513 Hz
second order Butterworth low pass filter, measured using a white noise stimulus, with
the stimulus data stored in Channel B and the response data stored in Channel A. 100
oscilloscope frames were inter-frame averaged and 43 intra-frame averages were
performed in each oscilloscope frame. The figure shows that the gain maintains at
nearly 0 dB from 0 Hz to about 5513 Hz, and then start to drop very quickly,
meanwhile the phase changes gradually from 0º at 0 Hz towards –180º as the
frequency goes to infinity. The cursor reader indicates that at 5512.5 Hz (i.e. around
the cutoff frequency), the gain is about –3.03 dB and the phase is about -89.93º.
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As indicated in the previous section, the coherence function of this measurement
drops very quickly towards zero after 15 kHz, thus the transfer function results
beyond 15 kHz may not be trustable because the response and stimulus are no more
closely correlated due to the poor signal-to-noise ratio.

The following figure shows a first order RC low pass filter. The resistor R is 200Ω
and the capacitor C is 2.2µF. Its cutoff frequency can be calculated as:
1/(2πRC)=362Hz. Its transfer function was measured using a sound card. The
stimulus was a white noise. 143 oscilloscope frames were inter-frame averaged and
two intra-frame averages were performed in each oscilloscope frame. The measured
bode plot is show as follows. The measured cutoff frequency is about 360Hz and the
measured phase shift changes from 0° to -90° as frequency increases.
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The following DDPs are generated by the transfer function display mode:
(1) PeakGainFreq_AB(Hz): Frequency at the peak gain
(2) PeakGainValue_AB(dB): Peak gain
(3) PeakGainPhase_AB(D): Phase at the peak gain
(4) GainAtGeneratedFreq(dB): Gain at the frequency generated by Channel A of the
Signal Generator
(5) PhaseAtGeneratedFreq(D): Phase at the frequency generated by Channel A of the
Signal Generator
(6) InBandMinF_A(Hz): Frequency at which the minimum gain is located in the
specified frequency band
(7) InBandMinRMS_A(EU): Minimum gain in the specified frequency band, its unit
will be updated to dB
(8) InBandMaxF_A(Hz): Frequency at which the maximum gain is located in the
specified frequency band
(9) InBandMaxRMS_A(EU): Maximum gain in the specified frequency band, its unit
will be updated to dB
(10) InBandMinF_B(Hz): Frequency at which the minimum gain is located in the
specified frequency band
(11) InBandMinRMS_B(EU): Phase at the minimum gain in the specified frequency
band, its unit will be updated to D
(12) InBandMaxF_B(Hz): Frequency at which the maximum gain is located in the
specified frequency band
(13) InBandMaxRMS_B(EU): Phase at the maximum gain in the specified frequency
band, its unit will be updated to D
The above (1), (2) and (3) are also displayed in the upper part of the Spectrum
Analyzer. (4) and (5) are usually used in transfer function measurements using
frequency stepped sine stimulations through Device Test Plan. If the signals acquired
in the two input channels are not time aligned, and it is required to remove the time
delay between them before the transfer function is calculated, then please refer to the
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Time Delay Removal method introduced in the previous chapter. Some sample panel
setting files for Bode plot measurements are provided in the PSF subdirectory of the
software.

3.2.6.1 Frequency Range (F)
Same as Amplitude Spectrum.
3.2.6.2 Frequency Multiplier
Same as Amplitude Spectrum.
3.2.6.3 Channel A Display Range

27 options available: Off, 1dB, 2dB, 5dB, 10dB, 15dB, 20dB, 25dB, 30dB,
35dB, 40dB, 45dB, 50dB, 60dB, 70dB, 80dB, 90dB, 100dB, 120dB,
150dB, 200dB, 250dB, 300dB, 350dB, 400dB, 450dB, 500dB.
When "Off" is selected, the data in Channel A will not be displayed.

3.2.6.4 Channel A Multiplier
Same as Amplitude Spectrum.

3.2.6.5 Channel B Display Range
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Five options available: Off, ± 180D (i.e. ± 180 degree), 135D, 90D, 45D.
When "Off" is selected, the data in Channel B will not be displayed.

3.2.6.6 Channel B Multiplier
Same as Amplitude Spectrum.
3.2.6.7 FFT Size
Same as Amplitude Spectrum.
3.2.6.8 Window Function
Same as Amplitude Spectrum.
3.2.6.9 Window Overlap Percentage
Same as Amplitude Spectrum.

3.2.6.10 Impedance Analyzer Mode
Under the Transfer Function display mode, to switch to Impedance Analyzer mode,
right click anywhere within the Spectrum Analyzer window and select [Spectrum
Analyzer Y Scale] in the pop-up menu, then tick “Convert to Impedance” checkbox
(see figure below).
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Impedance is a two-dimensional vector quantity consisting of two independent scalars:
resistance and reactance. It is represented as a complex quantity Z. In polar form, the
impedance is represented by its magnitude and phase angle, both of which are
functions of frequency. The impedance magnitude and phase vs frequency plot is thus
quite similar to the gain and phase vs frequency plot of a LTI system. So does the
measurement method. Two connection methods are supported in the software (see
figure below).

where Zx is the impedance to be measured, Rr the reference resistor, Vo the output
voltage from the signal generator and Vi the input voltage fed by the voltage divider
formed by Zx and Rr. Both Vo and Vi are ground referenced, so measuring devices
with either ground referenced inputs or differential inputs can be used. The input
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impedance of the measuring device must be much higher than Zx and Rr so that their
effect on the measurement accuracy can be ignored. The output impedance and
overall frequency response of the measuring device do not affect the measurement
accuracy directly thanks to the dual-channel measurement method, but it is still
recommended for the measuring device to have a low output impedance and a flat
overall frequency response. The dual-channel measurement method requires the two
input channels to have minimum gain and phase differences within the frequency
range of interest. Unlike the transfer function measurement, these differences cannot
be compensated in the software.
Rr is an external reference resistor. You need to find the resistor and make the
connection by yourself. It is recommended to have Rr’s value comparable to that of
Zx. The actual value of Rr should be entered into the Rr(Ω) edit box in [Spectrum
Analyzer Y Scale] dialog box. The actual connection used also needs to be selected
there. Unlike the single-channel impedance measurement method under Amplitude
Spectrum display mode, the dual-channel method does not require a Reference Vo file
as Vo is already measured simultaneously with Vi. In Connection 1, Zx = Rr × (VoVi) / Vi while in Connection 2, Zx = Rr × Vi / (Vo-Vi). To achieve a good
measurement accuracy, significant stimulus energy must be present in the frequency
range of interest. Commonly used signals are chirp signal (frequency swept sine) and
white noise as well as multitones capable of simultaneously stimulating all FFT
frequency bands in the frequency range of interest. Various average methods can be
used to smoothen the result.
Under the Impedance Analyzer mode, Channel A Display Range will be updated to
display impedance in Ω. The “Auto” option of the display range is about 5×Rr. The
following DDPs are generated by the Impedance Analyzer mode:
(1) PeakGainFreq_AB(Hz): Frequency at the peak impedance
(2) PeakGainValue_AB(dB): Peak impedance value, its unit will be updated to Ω
(3) PeakGainPhase_AB(D): Phase at the peak impedance
(4) GainAtGeneratedFreq(dB): Impedance at the frequency generated by Channel A
of the Signal Generator, its unit will be updated to Ω
(5) PhaseAtGeneratedFreq(D): Phase at the frequency generated by Channel A of the
Signal Generator
(6) InBandMinF_A(Hz): Frequency at which the minimum impedance is located in
the specified frequency band
(7) InBandMinRMS_A(EU): Minimum impedance in the specified frequency band
(8) InBandMaxF_A(Hz): Frequency at which the maximum impedance is located in
the specified frequency band
(9) InBandMaxRMS_A(EU): Maximum impedance in the specified frequency band
(10) InBandMinF_B(Hz): Frequency at which the minimum impedance is located in
the specified frequency band
(11) InBandMinRMS_B(EU): Phase at the minimum impedance in the specified
frequency band, its unit will be updated to D
(12) InBandMaxF_B(Hz): Frequency at which the maximum impedance is located in
the specified frequency band
(13) InBandMaxRMS_B(EU): Phase at the maximum impedance in the specified
frequency band, its unit will be updated to D
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The above (1), (2) and (3) are also displayed in the upper part of the Spectrum
Analyzer. (4) and (5) are usually used in impedance measurements using frequency
stepped sine stimulations through Device Test Plan.
The following examples use different stimuli and configurations to measure a 2.5” 8Ω
speaker’s impedance with a 25Ω reference resistor.
(1) White Noise
Oscilloscope:
ADC Device: VT DSO-2A20E,
Bit Resolution: 16
Sampling Frequency: 50 kHz,
Record Length: 200 ms (10000 samples)
Trigger Mode: Normal,
Trigger Level: 0%
Spectrum Analyzer:
FFT size: 32768,
Window Function: Rectangle
Intra-Frame Processing: Smooth via Moving Average: 10 points
Inter-Frame Processing: 200-frame linear average
X Scale: Log,
Y Scale: Convert to Impedance
Max. and Min. Impedance Searching Range: 20 Hz ~ 5 kHz
Frequency Range of Interest: 20 Hz ~ 20 kHz
Signal Generator:
DAC Device: Sound Card Headphone Output,
Duration: Loop
Waveform: White Noise，
Sampling Frequency: 48 kHz

The measured resonant frequency is 394 Hz at the impedance peak 10.5 Ω. The
lowest impedance is 6.8 Ω at the lower frequency end. The phases at the resonant
frequency and lower frequency end are 1.1 degree and 0.1 degree respectively, which
are very close to zero.
(2) Pink Noise
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Oscilloscope:
ADC Device: VT DSO-2A20E,
Bit Resolution: 16
Sampling Frequency: 50 kHz,
Record Length: 200 ms (10000 samples)
Trigger Mode: Normal,
Trigger Level: 0%
Spectrum Analyzer:
FFT size: 32768,
Window Function: Rectangle
Intra-Frame Processing: Smooth via Moving Average: 10 points
Inter-Frame Processing: 200-frame linear average
X Scale: Log,
Y Scale: Convert to Impedance
Max. and Min. Impedance Searching Range: 20 Hz ~ 5 kHz
Frequency Range of Interest: 20 Hz ~ 20 kHz
Signal Generator:
DAC Device: Sound Card Headphone Output,
Waveform: Pink Noise,

Duration: Loop
Sampling Frequency: 48 kHz

The measured resonant frequency is 392 Hz with an impedance peak of 10.8 Ω. The
lowest impedance is 7.0 Ω at the lower frequency end. The phases at the resonant
frequency and lower frequency end are 2.3 degree and 1.0 degree respectively, which
are very close to zero.
(3) Frequency linearly swept sine wave
Oscilloscope:
ADC Device: VT DSO-2A20E,
Bit Resolution: 16
Sampling Frequency: 50 kHz,
Record Length: 200 ms (10000 samples)
Trigger Mode: Single,
Trigger Level: 1%
Spectrum Analyzer:
FFT size: 32768,
Window Function: Rectangle
Intra-Frame Processing: Smooth via Moving Average: None
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Inter-Frame Processing: None
X Scale: Log,
Y Scale: Convert to Impedance
Max. and Min. Impedance Searching Range: 20 Hz ~ 5 kHz
Frequency Range of Interest: 20 Hz ~ 20 kHz
Signal Generator:
DAC Device: Sound Card Headphone Output,
Duration: 200 ms
Waveform: Frequency linearly swept sine wave from 10 Hz to 21 kHz
Sampling Frequency: 48 kHz

The measured resonant frequency is 394 Hz with an impedance peak of 10.7 Ω. The
lowest impedance is 7.0 Ω at the lower frequency end. The phases at the resonant
frequency and lower frequency end are -0.5 degree and 0.5 degree respectively, which
are very close to zero.
(4) Frequency logarithmically swept sine wave
Oscilloscope:
ADC Device: VT DSO-2A20E,
Bit Resolution: 16
Sampling Frequency: 50 kHz,
Record Length: 200 ms (10000 samples)
Trigger Mode: Single,
Trigger Level: 1%
Spectrum Analyzer:
FFT size: 32768,
Window Function: Rectangle
Intra-Frame Processing: Smooth via Moving Average: 10 points
Inter-Frame Processing: None
X Scale: Log,
Y Scale: Convert to Impedance
Max. and Min. Impedance Searching Range: 20 Hz ~ 5 kHz
Frequency Range of Interest: 20 Hz ~ 20 kHz
Signal Generator:
DAC Device: Sound Card Headphone Output,
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Waveform: Frequency logarithmically swept sine wave from 10 Hz to 21 kHz
Sampling Frequency: 48 kHz

The measured resonant frequency is 391 Hz with an impedance peak of 10.6 Ω. The
lowest impedance is 6.9 Ω at the lower frequency end. The phases at the resonant
frequency and lower frequency end are 0.7 degree and 1.5 degree respectively, which
are very close to zero.
All the above tests obtain similar results. Among them, the frequency swept sine wave,
either the linear one or the logarithmic one, is the fastest method. If a longer record
length is chosen, the frequency resolution of the results would be finer.
3.2.7 View Parameters for Impulse Response Display

Selecting Impulse Response in the above View Type selection box switches the
Spectrum Analyzer to impulse response display mode under which the impulse
response graph is shown. The Fourier transform of the impulse response of a LTI
system is precisely the frequency response of the system. The impulse response here
is computed from the frequency response (i.e. transfer function) measured in the
previous section through inverse FFT.
For impulse response measurement using the software, Channel B must be fed with
the stimulus sent to the Device Under Test (DUT) and Channel A must be fed with
the response from the DUT. To achieve a good measurement accuracy, significant
stimulus energy must be present in the frequency range of interest. Commonly used
test signals are chirp signal (swept sine) and white noise as well as multitones capable
of simultaneously stimulating all FFT frequency bands within the frequency range of
interest.
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The following figure illustrates the impulse response of the aforementioned 5513 Hz
second order Butterworth low pass filter. It can be seen that the measured impulse
response is the same as the one measured using circular cross-correlation previously,
except that they may be have different vertical scaling factors. Similarly, the
measured impulse response here can also be exported to a TXT file and then imported
into the Oscilloscope for further analysis (e.g. reverberation and speech intelligibility
analysis). Unlike the circular cross correlation method, the impulse response
measurement method here does not requires the stimulus to be white-noise like, any
broadband signal that convers the frequency band of interest can be used.

The following DDPs are generated by the impulse response display mode:
(1) PeakIPRTime_AB(s): Time at the peak of the Impulse Response
(2) PeakIPRValue_AB: Peak Impulse Response Value
These values are also displayed in the upper part of the Spectrum Analyzer. Some
sample panel setting files for impulse response measurements are provided in the PSF
subdirectory of the software.

3.2.7.1 Time Range (T)
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49 options are available: Auto, 1ns, 2ns, 4ns, 5ns, 10ns, 20ns, 40ns, 50ns, 100ns,
200ns, 400ns, 500ns, 1µs, 2µs, 4µs, 5µs, 10µs, 20µs, 40µs, 50µs, 100µs, 200µs,
400µs, 500µs, 1ms, 2ms, 4ms, 5ms, 10ms, 20ms, 40ms, 50ms, 100ms, 200ms, 400ms,
500ms, 1s, 2s, 4s, 5s, 10s, 20s, 40s, 50s, 100s, 200s, 400s, 500s.
When “Auto” is selected, the Time Range will be set by the software automatically
based on the following formula:
Time Range = the nearest integer that is equal to or greater than the value of [FFT
Size] / [Sampling Frequency]
The impulse response here is obtained by converting the frequency response (i.e.
Transfer Function) from the frequency domain to the time domain using inverse FFT.
The time range is thus [FFT size]/[Sampling Frequency].

3.2.7.2 Time Multiplier
Same as Amplitude Spectrum.

3.2.7.3 Channel A Display Range
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19 options available: Off, 1n, 10n, 100n, 1µ, 10µ, 100µ, 1m, 10m, 100m,
1, 10, 100, 1k, 10k, 100k, 1M, 10M, 100M.
When "Off" is selected, the data in Channel A will not be displayed.
3.2.7.4 Channel A Multiplier
Same as Amplitude Spectrum.
3.2.7.5 Channel B Display Range
Not applicable and disabled.
3.2.7.6 Channel B Multiplier
Not applicable and disabled.
3.2.7.7 FFT Size
Same as Amplitude Spectrum.
3.2.7.8 Window Function
Same as Amplitude Spectrum.
3.2.7.9 Window Overlap Percentage
Same as Amplitude Spectrum.
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3.3 Menu
Spectrum Analyzer has its own menu bar and additional functions can be accessed
through the menu items in each submenu. Click anywhere within the Spectrum
Analyzer window will switch the software’s main menu to the Spectrum Analyzer
menu.
3.3.1 File SubMenu

This submenu provides access to the file operation and printing functions.

3.3.1.1 New (File SubMenu) (ALT-F-N, CTRL-N)
The command is used to create a new, blank document for measurement, with the
system default panel setting fixed in the factory. The new document will be used to
hold the latest collected frame of data.
This command is also available through the button
in the Instrument Toolbar.
When there is no Oscilloscope, Spectrum Analyzer and Multimeter opened, click the
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above "Spectrum Analyzer" button will open a new document without changing the
current Trigger and Sampling Parameters.
3.3.1.2 Open (File SubMenu) (ALT-F-O, CTRL-O)
Same as Oscilloscope.
3.3.1.3 Open Frame by Frame (File SubMenu) (ALT-F-F)
Same as Oscilloscope.
3.3.1.4 Import (File SubMenu) (ALT-F-I)
Same as Oscilloscope.
3.3.1.5 Combine (File SubMenu) (ALT-F-B)
Same as Oscilloscope.
3.3.1.6 Extract (File SubMenu) (ALT-F-T)
Same as Oscilloscope.
3.3.1.7 Close (File SubMenu) (ALT-F-C)
Same as Oscilloscope.
3.3.1.8 Save (File SubMenu) (ALT-F-S, CTRL-S)
Same as Oscilloscope.
3.3.1.9 Save As (File SubMenu) (ALT-F-A)
Same as Oscilloscope.
3.3.1.10 Print Screen (File SubMenu) (ALT-F-R)
Same as Oscilloscope.
3.3.1.11 Spectrum Analyzer Export (File SubMenu) (ALT-F-E)
This command is used to export either the calculated data (RMS Amplitude Spectrum,
Octave Amplitude Spectrum, Phase Spectrum, Auto Correlation Function, Cross
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Correlation Function, Coherence Function, Transfer Function, Impulse Response,
depending on the current view type) to a TXT file or the currently displayed graph to
a BMP file. When clicked, a "Save As" window will pop up. You can specify whether
you want to export as a TXT file or a BMP file by selecting "Text File (*.txt)" or
"Bitmap File (*.bmp)" in the "Save as type" combo box. The text file can be imported
into third party software such as Microsoft Excel for further processing and analysis.
This command is disabled when the document is empty.

3.3.1.12 Spectrum Analyzer Print (File SubMenu) (ALT-F-P, CTRL-P)
Similar to Oscilloscope.

3.3.1.13 Spectrum Analyzer Print Preview (File SubMenu) (ALT-F-V)
Similar to Oscilloscope.

3.3.1.14 Recent File (File SubMenu)
Same as Oscilloscope.
3.3.2 Setting SubMenu

This submenu provides access to various setting functions.
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3.3.2.0 Restore to Factory Default (Setting SubMenu) (ALT-S-U)
Same as Oscilloscope.
3.3.2.1 ADC Device (Setting SubMenu) (ALT-S-A)
Same as Oscilloscope.
3.3.2.2 DAC Device (Setting SubMenu) (ALT-S-E)
Same as Oscilloscope.

3.3.2.3 Calibration (Setting SubMenu) (ALT-S-C)
Same as Oscilloscope.

3.3.2.4 Display (Setting SubMenu) (ALT-S-D)
Same as Oscilloscope.

3.3.2.5 Note (Setting SubMenu) (ALT-S-N)
Same as Oscilloscope.

3.3.2.6 ADC Device Database (Setting SubMenu) (ALT-S-B)
Same as Oscilloscope.

3.3.2.7 DAC Device Database (Setting SubMenu) (ALT-S-T)
Same as Oscilloscope.

3.3.2.8 Spectrum Analyzer Processing (Setting SubMenu) (ALT-S-G)
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After being processed in time domain in the Oscilloscope, the signal will undergo the
following processes in frequency domain sequentially:
(1) Intra-frame Processing
(2) Inter-frame Processing
(3) Parameter Measurement
The data frame here is the same as that in the Oscilloscope. A data frame can be
further divided into one or multiple FFT segments depending on the ratio of Record
Length in the Oscilloscope and FFT Size in the Spectrum Analyzer.

3.3.2.8.1 Intra-Frame Processing
The Intra-Frame Processing, as its name suggests, is performed within a data frame in
frequency domain based on FFT segments. There are four types of Intra-Frame
Processing: Remove DC, Frequency Compensation, Frequency Weighting,
Smoothing via Moving Average. They are performed in sequence as above.
3.3.2.8.1.1 Remove DC
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If this checkbox is ticked, the mean value of the current frame of data will be
subtracted from the data before FFT computation.
Some of the sound cards may introduce a small background DC offset even though
the sound card is AC coupled. This DC offset, if not compensated in time domain,
will result in one or a few frequency peaks around 0 Hz and sometimes these peaks
can be higher than those frequency peaks of interest. Leaving this checkbox ticked
will remove the DC component present in the input signal during FFT. This checkbox
is ticked by factory default.
It should be noted that the mean value of the current frame of data is calculated
without applying any non-uniform window function (i.e. only Rectangle Window is
applied). If a window function other than Rectangle is used in the Spectrum Analyzer,
some DC residual may still exist after DC removal and under some conditions, the
DC residual may be even greater than the case if this option is not chosen.
3.3.2.8.1.2 Compensation
There are two types of compensation: frequency compensation under amplitude
spectrum mode, and gain and phase compensation under transfer function mode. “-C” will be displayed at the bottom left of the Spectrum Analyzer window if a frequency
compensation is applied.
3.3.2.8.1.2.1 Frequency Compensation
Under amplitude spectrum mode, if you check the “Compensation1” or
“Compensation2” checkbox, you are allowed to load a Frequency Compensation File
(*.fcf) to compensate the amplitude spectrum. You can specify up to two
compensation files. For example, you can use one compensation file to compensate
the magnitude frequency response of the measuring circuit, and use another
compensation file to compensate the magnitude frequency response of the
microphone.
A Frequency Compensation File is a Comma Separated Variable (CSV) TXT file that
defines the magnitude compensation value (in dB) at each frequency. A mono
frequency compensation file has the following format (which follows the same format
as the Frequency Response File (*.frf) defined previously):
Example:
1,20,-50.5
2,25,-44.7
3,31.5,-39.4
4,40,-34.6
……
Each line contains three comma separated variables. The first variable is the
sequential number. The second one is the frequency value in Hz. And the third one is
the corresponding gain value in dB. Note that 0 dB represents the unit gain. Any
frequency that falls outside the defined range will be given a gain value of –1000 dB.
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A stereo frequency compensation file has a fourth variable in each line, specifying the
gain value in dB for the second channel. If the sampled data are stereo but the
frequency compensation file is mono, then the same frequency compensation will be
applied to both channels.
When the magnitude frequency response of a measuring device itself is obtained in
the Spectrum Analyzer, the corresponding frequency compensation file can be
generated by right clicking anywhere within the Spectrum Analyzer window and
selecting “Generate Frequency Compensation File (Flat)”.
The generated
compensation file can be used to eliminate the effect of the non-flat magnitude
frequency response of the measuring device itself on the measurement.
Some sample files are provided in the FCF directory of the software and can be used
as templates. Frequency compensation is only applicable to the Amplitude Spectrum
display.
It is also possible to load an “Original Frequency Response File (*.txt)” here. This
type of TXT files is normally provided by device manufacturers. It contains a few
lines of textual information in the header, followed by many lines of data (see
example below). Each header line starts with a non-numeric character while each
data line starts with a numeric one. Each data line contains two (frequency in Hz and
gain in dB) or three (frequency in Hz, Ch.A gain in dB, Ch.B gain in dB) spaceseparated variables. The products, whose original frequency response files are
compatible with the above format, include Dayton EMM-6 measurement microphone,
miniDSP UMIK-1 USB measurement microphone, etc. It is important to note that
signs of the gain values in the frequency response file will be automatically reversed
in the software in order to compensate for them.
Example:
*1000Hz

-40.6

20.00 -2.4
20.55 -2.1
…

3.3.2.8.1.2.2 Gain and Phase Compensation
Under transfer function mode, if you check the “Compensation1” or
“Compensation2” checkbox, you are allowed to load a Gain and Phase Compensation
file (*.gpc) to compensate the gain and phase plot. You can specify up to two
compensation files.
A Gain and Phase Compensation file is a Comma Separated Variable (CSV) TXT file
that defines the gain compensation value (in dB) and phase compensation value (in
degree) at each frequency. It has the following format:
Example:
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1,20,-50.5,0.49
2,25,-44.7,2.85
3,31.5,-39.4,4.54
4,40,-34.6,-0.38
……
Each line contains four comma separated variables. The first variable is the sequential
number. The second one is the frequency value in Hz. The third one is the
corresponding gain compensation value in dB, and the fourth one the corresponding
phase compensation value in degree. Note that 0 dB represents the unit gain. Any
frequency that falls outside the defined range will be given a gain compensation value
of 0 dB and a phase compensation value of 0 º.
When the transfer function of a measuring device itself is obtained (usually by
directly injecting the same test signal into both input channels) in the Spectrum
Analyzer, the corresponding gain and phase compensation file can be generated by
right clicking anywhere within the Spectrum Analyzer window and selecting
“Generate Frequency Compensation File (Flat)”. The generated compensation file
can be used to eliminate the effect of the gain and phase difference between the two
input channels of the measuring device itself on the measurement.
Gain and phase compensation is only applicable to the transfer function display. Note
that under the impedance measurement submode of the transfer function mode, these
compensation files, if any, will be ignored.
3.3.2.8.1.3 Frequency Weighting

Four commonly used weighting profiles are supported: A, B, C and ITU-R 486. The
following figure illustrates the four weighting curves obtained by analyzing white
noise with the corresponding weighting profile. All curves cross at 1 kHz with a gain
value of 0 dB.
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In addition, the following frequency weighting schemes are supported via their
respective frequency compensation files:
(1)
(2)
(3)
(4)
(5)

ITU_R_ARM
Recording RIAA
Reproducing RIAA
10Hz-20kHz Z_Weighting
20Hz-20kHz Band Width Limiting

Frequency weighting is only applicable to the Amplitude Spectrum display. It can be
applied to Channel A, Channel B, or both of them. Different weighting options
generate different DDPs. A, C weighting generates RMSDBA_A(dBA) and
RMSDBC_A(dBC) respectively for Channel A, and RMSDBA_B(dBA) and
RMSDBC_B(dBC) respectively for Channel B. These DDPs can be displayed in the
respective display mode in the Multimeter.
3.3.2.8.1.4 Smoothing via Moving Average
If this option is ticked, moving average will be applied to the data in frequency
domain to make the displayed curves smoother. The size of the moving average
window is adjustable. The bigger the moving average window, the smoother the
displayed curves, the coarser the frequency resolution.
Along the frequency axis, the size of the moving average window can be a fixed one
which is the number of “Points” under the “linear” mode, or a variable one according
1/1, 1/3, 1/6, 1/12, 1/24, 1/48, 1/96 octave bands. The latter is referred to as octave
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smoothing. Its moving average window size increases exponentially with frequency.
This is especially useful when the X axis is scaled logarithmically. Under the octave
smoothing mode, the number of “Points” specified will still play a part. It acts as the
minimum moving average window size in case the fractional octave bandwidth is too
small in the low frequency region.
The moving average is performed in terms of power under the amplitude spectrum
display mode while under other display modes, it is just an arithmetic average.
3.3.2.8.1.5 Parameter Measurements before Inter-Frame Processing
Some parameters are measured before inter-frame processing. Therefore, their values
will reflect only the current frame of data in the Oscilloscope and will not be affected
by the inter-frame processing. These parameters include dBA, dBZ and dBC in the
Multimeter, and sound quality parameters such as loudness, loudness level and
sharpness.
3.3.2.8.1.5.1 Sound Quality
It has long been known that the conventional acoustic metrics, such as A-weighted
sound pressure level, don’t correlate well with perceptions of sound quality by end
users. The term sound quality here refers to the overall experience of the information
in the sound that leads to a person’s liking it or not, or that leads to a perception of the
non-acoustical qualities of the device emitting the sound (that is, engine power, robust
construction, etc.). There are a large number of metrics, some of which are well
defined and others which are not. Very few have been standardized and the usefulness
of a particular metric is dependent on the nature of the sound being tested. The
following sections describe the sound quality parameters such as loudness, loudness
level, sharpness, articulation index and open articulation index, which can be
measured by the software.
3.3.2.8.1.5.1.1 Loudness and Loudness Level
Sound loudness is a subjective term describing the strength of human ear's perception
of a sound. Different standards exist for loudness calculation. ISO 532B (DIN45631)
is used here. It is the most widely accepted standard for loudness calculation of a
stationary sound. The calculation is based on 1/3 octave band levels of a sound.
Options are provided to allow the user to specify the type of sound fields: Free Field
or Diffuse Field.
The unit of loudness is sone. The sone scale is linear. Doubling the perceived
loudness doubles the sone value. A loudness of 1 sone is equivalent to the loudness
of a signal at 40 phons, the loudness level of a 1 kHz tone at 40 dB SPL.
The unit of loudness level is phon. The phon scale is logarithmic. The number of
phons of a sound is the dB SPL of a sound at a frequency of 1 kHz that sounds just as
loud. The following figure shows the equal-loudness contours.
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Loudness and loudness level are interconvertible. When the loudness is equal to or
greater than 1 sone, [loudness level] = 40 + 10×log2(loudness). When the loudness is
less than 1 sone, [loudness level] = 40×(loudness+0.0005)0.35. In the software, their
values are accessible through the Derived Data Points (DDPs): Loudness_A(SONE)
and LoudnessLevel_A(PHON) for Channel A, and Loudness_B(SONE) and
LoudnessLevel_B(PHON) for Channel B. It should be noted that the loudness
calculation is performed after “Remove DC” and Frequency Compensation but before
Frequency Weighting. Therefore, their values will not be affected by the frequency
weighting option.
For loudness calculation, FFT size should be set greater than 16384 (required by 1/3
octave analysis at a sampling frequency of 48 kHz) and normally Rectangle window
function should be used for wide band noises.
3.3.2.8.1.5.1.2 Sharpness
Sharpness is a hearing sensation related to frequency and independent of loudness.
Sharpness corresponds to the sensation of a sharp, painful, high-frequency sound and
is the comparison of the amount of high frequency energy to the total energy.
Sharpness delineates human sensation in a linear manner as well. In general,
sharpness is increased by adding higher frequency content, and decreased by adding
lower frequency content. The unit of sharpness is acum. Sharpness of one acum is
produced by a narrow-band noise at 1 kHz with a bandwidth smaller than 150 Hz and
a level of 60 dB.

www.virtins.com

260 Copyright © 2006-2022

Virtins Technology

VIRTINS Multi-Instrument 3.9 Manual

Virtins Technology

Different standards exist for sharpness calculation but there is no international
standard yet. DIN45692 is used here. It is calculated together with the loudness and
loudness level introduced previously.
In the software, sharpness values are accessible through the Derived Data Points
(DDPs): Sharpness_A(ACUM) for Channel A, and Sharpness_B(ACUM) for Channel
B.
3.3.2.8.1.5.1.3 Articulation Index and Open Articulation Index
Articulation index (AI), as defined in ANSI S3.5-1969 and ANSI S3.5-1997, is used
to indicate how much background sound levels can interfere with human speech. It
was used originally in applications like measuring speech privacy and the
effectiveness of communication systems. Nowadays, it is also used to rate vehicle
interior noise, the quietness of white goods and more. It has a value between 0% (no
speech understood) to 100% (all speech understood).
There can be slight variations in the calculation method of articulation index. It is
calculated here based on the A-weighted 1/3 octave spectrum of the measured sound,
as shown in the following table.
1/3 Octave Center
Frequency (Hz)
200
250
315
400
500
630
800
1000
1250
1600
2000
2500
3150
4000
5000
6300

Low Limit (dBA)

High Limit (dBA)

Weighting Factor (%)

23.1
30.4
34.4
38.2
41.8
43.1
44.2
44.0
42.6
41.0
38.2
36.3
34.2
31.0
26.5
20.9

53.1
60.4
64.4
68.2
71.8
73.1
74.2
74.0
72.6
71.0
68.2
66.3
64.2
61.0
56.5
50.9

1
2
3.25
4.25
4.5
5.25
6.5
7.25
8.5
11.5
11.0
9.5
9.0
7.75
6.25
2.5

The difference between the High Limit and Low Limit in the above table is fixed at
30 dB. When the measured value in a 1/3 octave band is greater than the respective
High Limit, the result in that octave band is 0. When that value is lower than the
respective Low Limit, the result is 1. When that value is in between, the result is
given by ([High Limit]- [Measured Value])/30. All results from 200Hz to 6300Hz are
weighted and averaged to yield a single value of articulation index.
Open articulation index has a wider range than 0% ~ 100%. Its calculation method is
similar to that of the articulation index. But the measured value is not limited by the
above octave band specific High Limit and Low Limit during calculation. Instead, it
is limited by a fixed 80dB range, from 20dBA to 100dBA. As a result, the open
articulation index has a value between -108.56% and 158.11%.
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In the software, Articulation index and open articulation index are accessible through
the
Derived
Data
Points
(DDPs):
ArticulationIndex_A(%)
and
OpenArticulationIndex_A(%) for Channel A, and ArticulationIndex_B(%) and
OpenArticulationIndex_B(%) for Channel B.
The following figure shows the measured dBSPL, loudness, loudness level, sharpness,
articulation index and open articulation index of a white noise in a free field.

Two preconfigured panel setting files for loudness, loudness level, sharpness and
articulation index measurement can be found in the PSF subdirectory of the software:
\pro\Loudness.psf
\pro\Loudness_RTAFCF.psf
3.3.2.8.2 Inter-Frame Processing
There are four options: None, Peak Hold, Linear Average, Exponential Average. You
can specify the number of consecutive frames to be processed. The available options
are: 2, 3, 4, 5, 6, 7, 8, 9, 10, 20, 30, 40, 50, 60, 70, 80, 90, 100, 120, 140, 160, 180,
200 and forever. Note that when the Spectrum 3D Plot is running, the number of
frames here must be less than or equal to the number of frames specified in Spectrum
3D Plot. When “Forever” is selected, you can reset the process using the Reset button
when necessary. The number of frame processed is displayed at the bottom right
corner of the Spectrum Analyzer window. It can be accessed through DDP:
NumberOfFrames.
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3.3.2.8.2.1 Peak Hold
If Peak Hold is selected, the Spectrum Analyzer will keep track of each data frame
acquired and only display the peak value (in terms of absolute value) at each
frequency for the specified number of frames acquired most recently. The number of
frames processed will be displayed at the bottom-right corner of the Spectrum
Analyzer view.
You can utilize the peak hold function together with a swept sine signal generated via
the Signal Generator to obtain the magnitude frequency response of a Device Under
Test (DUT). This method requires the Record Length, FFT frequency resolution and
sweep duration to be carefully chosen. The finer the frequency resolution, the longer
the sweep duration. The following figure illustrates the magnitude frequency
response of a laptop built-in sound card measured using an external loopback cable.
The sinusoidal signal was swept linearly from 20 Hz to 22050 Hz for 300 seconds.
The frame size of the Oscilloscope was 200 ms with a sampling rate of 44100 Hz. The
Spectrum Analyzer was in the Peak Hold mode with 1024 FFT points. The figure
shows that the magnitude frequency response was finally obtained by peak holding
813 frames of data. This panel setting can be found in the Panel Setting File (PSF)
directory of the software.
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3.3.2.8.2.2 Linear Average
If Linear Average is selected, the Spectrum Analyzer will keep track of each data
frame acquired and only display the averaged value at each frequency for the
specified number of frames acquired most recently. The number of frames processed
will be displayed at the bottom-right corner of the Spectrum Analyzer view.
The following figure illustrates the magnitude frequency response of a laptop built-in
sound card measured using an external loopback cable. White noise was used as the
test signal. The frame size of the Oscilloscope was 2 s with a sampling rate of 44100
Hz. The Spectrum Analyzer was in the averaging mode with 65536 FFT points. The
result was obtained by averaging 50 frames of white noise. The more the averaged
frames, the smoother the curve. This panel setting can be found in the Panel Setting
File (PSF) directory of the software.
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3.3.2.8.2.3 Exponential Average
Unlike linear average where all data frames used for average are given equal weights,
in exponential average, the weighting factor for each data frame decreases with time
exponentially, giving much more importance to recent observations while still not
discarding older observations entirely. The degree of weighting decrease is expressed
as a constant  in percentage. The greater the , the faster the decrease. Alternatively,
 may be expressed in terms of N, where  = 2/(N+1), and N  [time interval
between the start times of two adjacent data frames] is called the time constant.

3.3.2.8.3 Parameter Measurement after Inter-frame Processing
Parameter Measurement is performed after the Intra-Frame and Inter-Frame
processing. It is done only in the Amplitude Spectrum display. The following
parameters can be measured.
3.3.2.8.3.1 THD, THD+N, SINAD, SNR, NL
If the option is ticked, THD, THD+N, SINAD, SNR, and NL values will be displayed
in the upper portion of the Spectrum Analyzer view. These parameters are measured
with reference to the single test tone frequency, which is detected automatically with a
sub-FFT-bin-size accuracy, in other words, its accuracy is much higher than the FFT
frequency resolution. These parameters can also be measured with frequency
weighting such as A-weighting.
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THD (Total Harmonic Distortion) is defined here as the square root of the ratio of the
sum of the powers of all harmonic frequencies above the fundamental frequency to
the power of the fundamental. It is displayed in both percentage (%) and dB. It can be
accessed through the Derived Data Points (DDPs): THD_A(%) and THDDB_A(dB)
for Channel A, and THD_B(%) and THDDB_B(dB) for Channel B.
THD+N (Total Harmonic Distortion plus Noise) is defined here as the square root of
the ratio of the sum of the powers of all harmonic frequencies above the fundamental
frequency plus noise to the total power. In other words, it equals to the square root of
the ratio of the total power less the power of the fundamental frequency to the total
power. It is displayed in both percentage (%) and dB. It can be accessed through the
Derived Data Points (DDPs): THDN_A(%) and THDNDB_A(dB) for Channel A, and
THDN_B(%) and THDNDB_B(dB) for Channel B.
SINAD (Signal in Noise and Distortion) is defined here as the ratio of the total power
to the total power less the power of the fundamental frequency, converted to dB. It
can be accessed through the Derived Data Points (DDPs): SINAD_A(dB) for Channel
A and SINAD_B(dB) for Channel B.
SNR (Signal-to-Noise Ratio) is defined here as the ratio of the power of the
fundamental frequency to the power of the noise, converted to dB. It can be accessed
through the Derived Data Points (DDPs): SNR_A(dB) for Channel A and SNR_B(dB)
for Channel B.
NL (Noise Level) is defined here as the square root of the noise power. The unit of the
Noise Level depends on the Y scale chosen. Apart from the value display, the noise
level will also be displayed as a dotted line in the Amplitude Spectrum. Note that the
noise level will always appear higher than the “apparent” noise level because it
represents the total power of all noises, not the noise power at a particular frequency
bin. The “apparent” noise level varies with the FFT size. The bigger the FFT size, the
smaller each FFT frequency bin, the less the noise power contained in each FFT
frequency bin, thus the lower the “apparent” noise level. However, the real noise
level will not go down because the total noise power will not change with the FFT
size. The noise level can be accessed through the Derived Data Points (DDPs):
NoiseLevel_A(EU) for Channel A and NoiseLevel_B(EU) for Channel B.
ENOB (Effective Number of Bits) is defined here as: ENOB = (SINAD-1.76dB) /
6.02. It can be accessed through the Derived Data Points (DDPs): ENOB_A(Bit) for
Channel A and ENOB_B(Bit) for Channel B.
The above parameters are automatically computed based on the peak frequency
detected in the amplitude spectrum. In order to achieve a high measurement accuracy,
test signal frequency, sampling frequency, Record Length and FFT size must be
carefully chosen such that a FFT segment contains exactly an integer number of
cycles of the test signal, in order to avoid any artificial noise introduced due to the
spectral leakage inherent in FFT algorithm. It is recommended to use the following
formula to derive the test signal frequency: N × [Sampling Frequency]/[FFT Size],
where N is an integer. For example, when the sampling frequency is 44100 Hz and
the FFT size is 16384, and you want a test signal of about 1 kHz, then the
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recommended test frequency would be 1001.293945 Hz (i.e. N=372) and the Record
Length should be set to a value equal to or greater than the FFT size to avoid zero
padding. The following table lists the recommended test frequencies for different
sampling frequencies and FFT sizes. No window function is necessary if the
recommended test frequency is used.
FFT Size \ Sampling Frequency
1024
2048
4096
8192
16384
32768
65536
131072
262144

44100 Hz
990.5273438
990.5273438
1001.293945
1001.293945
1001.293945
999.9481201
999.9481201
999.9481201
999.9481201

48000 Hz
984.375
1007.8125
996.09375
1001.953125
999.0234375
1000.488281
999.7558594
1000.12207
999.9389648

96000 Hz
1031.25
984.375
1007.8125
996.09375
1001.953125
999.0234375
1000.488281
999.7558594
1000.12207

192000 Hz
937.5
1031.25
984.375
1007.8125
996.09375
1001.953125
999.0234375
1000.488281
999.7558594

In many cases, however, it may not be practical to ensure a FFT segment contains
exactly an integer number of cycles of the test signal (e.g. due to the round off error of
the test frequency, discrepancy in ADC and DAC clock frequency…), thus a proper
window function must be used to suppress the spectrum leakage, otherwise very
different and inaccurate results can be obtained. The software uses Kaiser 6 as the
default window function for the above parameter measurement. Other window
functions that can be used here includes: Kaiser 7 ~ Kaiser 20, Blackman Harris 7,
Cosine Sum 220, Cosine Sum 233, Cosine Sum 246, Cosine Sum 261.
Generally, if you use a sound card to generate the test signal and use the same sound
card (i.e. share the same ADC and DAC clock) to measure the above parameters, then
you should use the above recommended test frequencies, FFT size and sampling
frequency. The Record Length should be set to a value equal to or greater than the
FFT size (i.e. no zero padding) and Rectangle window function should be chosen in
the Spectrum Analyzer. If the ADC and DAC do not share the same clock, Kaiser 6
window and the like is then recommended, and zero padding is allowed in this case.
To measure the above parameters, you must define a frequency band within which the
total power of the signal (exclusive of the DC component), the power of the
fundamental frequency, the total power of all the harmonic frequencies, and the total
power of the noises are calculated. By default, the frequency band is set to 20 Hz ~20
kHz. Note that the upper limit of the frequency band must be equal to or lower than ½
of the sampling frequency. Otherwise, ½ of the sampling frequency will be used as
the upper limit of the frequency band internally by the software. If you tick the
harmonic order checkbox, you can further specify the maximum order of harmonics
used for the calculation of the total power of the harmonic frequencies. That is, the
power of a certain order of harmonic frequency will be taken into account only if it is
within the frequency band specified, and it is equal to or lower than the harmonic
order specified.
The “f1(Hz)” combo box specifies how the fundamental frequency f1 is determined:
(1) Peak (default)
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The fundamental frequency is the peak frequency detected in each channel.
(2) Max_A(EU), Min_A(EU), Mean_A(EU), RMS_A(EU), f1Freq_A(Hz) ~
f7Freq_A(Hz), Freq_A, RPM_A(rpm)
In Channel A, the fundamental frequency is the peak frequency detected in
Channel A.
In Channel B, the fundamental frequency is the value of the DDP selected.
Essentially it tracks the variation of the DDP in Channel A. Its applications
include order tracking. Max_A(EU), Min_A(EU), Mean_A(EU), RMS_A(EU)
are usually voltages that represent frequencies such as analog outputs from
some tachometers. They can be calibrated to Hz or RPM through
[Setting]>[Calibration]> “Sensor”> “Sensitivity” and “Unit”.
(3) Freq_B(Hz), RPM_B(rpm)
In Channel A, the fundamental frequency is the DDP selected. Essentially it
tracks the variation of the DDP in Channel B. Its applications include order
tracking.
In Channel B, the fundamental frequency is the peak frequency detected in
Channel B.
The options here are not symmetric with those in (2) for software simplicity.
(4) A positive value (in Hz)
The fundamental frequency in each channel is the one specified by the user. It
can be used in the cases where certain harmonics have higher amplitudes than
the fundamental.
Some recommended panel settings for the above parameter measurement are provided
in the Panel Setting File (PSF) directory of the software.
The following figure shows the THD related parameters of a laptop built-in sound
card measured using an external loopback cable.
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The following figures shows the THD related parameters of the same laptop built-in
sound card measured via a loopback at the sound card’s mixer level. As you can see
that all the parameters are substantially better than the above case, due to the fact that
the current measurement excluded the adverse contribution from the sound card’s
power amplifier (output) and mic amplifier (input) as well as the possible external
noises induced via the external loopback cable.
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Some professional sound cards in the market have excellent performances in audio
parameter measurements. The following figure shows the loopback measurement
result of an EMU Tracker Pre USB sound card. The measured THD is only
0.000351% and THD+N is only 0.001424%. Sound Card ASIO driver was used here
to avoid the possible Sampling Rate Conversion (SRC) performed automatically by
Sound Card MME driver which may introduce some additional distortions and noises.

A professional sound card together with the software is a very cost effective audio
analyzer solution. When measuring the output of an audio power amplifier, the signal
may need to be attenuated first using a linear attenuation circuit such as a simple
voltage divider formed by two resistors. It should also be noted that the loopback
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performance of the measuring device should be better than the performance of the
Device Under Test to ensure measurement quality. The loopback results of some
sound cards can be found at:


EMU Tracker Pre Test Report using Multi-Instrument
Download link:
http://www.virtins.com/doc/D1004/EMU_Tracker_Pre_Report_D1004.pdf



EMU 0204 Test Report using Multi-Instrument
Download link:
http://www.virtins.com/doc/D1007/EMU_0204_Report.pdf



Focusrite Scarlett Solo Test Report using Multi-Instrument
Download link:
http://www.virtins.com/doc/Focusrite-Scarlett-Solo-Test-Report-using-Multi-Instrument.pdf

For more information on the measurement of THD and its related parameters, please
refer to Measurement of Total Harmonic Distortion and Its Related Parameters using
Multi-Instrument.
Download link:
http://www.virtins.com/doc/Measurement-of-Total-Harmonic-Distortion-and-Its-Related-Parametersusing-Multi-Instrument.pdf

3.3.2.8.3.2 IMD
Intermodulation is the result of two or more signals of different frequencies being
mixed together, forming additional signals at frequencies that are not in general, at
harmonic frequencies (integer multiples) of either. Three types of Intermodulation
Distortion (IMD) can be measured: SMPTE/DIN IMD, CCIF2 IMD, CCIF3 IMD.
Note that the fourth option, DIM (Dynamic Intermodulation distortion), will be
introduced separately later.
SMPTE/DIN IMD is the most common IMD measurement. SMPTE standard RP1201983 and DIN standard 45403 are similar. Both specify a two-sinewave test signal
consisting of a large amplitude low-frequency tone linearly mixed with a highfrequency tone at ¼ the amplitude of the low frequency tone. SMPTE specifies 60 Hz
and 7 kHz mixed at 4:1. The DIN specification allows several choices in both
frequencies, with 250 Hz and 8 kHz being the most common. The IMD under this
category is defined here as the square root of the ratio of the power of the sidebands to
the power of the upper frequency. It is displayed in both percentage (%) and dB. The
sidebands used for this type of IMD calculation are fH-fL, fH+fL, fH-2fL, fH+2fL, where
fH and fL are the high frequency and low frequency of the test signal respectively.
IMD measured in this way is also called Modulation IMD (MOD).
CCIF IMD, also called Twin-Tone IMD, or Difference-Tone IMD, is another
common IMD measurement. The test specifies two equal-amplitude closely spaced
high frequency signals. The IMD under this category is defined here as the square
root of the ratio of the power of the intermodulation distortion products to the power
of the two test frequencies. It is displayed in both percentage (%) and dB. It has two
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sub-types: CCIF2 IMD and CCIF3 IMD. IMD measured in this way is also called
Difference Frequency Distortion (DFD). It is described in IEC60118 and IEC60268.
For CCIF2 IMD, the commonly used frequencies are: 19 kHz and 20 kHz. The
intermodulation distortion products used for this type of IMD calculation is: fH-fL, i.e.
only the low-frequency second-order product is used.
For CCIF3 IMD, the commonly used frequencies are: 13 kHz and 14 kHz, 14 kHz
and 15 kHz, or 15 kHz and 16 kHz. The intermodulation distortion products used for
this type of IMD calculation is: fH-fL, 2fL- fH, 2fH-fL, i.e. up to the third-order products
are used.
To conduct the above IMD tests, you can use the MultiTone generation function of
the Signal Generator to generate the test signal. Some sample test tones for IMD
measurements are provided under the Tone Configuration File (TCF) directory of the
software. It is also possible to use other signal generation source such as a CD, as the
software is able to detect the two test frequencies automatically.
Similar to the THD measurement, the IMD measurement is also very sensitive to
spectral leakage. According to the specified two test frequencies and their
intermodulation terms, it is almost impossible to ensure that each FFT segment
contains integer numbers of cycles of all these individual test frequencies. Therefore,
a window function must be used. The software uses the Kaiser 6 window by default
for the IMD tests. Other window functions that can be used includes: Kaiser 7 ~
Kaiser 20, Blackman Harris 7, Cosine Sum 220, Cosine Sum 233, Cosine Sum 246,
Cosine Sum 261. Some recommended panel settings for different IMD measurements
are provided in the Panel Setting File (PSF) directory of the software.
The following figure illustrates the SMPTE IMD of a laptop built-in sound card
measured using an external loopback cable.
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The following figure illustrates the DIN IMD of a laptop built-in sound card measured
using an external loopback cable.

The following figure illustrates the CCIF2 IMD of a laptop built-in sound card
measured using an external loopback cable.
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The following figure illustrates the CCIF3 IMD of a laptop built-in sound card
measured using an external loopback cable.

www.virtins.com

274 Copyright © 2006-2022

Virtins Technology

VIRTINS Multi-Instrument 3.9 Manual

Virtins Technology

Some professional sound cards in the market have excellent performances in audio
parameter measurements. The following figure illustrates the SMPTE IMD of an
EMU Tracker Pre USB sound card measured using an external loopback cable.

In addition to the IMD values, the two test tone frequencies and their RMS values
measured will also be displayed. The test tone frequencies here are measured with a
sub-FFT-bin-size accuracy. IMD can be accessed through the DDPs: IMD_A(%) and
IMD_A(dB) for Channel A and IMD_B(%) and IMD_B(dB) for Channel B.
For more information on IMD measurement, please refer to Measurements of Various
Intermodulation Distortions (IMD, TD+N, DIM) using Multi-Instrument.
Download link:
http://www.virtins.com/doc/Measurements-of-Various-Intermodulation-DistortionsIMD-TD+N-DIM-using-Multi-Instrument.pdf
3.3.2.8.3.3 Bandwidth
Bandwidth (-3dB) is defined here as the difference between the upper and lower
cutoff frequencies where the magnitude frequency response drops by –3 dB compared
with the highest peak. To obtain accurate bandwidth measurement, the magnitude
frequency response must be measured accurately with little fluctuation along the
curve. You can use the aforementioned “Smoothing via Moving Average” function to
make the curve smoother. Alternatively, you can always use the cursor reader to
obtain the bandwidth manually.
In most of the cases, the bandwidth and flatness of the magnitude frequency response
of a system is of more interest than the absolute gain of the output over the input at
different frequencies (i.e. the gain graph in Bode Plot). The former is easier to
measure as it measures only the output signal and does not need to measure the input
signal. There are quite a few ways to do it:
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(1) White noise stimulation + inter-frame average in Spectrum Analyzer
(2) Linearly swept sine stimulation + inter-frame peak hold in Spectrum Analyzer
(3) Linearly swept sine stimulation + it is captured and analyzed in one frame in
Spectrum Analyzer
(4) Pink noise stimulation + octave analysis and inter-frame average in Spectrum
Analyzer
(5) Multi-tones stimulation with each tone with an equal amplitude at the center
frequency of each octave band + octave analysis in Spectrum Analyzer
(6) Logarithmically swept sine stimulation + octave analysis in Spectrum Analyzer
(7) Impulse stimulation + Spectrum Analyzer
(8) MLS stimulation + inter-frame average in Spectrum Analyzer
(9) Periodic white noise stimulation + Spectrum Analyzer
(10) Periodic pink noise stimulation + octave analysis in Spectrum Analyzer
…
Some recommended panel settings for the above parameter measurement are provided
in the Panel Setting File (PSF) directory of the software.
The following figure illustrates the Bandwidth of a laptop built-in sound card
measured using the mixer-level loopback. White noise was used as the stimulus and
454 frames were averaged.

The following figure illustrates the bandwidth of an EMU Tracker Pre USB sound
card measured using an external loopback cable. The measured bandwidth is about
7.3Hz ~ 90443Hz when the sampling rate is 192 kHz. White noise was used as the
stimulus and 200 frames were averaged.
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Bandwidth can be accessed through these DDPs: BandWidthLowLimit_A(Hz) and
BandWidthHighLimit_A(Hz) for Channel A, and BandWidthLowLimit_B(Hz) and
BandWidthHighLimit_B(Hz) for Channel B. They can also be used to derive Quality
Factor and Damping Ratio.
To describe the degree of flatness of the magnitude frequency response within a
specified frequency band, four DDPs are provided per channel:
InBandMinRMS_A(EU): the minimum in the specified frequency band in Ch. A.
InBandMinF_A(Hz): the frequency at which the minimum is located in Ch. A.
InBandMaxRMS_A(EU): the maximum in the specified frequency band in Ch. A.
InBandMaxF_A(Hz): the frequency at which the maximum is located in Ch. A.
Similarly, InBandMinRMS_B(EU), InBandMinF_B(Hz), InBandMaxRMS_B(EU)
and InBandMaxF_B(Hz) are used for Ch. B.
3.3.2.8.3.4 Crosstalk
Crosstalk occurs when signal from one channel leaks into another channel. Crosstalk
is defined here as the ratio of the power of the fundamental frequency between the
channel without the test signal and the channel with the test signal. It is expressed in
dB. The input of the channel without the test signal must be terminated to the signal
ground to prevent external noises from entering. The test signal used should be a
single-frequency signal and the crosstalk value measured is for that frequency only.
The test tone frequency is measured with a sub-FFT-bin-size accuracy.
In the Spectrum Analyzer, two crosstalk values will be displayed, one is from
Channel A to Channel B, the other is from Channel B to Channel A. To measure the
former one, the test signal should be injected into Channel A, and to measure the
latter one, the test signal should be injected into Channel B. The test signal is
normally a sine wave. It is possible to inject two test signals with different frequencies
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(can be very close with each other but not the same) into the two channels
respectively so as to measure the mutual crosstalks simultaneously.
To minimize the effect of spectral leakage on the crosstalk measurement, the software
uses the Kaiser 6 window by default. Other window functions that can be used
includes: Kaiser 7 ~ Kaiser 20, Blackman Harris 7, Cosine Sum 220, Cosine Sum 233,
Cosine Sum 246, Cosine Sum 261.
The following figure illustrates the Crosstalk at 1 kHz from Channel A to Channel B
in a laptop built-in sound card measured using the mixer-level loopback.

The following figure illustrates the crosstalk at 1 kHz from Channel A to Channel B
of an EMU Tracker Pre USB sound card measured using an external loopback cable.
The crosstalk is about -109dB.
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Crosstalk can be accessed through these DDPs: CrossTalkAB(dB) for crosstalk from
Channel A to Channel B and CrossTalkBA(dB) for crosstalk from Channel B to
Channel A. Some recommended panel settings for crosstalk measurement are
provided in the Panel Setting File (PSF) directory of the software.

3.3.2.8.3.5 Harmonics
When this option is selected, the software will analyze up to the 100th harmonic and
display the fundamental frequency and its RMS value as well as the RMS values of its
2nd ~ 7th harmonics on the top of the spectrum graph. The fundamental frequency is
the peak frequency detected (with a sub-FFT-bin-size accuracy) if “f1(Hz)” is set to
“Peak”. Please refer to the previous THD section for detailed description of all
options of “f1(Hz)”. The fundamental frequency and its harmonic frequencies can be
accessed through the DDPs: f1Freq_A(Hz)~f7Freq_A(Hz) for Channel A, and
f1Freq_B(Hz)~f7Freq_B(Hz) for Channel B. Their respective RMS values can be
accessed through the DDPs: f1RMS_A(EU) ~ f7RMS_A(EU) for Channel A, and
f1RMS_B(EU) ~ f7RMS_B(EU) for Channel B. It should be noted that the
fundamental frequency and its RMS value can always be accessed in Amplitude
Spectrum Display regardless of the parameter measurement option selected. To
minimize the effect of spectral leakage on the fundamental and harmonic RMS value
measurement, the software uses the Kaiser 6 window by default. Other window
functions that can be used includes: Kaiser 7 ~ Kaiser 20, Blackman Harris 7, Cosine
Sum 220, Cosine Sum 233, Cosine Sum 246, Cosine Sum 261.
The phase angle of the fundamental frequency will also be displayed. It can be
accessed through these DDPs: f1Phase_A(D) for Channel A and f1Phase_B(D) for
Channel B. This option can be used to perform quantitative phase difference
measurement between the two channels, in contrast to the qualitative phase difference
measurement through Lissajous pattern. Note that the phase angle is of a sine function.
The fundamental and harmonic frequencies, RMS values and phases can also be
accessed through the following DDP Arrays: fnFreq_A(Hz)_Array[?],
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fnRMS_A(EU)_Array[?] and fnPhase_A(D)_Array[?] for Channel A, and
fnFreq_B(Hz)_Array[?], fnRMS_B(EU)_Array[?] and fnPhase_B(D)_Array[?] for
Channel B. The “?” should be replaced by the actual order of harmonic-1. That is,
“0” for fundament, “1” for the 2nd harmonic and so on. The maximum index number
allowed is “99”. Multi-Instrument features a specially designed algorithm which is
able to measure the phase of a harmonic accurately even when its amplitude is only
0.01% of that of the fundamental or the signal itself (when sampling bit resolution
=16). The following figure shows an example of harmonic analysis. DDP array
viewer is used to display the frequency, RMS value and phase of each harmonic. DDP
array viewer will be introduced later.

Two panel setting examples can be found at:
Pro\Harmonic_FFT32768_SR48000_SingleChannel.psf
Pro\Harmonic_FFT32768_SR48000.psf

3.3.2.8.3.6 Energy in User Defined Frequency Bands
When this option is selected, the software can analyze up to 100 user defined
frequency bands and display the RMS values of up to 8 of them on the top of the
spectrum graph. These values can be accessed through these DDPs:
fBand1RMS_A(EU)~ fBand8RMS_A(EU) for Channel A, and fBand1RMS_B(EU)~
fBand8RMS_B(EU) for Channel B. Note that the maximum number of bands that
can be defined here is actually 100. Their RMS values can be accessed through the
DDP arrays: fnRMS_A(EU)_Array[?] for Channel A and fnRMS_B(EU)_Array[?]
for Channel B. The“?” should be replaced by the actual frequency band number
starting from 0. The maximum allowed number is “99”.
The start and end frequencies of each frequency band can be specified and then the
specified frequency band can be added into the list box. Please note that the
calculation here is based on narrow band FFT and thus wide band octave analysis
should not be used. The finer the FFT frequency resolution, the more accurate the
results.
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If the X scale is set to an octave scale, this option will be disabled. Under octave
analysis, it is possible to obtain the RMS values of a particular octave band through
the DDP arrays: oBandRMS_A(EU)_Array[?] for Channel A and
oBandRMS_B(EU)_Array[?] for Channel B. The“?” should be replaced by the actual
octave band number starting from 0. Please note that when using a cursor reader to
read the RMS value of an octave band from the screen, the octave band number “N”
displayed starts from 1 instead of 0. Therefore, if you want to access the octave band
number
N=31
in
Channel
A
on
the
screen,
for
example,
oBandRMS_A(EU)_Array[30] should be used.
The concept of DDP array greatly expands the number of DDPs without defining
additional DDPs.
It is possible to access multiple elements of the array
simultaneously. One efficient way to view the DDP array is to use the DDP array
viewer which will be introduced later.

3.3.2.8.3.7 Peaks
When this option is selected, the software can detect up to 100 peaks and display up
to 7 peak frequencies and their RMS values on the top of the spectrum graph. They
can be accessed through these DDPs: f1Freq_A(Hz)~f7Freq_A(Hz) and
f1RMS_A(EU)~f7RMS_A(EU) for Channel A, and f1Freq_B(Hz)~f7Freq_B(Hz) and
f1RMS_B(EU)~f7RMS_B(EU) for Channel B. You can specify the number of peaks
to be displayed and the deadband between adjacent peaks. A peak spectral line in
frequency domain is normally surrounded by a few sub-peaks. The deadband is used
to avoid detecting these surrounding sub-peaks as peaks. Within the dead band
specified, only one peak can be detected. In other words, two adjacent peaks must be
at least one deadband apart. The detected peaks can be sorted by either magnitude or
frequency. It should be noted that the maximum number of peaks that can be detected
here is actually 100. The frequencies, RMS values and phases of the peaks can be
accessed through these DDP arrays: fnFreq_A(Hz)_Array[?], fnRMS_A(EU)_Array[?]
and fnPhase_A(D)_Array[?] for Channel A, and fnFreq_B(Hz)_Array[?],
fnRMS_B(EU)_Array[?] and fnPhase_B(D)_Array[?] for Channel B. The “?” should
be replaced by the actual peak number starting from 0. The maximum allowed
number is “99”. One efficient way to view the DDP array is to use the DDP array
viewer which will be introduced later.
To minimize the effect of spectral leakage on the peak RMS value measurement, the
software uses the Kaiser 6 window by default. Other window functions that can be
used includes: Kaiser 7 ~ Kaiser 20, Blackman Harris 7, Cosine Sum 220, Cosine
Sum 233, Cosine Sum 246, Cosine Sum 261. All the peak frequencies here are
measured with a sub-FFT-bin-size accuracy.
SFDR (Spurious Free Dynamic Range) is also calculated here. It is defined here as the
ratio of the power of the highest peak to that of the second highest peak, converted to
dB. It can be accessed through the Derived Data Points (DDPs): SFDR_A(dB) for
Channel A, and SFDR_B(dB) for Channel B.
3.3.2.8.3.7.1 Total Distortion + Noise (TD+N)
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Nonlinear distortion measurements depend heavily on the spectral content and level
of the stimulus. Single-tone THD and Dual-Tone IMD measurements are often
criticized for being far too simple to represent a real-world audio signal such as music
or speech. A multitone signal contains more than two frequencies and is a closer
resemblance of a real-world audio signal. It is usually used as a test signal for fast
frequency response measurements (a.k.a linear distortion measurements). Meanwhile,
it can also be used as a test signal for nonlinear distortion measurements. It excites
both harmonic and intermodulation distortions in a DUT simultaneously.
Total Distortion + Noise (TD+N) is defined here as the square root of the ratio of the
power of the total distortions plus noise to the power of all the fundamentals, in other
words, the square root of the ratio of the total power less the power of all the
fundamentals to the power of all the fundamentals. It is expressed in both percentage
(%) and dB. It can be accessed through the Derived Data Points (DDPs): TDN_A(%)
and TDN_A(dB) for Channel A, and TDN_B(%) and TDN_B(dB) for Channel B.
The frequency range of TD+N calculation can be set via [Spectrum Analyzer
Processing]>“Parameter Measurement”>“Range (Hz)”. The default range is
20Hz~20kHz. Multi-Instrument detects the fundamentals in the multitone response
automatically using its peak detection function. Therefore it is crucial that the
“Number of Peaks” and “Deadband” are set correctly according to the stimulus’s
multitone configuration.
The fundamental frequencies configured in the multitone signal should be carefully
chosen such that they do not coincide with their harmonics and intermodulation
products. The number of harmonic and intermodulation tones grows extremely fast
with the number of stimulus tones. Therefore, the number of stimulus tones is usually
kept below 32. Their phases should be selected to minimize the crest factor of the
overall signal. This can usually be achieved by randomizing or collectively optimizing
their initial phases.
The following figure shows the TD+N measurement results of a RTX6001 audio
analyzer. The multitone stimulus used consists of 250Hz, 1938Hz, 3626Hz, 5314Hz,
and 7002Hz tones.
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For more information on TD+N measurement, please refer to Measurements of
Various Intermodulation Distortions (IMD, TD+N, DIM) using Multi-Instrument.
Download link:
http://www.virtins.com/doc/Measurements-of-Various-Intermodulation-DistortionsIMD-TD+N-DIM-using-Multi-Instrument.pdf

3.3.2.8.3.8 Wow and Flutter
Flutter, wow, drift, and “scrape flutter” are all forms of distortion in analog recording
and reproducing systems that use a moving medium. These are caused by undesired
frequency modulation introduced into the signal by an irregular motion of the
recording medium during the recording, duplicating, and reproducing processes. The
measurement of wow and flutter quantifies the amount of 'frequency wobble' (caused
by speed fluctuations) present in subjectively valid terms. Different standards exist
for wow and flutter measurement. AES6-2008 (r2012) is used here. It is compatible
with IEC 60386, IEEE Std-193, CCIR 409-2, and DIN 45507. In particular, “Two
Sigma” method is used.
Drift refers to frequency modulation of the signal in the range below approximately
0.5 Hz resulting in distortion which may be perceived as a slow changing of the
average pitch.
Wow refers to frequency modulation of the signal in the range of approximately 0.5
Hz to 6 Hz resulting in distortion which may be perceived as a fluctuation of pitch of
a tone or program.
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Flutter refers to frequency modulation of the signal in the range of approximately 6
Hz to 100 Hz resulting in distortion which may be perceived as a roughening of the
sound quality of a tone or program.
“Scrape Flutter” refers to frequency modulation of the signal in the range above
approximately 100 Hz, which is caused by stick-slip motion (stiction) of the tape. It
results in distortion which may be perceived as a noise added to the signal – that is, a
noise not present in the absence of a signal. It is also called “friction noise” or
“stiction noise”.
During wow and flutter measurement, a test frequency, usually 3150Hz, is used. The
measured signal is demodulated first to obtain the instantaneous frequency deviation
from that test frequency. The variation of the instantaneous frequency deviation is
then weighted according to the subjective perception of human ears. The weighting
curve is shown as follows. It can be seen that the “Drift” and “Scrape Flutter” are
greatly suppressed by the weighting factor, leaving only the “Wow and Flutter”
prominent. An unweighted option is also provided in the software.

Then “Two Sigma” statistical analysis method is used to find the weighted peak
flutter (%). The cumulative time for which the instantaneous speed deviations (%)
exceeds the weighted peak flutter (%) in the positive or negative direction is equal to
5% of the given time interval. The peak wow and flutter value can be accessed
through the Derived Data Points (DDPs): WowAndFlutter_A(%) for Channel A, and
WowAndFlutter_B(%) for Channel B. In addition, RMS wow and flutter, RMS wow,
RMS flutter and RMS drift are also measured. They can be accessed through
WowAndFlutterRMS_A(%), WowRMS_A(%), FlutterRMS_A(%), DiftRMS_A(%)
for Channel A and a similar set of DDPs for Channel B. Their frequency ranges are
as follows.
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1) Peak and RMS Wow and Flutter, 0*~400Hz (weighted), 0*~0.4×[Test Frequency]
Hz (unweighted)
2) RMS Wow, 0.5~6Hz (weighted and unweighted)
3) RMS Flutter, 6~400Hz (weighted), 6~0.4×[Test Frequency] Hz (unweighted)
4) RMS Drift, 0.05*~0.5 Hz (unweighted always)
*The lowest frequency is equal to 1/[Sampling Duration]. For example, if the
[Sampling Duration] is 10 seconds, then the lowest frequency measurable is 0.1 Hz.
It should be noted that for this measurement, the Record Length of the Oscilloscope
must be greater than 5 s (corresponding to an achievable frequency resolution of 1/5 =
0.2 Hz) in order to achieve a sufficient accuracy. The test frequency does not have to
be 3150 Hz as the software can detect the average signal frequency automatically,
based on either the frequency peak detected in the Spectrum Analyzer or the
frequency counted by the frequency counter of the Multimeter. The latter will take
precedence if the Multimeter is opened and set to frequency counter mode. A FM
signal spans a frequency range and the peak frequency in that range may not be
located at the center. This measurement error in the Spectrum Analyzer usually
increases with the degree of wow and flutter. Typically, for 1% wow and flutter, the
error is less than 1%. Thus, there is generally no need to correct this error. On the
other hand, the frequency counted by the frequency counter of the Multimeter reflects
the true average frequency. Pre-configured panel setting files are available for both
methods. When the wow & flutter is lower than 1%, there is little difference between
these two methods.
Other than the average frequency detection, which may be affected by the settings in
the Spectrum Analyzer or frequency counter of the Multimeter, the rest of wow and
flutter measurement algorithm is independent and self-contained.
The following figure shows a 30s-long 3150Hz carrier frequency modulated by 20Hz
with a maximum frequency deviation of 3.15Hz. The theoretical unweighted peak
wow and flutter value is thus 3.15 / 3150 × sin(0.95×90°) = 0.0997%. The theoretical
weighted peak value is then 0.508 × 0.0997% = 0.0506%. This value is accurately
measured by the software as shown below.
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Four panel setting examples can be found at:
psf\Pro\WeightedPeakWowAndFlutter_10s.psf
psf\Pro\UnweightedPeakWowAndFlutter_10s.psf
psf\Pro\WeightedPeakWowAndFlutterFrequenceCounter_10s.psf
psf\Pro\UnweightedPeakWowAndFlutterFrequenceCounter_10s.psf
Please refer to the article Wow and Flutter Measurement using Multi-Instrument at
http://www.virtins.com/doc/Wow-and-Flutter-Measurement-using-MultiInstrument.pdf for more information.
3.3.2.8.3.9 Non-Coherence
This option is used to switch between the coherence and non-coherence function
display modes when the View Type of the Spectrum Analyzer is set to Coherence
Function. The Total Non-Coherent Distortion and Noise (TNCD) is calculated only
under the non-coherence function display mode. Please refer to the section for
Coherence / Non-Coherence Function for details.
3.3.2.8.3.10 GedLee Metric
It has long been known that the conventional nonlinearity metrics, such as THD and
IMD, don’t correlate well with human auditory perception. A number of new
nonlinearity metrics have been proposed by many researchers in the past, attempting
to take into account the subjective assessment in addition to the objective one. Among
them, a notable one is GedLee Metric, proposed by Dr. E.R.Geddes and Dr. L.W.Lee
in their paper “Auditory Perception of Nonlinear Distortion - Theory,” presented at
the 115th Convention of the Audio Engineering Society, October, 2003.
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GedLee metric (Gm) is a perceptually weighted quantitative measure of the
nonlinearity of an ideal memory-less (static) nonlinear system, which has no
frequency dependence or memory in time and thus has an infinite bandwidth. In such
a system, the instantaneous output y is determined only by the instantaneous input x
through the nonlinear transfer function T(x), i.e. y = T(x). Gm is defined by:

The second derivative of T(x) corresponds to the curvature of the T(x) curve. If the
system is linear, then the curve becomes a straight line and thus the curvature is zero.
As a result, Gm becomes zero. Squaring the second derivative of T(x) alleviates the
sign problem and makes upward and downward concave, both of which deviate from
a straight line, equally weighted. By taking the second derivative of the nonlinear
transfer function T(x), the metric gives more weight to higher order distortions as the
second derivative increases in value according to n×(n-1) where n is the order of nonlinearity in T(x)’s polynomial expansion. This attempts to account for the masking
effect of the human ear which tends to make higher order nonlinearities more audible
than lower order ones. Finally, the offset and linear gain terms in T(x) are completely
removed by taking the second derivative, leaving only the nonlinear distortion in Gm
calculation.
The squared cosine term in the above formula attempts to addresses another masking
effect which tends to cause nonlinearities that occur at low signal levels to be more
audible than those that occur at higher signal levels. It is unity at small values of the
signal and zero at the largest ones.
The product of the above two terms is then integrated along x from -1 to +1 (the
normalized range of the output signal) after which the square root is taken to yield
Gm.
In the real world, it is difficult to find an ideal memory-less system. Thus, T(x) is
frequency dependent in a real system, i.e. T(x,f). As a result, Gm(f) is also frequency
dependent. However, there is no ambiguity in performing calculation if Gm is
measured at a particular frequency. This is completely analogous to the case of THD.
Therefore, in Multi-Instrument, Gm is measured using a sine wave as the stimulus at a
particular frequency. It can be measured together with THD, THD+N, SNR, etc.
Please refer to the previous THD measurement section for the selection of a proper
testing frequency and window function in order to avoid or suppress the spectral
leakage in FFT and obtain correct measurement results. Unlike THD, Gm takes into
account the relative phase information of harmonics as well and thus it requires the
software to be able to measure the relative phase of each harmonic accurately. In
Multi-Instrument, to measure the phase of each harmonic, the FFT size must be set to
a value greater than ½ of the Record Length, but less than or equal to 1/1 of it. MultiInstrument features a specially designed algorithm which is able to measure the phase
angle of a harmonic accurately even when its amplitude is only 0.01% of that of the
fundamental or the signal itself. Same as the THD measurement, it is possible to
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specify the frequency range and the highest order of harmonics used to calculate Gm.
The highest order of harmonics allowed in Gm calculation is 100.
According to the aforementioned researches by Dr. Geddes and Dr. Lee, Gm < 1.0
can be expected to yield subjective ratings of “imperceptible” and Gm < 3.0 can be
expected to yield subjective ratings of “barely perceptible but not annoying”.
The following two examples (see figures below) are quoted from Keith Howard’s
article “Weighting Up”. The stimulus is a 1 kHz sine wave. In these two examples,
the measured harmonics have the same amplitudes but different relative phases. In
particular, the second example has its 3rd, 7th, 11th, 15th and 19th harmonics’ polarities
inverted (i.e. a phase difference of 180 degree) as compared to those of the first
example. The phase differences result in different waveforms: the first example
shows obvious cross-over distortions while the second one has obvious distortions at
its peaks and troughs. In both cases, the measured THD values are the same (about
6.48%), implying that THD is not able to differentiate these two cases. On the other
hand, the measured Gm values are very different: 2.22 and 0.92 respectively,
illustrating that Gm places greater emphasis on the nonlinear distortion perceived at
low signal levels than high ones, which is in accordance with the psychoacoustic
findings as well as the fact that the signal amplitude of a music is close to the zero
crossing for much of the time, with only infrequent excursions to high amplitudes.
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It should be noted that the phase angles displayed in the DDP array viewer (will be
introduced later) in the above two examples reference to sine functions. Internally in
the software, the nonlinear transfer function T(x) is expressed as a series of
harmonically related cosine terms. The measured phase angles of harmonics are
normalized with respect to that of the fundamental in terms of cosine functions, and
the measured amplitudes of the harmonics are normalized by that of the fundamental.
Gm is calculated according to its definition after these normalizations. No inter-frame
average in the Spectrum Analyzer is allowed in Gm calculation. Averaging, if needed,
can be done through DDP viewer.
Gm can be accessed through the Derived Data Points (DDPs): GedLeeMetric_A for
Channel A, and GedLeeMetric_B for Channel B. Two Panel Setting File examples
can be found at:
\psf\Pro\GedLeeMetric_FFT32768_SR48000_SingleChannel.psf
\psf\Pro\GedLeeMetric_FFT32768_SR48000.psf

3.3.2.8.3.11 Dynamic Intermodulation Distortion (DIM)
Nonlinear distortions, particularly in power amplifiers, can be categorized as either
static or dynamic. Those that result from basic device nonlinearity are called static
distortions. They are not really frequency dependent although their magnitude may
change with the change in feedback factor with frequency. Thus, the distortions vary
with frequency in direct proportion to the change in feedback with frequency. This
distinguishes such distortions from ones which inherently change magnitude with
frequency - often called “dynamic” distortions. Since dynamic distortions change with
frequency, even without a change in feedback with frequency, the addition of
frequency dependent feedback creates a high order dependence of distortion on
frequency. The term dynamic distortion has commonly referred to mechanisms which
get worse with fast or high frequency signals. In other words, dynamic distortion is
very much slew rate related, and thus it is sometimes called Slewing Induced
Distortion (SID) or Slope Induced Distortion (SID), Transient Intermodulation
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Distortion (TIM). It is excited by the signal rate of change and becomes worse when
slew rate limiting occurs.
Numerous techniques have been proposed for measuring static and dynamic
distortions. Measuring THD as a function of frequency and level yields a complete
performance profile of a DUT. For those severely bandlimited DUTs, other
techniques must be employed.
If static distortions are of special interest,
SMPTE/DIN IMD can be used. If dynamic distortions are of concern, CCIF should
be measured. If the DUT’s bandwidth allows, measuring DIM is an effective and
efficient way to characterize both the static and dynamic distortions. It is designed to
be particularly sensitive to distortions produced during transient conditions.
According to IEC 60268-3, the DIM test signal consists of a bandlimited square wave
component at a frequency of 3.15 kHz and a sine wave component at a frequency of
15 kHz with an amplitude of ¼ of that of the square wave component. Two DIM tests
are common: DIM30 and DIM100. DIM30 uses a single-pole low-pass filter with a
cutoff frequency of 30 kHz while in DIM100 the cutoff frequency is 100 kHz. In both
tests, nine intermodulation products are measured. They are listed in the following
table.
Intermodulation
(fq=3.15 kHz, fs=15 kHz)
5fq - fs
fs - 4fq
6fq - fs
fs - 3fq
7fq - fs
fs - 2fq
8fq - fs
fs - fq
9fq - fs

Frequency (kHz)

Symbol

0.75
2.40
3.90
5.55
7.05
8.70
10.20
11.85
13.35

U1
U2
U3
U4
U5
U6
U7
U8
U9

DIM is calculated as the square root of the ratio of the power of the above nine
intermodulation products to the power of the 15 kHz sine wave. It is expressed as a
percentage or in dB. The following DDPs are used to store the related parameters.
(1) IMD_A(%): DIM in % for Channel A
(2) IMD_A(dB): DIM in dB for Channel A
(3) F1Freq_A(Hz)~ F7Freq_A(Hz): 3.15 kHz, 15 kHz, frequencies of U1~U5 for
Channel A
(4) f1RMS_A(EU): 3.15 kHz RMS value, 15 kHz RMS value, RMS values of
U1~U5 for Channel A
(5) fnFreq_A(Hz)_Array[0]~fnFreq_A(Hz)_Array[10]: 3.15 kHz, 15 kHz,
frequencies of U1~U9 for Channel A
(6) fnRMS_A(EU)_Array[0]~fnRMS_A(EU)_Array[10]: 3.15 kHz RMS value,
15 kHz RMS value, RMS values of U1~U9 for Channel A
There are a similar set of DDPs for Channel B.
The DIM test signal can be generated using the Multitone function of the Signal
Generator of the software. Four DIM test tone configurations can be found in the
software’s TCF subdirectory:
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(1) DIM30_SharplyBandLimited
The square wave component is sharply bandlimited by a 30 kHz brick-wall
(ideal) low-pass filter. An output sampling rate of at least 96 kHz is
recommended for signal generation.
(2) DIM30_SinglePole_LowpassFiltered
The square wave component is bandlimited by a 30 kHz single-pole (firstorder) low-pass filter. An output sampling rate of at least 192 kHz is
recommended.
(3) DIM100_SharplyBandLimited
The square wave component is sharply bandlimited by a 100 kHz brick-wall
(ideal) low-pass filter. An output sampling rate of at least 192 kHz is
recommended for signal generation.
(4) DIM100_SinglePole_LowpassFiltered
The square wave component is bandlimited by a 100 kHz single-pole (firstorder) low-pass filter. An output sampling rate of at least 384 kHz is
recommended for signal generation.
Two panel setting examples for DIM30 and DIM100 measurements respectively can
be found at:
\psf\pro\DIM30_FFT131072_SR192000.psf
\psf\pro\DIM100_FFT262144_SR384000.psf
The square wave components are single-pole low pass filtered in the above two
settings. The default window function for DIM measurement is the Kaiser 6 window.
Other window functions that can be used includes: Kaiser 7 ~ Kaiser 20, Blackman
Harris 7, Cosine Sum 220, Cosine Sum 233, Cosine Sum 246, Cosine Sum 261. The
following figure shows the measured DIM30 of a RTX6001 audio analyzer.
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For more information on DIM measurement, please refer to Measurements of Various
Intermodulation Distortions (IMD, TD+N, DIM) using Multi-Instrument.
Download link:
http://www.virtins.com/doc/Measurements-of-Various-Intermodulation-DistortionsIMD-TD+N-DIM-using-Multi-Instrument.pdf
3.3.2.9 Spectrum Analyzer X Scale (Setting SubMenu) (ALT-S-X)
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Selection of X Scale is only available in Amplitude Spectrum, Phase Spectrum,
Coherence Function, and Transfer Function displays. The horizontal axis (X) can be
set to Linear, Logarithmic, Octave (1/1, 1/3, 1/6, 1/12, 1/24, 1/48, 1/96). The X Scale
dialog can also be accessed by double clicking on the X axis.
Octave scales are only available in Amplitude Spectrum display. When an octave
scale is selected, the software will check the corresponding minimum FFT size
required and change the current FFT size automatically if necessary. The larger the
FFT size, the more accurate the octave analysis. The window function will be set to
“Rectangle” by default under octave analysis.
The X axis in Amplitude Spectrum, Phase Spectrum, Coherence Function, and
Transfer Function displays is a frequency axis. By default, the X axis starts from 0 Hz
in linear scale, a frequency equal to the FFT frequency resolution in logarithmic scale,
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and the lowest octave band in octave scale. If the above Start Frequency checkbox is
ticked, you can customize the start frequency of the X axis.

3.3.2.10 Spectrum Analyzer Y Scale (Setting SubMenu) (ALT-S-Y)

Selection of Y Scale is only available in Amplitude Spectrum as well as Transfer
Function. It can also be accessed by double clicking on the Y axis.
3.3.2.10.1 Under Amplitude Spectrum Mode
There are two display modes for the vertical axis (Y): Absolute Display Mode and
Relative Display Mode.
Under Relative Display Mode, the vertical axis is scaled relatively with reference to
the maximum value in the current measurement (i.e. Vr=peak), in either linear or
logarithmic (dBr) scale. When “dBr” is selected, it is also possible to set its reference
level at a particular frequency instead of using the maximum value.
Under Absolute Display Mode, all spectral data points are plotted based on their
absolute values, in Vrms, dBV, dBu, dB, or dBFS. Note that by definition, the
reference voltages for dBV and dBu are 1 Vrms and 0.775 Vrms respectively. 1 dBu

www.virtins.com

294 Copyright © 2006-2022

Virtins Technology

VIRTINS Multi-Instrument 3.9 Manual

Virtins Technology

in amplitude spectrum is equivalent to 1 dBm in power spectrum when the load is 600
ohms. The reference level (Vr) for dB is user definable. To set the Vr, press the “Set
Vr” button, the Calibration Setting dialog box will pop up. Enter the values of 0dB
Reference Vr for both channels at the upper right corner. (Please refer to the section
for “0dB Reference Vr” introduced previously). The reference voltage for dBFS is
the input full-scale voltage (1/2 Vpp). When dBFS is used in the context of peak
values, there is no ambiguity. However, when it is used in the context of RMS values
such as the ones in the case of spectra, there are two conventions: 0 dBFS = Full Scale
Sine Wave or 0 dBFS = Full Scale Square Wave. The difference between the two is
3.01dB. Note that, if the Sensor Engineering Unit is not “V”, then the above options
will be changed accordingly but the concept remains the same. Please refer to Section
“Channel A Display Range” described previously for details.
If the “Per Hz” option is ticked, the Spectrum Analyzer will display the amplitude
spectral density function for Vrms and the respective power spectral density function
for dBV, dBu, dB and dBFS.
“Convert to Impedance” option is enabled when the Spectrum Analyzer is in
Amplitude Spectrum mode or Transfer Function / Impedance Analyzer mode. The
former allows using the single-channel method to measure the impedance vs
frequency plot, while the latter allows using the dual-channel method to measure the
impedance and phase vs frequency plot. These two methods have already been
described previously.
3.3.2.10.2 Under Transfer Function Mode
The “Gain Scale” option is enabled under Transfer Function mode. It can be set on
either linear or dB scale.

3.3.2.11 Spectrum Analyzer Chart Options (Setting SubMenu) (ALT-S-O)
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Same as Oscilloscope except the Mark Peaks option.
Mark Peaks option will be enabled for selection under the following parameter
measurements: None, THD, IMD, Crosstalk, Harmonics, Peaks. When this option is
ticked, the relevant peaks in the spectrum will be marked at their accurately calculated
no-spectral-leakage heights and accurately interpolated frequencies which may not be
located at the centers of FFT bins, with or without labels. The following figure shows
an IMD DIN measurement with the relevant peaks marked with labels.

In single-channel 1/1 or 1/3 octave analysis, if "Mark Peaks" is ticked and [Spectrum
Analyzer Y Scale] is in dBV, dBu, dB or dBFS, the Y value of each octave band will
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be displayed as text on the spectrum graph. This would be convenient during EQ
processes.

3.3.2.12 Spectrum Analyzer Reference (Setting SubMenu) (ALT-S-R)

Similar to Oscilloscope. The related six DDPs are: SpectrumComparisonH_A,
SpectrumComparisonL_A,
SpectrumSimilarity_A,
SpectrumComparisonH_B,
SpectrumComparisonL_B, SpectrumSimilarity_B.
3.3.2.13 Save Current Panel Setting as Default (Setting SubMenu) (ALT-S-F)
Same as Oscilloscope.
3.3.2.14 Save Current Panel Setting (Setting SubMenu) (ALT-S-S)
Same as Oscilloscope.
3.3.2.15 Load Panel Setting (Setting SubMenu) (ALT-S-L)
Same as Oscilloscope.
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3.3.2.16 Configure Hot Panel Setting Toolbar (Setting SubMenu) (ALT-S-P)
Same as Oscilloscope.
3.3.2.17 Show Hot Panel Setting Toolbar (Setting SubMenu) (ALT-S-H)
Same as Oscilloscope.
3.3.2.18 Change Password (Setting SubMenu) (ALT-S-W)
Same as Oscilloscope.
3.3.3 Instrument SubMenu
Same as Oscilloscope.
3.3.4 Window SubMenu
Same as Oscilloscope.
3.3.5 Help SubMenu
Same as Oscilloscope.

3.4 Cursor Reader and Markers
Similar to Oscilloscope.

3.5 Peak Values
Spectrum Analyzer will display the peak frequency in Amplitude Spectrum display,
the second peak time delay and the corresponding coefficient in Auto Correlation
Function display, the peak time delay and the corresponding coefficient in Cross
Correlation Function display, the peak frequency and the corresponding coefficient in
Coherence Function display, the peak frequency and the corresponding gain and
phase in Gain and Phase display, the peak time in Impulse Response display.

3.6 Context Menu
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The above context menu will be shown when right clicking anywhere within the
Spectrum Analyzer view. It provides additional convenience to you. All menu items
in the context menu can also be found in the spectrum analyzer main menu except the
following items:


Copy As Bitmap
Same as Oscilloscope



Copy As Text
Same as Oscilloscope



Generate Frequency Compensation File (Reference)
This command is used to generate a Frequency Compensation File, which
compensates the currently measured magnitude frequency response in Channel A
to that in Channel B with the compensation factor at 1 kHz being 0 dB. Channel
A is the one to be compensated and Channel B is the reference. For example, you
can connect the microphone to be compensated in Channel A and the reference
microphone in Channel B, and generate a Frequency Compensation File for the
microphone in Channel A using pink noise or white noise as the stimulus. The
generated Frequency Compensation File can be loaded later for frequency
compensation.



Generate Frequency Compensation File (Flat)
Under amplitude spectrum mode, this command is used to generate a Frequency
Compensation File, which compensates the currently measured magnitude
frequency response to a flat one with the compensation factor at 1 kHz being 0 dB.
For example, you can use this command to generate a Frequency Compensation
File which compensates the frequency response of a sound card to a flat frequency
response using white noise and a loopback cable from the sound card’s output to
its input. The generated Frequency Compensation File can be loaded later for
frequency compensation.
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Under transfer function mode (and not in its impedance measurement mode), this
command is used to generate a Gain and Phase Compensation file, which can be
used to compensates the currently measured gain and phase to 0 dB and 0 degree
respectively. For example, you can use this command to generate a Gain and
Phase Compensation file which eliminates the small gain and phase difference
between the two input channels of the measuring device itself.


AutoScaling
It adjusts the vertical display scales based on the peak values in the sampled data
frame.



Separate Display
It separates the display of Channel A from that of Channel B vertically.



Merge Display
It merges the displays of Channel A and Channel B vertically.



Display Ch. A Only
It will hide other channels and display Ch. A only in all views.



Display Ch. B Only
It will hide other channels and display Ch. B only in all views.



Display All
It will display all channels in all views.
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4 Signal Generator
4.1 Overview

This is a dual channel Signal Generator (Sweep / Arbitrary/ Function/ Burst/ Noise/
Modulation/ Playback Generator), providing the following types of waveforms for
output:





Sine
Rectangle (with adjustable duty cycle)
Triangle
Saw Tooth
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White Noise
Pink Noise
Multi-tones
Arbitrary via user-configurable waveform library (WFLibrary)
Maximum Length Sequence (MLS), with adjustable length (127~16777215)
Dual Tone Multi-Frequency (DTMF)
Unit Impulse
Unit Step
Musical Scale
Wave File

at either a fixed frequency, or a frequency that sweeps linearly or logarithmically
within a specified frequency range and time duration. The output signal can be looped
back partially (i.e. only one channel while the other channel can be used for field
input) or fully (i.e. both channels), via the software itself, to the input of the
Oscilloscope for display and analysis in real time. Synchronized operation between
the Signal Generator and the Oscilloscope with a timing accuracy in the same order of
the sampling frequency is allowed. Amplitude sweeping, burst signal generation,
output signal fade in/out and modulation (AM, FM, PM) are also supported. In
addition to the streaming mode, the software supports DDS (Direct Digital Synthesis)
mode when the hardware used supports DDS.
For a sound card based system, the accuracy of the output signal is dependent on the
sound card. Almost all sound cards are "AC coupled" and thus will filter out DC and
near-DC components. As a result, signal components below approximately 10 Hz
may be distorted. The flatness of pulses and rectangle waves may be affected and
ramp signals may become non-linear.
The Signal Generator panel is intentionally made compact so that it can be displayed
and operated simultaneously with other instruments within the confinement of the
screen. You can un-tick the “Show Editor” checkbox to make the panel even smaller
after you have set your desired parameters.
The toggle button
in the Instrument Toolbar is used to open or close the Signal
Generator. You can also close it by clicking the "Close" button at the upper right
corner of the Signal Generator panel.

4.2 Output Sampling Parameters
The sampling capability is fully dependent on the DAC device. Once the sampling
parameters are specified and the Run button is clicked, it will attempt to start
outputting using the specified sampling parameters. An error message will pop up if
the specified sampling parameters are not supported by the DAC device.
Note that some sound cards may not generate error messages even if the sampling
frequency specified exceeds their limits. Please check your sound card manual before
you can use a sampling frequency greater than 44100 Hz, otherwise measurement
error may be introduced.
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4.2.1 Sampling Frequency

For a sound card based system, the following sampling frequencies can be selected:
2kHz, 4kHz, 8kHz, 11.025kHz, 16kHz, 22.05kHz, 32kHz, 44.1kHz, 48kHz, 64kHz,
88.2kHz, 96kHz, 176.4kHz, 192kHz, 384kHz, 768kHz.

4.2.2 Sampling Channels

Two options are available:


A
Only Channel A is sampled. For stereo sound cards, this will output the same
signal in both channels.



A&B
Both Channel A and Channel B are sampled. Therefore, different signals can be
generated in different channels.

4.2.3 Sampling Resolution

Three options are available: 8 Bit, 16 Bit, 24 Bit.
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4.3 Output Signal Parameters
Each channel has its own output signal parameters.
4.3.1 Output Waveform

There are 14 options available.

4.3.1.1 None
No signal will be generated, i.e. the output will be zero. No output frequency and
output amplitude need to be specified.

4.3.1.2 Sine

A sinusoidal waveform will be generated. Note that the above figure also illustrates
the initial phase of the generated signal. If you tick the “No Spectral Leakage” option,
the frequency of the sinusoidal wave you specify will be fine tuned to the nearest
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integer multiple of [Sampling Frequency of the Oscilloscope] / [FFT Size of the
Spectrum Analyzer], once the “No Spectral Leakage” checkbox is ticked or the Run
button of the Signal Generator is pressed. For example, if the sinusoidal wave
frequency you specify is 1 kHz, the Sampling Frequency of the Oscilloscope is 48
kHz, and the FFT Size of the Spectrum Analyzer is 16384, then the sinusoidal wave
frequency will be changed to 999.0234375 Hz. This option is used to ensure that an
FFT segment in the Spectrum Analyzer contains exactly an integer number of cycles
of the signal so as to avoid the spectral leakage issue, if the generated signal will be
sampled by the Oscilloscope. Rectangle window function should be used in the
Spectrum Analyzer when no spectral leakage occurs.

4.3.1.3 Rectangle

A rectangle waveform will be generated. Note that the above figure also illustrates the
initial phase of the generated signal. The duty cycle of the rectangle wave can be
specified (refer to the figure below).

4.3.1.4 Triangle
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A triangle waveform will be generated. Note that the above figure also illustrates the
initial phase of the generated signal.

4.3.1.5 Saw Tooth

A saw tooth waveform will be generated. Note that the above figure also illustrates
the initial phase of the generated signal.

4.3.1.6 White Noise
White Noise will be generated. White noise has an equal amount of energy per Hz of
bandwidth. No output frequency needs to be specified.
Unlike most of the digital white noise generators in the market, which eventually
repeat the same segment of white noise, the white noise generated here is "true" white
noise without any form of repetition. This is very useful when you want to use
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averaging method to obtain the frequency response of a Device Under Test (DUT)
with a continuous white noise excitation. The white noise generated here has a
statistically flat spectrum from 0Hz to ½ sampling frequency. Multi-Instrument is
also capable of generating a periodic or pseudo random white noise in a specified
frequency range with an ideally flat spectrum even without averaging under restricted
conditions. This will be introduced later in the Multitones section.
The following figure illustrates the white noise generated by the software. It has a
very flat amplitude spectrum (in dBV) in the range of 0 Hz ~1/2 sampling frequency.

The following figure is the 1/12 octave amplitude spectrum (in dBV) of the same
white noise. It shows an incremental of 3dB per octave.
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By default, the generated white noises in different channels are not correlated. To generate identical
white noises in both channels, tick “Same Across Channels” checkbox in the following figure.

4.3.1.7 Pink Noise
Pink Noise will be generated. Pink noise has an equal amount of energy per octave of
bandwidth. No output frequency needs to be specified.
Unlike most of the digital pink noise generators in the market, which eventually
repeat the same segment of pink noise, the pink noise generated here is "true" pink
noise without any form of repetition. This is very useful when you want to use
averaging method to obtain the magnitude frequency response of a Device Under Test
(DUT) with a continuous pink noise excitation. The pink noise generated here has a
statistically equal amount of energy per octave of bandwidth from 0Hz to ½ sampling
frequency. Multi-Instrument is also capable of generating periodic or pseudo random
pink noise in a specified frequency range with an ideally equal amount of energy per
octave of bandwidth even without averaging under restricted conditions. This will be
introduced later in the Multitones section.
The following figure illustrates the pink noise generated by the software. Its
amplitude spectrum (in dBV) shows a slope of -3dB/octave.
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The following figure is the 1/12 octave amplitude spectrum (in dBV) of the same pink
noise. It shows that the spectrum is rather flat in octave scale.
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By default, the generated pink noises in different channels are not correlated. To generate identical
pink noises in both channels, tick “Same Across Channels” checkbox in the following figure.

4.3.1.8 MultiTones

If MultiTones is selected, the above MultiTones Configuration dialog window will
pop up. There are two configuration methods: Manual or Automatic.
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4.3.1.8.1 Manual Configuration
Manual configuration mode allows you to manually add signals with different
waveforms, frequencies, amplitudes and initial phases together. You can add as much
as 200 tones for each channel. The available waveform options are: Sine, Square,
Triangle, Saw Tooth, White Noise, Pink Noise.
The available options for Frequency are: 50 MHz, 20 MHz, 10 MHz, 5 MHz, 2 MHz,
1 MHz, 500 kHz, 200 kHz, 100 kHz, 50 kHz, 20 kHz, 10 kHz, 5 kHz, 2 kHz, 1kHz,
500 Hz, 200 Hz, 100 Hz, 50 Hz. Alternatively, you can enter any value that is less
than or equal to half of the output sampling frequency specified in the Signal
Generator panel. The frequency selected or entered must be greater than or equal to 1
and less than or equal to half of the output sampling frequency. Otherwise an error
message will pop up. It will round off to an integer value even if a non-integer value
is entered. As the output frequency for each tone has already been specified in this
configuration, no output frequency needs to be specified in the Signal Generator panel.
Relative Amplitude, ranging from 0 to 1, is used as the amplitude weighting factor
when different waveforms are added together, in order to define their relative strength.
However, it has no impact on the absolute output amplitude. The absolute output
amplitude is specified in the Signal Generator panel. It refers to the maximum value
of the resultant waveform of the MultiTones.
You can add a tone into the MultiTones configuration for each channel by clicking ">" button and you can remove a tone from the MultiTones configuration by clicking
"<-" button. The MultiTones configuration can be saved and reloaded. The default
extension for a MultiTones configuration file is .tcf.
If all the configured tones are sine waves, the “Phase Optimization” button and the
“Crest Factor Preview” button will be enabled. If the “Phase Optimization” button is
clicked, the software will try to minimize the crest factor of the synthesized waveform
by adjusting the phase of each tone and in the end prompt you to confirm if you want
to replace the current phases with the optimized ones. The process may take some
time. The optimization algorithm usually works well when all tones are harmonically
related.
You can change or review the MultiTones configuration by clicking on the following
button in the Signal Generator panel
Configuration dialog window.

.

It will bring up the MultiTones

When the Sweep checkbox in the Signal Generator panel is ticked, a MultiTone
waveform can be generated at a frequency (or amplitude) that sweeps linearly or
logarithmically within specified frequency (or amplitude) range and time duration.
Under frequency swept mode, the frequencies specified in the Multitones
Configuration will be ignored and the Start Frequency and End Frequency specified in
the Signal Generator panel will be used instead.

4.3.1.8.2 Automatic Configuration
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Automatic configuration mode is activated by selecting the “Automatic” checkbox in
the MultiTones Configuration dialog window. This mode is used to automatically
configure a multitone signal consisting of multiple frequencies within the specified
frequency range. These frequencies can be aligned one by one to either the FFT
bands or the fractional octave bands (1/1, 1/3, 1/6, 1/12, 1/24, 1/48, 1/96) that are set
in the Spectrum Analyzer, in order to achieve a designated spectrum if the generated
signal is to be sampled by the Oscilloscope and analyzed by the Spectrum Analyzer.
The designated spectrum can be white, pink or arbitrary. The initial phase of each
tone is randomized to avoid any prominent time-domain pattern (e.g. much-higherthan-RMS peaks, steep jumps or falls, etc.) in the aggregate signal and make it noiselike. However, unlike white noise and pink noise, this noise-like multitone signal is
deterministic and periodic. Thus it is only pseudo random. One distinct advantage of
using this type of periodic noises is that it converges much faster in frequency
response tests and thus requires much less number of averages or even no average.
The frequency response tests here include magnitude frequency response, transfer
function, coherence function, impulse response, impedance & phase tests, etc..
Another distinct advantage is that the test signal’s frequency range and the amplitudefrequency profile can be easily controlled. For example, a bandlimited periodic pink
noise for speaker tests can be readily generated using this method.
Three phase options are provided: Randomized, Optimized 1 and Optimized 2, with
increasing chances of finding a smaller crest factor while taking more time. The phase
optimization algorithm here works well under almost all conditions. However, the
signals generated with “Optimized 1” and “Optimized 2” are less noise-like than the
“Randomized” ones. The“Crest Factor Preview”button can be used to preview the
crest factor. Meanwhile, it pre-generates the waveform and save some initial time
when outputting the real signals.

4.3.1.8.2.1 Align To FFT Bands
If the multitones are aligned to FFT bands, each FFT band in the specified frequency
range will be filled with a tone with a relative level defined by the “Frequency
Response”. Three options are available in the “Frequency Response” selection box:
white noise, pink noise, and arbitrary. These tones are spaced at an interval equal to
the FFT resolution. The period of the resulting signal equals to [FFT Size] /
[Sampling Frequency].
It should be noted that the sampling rates of the Oscilloscope and Signal
Generator must be kept the same in order for this option to function properly.
4.3.1.8.2.1.1 Periodic White Noise
If the “Frequency Response” is set to “White Noise”, a periodic white noise will be
generated within the specified frequency range. If this signal is used for magnitude
frequency response measurement, the following restrictions should be noted:
1) Do not change FFT size and sampling rate after the signal is already generated.
2) Rectangle window should be used
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3) [Record Length] >= [FFT Size]
4) Narrowband FFT rather than broadband octave analysis in the Spectrum Analyzer
should be used
However, if this signal is employed in transfer function or impulse response
measurement which involves division operations in frequency domain, some
prominent artefacts may show up if the stimulus is ideally band limited and cannot
cover the entire frequency range from 0 to ½ sampling rate. In that case, a window
function other than the Rectangle window should be applied.
The following figure shows a multitone signal aligned to 32768-point FFT with a
white noise frequency response in the range of 20 Hz ~ 20 kHz, and analyzed using
narrowband FFT. It can be seen from the figure that the spectrum is ideally flat even
without averaging.

4.3.1.8.2.1.2 Periodic Pink Noise
If the “Frequency Response” is set to “Pink Noise”, a periodic pink noise will be
generated within the specified frequency range. If this signal is used for magnitude
frequency response measurement, the following restrictions should be noted:
1) Do not change FFT size and sampling rate after the signal is already generated.
The larger the FFT size, the more accurate the octave analysis
2) Rectangle window should be used
3) [Record Length] >= [FFT Size]
4) Broadband octave analysis rather than narrowband FFT in the Spectrum Analyzer
should be used
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However, if this signal is employed in transfer function or impulse response
measurement which involves division operations in frequency domain, some
prominent artefacts may show up if the stimulus is ideally band limited and cannot
cover the entire frequency range from 0 to ½ sampling rate. In that case, a window
function other than the Rectangle window should be applied.
The following figure shows a multitone signal aligned to 32768-point FFT with a pink
noise frequency response in the range of 20 Hz ~ 23 kHz, and analyzed using 1/3
octave band analysis. It can be seen from the figure that the spectrum is ideally flat
even without averaging.

4.3.1.8.2.1.3 Signal with an Arbitrary Spectrum
If the “Frequency Response” is set to “Arbitrary”, a frequency response file needs to
be selected. Please refer to the section regarding arbitrary digital filter in the
Oscilloscope described previously for the format of the frequency response file (*.frf).
If the generated signal is to be sampled by the Oscilloscope, to achieve the designated
spectrum in the Spectrum Analyzer, the following restrictions should be noted:
1) Do not change FFT size and sampling rate after the signal is already generated.
2) Rectangle window should be used
3) [Record Length] >= [FFT Size]
In the FRF subdirectory of the software, some samples frequency response files are
provided, including:
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RecordingRIAA.frf
ReproducingRIAA.frf
SpeechMale.frf
SpeechFemale.frf

The following figure shows a periodic noise signal generated using
RecordingRIAA.frf. It can be used as a frequency response test signal for phono preamplifiers.

The following figure shows a periodic noise signal generated using SpeechMale.frf.
It can be used as the male Speech Transmission Index test signal according to IEC
60268-16.
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The gender-specific spectra of STI test signals are defined in IEC 60268-16 as follows.

4.3.1.8.2.2 Align To 1/1~1/96 Octave Bands
If the multitones are aligned to 1/1~1/96 octave bands, each octave or fractional
octave band in the specified frequency range will be filled with a tone with an equal
level. No frequency response option is available. These tones are an octave or a
fractional octave band apart and thus the spectrum of the multitones follows that of a
pink noise. If this signal is used for magnitude frequency response measurement, the
following restrictions should be noted:
1) Broadband octave analysis rather than narrowband FFT in the Spectrum Analyzer
should be used. Do not change to a finer octave band analysis than the one
specified by “Align to”. The larger the FFT size, the more accurate the octave
analysis.
2) Rectangle window is recommended for most of the cases.
In the TCF subdirectory of the software, OCT1_MultiTone_11.tcf,
OCT3_MultiTone_32.tcf, OCT6_MultiTone_63.tcf and OCT12_MultiTone_125.tcf
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are manually configured Tone Configuration Files (*.tcf) for 1/1, 1/3, 1/6, 1/12 octave
band stimulation in the frequency range of 20 Hz ~ 20 kHz, respectively. Each
frequency in these configurations has a fixed initial phase of 0 degree. The following
figure shows the 1/3 octave amplitude spectrum (in dBV) of a multitone signal
generated using OCT3_MultiTone_32.tcf.

The following figure shows the 1/3 octave amplitude spectrum (in dBV) of a
multitone signal aligned to 1/3 octave bands in the range of 20 Hz ~ 20 kHz,
generated using the automatic configuration method instead.

Both of the above two figures have a perfectly flat spectrum in the range of 20 Hz ~
20 kHz under 1/3 octave analysis with a rectangle window function. However, the
former shows some patterns (unwanted sometimes) in time domain while the latter
does not.
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The following figure shows the 1/96 octave amplitude spectrum (in dBV) of a
multitone signal aligned to 1/96 octave bands in the range of 1 kHz ~ 2 kHz. It is
essentially a 1 kHz ~ 2 kHz band limited pink noise.

4.3.1.9 Waveform Library (WFLibrary)
If WFLibrary is selected, a dialog window will popup, asking you to select a
Waveform Library file (*.wfl), a BitPerfect Library file (*.bpl), or any file (*.*) that
conforms to the format of a Waveform Library file (*.wfl).

Both types of waveform libraries *.wfl and *.bpl define an arbitrary wave shape of
one cycle of the signal to be generated using a number of discrete samples (points).
When a Waveform Library file (*.wfl) is used, the output frequency (i.e. the repetition
rate of the defined wave shape) and amplitude can be specified explicitly. This
method works in a similar way as the DDS (Direct Digital Synthesis) method. Scaling,
resampling and interpolation are involved in order to generate the signal with the
specified frequency and amplitude. The resultant digital samples (before DAC) may
not have exactly the same values as the ones defined in the library. In this regard, it is
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not a bit perfect method. In contrast, when a BitPerfect Library file is used, the
samples inside in the library file will be output one by one by the output sampling
clock without any modification of their values. The output frequency and amplitude
are not specified explicitly. They can only be derived, if required, indirectly from the
samples in the library. Only file name with an extension “.bpl” will be treated as a
BitPerfect library file.

4.3.1.9.1 Waveform Library File (*.wfl)
A Waveform Library file defines an arbitrary wave shape for one cycle of the signal
to be generated. It is a Comma Separated Variable (CSV) text file with the following
format:
0,0,0
1,0.006135885,0.006135885
2,0.012271538,0.012271538
……
1022,-0.012271645,-0.012271645
1023,-0.006135992,-0.006135992
……
Each row contains the coordinates of a point of the waveform with three variables: the
sequential number, the relative amplitude value for Channel A, the relative amplitude
value for Channel B. Minimum two points must be specified per waveform and you
can define as many points as you want. There is no restriction on the range of the
relative amplitude value as relative values are used inside the software. However, for
easy understanding purpose, it is recommended to use values between –1 and 1. It
should be noted that if there is DC component in the waveform, it will be filtered out
if the signal is output via the sound card hardware.
You can use Microsoft EXCEL, Notepad or other third party software to composite a
Waveform Library file. One advantage of using Microsoft EXCEL is that you can
make use of its mathematical function to construct the wave shape and then use its
charting function to have a preview on it. There is no restriction on the file extension
to be used either. However, it is recommended to use .wfl as the file extension.
Waveform libraries provide great flexibility to the Signal Generator. Any arbitrary
wave shape can thus be generated by constructing a corresponding waveform library.
An arbitrary waveform can be generated at either a fixed frequency (or amplitude) or
a frequency (or amplitude) that sweeps linearly or logarithmically within the specified
frequency (amplitude) range and time duration.
You can change the waveform library by clicking on the following button in the
Signal Generator panel:

.

It will bring up the file "Open" Window.

Some sample WFL files are provided in the WFL subdirectory of the software.
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4.3.1.9.2 BitPerfect Library File (*.bpl)
A BitPerfect Library file defines an arbitrary wave shape for one cycle of the signal to
be generated. It is a Comma Separated Variable (CSV) text file with the following
format:
0,12582912,12582912
1,12582912,12582912
2,4194304,4194304
3,4194304,4194304
Each row contains the coordinates of a sample of the waveform with three variables:
the sequential number, the sample (a positive integer value) for Channel A, the
sample (a positive integer value) for Channel B. At least one sample must be specified
per waveform and you can define as many samples as you want. The positive integer
values must be within the range allowed by the output sampling bits: 0~255 for an 8bit DAC (unsigned, +FS = 255, -FS = 0), 0~65535 for a 16-bit DAC (signed, +FS =
32767, -FS = 32768), and 0~16777215 for a 24-bit DAC (signed, +FS = 8388607, -FS
= 8388608). This is in accordance with the WAV file format. The signed integers are
represented by two’s complement. Each output sampling clock pulse will push one
sample out until all the samples in the library are done before repeating from Sample
0 again. Thus the repetition rate of the defined waveform equals to [Sampling
Frequency] / [Number of Samples Defined in the BitPerfect library].
You can change the waveform library by clicking on the following button in the main
window of the Signal Generator:

.

It will bring up the file "Open" Window.

Some sample BPL files including those for jitter tests are provided in the WFL
subdirectory of the software.

4.3.1.9.2.1 J-Test Signal for Jitter Tests
The J-Test signal developed by Julian Dunn is widely used to stimulate worse-case
jitter over an AES3 digital audio connection, such as balanced and unbalanced pro
formats, as well as the coaxial and optical SPDIF consumer variants. It contains an
un-dithered “square wave” at 1/4 of the sample rate (e.g. 12kHz for a 48 kHz sample
rate), with an amplitude of a half of the full scale (Note: when converted to an analog
signal, the "square wave" would be bandlimited at the half of the sampling rate and
thus becomes a sine wave with an amplitude of 0.707 of the full scale), to which is
added an un-dithered low-frequency (usually at 1/192 of the sampling rate, e.g. 250Hz
for a 48kHz sampling rate) square wave with an amplitude of 1 LSB (Least
Significant Bit) toggling between 0 to -1 LSB. The spectrum of a 24-bit J-Test signal
sampled at 48kHz is shown in the following figure. The high-frequency sine wave
has a single frequency component at 12kHz while the low-frequency square wave has
a fundamental frequency at 250Hz and all its odd harmonics. It can be seen that the
12kHz signal exceeds its neighboring side bands by more than 170dB and the 250Hz
by more than 140 dB under no-jitter condition. This leaves a good room for jitter
measurement as jitter will show up as side bands around the signal frequency due to
its phase modulation nature.
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The above 24-bit J-Test signal is generated using the BitPerfect library: JTest_24Bit.bpl in the software’s WFL subdirectory. It consists of 192 samples in
HEX format:
C00000,C00000,400000,400000 (× 24)
BFFFFF,BFFFFF,3FFFFF,3FFFFF (× 24)
Or in Decimal format (only this format should be used in the BitPerfect library):
12582912,12582912,4194304,4194304 (× 24)
12582911,12582911,4194303,4194303 (× 24)
The above BPL file must be used with a sampling bit resolution of 24. It
automatically adapts to any sampling rate selected. For example, if the sampling rate
is 48kHz, the repetition rate of the waveform would be 48000/192=250 Hz. If the
sampling rate is 44.1kHz, the repetition rate would be 44100/192=229.6875 Hz. The
16-bit counterpart of this file is J-Test_16Bit.bpl in the same subdirectory.
SineAtOneFourthFs_24Bit.bpl and SineAtOneFourthFs_16Bit.bpl in the same
subdirectory can be used to generate a clean sine wave signal at ¼ of the sampling
rate.
In a J-Test, periodic jitter would show up as sideband pairs around the signal
frequency while random jitter would increase the noise level. The jitter frequencies
can be determined by the distances from the sidebands to the signal frequency, while
the jitter amplitudes can be inferred from the amplitude ratio of the sidebands to the
signal frequency. The RMS jitter level in (picoseconds) can be determined by:
R=20×log10(Jrms×f)-227dB, where R is the amplitude ratio (in dB) of one sideband of
the jitter frequency to the signal frequency, Jrms the RMS jitter level in picoseconds,
and f the signal frequency in Hz. A jitter frequency will create a pair of sidebands
around the signal frequency. If R is computed based on the combined energy from the
double sidebands, then the above formula becomes R’=20×log10(Jrms×f)-224dB.
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Two preconfigured panel setting files: J-Test_24Bit.psf and J-Test_16Bit.psf are
provided in the Panel Setting File (PSF) directory of the software. They can be used to
measure the total RMS jitter level in time by assuming all the sidebands and noises
are caused by jitter only. The RMS jitter level in time for the second highest peak in
the spectrum is also calculated. It is assumed that the second highest peak is one of
the sideband of periodic jitter around the first highest peak. These two panel setting
files can also be used to measure jitter when the test frequency is a pure sinewave
instead of the J-Test signal. The following figure shows a 12kHz tone with a 3.5ns
RMS 5kHz sinewave jitter.

4.3.1.10 MLS

Maximum Length Sequence (MLS) is a pseudo random sequence of pulses consisting
of the values 1 and –1. It is actually periodic with the period equal to the length of the
sequence, which can be chosen from: 127, 255, 511, 1023, 2047, 4095, 8191, 16383,
32767, 65535, 131071, 262143, 524287, 1048575, 2097151, 4194303, 8388607, and
16777215 points (refer to the figure below). You can also explicitly specify how
many times the sequence will be repeated, and the signal “Duration” will be updated
automatically. If you opt to specify the signal “Duration” instead, then the “Times”
will be updated automatically. MLS is often used as stimulus in frequency response
or impulse response measurements. It has a white spectrum from 0 Hz to ½ sampling
rate, if its length is equal to or greater than the Record Length, so as to avoid any
repetition of the sequence in the sampled data. The figure below shows an example of
a 65535-point MLS signal. The Record length is 48000 and the FFT size is 1024.
Therefore the number of intra-frame average is 48000/1024=46. It can be seen from
the figure that the resulting spectrum is very flat in the range of 0 Hz ~ 1/2 sampling
rate.
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4.3.1.11 DTMF

A Dual-Tone Multi-Frequency (DTMF) signal is used for telephone signaling over
the line in the voice-frequency band to the call switching center. The above panel
(same as the standard telephone panel) will pop up when DTMF is selected. A short
signal (0.1s by default) consists of two equal-amplitude frequencies will be generated
when a button on the panel is pressed. For example, if the button labelled “8” is
pressed, a signal contains 852 Hz and 1336 Hz with an amplitude ratio 1:1 will be
generated.

4.3.1.12 Unit Impulse
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A Unit Impulse is a signal with zero values at all places except one sample which has
a unit value. It can be used to test a system’s impulse response. Its amplitude
spectrum is a horizontal straight line.
The Unit Impulse has some particular use. The following figure illustrates the transfer
function of a digital 5513 Hz second order Butterworth low pass filter, measured
using the Unit Impulse, with the stimulus data stored in Channel B and the response
data stored in Channel A. It shows that the gain maintains at nearly 0 dB from 0 Hz
to about 5513 Hz, and then start to drop down very quickly, meanwhile the phase
changes gradually from 0 degree at 0 Hz towards –180 degree as the frequency goes
to infinity. The cursor reader indicates that at 5523.45 Hz (i.e. around the cutoff
frequency), the gain is about –3.03 dB and the phase is about -90.18 degree. Note that
the waveform of Channel A in the Oscilloscope represents the unit impulse response
of the filter directly.

The following figure illustrates the unit impulse response of a digital 5000 Hz FIR
low pass filter (1022-order Kaiser 6 windowed), measured using the Unit Impulse,
with the stimulus data stored in Channel B and the response data stored in Channel A.
It shows that the impulse response is delayed by [FIR Order]/2/[Sampling
Rate]=1022/2/44100=0.0115873 (s) compared with the stimulus. The impulse
response is symmetric and thus the filter has a linear phase response.
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4.3.1.13 Unit Step
A Unit Step is a signal that maintains at zero until a sudden jump from zero to a unit
value and then maintains at that level afterwards. It can be used to test a system’s step
response.
The following figure illustrates the step response of a digital 5513 Hz second order
Butterworth low pass filter, measured using the Unit Step signal, with the stimulus
data stored in Channel B and the response data stored in Channel A. To avoid the
clipping of the digital filter, the stimulus is generated at half of the output full-scale
voltage. The figure shows that the overshoot for this case is about 5.5%.
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4.3.1.14 Wave File
An 8-bit, 16-bit, or 24-bit standard or extensible wave file in PCM format can be
replayed through the Signal Generator. The sampling frequency and bit resolution of
the wave file do not have to be the same as those of the Signal Generator as the
software is able to convert them automatically. If the wave file contains two channels
but the signal generator has only one channel, then the user will be prompted to select
which channel of the wave file he/she wants to output. The wave file replaying
function is only supported in streaming mode and not supported in DDS mode.
Whether the output data are continuous or not depends on the system throughput,
sampling frequency, bit resolution, number of sampling channels, etc. It is generally
possible to output signals continuously without any interruption using sound cards. In
case there is a possible discontinuity in the output signal, a warning cross mark will be
shown as follows. If this happens, you will have to offload the computer (e.g. stop the
Oscilloscope), or choose a lower sampling frequency, etc.

It is possible to use the Record function in the Oscilloscope to record a wave file and
later replay it through the Signal Generator.
4.3.2 Output Frequency

The available options are: 50MHz, 20MHz, 10MHz, 5MHz, 2MHz, 1MHz, 500kHz,
200kHz, 100kHz, 50kHz, 20kHz, 10kHz, 5kHz, 2kHz, 1kHz, 500Hz, 200Hz, 100Hz,
50Hz.
If you cannot find the output frequency you want from the above options, you can
enter the value you want directly. It can be a non-integer value. You can also use the
left most vertical scroll bar (for Channel A) or the right most vertical scroll bar (for
Channel B) to adjust the value of the output frequency.
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It should be noted that the software will not allow the fundamental frequency of an
output signal to be greater than half of the sampling frequency selected.
The Output Frequency is not applicable and is disabled when the waveform is "None",
"White Noise", "Pink Noise" or "MultiTone", "MLS", "DTMF", "Unit Impulse",
"Unit Step", or the Signal Generator is under frequency sweep mode.
4.3.3 Output Amplitude

The available options are: 2, 1, 0.5, 0.2, 0.1, 0.05, 0.02, 0.01, 0.005, 0.002, 0.001,
0.0005, 0. Note that the engineering unit of the Output Amplitude can be either V
(voltage) or A (ampere) depending on the DAC device used.
If you cannot find the output amplitude you want from the above options, you can
enter the value you want directly. You can also use the vertical scroll bar to adjust the
value of the output amplitude. The output amplitude will also be displayed in dBFS,
dBu or dBV, just below the vertical scroll bar. Click on the text to switch the display.
It should be noted that the software will not allow you to specify an output amplitude
greater than the output full-scale voltage (1/2 Vpp) configured.
The Output Amplitude is disabled when the waveform is "None" or the Signal
Generator is under amplitude sweep mode.
4.3.4 Output Phase Difference

You can specify the Output Phase Difference between the output signals in the two
channels when their output frequencies are the same. This is only applicable to
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waveforms "Sine", "Rectangle", "Triangle", "Saw Tooth", in non-sweep mode. For
different waveforms, the phase difference is calculated with respect to the initial
phase described in the waveform sections.
4.3.5 Output DC Offset

For DAC devices that support output DC offset, the above spin boxes will become
visible just below the waveform selection combo boxes in the Signal Generator panel.
You can use the spin boxes to adjust the output DC offset.
4.3.6 Waveform Details

Some types of waveforms have additional parameters to be specified, such as the duty
cycle of a rectangle wave. These parameters are normally displayed just below the
waveform selection combo boxes. However, if that place is taken up by the output
DC offset parameters, then you can click the
to call up the Waveform Details dialog.

button in the Signal Generator panel

4.4 Sweep Parameters
When “Sweep” checkbox is ticked and “Frequency” radio box is selected, the
waveform can be output at a frequency that sweeps linearly or logarithmically within
the specified frequency range and time duration. This is called frequency sweep.
When “Sweep” checkbox is ticked and “Amplitude” radio box is selected, the
waveform can be output at an amplitude that sweeps linearly or logarithmically within
the specified amplitude range and time duration. This is called amplitude sweep.
4.4.1 Frequency Sweep
4.4.1.1 Start Frequency
Each channel has its own Start Frequency. You can enter a value between 0 Hz and
half of the Output Sampling Frequency specified. You will be notified if the value is
out of range.
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4.4.1.2 End Frequency
Each channel has its own End Frequency. You can enter a value between 0 Hz and
half of the Output Sampling Frequency specified. You will be notified if the value is
out of range.
4.4.2 Amplitude Sweep
4.4.2.1 Start Amplitude
Each channel has its own Start Amplitude. You can enter a value between 0 and the
output full-scale voltage (1/2 Vpp). You will be notified if the value is out of range.

4.4.2.2 End Amplitude
Each channel has its own End Amplitude. You can enter a value between 0 and the
output full-scale voltage (1/2 Vpp). You will be notified if the value is out of range.
4.4.3 Sweep Mode
You can specify either linear or logarithmic sweep mode.
A frequency linearly swept sine wave has an equal amount of energy per Hz of
bandwidth within the swept frequency range while a frequency logarithmically swept
sine wave has an equal amount of energy per octave of bandwidth within the swept
frequency range. The spectrum of the former is white-noise-like while that of the
latter is pink-noise-like.
For magnitude frequency response tests, a frequency linearly swept sine wave should
be analyzed using narrow band FFT analysis while a frequency logarithmically swept
sine wave should be analyzed using octave band analysis. The longer the sweep
duration, the better the frequency resolution as well as the accuracy at the lower
frequency end. Linear frequency sweep has an equal frequency resolution
everywhere along the frequency axis. In contrast, logarithmic frequency sweep has
finer frequency resolutions at lower frequencies and coarser frequency resolutions at
higher frequencies. The oscilloscope frame width must be set to be equal to or greater
than the frequency sweep duration, and the trigger parameters should be set properly
to ensure that the entire frequency sweep signal is captured in one oscilloscope frame,
from the start frequency to the end frequency. The FFT size must be equal to or
greater than the Record Length of the Oscilloscope to avoid the intra-frame average.
The “loop” checkbox in the Signal Generator panel must be unticked so that the
sweep can be fired individually. This is to prevent the Oscilloscope from capturing
something that spans two continuous sweeps.
The following figure shows the spectrum of a 1-second 10 Hz ~ 21 kHz frequency
linearly swept sine wave analyzed using 65536-point FFT with a Rectangle window,
at the sampling rate of 48 kHz. It can be seen that the frequency response is perfectly
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flat within the range of 20 ~ 20 kHz. Note that the frequency sweep range is a little
wider than the frequency range of interest in order to minimize any potential
boundary effects.

The following figure shows the spectrum of a 1-second 10 ~ 24 kHz frequency
logarithmically swept sine wave analyzed using 1/3 octave analysis based on 65536point FFT with a Rectangle window, at the sampling rate of 48 kHz. It can be seen
that the frequency response is perfectly flat within the range of 20 ~ 20 kHz. Note that
the frequency sweep range is a little wider than the frequency range of interest in
order to minimize any potential boundary effects. Logarithmic frequency sweep mode
spends more time on lower frequencies and thus requires less time to achieve the
same resolution at the lower frequency end than linear frequency sweep mode.
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Magnitude frequency response tests can also be performed using the peak hold
function of the Spectrum Analyzer. In this method, the oscilloscope frame width must
be set to be much less than the frequency sweep duration such that the data sampled in
an oscilloscope frame contains very little frequency variation. A smooth magnitude
frequency response curve can be obtained by peak-holding a large number of
consecutive frames of spectra through the inter-frame processing. The “Loop”
checkbox in the Signal Generator panel must be ticked so that the sweep can be fired
continuously. Moreover, to make multiple sweeps interconnected smoothly, the
“Reverse” checkbox should be ticked. One advantage of this method is that it allows
you to monitor the sweep process in real time. But its accuracy is not as good as that
of the previous method.

4.5 Output Duration/Loop
Under non-sweep mode, the “Duration” specifies the duration of the output signal. If
the “Loop” checkbox is ticked, the specified signal will be output continuously until
the Signal Generator is stopped manually, and in this case, the “Duration” edit box
will be disabled and become not applicable.
Under sweep mode, the “Duration” specifies the sweep duration instead. If the
“Loop” checkbox is ticked, the specified signal will be output continuously until the
Signal Generator is stopped manually.
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4.6 Output Signal Processing
The output signal will undergo the following processes sequentially before it is finally
output. They are:
(1) Output Masking
(2) Output Fade In/ Fade Out
(3) Output Modulation
The above processing steps are usually performed by software and supported by
streaming mode only.
4.6.1 Output Masking (Window-Shaped Bursts)
The output mask is used to mask “on” or mask “off” the output signal periodically. If
the “Mask” checkbox is ticked, you can specify the “on” time and “off” time in a
masking cycle. “On” means to let the signal pass and "off" means to block the signal.
You can use this feature to generate a burst-like signal. For signals with a “Sine”,
“Rectangle”, “Triangle”, “Saw Tooth”, “MultiTones”, “WFLibrary”, or “DTMF”
waveform, you can also force each burst to start at the same phase by ticking the
“Phase Lock” checkbox.
The following figure shows a sine wave burst signal of 1000 Hz, with a mask-on time
of 0.01 s, a mask-off time of 0.0055 s, and no phase lock. It can be seen that each
burst is not started at the same phase angle.
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The following figure shows the same signal as above except that the phase lock is
enforced here. It can be seen that each burst is started at exactly the same phase angle.

4.6.1.1 Window-Shaped Mask Configuration
In the above two examples, “On” means “100% pass” while “Off” means “0% pass”.
This is the default behavior of the mask function. More sophisticated behavior can be
configured by clicking the button
following dialog box.

beside the “Mask” checkbox to open the

The above mask configuration dialog box allows you to specify a window function to
be applied to the signal during the “on” period, and the off/on amplitude radio in dB.
“Rectangle” and “Off” is selected by default.
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Generally speaking, the mask function works as an amplitude modulator. A masking
cycle consists of an “On” time and an “Off” time. The masking cycle determines the
modulating frequency. The window function and off/on amplitude ratio determine the
modulating envelop. The signal to be masked is the carrier. It can be of any kind.
This is in contrast to the output amplitude modulation function which will be
introduced later. The following figure illustrates how the window-shaped mask
function works.

4.6.1.2 Intensity-Modulated Band-Limited Pink Noise for Direct STI measurements
As described previously in the Oscilloscope chapter, in direct STI (Speech
Transmission Index) measurements, a band-limited pink noise intensity-modulated by
a low-frequency sine wave is used to measure the corresponding modulation transfer
function (MTF). The Full STI can be derived after 98 such MTFs are measured. The
following figure shows a 1 kHz pink noise with a half-octave bandwidth from 841 Hz
to 1189 Hz, intensity-modulated by a 4 Hz sine wave. The band-limited pink noise is
generated using automatic MultiTones configuration with all tones aligned to 1/96
octave bands. The 4 Hz intensity modulation is realized using Cosine 1.0 windowshaped mask with [On time] = 0.25 s, [Off time] = 0 s, [Off/On Amplitude Ratio] =
Off. Note that if amplitude modulation is required instead, Hann window, a.k.a
Cosine 2.0 window, should be used instead.
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4.6.1.3 ANSI / CEA-2010 Subwoofer Peak SPL Test
ANSI / CEA-2010 standard defines a method to measure the peak SPL of a powered
subwoofer within the specified harmonic distortion limits. The test signal is a 6.5cycle Hann-windowed sinewave burst. The generated burst signal is captured and
analyzed with narrow-band FFT. The resulting spectrum is checked against the
harmonic distortion limits which are defined in the following table. The peak SPL
can be obtained by stepping up the output power until the stipulated limits are about
to be broken. The tests are usually performed individually at fundamental frequencies
20Hz, 25Hz, 31.5Hz, 40Hz, 50Hz, and 63Hz. The bandwidth of the test signal is
exactly 1/3 octave.
Start Frequency (Hz)
16
1.59f0
2.52f0
3.78f0
5.61f0
8.50f0

End Frequency (Hz)
1.59f0
2.52f0
3.78f0
5.61f0
8.50f0
10k

Limit (dB)
0
-10
-15
-20
-30
-40

Notes
Fundamental
2nd harmonic
3rd harmonic
th
4 , 5th harmonic
6th, 7th ,8th
th
9 and above

Six panel setting files are provided in the PSF\Pro subdirectory of the software:
(1)
(2)
(3)
(4)
(5)

CEA-2010-20Hz.psf
CEA-2010-25Hz.psf
CEA-2010-31.5Hz.psf
CEA-2010-40Hz.psf
CEA-2010-50Hz.psf
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(6) CEA-2010-63Hz.psf
Correspondingly, six reference files are provided in the REF subdirectory of the
software.
(1)
(2)
(3)
(4)
(5)
(6)

CEA-2010-20Hz.ref
CEA-2010-25Hz.ref
CEA-2010-31.5Hz.ref
CEA-2010-40Hz.ref
CEA-2010-50Hz.ref
CEA-2010-63Hz.ref

In the above settings, the Record Length of the Oscilloscope is twice the length of the
sine burst. Noise and room reflections outside the Record Length are excluded. The
trigger level and trigger delay are set such that the sine burst will be captured in the
Oscilloscope and aligned left. 1/12 octave smoothing is recommended in the standard
and can be added if necessary. The repetition rate of the burst must be greater than 1
second. The peak SPL is obtained through [Spectrum Analyzer
Processing]>“Parameter Measurement”>“Energy in User Defined Frequency Bands”,
in the 1/3 octave band around the fundamental, in accordance with CEA-2010B. The
peak SPL values for Channels A&B are stored in DDPs: RMSDB_A(dB) and
RMSDB_B(dB), when the Multimeter is not opened. The reference curve is
configured as the High-High limit. Whether the limit is broken and how much it is
exceeded can be accessed through DDPs:
SpectrumComparisonH_A and
SpectrumComparisonH_B for Channels A&B respectively. The following figure
shows a sample test at 20Hz.
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4.6.2 Output Fade In / Out
If “Fade” is ticked, you can specify the Fade In duration for the output signal. This
duration starts as the signal output starts. During this duration, the signal amplitude
increases linearly from zero to the specified Output Amplitude.
Furthermore, if the output signal is time limited (i.e. the “Loop” checkbox is not
ticked), then you can also specify the Fade Out duration. This duration starts at the
[End time of the output signal]-[Fade out duration]. During this duration, the signal
amplitude decreases linearly from the specified Output Amplitude to zero.
The following figure illustrates a 1-second 50 Hz signal with a Fade In duration of 0.2
s and Fade Out duration of 0.1 s.

4.6.3 Output Modulation
Note that if an output modulation method is selected, all the signal parameters
described previously refer to those of the modulating signal, except the output
amplitude which refers to the modulated signal. The carrier signal here is a sine wave.
For the cases of a non-sinewave carrier signal, consider using the window-shaped
mask function described previously.
4.6.3.1 Amplitude Modulation (AM)
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In Amplitude Modulation (AM), the amplitude of the carrier signal varies in
proportion to the instantaneous amplitude of the modulating signal. The carrier
frequency in the range from 0 to ½ of the sampling frequency and the modulation
index in the range from 0% to 100% can be specified.
4.6.3.2 Frequency Modulation (FM)
In Frequency Modulation (FM), the instantaneous frequency deviation from the
carrier frequency of the modulated signal varies in proportion to the instantaneous
amplitude of the modulating signal. The carrier frequency in the range from 0 to ½ of
the sampling frequency and the maximum frequency deviation in the range from 0 to
1/2 of the carrier frequency can be specified.
4.6.3.3 Phase Modulation (PM)
In Phase Modulation (PM), the instantaneous phase deviation from the carrier phase
(i.e. the phase if no modulation on the carrier signal is applied) of the modulated
signal varies in proportion to the instantaneous amplitude of the modulating signal.
The carrier frequency in the range from 0 to ½ of the sampling frequency and the
maximum phase deviation in the range from 0 to 180° can be specified.

4.7 Musical Scale
The Musical Scale button
is enabled when the signal is “Sine”, “Rectangle”,
“Triangle”, “Saw Tooth”, or “WFLibrary”. If pressed, the following Musical Scale
panel will pop up. The reference pitch can be adjusted if necessary.
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4.8 Save Function
The specified output signal can be saved as a Wave File (*.wav) or Text File (*.txt)
for a time duration specified by the “Duration” (The “Loop” checkbox will be ignored
even if it is ticked). If the “Duration” is greater than 1000 seconds, it will be limited to
1000 seconds. If the Save button
is pressed, a "Save as" window will be
displayed. You can select a file type and enter a file name for the file to be saved.
The wave file format follows the standard Wave File PCM format and can be
replayed using third party software such as Microsoft Windows Media Player or
loaded back into the software itself. The Text File is a Comma Separated Variable file
and has the following format. It can be loaded back into the software using the
[File]>[Import] command described previously in the Oscilloscope chapter.


One channel data format

;Data Points
;Sampling Frequency (Hz) = 44100
;Sampling Bit Resolution (Bits) = 16
;Sampling Channels = 1
;A:Full-scale Voltage (V) = 1
;A:Sensor Sensitivity (V/V)=1
;Total Data Points = 44100
;No., Time (S), Channel A (V)
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1, 0.000000, 0.000000
2, 0.000023, 0.141995
3, 0.000045, 0.281113
4, 0.000068, 0.414534
5, 0.000091, 0.539554
……
Apart from the 8 header lines, each row contains a sequential number, a time stamp
(in second) and a value for Channel A (in Volt).


Two channel data format

;Data Points
;Sampling Frequency (Hz) = 44100
;Sampling Bit Resolution (Bits) = 16
;Sampling Channels = 2
;A:Full-scale Voltage (V) = 1
;A:Sensor Sensitivity (V/V)=1
;B:Full-scale Voltage (V)=1
;B:Sensor Sensitivity (V/V) = 1
;Total Data Points = 44100
;No., Time (S), Channel A (V),
1, 0.000000, 0.000000, 1.000000
2, 0.000023, 0.141732, 1.000000
3, 0.000045, 0.275591, 1.000000
4, 0.000068, 0.409449, 1.000000
5, 0.000091, 0.535433, 1.000000
……

Channel B (V)

Apart from the 10 header lines, each row contains a sequential number, a time stamp
(in second), a value for Channel A (in Volt) and a value for Channel B (in Volt).

4.9 Run/Stop

Clicking this button will generate the signal. It toggles between Run and Stop if
clicked. You can also use the Enter key to start/stop the signal generator when the
signal generator panel is the current active window.

4.10 Loopback Mode
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The available loopback modes depend on the DAC and ADC devices used. For a
sound card based system, there are seven loopback modes available:
4.10.1 No Loopback
Under this mode, the Signal Generator and the DAQ-related instruments (e.g.
Oscilloscope, Spectrum Analyzer, Multimeter, Spectrum 3D Plot, Data Logger…)
work independent within the software. However, you can still establish a loopback
via external means:


Hardwired loopback via an external loopback cable



Mixer-level loopback established via selecting "Wave Out Mix" or the like as the
input source in the Recording Control under Windows Control Panel. From
Windows Vista onwards, this can be selected via [Setting]>[ADC
Device]>"Device No."
The "Wave Out Mix" may not be listed as an input source in the Recording
Control by default, but you should be able to find it in the Options of the
Recording Control. This method feeds the sound card DAC output directly to its
ADC input through the sound card mixer, so there is some hardware involved. Be
sure to adjust the "Wave Out Mix" volume properly to avoid possible input
saturation.



External software loopback via virtual audio cable software, which is available as
freeware or shareware such as the one from www.vb-audio.com. This method
usually involves software resampling which introduces a small amount of
distortion and noise.

4.10.2 iA = oA, iB = oB
Under this mode, a full loopback digital route is established at software level between
the output channel and input channel, such that the signal from the Output Channel A
is fed into the Input Channel A and the signal from the Output Channel B is fed into
the Input Channel B.
Under this mode, the Trigger Parameters and Sampling Parameters will be
automatically set by the software, and will be disabled and remain not adjustable until
the end of the signal output. The frame width of the Oscilloscope has to be 1 second.
It should be noted that the signal fed into the input channels is "ideal" in the sense that
it does not pass through any hardware circuit, neither the sound card output channels,
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nor the sound card input channels. This is different from the hardwired loopback and
mixer-level loopback modes described previously. This mode is especially useful for
teaching.
4.10.3 iA = oA, iB = oA
This loopback mode is similar to the previous one except that both input channels are
fed with the signal from the Output Channel A only. It is especially useful, for
example, when you want to evaluate the characteristics of a digital filter in the
Oscilloscope and Spectrum Analyzer. In such cases, you should generate a proper
stimulus from the Channel A of the Signal Generator and apply the digital filter in the
Oscilloscope to the Input Channel A only, leaving the same stimulus fed into the
Input Channel B intact. This arrangement complies with the requirements of the cross
correlation, transfer function, coherence function and impulse response modes of the
Spectrum Analyzer.
4.10.4 iB = oA
Under this mode, a partial loopback digital route is established at software level
between the Output Channel A and the Input Channel B, such that the signal from the
Output Channel A is fed into the Input Channel B and the Input Channel A is still
available for field input. Only the very first part of data from the Output Channel A,
with a length equal to the Record Length of the Oscilloscope, will be fed into the
Input Channel B and remain unchanged there. In other words, if the oscilloscope
continues to acquire the second frame of data, then the data in Channel A may not be
in correspondence with the data in Channel B anymore. The Oscilloscope should be
set in dual channel mode in order to see the signal from the Signal Generator. This
mode is usually employed as a single-channel method for the measurements of cross
correlation, transfer function, coherence function and impulse response, as illustrated
as follows. The drawback of this method is that the measured transfer function /
impulse response includes the contributions from the output channel A and the input
channel A of the measuring device as well. Thus these two should be kept as
“transparent” as possible.
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In contrast to the above single-channel measurement method using the “iB=oA” mode,
the following figure illustrates a dual-channel measurement method using the “No
loopback” mode. The dual-channel method offers a higher accuracy as the measured
transfer function / impulse response is only affected by the disparity between the input
channels A&B of the measuring device, which is usually very small. Moreover, this
disparity can be compensated in the software if necessary.

To make the single-channel measurement method work properly, “Loop” option in
the Signal Generator panel should be unticked so that only a short-time signal will be
generated. In the Oscilloscope, the Record Length should be long enough to hold the
short-time test signal. Single trigger mode must be used and trigger parameters must
be set properly such that the response from the DUT in the input channel A is more or
less time aligned with the stimulus in the input channel B. “Time Delay Removal”
function in the Oscilloscope can be used to remove the time alignment error if
necessary. The time difference between the Signal generator is commanded to start
and the arrival of the captured response in the Oscilloscope will be displayed at the
bottom left of the Oscilloscope window. However, it should be considered as
indicative only. The following figure shows an impulse response of a sound card
loopback measured using frequency logarithmically swept sine wave under singlechannel mode.
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4.10.5 Sync. No Loopback
This mode is the same as the No Loopback mode, except that the start of the Signal
Generator and the start of the Oscilloscope are synchronized. The synchronization
works as follows:
(1) Stop the Oscilloscope manually if it is running
(2) Start the Signal Generator
The Oscilloscope will be started automatically after the Latency Time + the Delay
Time specified by “Start OSC after (s)”. The latency time should be calibrated
according to the procedure described previously in the section “Latency for
Synchronized Output/Input”.
If you tick "Echo Only", the delay time will be automatically filled with the duration
of the output signal and the “Loop” checkbox will be un-ticked once, so that the
Oscilloscope will start sampling just after the direct output signal finishes, i.e. only
the echo will be captured.
4.10.6 Sync. iB = oA
This mode is the same as the iB = oA mode, except the synchronization between the
Signal Generator and the Oscilloscope as described previously.
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4.10.7 Sync. iB<--oA
This loopback mode requires an external cable to feed the signal from the Output
Channel A into the Input Channel B. Note that as far as the loopback modes are
concern, “=” means a software-level loopback. And “” means a hardwired loopback
for synchronization and a software-level loopback for data.
You can specify when to start the Oscilloscope after the signal has been output from
the output channel by the signal generator. The Latency Time has no effect on this
mode, because the software uses the actual signal acquired from the Input Channel B
to determine when the front of the output signal actually arrives. So this mode is
more accurate than “Sync. iB = oA” mode, but the drawback is that it requires two
physical input channels with two input jacks and a hardwired loopback. Note that the
Trigger Edge, Trigger Level and Trigger Delay must be set properly to allow accurate
detection of the front of the output signal. The Trigger Mode will be forced to
“Single” and the Trigger Source will be forced to “B” automatically by the software.

4.11 DDS Mode vs Streaming Mode
The signal generator can work in two modes: streaming mode and DDS mode.
Under streaming mode, the output data are computed, continuously if necessary, by
the software in the computer and then streamed continuously to the DAC device for
output. One advantage of using streaming mode is that you can fully utilize the power
of the computer software to generate very complicated signal at minimum hardware
cost. However, limited by the software computing speed and the streaming speed, this
mode is not able to provide high frequency output. Also, it may consume a lot of
CPU time when the output sampling frequency is high or the output signal is
complicated. Some DAC devices such as sound cards work only in streaming mode.
Under DDS mode, the computer only needs to send the output signal parameters (such
as signal frequency, amplitude, waveform type or shape data, etc.) to the DAC device
and the DAC device will take care of the rest. No actual output data will be sent from
the computer to the DAC device. This greatly reduces the CPU work load and
communication traffic between the computer and the DAC device. Very high signal
frequencies can be generated if the DAC device is capable. One drawback is that not
all functions supported by the streaming mode are supported by the DDS mode.
Please refer to the respective hardware manual for details.
Some DAC devices such as VT DSO-2810 and VT DSO-2810E support both
streaming mode and DDS mode. Tick/Untick the DDS checkbox in the above dialog
to select the DDS mode/streaming mode. If the selection is disabled, try to select a
lower sampling frequency first as the streaming mode may not support very high
sampling frequency.
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5 Multimeter
5.1 Overview

This is a dual channel Multimeter, providing the following types of digital displays:

















RMS
dBV
dBu
dB
dB(A)
dB(Z)
dB(C)
Frequency Counter
RPM (Revolutions Per Minute)
Counter
Duty Cycle
F/V (Frequency Voltage Conversion)
Cycle RMS
Cycle Mean
Pulse Width
Vibrometer

The above items from Frequency Counter to Pulse Width involves a pulse counting
process, and the software allows you to configure the counter trigger level and trigger
hysteresis in order to rectify the analog signal to rectangular pulses before counting.
The frequency dividing ratio can also be configured.
The toggle button
in the Instrument Toolbar is used to open or close the
Multimeter. You can also close it by clicking the "Close" button at the upper right
corner of the Multimeter window.

5.2 View Parameters
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View parameters determine how the collected data are analyzed and displayed. There
are 16 types of views, as shown in the above figure.
5.2.1 RMS
Under this mode, the Multimeter displays the RMS values of the current frame of data,
which are the same as the ones displayed in the Oscilloscope but with bigger font.
You can display or hide the value for any channel. The rest of the view parameters in
the view parameter toolbar are not applicable.
The corresponding DDPs are: RMS_A(EU) for Channel A and RMS_B(EU) for
Channel B.
5.2.2 dBV
Under this mode, the Multimeter displays the dBV values of the current frame of data.
You can display or hide the value for any channel. The rest of the view parameters in
the view parameter toolbar are not applicable. If the Sensor Engineering Unit is not
voltage, then this option means dBEU.
The corresponding DDPs are: RMSDBV_A(dBEU)
RMSDBV_B(dBEU) for Channel B.

for

Channel

A

and

5.2.3 dBu
Under this mode, the Multimeter displays the dBu values of the current frame of data.
You can display or hide the value for any channel. The rest of the view parameters in
the view parameter toolbar are not applicable.
The corresponding DDPs are:
RMSDBu_B(dBu) for Channel B.

RMSDBu_A(dBu)

for

Channel

A

and

5.2.4 dB
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Under this mode, the Multimeter displays the dB values of the current frame of data.
You can display or hide the value for any channel. The rest of the view parameters in
the view parameter toolbar are not applicable. The reference level for dB is user
definable and can be set via [Setting]>[Calibration]>“0dB Reference Vr”.
The corresponding DDPs are: RMSDB_A(dB) for Channel A and RMSDB_B(dB) for
Channel B.
5.2.5 dB(A)
Under this mode, the Multimeter displays the dB(A) values of the current frame of
data. You can display or hide the value for any channel. The rest of the view
parameters in the view parameter toolbar are not applicable. Note that the Spectrum
Analyzer will be forced to display Amplitude Spectrum with A weighting.
The corresponding DDPs are: RMSDBA_A(dBA) for Channel A and
RMSDBA_B(dBA) for Channel B. Note that this value is sharply bandlimited to
10Hz ~20kHz.
5.2.6 dB(Z)
Under this mode, the Multimeter displays the dB(Z) values of the current frame of
data. You can display or hide the value for any channel. The rest of the view
parameters in the view parameter toolbar are not applicable. Note that the Spectrum
Analyzer will be forced to display Amplitude Spectrum with B weighting.
The corresponding DDPs are: RMSDBZ_A(dBZ) for Channel A and
RMSDBZ_B(dBZ) for Channel B. Note that this value is sharply bandlimited to 10Hz
~20kHz.
5.2.7 dB(C)
Under this mode, the Multimeter displays the dB(C) values of the current frame of
data. You can display or hide the value for any channel. The rest of the view
parameters in the view parameter toolbar are not applicable. Note that the Spectrum
Analyzer will be forced to display Amplitude Spectrum with C weighting.
The corresponding DDPs are: RMSDBC_A(dBC) for Channel A and
RMSDBC_B(dBC) for Channel B. Note that this value is sharply bandlimited to
10Hz ~20kHz.

5.2.8 Frequency Counter
Under this mode, the Multimeter displays the counted frequency values of the current
frame of data. You can display or hide the value for any channel.
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You can also set the Counter Trigger Level and Counter Trigger Hysteresis as well as
the ratio of the Frequency Divider. The Counter Trigger Level and Counter Trigger
Hysteresis are useful parameters under the Frequency Counter, RPM, Counter, Duty
Cycle, F/V, Cycle RMS, Cycle Mean, Pulse Width modes. They are used as
parameters to rectify the analog signal in the Oscilloscope to rectangular pulses before
the counting process. They behave in a similar way as the Trigger Level and Trigger
Hysteresis of an electronic Schmitt trigger, except that they are relative values which
vary with the maximum and minimum values detected in the current frame of data.
The Counter Trigger Level can be adjusted from –100% to 100%, with -100%
corresponding to the minimum value and 100% corresponding to the maximum value.
The Counter Trigger Hysteresis can be adjusted within 0 ~ 100% of the actual range
of the frame of data, i.e. [the maximum value]-[the minimum value]. These two
parameters are visualized as two markers along the vertical axes in the Oscilloscope,
as shown in the following figure. The markers on A axis are for Channel A, and the
markers on B axis are for Channel B.
In the figure, the signals in both channels are a 1 kHz sine wave mixed with a white
noise at an amplitude ratio of 5:1. The Counter Trigger Level and Counter Trigger
Hysteresis for Channel A are 50% and 0% respectively. In contrast, they are 50% and
20% respectively for Channel B. The Multimeter measures a frequency of 1457.355
Hz for Channel A which is incorrect due to the fluctuation caused by the white noise
component. For Channel B, the measured frequency is 999.930 Hz which is very
accurate. Thus, setting a proper hysteresis value is important when there are noises
present in the signal.
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The corresponding DDPs are: Freq_A(Hz) for Channel A and Freq_B(Hz) for
Channel B.
5.2.9 RPM
Under this mode, the Multimeter displays the RPM (Revolutions Per Minute) values
of the current frame of data. You can display or hide the value for any channel.
The Counter Trigger Level, Counter Trigger Hysteresis and Frequency Divider are
applicable to this mode.
The corresponding DDPs are: RPM_A(rpm) for Channel A and RPM_B(rpm) for
Channel B.
5.2.10 Counter
Under this mode, the Multimeter displays the total counts of the current frame of data.
You can display or hide the value for any channel.
The Counter Trigger Level, Counter Trigger Hysteresis and Frequency Divider are
applicable to this mode.
The corresponding DDPs are: TotalCount_A for Channel A and TotalCount_B for
Channel B.
5.2.11 Duty Cycle
Under this mode, the Multimeter displays the duty cycle values of the current frame
of data. You can display or hide the value for any channel.
The Counter Trigger Level and Counter Trigger Hysteresis are applicable to this
mode.
The corresponding DDPs are: DutyCycle_A(%) for Channel A and DutyCycle_B(%)
for Channel B.
5.2.12 F/V
Under this mode, the Multimeter displays the voltage values after performing
frequency counting and subsequent frequency/voltage conversion of the current frame
of data. You can display or hide the value for any channel. The frequency/voltage
conversion factors are configured as described previously in the section “Frequency
Voltage Conversion Factor”.
The Counter Trigger Level, Counter Trigger Hysteresis and Frequency Divider are
applicable to this mode.
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The corresponding DDPs are: FVC_A(V) for Channel A and FVC_B(V) for Channel
B.
5.2.13 Cycle RMS
Under this mode, the Multimeter displays the RMS values calculated from an integer
number of signal cycles within an Oscilloscope frame. The Cycle RMS is the “true”
RMS value of a periodic signal. An Oscilloscope frame does not necessarily contain
an integer number of signal cycles and thus the RMS value of the Oscilloscope frame
may not be the same as the Cycle RMS value.
You can display or hide the value for any channel. The Counter Trigger Level and
Counter Trigger Hysteresis are applicable to this mode.
The corresponding DDPs are: CycleRMS_A(EU) for Channel A and
CycleRMS_B(EU) for Channel B. This display mode also generates the following
DDPs: CyclePWR_A(W) for Channel A, which is the cycle power and equal to
CycleRMS_A(EU)2 / [Load Factor A], and CyclePWR_B(W) for Channel B, which is
the cycle power and equal to CycleRMS_B(EU)2 / [Load Factor B]. The load factors
for Channels A and B can be specified via [Setting]>[Calibration].
5.2.14 Cycle Mean
Under this mode, the Multimeter displays the Mean values calculated from an integer
number of signal cycles within an Oscilloscope frame. The Cycle Mean is the “true”
mean value of a periodic signal. An Oscilloscope frame does not necessarily contain
an integer number of signal cycles and thus the Mean value of the Oscilloscope frame
may not be the same as the Cycle Mean value.
You can display or hide the value for any channel. The Counter Trigger Level and
Counter Trigger Hysteresis are applicable to this mode.
The corresponding DDPs are:
CycleMean_B(EU) for Channel B.

CycleMean_A(EU)

for

Channel

A

and

5.2.15 Pulse Width
Under this mode, the Multimeter displays the pulse width of the current frame of data.
You can display or hide the value for any channel.
The Counter Trigger Level and Counter Trigger Hysteresis are applicable to this
mode.
The corresponding DDPs are: PulseWidth_A(s) for Channel A and PulseWidth_B(s)
for Channel B.
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5.2.16 Vibrometer

If one of the sensors used is an/a acceleration, velocity or displacement sensor, then
you can choose this mode to display the RMS, Peak or Peak-to-Peak (PP) and Crest
Factor (CF) values of Acceleration, Velocity and Displacement.
You can display or hide the values for any channel. The rest of the view parameters in
the view parameter toolbar are not applicable.
This display mode generates the following DDPs for Channel A:
(1) AccelerationRMS_A(g): Acceleration RMS value in g for Channel A
(2) AccelerationRMS_A(m/s^2): Acceleration RMS value in m/s^2 for Channel A
(3) AccelerationPeak_A(g): Acceleration Peak value in g for Channel A
(4) AccelerationPeak_A(m/s^2): Acceleration Peak value in m/s^2 for Channel A
(5) AccelerationCF_A: Acceleration Crest Factor for Channel A
(6) VelocityRMS_A(mm/s): Velocity RMS value for Channel A
(7) VelocityPeak_A(mm/s): Velocity Peak value for Channel A
(8) VelocityCF_A: Velocity Crest Factor for Channel A
(9) DisplacementRMS_A(µm): Displacement RMS value for Channel A
(10) DisplacementPP_A(µm): Displacement Peak-to-Peak value for Channel A
(11) DisplacementCF_A: Displacement Crest Factor for Channel A
It also generates similar DDPs for Channel B.

5.3 Menu
The menu for the Multimeter is only a subset of the menu for the Oscilloscope
described previously.
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6 Data Logger
6.1 Overview

This is a dual channel parameter data logger. It provides long time data logging
function for 246 derived data points and 16 user defined data points, including RMS
value, Peak Frequency, Sound Pressure Level, RPM, THD, etc. Up to eight data
logger windows can be opened and each window can trace up to 8 variables. The
logged data can be reloaded for review.
The push button
in the Instrument Toolbar is used to open a new data logger
window. You can close it by clicking the "Close" button at the upper right corner of
the window.
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6.2 Configuration

Whenever the “Data Logger” button in the Instrument Toolbar is clicked, a new data
logger window will be opened. A configuration dialog will pop up on the top of the
data logger window to allow you to enter the configuration first. Parameters to be
configured include the Derived Data Points (DDP) to be logged, Legend (color and
label of each DDP), Update Threshold for each DDP (if “Update Threshold” is chosen
for the Logging Method), Time Interval (if “Time Interval” is chosen for the Logging
method), Logging Method, etc. By default, the log files will be stored in the LOG
subdirectory of the software. This can be changed by re-selecting a “Real Time Log
File Directory”.
6.2.1 Derived Data Point and User Defined Data Point
In this software, a Derived Data Point (DDP) refers to a data point that is derived
from a frame of raw DAQ data. The DDP values are updated whenever a new frame
of data arrives. A User Defined Data Point (UDDP) is usually a function of certain
DDPs. It is updated after all DDPs are updated except OverallPassFailCheck which is
the last one to update. UDDPs can be configured by the user using DDP viewer. The
following derived data points and user defined data points can be selected for logging.
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No.
1
2
3

DDP
Max_A(EU)
Min_A(EU)
PP_A(EU)

4
5
6

Mean_A(EU)
RMS_A(EU)
PWR_A(W)

7
8
9

PeakLevelPercent_A(%)
PeakLeveldBFS_A
f1Freq_A(Hz)

10

f2Freq_A(Hz)

1. The 2nd Harmonic Frequency for Channel
A
2. The 2nd Peak Frequency for Channel A
3. The 2nd Peak Frequency for Channel A
4. 15 kHz for Channel A

11

f3Freq_A(Hz)

1. The 3rd Harmonic Frequency for Channel
A
2. The 3rd Peak Frequency for Channel A
3. The 2nd order IMD lower frequency for
Channel A
4. 0.75 kHz for Channel A

12

f4Freq_A(Hz)

1. The 4th Harmonic Frequency for Channel
A
2. The 4th Peak Frequency for Channel A
3. The 2nd order IMD higher frequency for
Channel A
4. 2.40 kHz for Channel A

13

f5Freq_A(Hz)

1. The 5th Harmonic Frequency for Channel
A
2. The 5th Peak Frequency for Channel A
3. The 3rd order IMD lower frequency for
Channel A
4. 3.90 kHz for Channel A

14

f6Freq_A(Hz)

1. The 6th Harmonic Frequency for Channel
A
2. The 6th Peak Frequency for Channel A
3. The 3rd order IMD higher frequency for
Channel A
4. 5.55 kHz for Channel A

15

f7Freq_A(Hz)

1. The 7th Harmonic Frequency for Channel
A

www.virtins.com

Description
Maximum value for Channel A or combined
Minimum value for Channel A or combined
Peak-to-Peak value for Channel A or
combined
Mean value for Channel A or combined
RMS value for Channel A or combined
Power value (= RMS2 / Load Factor) for
Channel A or combined
Peak Level in Percentage for Channel A
Peak Level in dBFS for Channel A
1. Peak / Fundamental Frequency for
Channel A
2. Frequency at peak impedance for Channel
A
3. 3.15 kHz for Channel A
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Source
OSC
OSC
OSC
OSC
OSC
OSC
OSC
OSC
1. SPEC(AMS)
2. SPEC
(AMS+IM)/(AMS
+OCT+IM)
3. SPEC
(AMS+DIM)
1. SPEC
(AMS+HARM)
2. SPEC
(AMS+Peak)
3. SPEC
(AMS+IMD)
4. SPEC
(AMS+DIM)
1. SPEC
(AMS+HARM)
2. SPEC
(AMS+Peak)
3. SPEC
(AMS+IMD)
4. SPEC
(AMS+DIM)
1. SPEC
(AMS+HARM)
2. SPEC
(AMS+Peak)
3. SPEC
(AMS+IMD)
4. SPEC
(AMS+DIM)
1. SPEC
(AMS+HARM)
2. SPEC
(AMS+Peak)
3. SPEC
(AMS+IMD)
4. SPEC
(AMS+IMD)
1. SPEC
(AMS+HARM)
2. SPEC
(AMS+Peak)
3. SPEC
(AMS+IMD)
4. SPEC
(AMS+DIM)
1. SPEC
(AMS+HARM)
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2. The 7th Peak Frequency for Channel A
3. 7.05 kHz for Channel A

16

fnFreq_A(Hz)_Array[?]

1. Harmonic Frequencies for Channel A
2. Peak Frequency for Channel A
3. 1st, 2nd, 3rd order IMD frequencies for
Channel A
4. 3.15 kHz, 15 kHz, U1~U9 frequencies for
Channel A

17

f1RMS_A(EU)

“?” should be replaced by a number starting
from 0.
1) RMS value at Peak / Fundamental
Frequency for Channel A
2) Peak impedance for Channel A
3) RMS value at 3.15 kHz for Channel A

18

f2RMS_A(EU)

1.

19

f3RMS_A(EU)

1. RMS value of the 3rd harmonics for
Channel A
2. RMS value of the 3rd peak for Channel
A
3. RMS value at the 2nd order IMD lower
frequency for Channel A
4. RMS value at 0.75 kHz for Channel A

20

f4RMS_A(EU)

1.

21

f5RMS_A(EU)

1.

22

f6RMS_A(EU)

1.

23

f7RMS_A(EU)

1.

www.virtins.com

2. SPEC
(AMS+Peak)
3. SPEC
(AMS+DIM)
1. SPEC
(AMS+HARM)
2. SPEC
(AMS+Peak)
3. SPEC
(AMS+IMD)
4. SPEC
(AMS+DIM)

RMS value of the 2nd harmonics for
Channel A
2. RMS value of the 2nd peak for Channel
A
3. RMS value at the 2nd peak frequency for
Channel A
4. RMS value at 15 kHz for Channel A

RMS value of the 4th harmonics for
Channel A
2. RMS value of the 4th peak for Channel A
3. RMS value at the 2nd order IMD higher
frequency for Channel A
4. RMS value at 2.40 kHz for Channel A
RMS value of the 5th harmonics for
Channel A
2. RMS value of the 5th peak for Channel A
3. RMS value at the 3rd IMD lower
frequency for Channel A
4. RMS value at 3.90 kHz for Channel A
RMS value of the 6th harmonics for
Channel A
2. RMS value of the 6th peak for Channel A
3. RMS value at the 3rd IMD higher
frequency for Channel A
4. RMS value at 5.55 kHz for Channel A
RMS value of the 7th harmonics for
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1. SPEC (AMS)
2. SPEC
(AMS+IM)
/(AMS+OCT+IM)
3. SPEC
(AMS+DIM)
1. SPEC
(AMS+HARM)
2. SPEC
(AMS+Peak)
3. SPEC
(AMS+IMD)
4. SPEC
(AMS+DIM)
1. SPEC
(AMS+HARM)
2. SPEC
(AMS+Peak)
3. SPEC
(AMS+IMD)
4. SPEC
(AMS+DIM)
1. SPEC
(AMS+HARM)
2. SPEC
(AMS+Peak)
3. SPEC
(AMS+IMD)
4. SPEC
(AMS+DIM)
1. SPEC
(AMS+HARM)
2. SPEC
(AMS+Peak)
3. SPEC
(AMS+IMD)
4. SPEC
(AMS+DIM)
1. SPEC
(AMS+HARM)
2. SPEC
(AMS+Peak)
3. SPEC
(AMS+IMD)
4. SPEC
(AMS+DIM)
1. SPEC
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Channel A
RMS value of the 7th peak for Channel A
RMS value at 7.05 kHz for Channel A

24

fnRMS_A(EU)_Array[?]

25

f1Phase_A(D)

26

fnPhase_A(D)_Array[?]

27
28
29
30
31
32
33
34
35

THD_A(%)
THDN_A(%)
THDDB_A(dB)
THDNDB_A(dB)
SINAD_A(dB)
SNR_A(dB)
NoiseLevel_A(EU)
ENOB_A(Bit)
IMD_A(%)

1. Phases of harmonics for Channel A
2. Phases of peaks for Channel A
“?” should be replaced by a number starting
from 0.
THD in % for Channel A
THD+N in % for Channel A
THD in dB for Channel A
THD+N in dB for Channel A
SINAD in dB for Channel A
SNR in dB for Channel A
Noise Level in EUrms for Channel A
Effective Number of Bits for Channel A
IMD in % for Channel A

36

IMD_A(dB)

IMD in dB for Channel A

37

TDN_A(%)

TD+N in % for Channel A

38

TDN_A(dB)

TD+N in dB for Channel A

39

GedLeeMetric_A

GedLee Metric for Channel A

40

BandWidthLowLimit_A(Hz)

Band Width Low Limit for Channel A

41

BandWidthHighLimit_A(Hz)

Band Width High Limit for Channel A

42

fBand1RMS_A(EU)

43

fBand2RMS_A(EU)

44

fBand3RMS_A(EU)

45

fBand4RMS_A(EU)

46

fBand5RMS_A(EU)

47

fBand6RMS_A(EU)

RMS value of frequency band 1 for Channel
A
RMS value of frequency band 2 for Channel
A
RMS value of frequency band 3 for Channel
A
RMS value of frequency band 4 for Channel
A
RMS value of frequency band 5 for Channel
A
RMS value of frequency band 6 for Channel
A

www.virtins.com

1.
2.
3.

RMS values of harmonics for Channel A
RMS values of peaks for Channel A
RMS values of 1st, 2nd, 3rd order IMD
frequencies for Channel A
4. RMS value in user defined frequency
bands for Channel A
5. RMS value at 3.15kHz, 15kHz, or
U1~U9 for Channel A
“?” should be replaced by a number starting
from 0.
Phase of Peak / Fundamental frequency for
Channel A
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(AMS+HARM)
2. SPEC
(AMS+Peak)
3. SPEC
(AMS+DIM)
1. SPEC
(AMS+HARM)
2. SPEC
(AMS+Peak)
3. SPEC
(AMS+IMD)
4. SPEC
(AMS+EFB)
5. SPEC
(AMS+DIM)
1. SPEC
(AMS+HARM)
2. SPEC
(AMS+Peak)
1. SPEC
(AMS+HARM)
2. SPEC
(AMS+Peak)
SPEC(AMS)
SPEC(AMS)
SPEC(AMS)
SPEC(AMS)
SPEC(AMS)
SPEC(AMS)
SPEC(AMS)
SPEC(AMS)
SPEC
(AMS+IMD)
SPEC
(AMS+IMD)
SPEC
(AMS+Peak+TD
N)
SPEC
(AMS+Peak+TD
N)
SPEC
(AMS+AMS)
SPEC
(AMS+BW)
SPEC
(AMS+BW)
SPEC
(AMS+EFB)
SPEC
(AMS+EFB)
SPEC
(AMS+EFB)
SPEC
(AMS+EFB)
SPEC
(AMS+EFB)
SPEC
(AMS+EFB)
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48

fBand7RMS_A(EU)

49

fBand8RMS_A(EU)

50

SFDR_A(dB)

51

RMSDBV_A(dBEU)

52

RMSDBu_A(dBu)

53
54

RMSDB_A(dB)
RMSDBA_A(dBA)

RMS value of frequency band 7 for Channel
A
RMS value of frequency band 8 for Channel
A
Spurious Free Dynamic Range for Channel
A
RMS value in dBEU for Channel A or
combined
RMS value in dBu for Channel A or
combined
RMS value in dB for Channel A or combined
RMS value in dB(A) for Channel A

55

RMSDBZ_A(dBZ)

RMS value in dB(Z) for Channel A

56

RMSDBC_A(dBC)

RMS value in dB(C) for Channel A

57

Freq_A(Hz)

Counted Frequency for Channel A

58
59
60
61
62
63
64

RPM_A(rpm)
TotalCount_A
DutyCycle_A(%)
FVC_A(V)
CycleRMS_A(EU)
CycleMean_A(EU)
CyclePWR_A(W)

65
66
67

PulseWidth_A(s)
AccelerationRMS_A(g)
AccelerationRMS_A(m/s^2)

68
69

AccelerationPeak_A(g)
AccelerationPeak_A(m/s^2)

70
71
72
73
74
75

AccelerationCF_A
VelocityRMS_A(mm/s)
VelocityPeak_A(mm/s)
VelocityCF_A
DisplacementRMS_A(µm)
DisplacementPP_A(µm)

76
77

DisplacementCF_A
WaveformComparisonH_A

78

WaveformComparisonL_A

79
80

WaveformComparisonSimila
rity_A
SpectrumComparisonH_A

81

SpectrumComparisonL_A

82

SpectrumComparisonSimilari
ty_A
InBandMinF_A(Hz)

Counted RPM for Channel A
Total Count for Channel A
Duty Cycle for Channel A
Voltage after F/V conversion for Channel A
Cycle RMS value for Channel A
Cycle Mean value for Channel A
Cycle Power value (= CycleRMS2 / Load
Factor) for Channel A
Pulse Width for Channel A
Acceleration RMS value in g for Channel A
Acceleration RMS value in m/s^2 for
Channel A
Acceleration Peak value in g for Channel A
Acceleration Peak value in m/s^2 for
Channel A
Acceleration Crest Factor for Channel A
Velocity RMS value for Channel A
Velocity Peak value for Channel A
Velocity Crest Factor for Channel A
Displacement RMS value for Channel A
Displacement Peak-to-Peak value for
Channel A
Displacement Crest Factor for Channel A
Waveform High or High-High Limit Alarm
for Channel A
Waveform Low or Low-Low Limit Alarm
for Channel A
Waveform Similarity Coefficient for
Channel A (Reserved)
Spectrum High or High-High Limit Alarm
for Channel A
Spectrum Low or Low-Low Limit Alarm for
Channel A
Spectrum Similarity Coefficient for Channel
A (Reserved)
1. Frequency at which the minimum RMS
value is located in the specified frequency
band in Channel A
2. Frequency at which the minimum
impedance value is located in the specified

83
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SPEC
(AMS+EFB)
SPEC
(AMS+EFB)
SPEC
(AMS+Peak)
MM(dBV)
MM(dBu)
MM(dB)
MM(dBA)
SPEC(AMS+A)
MM(dBZ)
SPEC(AMS)
MM(dBC)
SPEC(AMS+C)
MM (Freq.
Counter)
MM(RPM)
MM(Counter)
MM(Duty Cycle)
MM(F/V)
MM(CycleRMS)
MM(CycleMean)
MM(CycleRMS)
MM(Pulse Width)
MM(Vibrometer)
MM(Vibrometer)
MM(Vibrometer)
MM(Vibrometer)
MM(Vibrometer)
MM(Vibrometer)
MM(Vibrometer)
MM(Vibrometer)
MM(Vibrometer)
MM(Vibrometer)
MM(Vibrometer)
OSC
OSC
OSC
SPEC
SPEC
SPEC
1. SPEC
(AMS)/(AMS+O
CT)
2. SPEC
(AMS+IM)
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84

InBandMinRMS_A(EU)

85

InBandMaxF_A(Hz)

86

InBandMaxRMS_A(EU)

87

oBandRMS_A(EU)_Array[?]

88
89
90
91
92
93

WowAndFlutter_A(%)
WowAndFlutterRMS_A(%)
Drift_A(%)
WowRMS_A(%)
FlutterRMS_A(%)
SecondPeakACFTimeDelay_
A(s)
SecondPeakACFCoef_A

94
95
96
97
98
99

Loudness_A(SONE)
LoudnessLevel_A(PHON)
Sharpness_A(ACUM)
OutputAmplitude_A(dBFS)
AcousticParameter_A_Array
[?]

100

MaxDiscontinuityValue_A(
%)
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frequency band in Channel A
3. Frequency at which the minimum gain
value is located in the specified frequency
band
4. Frequency at which the minimum
impedance value is located in the specified
frequency band
1. The minimum RMS value in the specified
frequency band in Channel A
2. The minimum impedance value in the
specified frequency band in Channel A
3. The minimum gain value in the specified
frequency band
4. The minimum impedance value in the
specified frequency band
1. Frequency at which the maximum RMS
value is located in the specified frequency
band in Channel A
2. Frequency at which the maximum
impedance value is located in the specified
frequency band in Channel A
3. Frequency at which the maximum gain
value is located in the specified frequency
band
4. Frequency at which the maximum
impedance value is located in the specified
frequency band
1.The maximum RMS value in the specified
frequency band in Channel A
2.The maximum impedance value in the
specified frequency band in Channel A
3.The maximum gain value in the specified
frequency band
4.The maximum impedance value in the
specified frequency band
1. RMS value in a particular octave band in
Channel A. “?” should be replaced by the
actual band number starting from 0.
2. Impedance value in a particular octave
band in Channel A. “?” should be replaced
by the actual band number starting from 0.
Wow & Flutter for Channel A
RMS Wow & Flutter for Channel A
RMS Drift for Channel A
RMS Wow for Channel A
RMS Flutter for Channel A
Time Delay at the second peak of the AutoCorrelation Function for Channel A
The second peak Auto-Correlation Function
Coefficient for Channel A
Sound Loudness for Channel A
Sound Loudness Level for Channel A
Sound Sharpness for Channel A
Output Amplitude in dBFS for Channel A
Acoustic Parameters for Channel A. “?”
should be replaced by the actual array index
starting from 0.
Maximum Discontinuity Value for Channel
A
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/(AMS+OCT+IM)
3. SPEC(TF)
4. SPEC(TF+IM)

1. SPEC(AMS)
/(AMS+OCT)
2. SPEC
(AMS+IM)
/(AMS+OCT+IM)
3. SPEC(TF)
4. SPEC(TF+IM)
1. SPEC(AMS)
/(AMS+OCT)
2. SPEC
(AMS+IM)
/(AMS+OCT+IM)
3. SPEC(TF)
4. SPEC(TF+IM)

1. SPEC(AMS)
/(AMS+OCT)
2. SPEC
(AMS+IM)
/(AMS+OCT+IM)
3. SPEC(TF)
4. SPEC(TF+IM)
1.SPEC
(AMS+OCT)
2.SPEC
(AMS+OCT+IM)

SPEC(AMS)
SPEC(AMS)
SPEC(AMS)
SPEC(AMS)
SPEC(AMS)
SPEC(ACF)
SPEC(ACF)
SPEC(AMS)
SPEC(AMS)
SPEC(AMS)
GEN
OSC(RT60)

OSC(DIS)
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101

MaxDiscontinuityTime_A(s)

102

116
117
118
119
120
121

StepResponseLowLevel_A(E
U)
StepResponseHighLevel_A(
EU)
StepResponseOvershoot_A(
%)
StepResponseUndershoot_A(
%)
StepResponseRiseTime_A(s)
StepResponseFallTime_A(s)
StepResponsePeakTime_A(s)
StepResponsePeakSettle_A(s
)
StepResponseTroughTime_A
(s)
StepResponseTroughSettle_
A(s)
EchoTime_A(s)
DampingRatio_A(s)
ArticulationIndex_A(%)
OpenArticulationIndex_A(%
)
Max_B(EU)
Min_B(EU)
PP_B(EU)
Mean_B(EU)
RMS_B(EU)
PWR_B(W)

122
123
124

PeakLevelPercent_B(%)
PeakLeveldBFS_B
f1Freq_B(Hz)

125

f2Freq_B(Hz)

1. The 2nd Harmonic Frequency for Channel
B
2. The 2nd Peak Frequency for Channel B
3. The 2nd Peak Frequency for Channel B
4. 15 kHz for Channel B

126

f3Freq_B(Hz)

1. The 3rd Harmonic Frequency for Channel
B
2. The 3rd Peak Frequency for Channel B
3. The 2nd order IMD lower frequency for
Channel B
4. 0.75 kHz for Channel B

127

f4Freq_B(Hz)

1. The 4th Harmonic Frequency for Channel
B
2. The 4th Peak Frequency for Channel B
3. The 2nd order IMD higher frequency for

103
104
105
106
107
108
109
110
111
112
113
114
115

www.virtins.com

Time at Maximum Discontinuity for Channel
A
Low Level in Step Response for Channel A

OSC(DIS)

High Level in Step Response for Channel A

OSC(STR)

Overshoot in Step Response for Channel A

OSC(STR)

Undershoot in Step Response for Channel A

OSC(STR)

Rise Time in Step Response for Channel A
Fall Time in Step Response for Channel A
Peak Time in Step Response for Channel A
Peak Settling Time in Step Response for
Channel A
Trough Time in Step Response for Channel
A
Trough Settling Time in Step Response for
Channel A
Echo Time for Channel A
Damping Ratio for Channel A
Articulation Index for Channel A
Open Articulation Index for Channel A

OSC(STR)
OSC(STR)
OSC(STR)
OSC(STR)

Maximum value for Channel B
Minimum value for Channel B
Peak-to-Peak value for Channel B
Mean value for Channel B
RMS value for Channel B
Power value (= RMS2 / Load Factor) for
Channel B
Peak Level in Percentage for Channel B
Peak Level in dBFS for Channel B
1. Peak / Fundamental Frequency for
Channel B
2. Frequency at peak impedance for Channel
B
3. 3.15 kHz for Channel B

OSC(&, |)
OSC(&, |)
OSC(&, |)
OSC(&, |)
OSC(&, |)
OSC(&, |)
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OSC(STR)

OSC(STR)
OSC(STR)
OSC(ECH)
OSC(DPR)
SPEC(AMS)
SPEC(AMS)

OSC
OSC
1. SPEC(AMS)
2. SPEC
(AMS+IM)
/(AMS+OCT+IM)
3. SPEC
(AMS+DIM)
1. SPEC
(AMS+HARM)
2. SPEC
(AMS+Peak)
3. SPEC
(AMS+IMD)
4. SPEC
(AMS+DIM)
1. SPEC
(AMS+HARM)
2. SPEC
(AMS+Peak)
3. SPEC
(AMS+IMD)
4. SPEC
(AMS+DIM)
1. SPEC
(AMS+HARM)
2. SPEC
(AMS+Peak)
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Channel B
4. 2.40 kHz for Channel B

128

f5Freq_B(Hz)

1. The 5th Harmonic Frequency for Channel
B
2. The 5th Peak Frequency for Channel B
3. The 3nd order IMD lower frequency for
Channel B
4. 3.90 kHz for Channel B

129

f6Freq_B(Hz)

1. The 6th Harmonic Frequency for Channel
B
2. The 6th Peak Frequency for Channel B
3. The 3nd order IMD higher frequency for
Channel B
4. 5.55 kHz for Channel B

130

f7Freq_B(Hz)

1. The 7th Harmonic Frequency for Channel
B
2. The 7th Peak Frequency for Channel B
3. 7.05 kHz for Channel B

131

fnFreq_B(Hz)_Array[?]

1. Harmonic frequencies for Channel B
2. Peak frequency for Channel B
3. 1st, 2nd, 3rd order IMD frequencies for
Channel B
4. 3.15 kHz, 15 kHz, U1~U5 frequencies for
Channel B

132

f1RMS_B(EU)

“?” should be replaced by a number starting
from 0.
1. RMS value at Peak / Fundamental
Frequency for Channel B
2. Peak impedance for Channel B
3. RMS value at 3.15 kHz for Channel B

133

f2RMS_B(EU)

1.

134

f3RMS_B(EU)

1.

135

f4RMS_B(EU)

1.

www.virtins.com

RMS value of the 2nd harmonics for
Channel B
2. RMS value of the 2nd peak for Channel
B
3. RMS value at the 2nd peak frequency for
Channel B
4. RMS value at 15 kHz for Channel B
RMS value of the 2nd harmonics for
Channel B
2. RMS value of the 2nd peak for Channel
B
3. RMS value at the 2nd order IMD lower
frequency for Channel B
4. RMS value at 0.75 kHz for Channel B
RMS value of the 2nd harmonics for
Channel B
2. RMS value of the 2nd peak for Channel
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3. SPEC
(AMS+IMD)
4. SPEC
(AMS+DIM)
1. SPEC
(AMS+HARM)
2. SPEC
(AMS+Peak)
3. SPEC
(AMS+IMD)
4. SPEC
(AMS+DIM)
1. SPEC
(AMS+HARM)
2. SPEC
(AMS+Peak)
3. SPEC
(AMS+IMD)
4. SPEC
(AMS+DIM)
1. SPEC
(AMS+HARM)
2. SPEC
(AMS+Peak)
3. SPEC
(AMS+DIM)
1. SPEC
(AMS+HARM)
2. SPEC
(AMS+Peak)
3. SPEC
(AMS+IMD)
4. SPEC
(AMS+DIM)
1. SPEC(AMS)
2. SPEC
(AMS+IM)
/(AMS+OCT+IM)
3. SPEC
(AMS+DIM)
1. SPEC
(AMS+HARM)
2. SPEC
(AMS+Peak)
3. SPEC
(AMS+IMD)
4. SPEC
(AMS+DIM)
1. SPEC
(AMS+HARM)
2. SPEC
(AMS+Peak)
3. SPEC
(AMS+IMD)
4. SPEC
(AMS+DIM)
1. SPEC
(AMS+HARM)
2. SPEC
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4.
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B
RMS value at the 2nd order IMD higher
frequency for Channel B
RMS value at 2.40 kHz for Channel B

RMS value of the 2nd harmonics for
Channel B
2. RMS value of the 2nd peak for Channel
B
3. RMS value at the 3nd order IMD lower
frequency for Channel B
4. RMS value at 3.90 kHz for Channel B

136

f5RMS_B(EU)

1.

137

f6RMS_B(EU)

1.

138

f7RMS_B(EU)

1.

139

fnRMS_B(EU)_Array[?]

1.
2.
3.

RMS value of the 2nd harmonics for
Channel B
2. RMS value of the 2nd peak for Channel
B
3. RMS value at the 3nd order IMD higher
frequency for Channel B
4. RMS value at 5.55 kHz for Channel B
RMS value of the 2nd harmonics for
Channel B
2. RMS value of the 2nd peak for Channel
B
3. RMS value at 7.05 kHz for Channel B

4.
5.

RMS value of harmonics for Channel B
RMS value of peaks for Channel B
RMS values of 1st, 2nd, 3rd order IMD
frequencies for Channel B
RMS value in user defined frequency
bands for Channel B
RMS value at 3.15 kHz, 15kHz, or
U1~U9 for Channel B

“?” should be replaced by a number starting
from 0.
Phase of Peak / Fundamental Frequency for
Channel B

140

f1Phase_B(D)

141

fnPhase_B(D)_Array[?]

142
143
144
145
146
147
148
149
150

THD_B(%)
THDN_B(%)
THDDB_B(dB)
THDNDB_B(dB)
SINAD_B(dB)
SNR_B(dB)
NoiseLevel_B(EU)
ENOB_B(Bit)
IMD_B(%)

1. Phases of harmonic frequencies for
Channel B
2. Phases of peak frequencies for Channel
B
“?” should be replaced by a number starting
from 0.
THD in % for Channel B
THD+N in % for Channel B
THD in dB for Channel B
THD+N in dB for Channel B
SINAD in dB for Channel B
SNR in dB for Channel B
Noise Level in EUrms for Channel B
Effective Number of Bits for Channel B
IMD in % for Channel B

151

IMD_B(dB)

IMD in dB for Channel B
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(AMS+Peak)
3. SPEC
(AMS+IMD)
4. SPEC
(AMS+DIM)
1. SPEC
(AMS+HARM)
2. SPEC
(AMS+Peak)
3. SPEC
(AMS+IMD)
4. SPEC
(AMS+DIM)
1. SPEC
(AMS+HARM)
2. SPEC
(AMS+Peak)
3. SPEC
(AMS+IMD)
4. SPEC
(AMS+DIM)
1. SPEC
(AMS+HARM)
2. SPEC
(AMS+Peak)
3. SPEC
(AMS+DIM)
1. SPEC
(AMS+HARM)
2. SPEC
(AMS+Peak)
3. SPEC
(AMS+IMD)
4. SPEC
(AMS+EFB)
5. SPEC
(AMS+DIM)
1. SPEC
(AMS+HARM)
2. SPEC
(AMS+Peak)
1. SPEC
(AMS+HARM)
2. SPEC
(AMS+Peak)

SPEC(AMS)
SPEC(AMS)
SPEC(AMS)
SPEC(AMS)
SPEC(AMS)
SPEC(AMS)
SPEC(AMS)
SPEC(AMS)
SPEC
(AMS+IMD)
SPEC
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152

TDN_B(%)

TD+N in % for Channel B

153

TDN_B(dB)

TD+N in dB for Channel B

154

GedLeeMetric_B

GedLee Metric for Channel B

155

BandWidthLowLimit_B(Hz)

Band Width Low Limit for Channel B

156

BandWidthHighLimit_B(Hz)

Band Width High Limit for Channel B

157

fBand1RMS_B(EU)

158

fBand2RMS_B(EU)

159

fband3RMS_B(EU)

160

fband4RMS_B(EU)

161

fBand5RMS_B(EU)

162

fBand6RMS_B(EU)

163

fBand7RMS_B(EU)

164

fBand8RMS_B(EU)

165

SFDR_B(dB)

RMS value of frequency band 1 for Channel
B
RMS value of frequency band 2 for Channel
B
RMS value of frequency band 3 for Channel
B
RMS value of frequency band 4 for Channel
B
RMS value of frequency band 5 for Channel
B
RMS value of frequency band 6 for Channel
B
RMS value of frequency band 7 for Channel
B
RMS value of frequency band 8 for Channel
B
Spurious Free Dynamic Range for Channel B

166
167
168
169

RMSDBV_B(dBEU)
RMSDBu_B(dBu)
RMSDB_B(dB)
RMSDBA_B(dBA)

RMS value in dBEU for Channel B
RMS value in dBu for Channel B
RMS value in dB for Channel B
RMS value in dB(A) for Channel B

170

RMSDBZ_B(dBZ)

RMS value in dB(Z) for Channel B

171

RMSDBC_B(dBC)

RMS value in dB(C) for Channel B

172

Freq_B(Hz)

Counted Frequency for Channel B

173
174
175
176
177
178
179

RPM_B(rpm)
TotalCount_B
DutyCycle_B(%)
FVC_B(V)
CycleRMS_B(EU)
CycleMean_B(EU)
CyclePWR_B(W)

180
181
182

PulseWidth_B(s)
AccelerationRMS_B(g)
AccelerationRMS_B(m/s^2)

183
184

AccelerationPeak_B(g)
AccelerationPeak_B(m/s^2)

185
186

AccelerationCF_B
VelocityRMS_B(mm/s)

Counted RPM for Channel B
Total Count for Channel B
Duty Cycle for Channel B
Voltage after F/V conversion for Channel B
Cycle RMS for Channel B
Cycle Mean for Channel B
Cycle Power (= CycleRMS2 / Load Factor)
for Channel B
Pulse Width for Channel B
Acceleration RMS value in g for Channel B
Acceleration RMS value in m/s^2 for
Channel B
Acceleration Peak value in g for Channel B
Acceleration Peak value in m/s^2 for
Channel B
Acceleration Crest Factor for Channel B
Velocity RMS value for Channel B
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(AMS+IMD)
SPEC
(AMS+Peak+TD
N)
SPEC
(AMS+Peak+TD
N)
SPEC
(AMS+AMS)
SPEC
(AMS+BW)
SPEC
(AMS+BW)
SPEC
(AMS+EFB)
SPEC
(AMS+EFB)
SPEC
(AMS+EFB)
SPEC
(AMS+EFB)
SPEC
(AMS+EFB)
SPEC
(AMS+EFB)
SPEC
(AMS+EFB)
SPEC
(AMS+EFB)
SPEC
(AMS+Peak)
MM(dBV)
MM(dBu)
MM(dB)
MM(dBA)
SPEC (AMS+A)
MM(dBZ)
SPEC(AMS)
MM(dBC)
SPEC(AMS+C)
MM (Freq.
Counter)
MM(RPM)
MM(Counter)
MM(Duty Cycle)
MM(F/V)
MM(CycleRMS)
MM(CycleMean)
MM(CycleRMS)
MM(Pulse Width)
MM(Vibrometer)
MM(Vibrometer)
MM(Vibrometer)
MM(Vibrometer)
MM(Vibrometer)
MM(Vibrometer)
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187
188
189
190

VelocityPeak_B(mm/s)
VelocityCF_B
DisplacementRMS_B(µm)
DisplacementPP_B(µm)

191
192

DisplacementCF_B
WaveformComparisonH_B

193

WaveformComparisonL_B

194
195

WaveformComparisonSimila
rity_B
SpectrumComparisonH_B

196

SpectrumComparisonL_B

197
198

SpectrumComparisonSimilari
ty_B
InBandMinF_B(Hz)

199

InBandMinRMS_B(EU)

200

InBandMaxF_B(Hz)

201

InBandMaxRMS_B(EU)

202

oBandRMS_B(EU)_Array[?]

www.virtins.com

Virtins Technology

Velocity Peak value for Channel B
Velocity Crest Factor for Channel B
Displacement RMS value for Channel B
Displacement Peak-to-Peak value for
Channel B
Displacement Crest Factor for Channel B
Waveform High or High-High Limit Alarm
for Channel B
Waveform Low or Low-Low Limit Alarm
for Channel B
Waveform Similarity Coefficient for
Channel B (Reserved)
Spectrum High or High-High Limit Alarm
for Channel B
Spectrum Low or Low-Low Limit Alarm for
Channel B
Spectrum Similarity Coefficient for Channel
B (Reserved)
1. Frequency at which the minimum RMS
value is located in the specified frequency
band in Channel B
2. Frequency at which the minimum
impedance value is located in the specified
frequency band in Channel B
3. Frequency at which the minimum gain
value is located in the specified frequency
band
4. Frequency at which the minimum
impedance value is located in the specified
frequency band
1. The minimum RMS value in the specified
frequency band in Channel B
2. The minimum impedance value in the
specified frequency band in Channel B
3. The phase at the minimum gain value in
the specified frequency band
4. The phase at the minimum impedance
value in the specified frequency band
1. Frequency at which the maximum RMS
value is located in the specified frequency
band in Channel B
2. Frequency at which the maximum
impedance value is located in the specified
frequency band in Channel B
3. Frequency at which the maximum gain
value is located in the specified frequency
band
4. Frequency at which the maximum
impedance value is located in the specified
frequency band
1.The maximum RMS value in the specified
frequency band in Channel B
2.The maximum impedance value in the
specified frequency band in Channel B
3.The phase at the maximum gain value in
the specified frequency band
4.The phase at the maximum impedance
value in the specified frequency band
1. RMS value in a particular octave band in
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MM(Vibrometer)
MM(Vibrometer)
MM(Vibrometer)
MM(Vibrometer)
MM(Vibrometer)
OSC
OSC
OSC
SPEC
SPEC
SPEC
1. SPEC(AMS)
/(AMS+OCT)
2. SPEC
(AMS+IM)/
/(AMS+OCT+IM)
3. SPEC(TF)
4. SPEC(TF+IM)

1. SPEC(AMS)
/(AMS+OCT)
2. SPEC
(AMS+IM)
/(AMS+OCT+IM)
3. SPEC(TF)
4. SPEC(TF+IM)
1. SPEC(AMS)
/(AMS+OCT)
2. SPEC
(AMS+IM)
/(AMS+OCT+IM)
3. SPEC(TF)
4. SPEC(TF+IM)

1. SPEC(AMS)
/(AMS+OCT)
2. SPEC
(AMS+IM)
/(AMS+OCT+IM)
3. SPEC(TF)
4. SPEC(TF+IM)
1.SPEC
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203
204
205
206
207
208
209

WowAndFlutter_B(%)
WowAndFlutterRMS_B(%)
Drift_B(%)
WowRMS_B(%)
FlutterRMS_B(%)
SecondPeakACFTimeDelay_
B(s)
SecondPeakACFCoef_B

210
211
212
213
214

Loudness_B(SONE)
LoudnessLevel_B(PHON)
Sharpness_B(ACUM)
OutputAmplitude_B(dBFS)
AcousticParameter_B_Array[
?]

215

MaxDiscontinuityValue_B(
%)
MaxDiscontinuityTime_B(s)

216
217

227
228
229
230
231

StepResponseLowLevel_B(E
U)
StepResponseHighLevel_B(
EU)
StepResponseOvershoot_B(
%)
StepResponseUndershoot_B(
%)
StepResponseRiseTime_B(s)
StepResponseFallTime_B(s)
StepResponsePeakTime_B(s)
StepResponsePeakSettle_B(s
)
StepResponseTroughTime_B
(s)
StepResponseTroughSettle_
B(s)
EchoTime_B(s)
DampingRatio_B
ArticulationIndex_B(%)
OpenArticulationIndex_B(%)
PeakCCFTimeDelay_AB(s)

232
233

PeakCCFCoef_AB
PeakCHFFreq_AB(Hz)

234
235
236

PeakCHFCoef_AB
TNCD_AB(%)
PeakGainFreq_AB(Hz)

237

PeakGainValue_AB(dB)

238

PeakGainPhase_AB(D)

218
219
220
221
222
223
224
225
226
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Channel B. “?” should be replaced by the
actual band number starting from 0.
2. Impedance value in a particular octave
band in Channel B. “?” should be replaced
by the actual band number starting from 0.
Peak Wow & Flutter for Channel B
RMS Wow & Flutter for Channel B
RMS Drift for Channel B
RMS Wow for Channel B
RMS Flutter for Channel B
Time Delay at the second peak of the AutoCorrelation Function for ChannelB
The second peak Auto-Correlation Function
Coefficient for Channel B
Sound Loudness for Channel B
Sound Loudness Level for Channel B
Sound Sharpness for Channel B
Output Amplitude in dBFS for Channel B
Acoustic Parameters for Channel B. “?”
should be replaced by the actual array index
starting from 0.
Maximum Discontinuity Value for Channel
B
Time at Maximum Discontinuity for Channel
B
Low Level in Step Response for Channel B

(AMS+OCT)
2.SPEC
(AMS+OCT+IM)

High Level in Step Response for Channel B

OSC(STR)

Overshoot in Step Response for Channel B

OSC(STR)

Undershoot in Step Response for Channel B

OSC(STR)

Rise Time in Step Response for Channel B
Fall Time in Step Response for Channel B
Peak Time in Step Response for Channel B
Peak Settling Time in Step Response for
Channel B
Trough Time in Step Response for Channel
B
Trough Settling Time in Step Response for
Channel B
Echo Time for Channel B
Damping Ratio for Channel B
Articulation Index for Channel B
Open Articulation Index for Channel B
Time Delay at the peak of the CrossCorrelation Function
Peak Cross-Correlation Function Coefficient
Frequency at the peak of the Coherence
Function
Peak Coherence Function Coefficient
Total Non-Coherent Distortion and Noise
1. Frequency at the peak gain
2. Frequency at the peak impedance
1. Peak gain Value
2. Peak impedance Value
1. Phase at the peak gain
2. Phase at the peak impedance

OSC(STR)
OSC(STR)
OSC(STR)
OSC(STR)
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SPEC(AMS)
SPEC(AMS)
SPEC(AMS)
SPEC(AMS)
SPEC(AMS)
SPEC(ACF)
SPEC(ACF)
SPEC(AMS)
SPEC(AMS)
SPEC(AMS)
GEN
OSC(RT60)

OSC(DIS)
OSC(DIS)
OSC(STR)

OSC(STR)
OSC(STR)
OSC(ECH)
OSC(DPR)
SPEC(AMS)
SPEC(AMS)
SPEC(CCF)
SPEC(CCF)
SPEC(CHF)
SPEC(CHF)
SPEC(CHF)
1. SPEC(TF)
2. SPEC(TF+IM)
1. SPEC(TF)
2. SPEC(TF+IM)
1. SPEC(TF)
2. SPEC(TF+IM)
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239
240
241

PeakIPRTime_AB(s)
PeakIPRValue_AB
GainAtGeneratedFreq(dB)

242

PhaseAtGeneratedFreq(D)

243
244
245
246

CrossTalkAB(dB)
CrossTalkBA(dB)
NumberOfFrames
OverallPassFailCheck

Virtins Technology

Time at the peak of the Impulse Response
Peak Impulse Response Value
1. Gain at the frequency generated by
Channel A of the Signal Generator
2. Impedance at the frequency generated by
Channel A of the Signal Generator
1. Phase at the frequency generated by
Channel A of the Signal Generator
2. Phase at the frequency generated by
Channel A of the Signal Generator
Crosstalk from Channel A to Channel B
Crosstalk from Channel B to Channel A
Number of data frames sampled
Overall pass/fail check for all opened DDP
viewers
User Defined Data Points

SPEC(IPR)
SPEC(IPR)
1. SPEC
(TF,GEN)
2. SPEC
(TF+IM,GEN)
1.SPEC
(TF,GEN)
2. SPEC
(TF+IM,GEN)
SPEC(AMS,CT)
SPEC(AMS,CT)
Always
DDP Viewer

247 UDDP1(UU)
DDP Viewer
~
~
262 UDDP16(UU)
Legend: OSC---Oscilloscope, SPEC---Spectrum Analyzer, GEN---Signal Generator, MM---Multimeter
AMS---Amplitude Spectrum, CCF---Cross Correlation Function, CHF---Coherence Function, TF--Transfer Function, IPR---Impulse Response, BW---Bandwidth, EFB---Energy in User Defined
Frequency Bands, HARM---Harmonics, CT---Crosstalk, A---A Weighting, Z---Z Weighting, C---C
Weighting, OCT---Octave Analysis, IM---Impedance Mode, IMD---Intermodulation, DIM---Dynamic
Intermodulation, TDN---Total Distortion+Noise, RT60---Reverberation and Speech Intelligibility, DIS--Discontinuity, STR---Step Response, ECH---Echo, DPR---Damping Ratio

6.2.2 Legend
Each DDP can be assigned a unique color and label.
6.2.3 Logging Method
Three logging methods are supported:


Fastest
The data logger will take one record whenever a new data frame is available



Time Interval
The data logger will take one record whenever a new data frame is available and
the specified time duration has elapsed since the last update.



Update Threshold
The data logger will take one record whenever a new data frame is available and
the change of any DDP compared with its last update exceeds the specified update
threshold for that DDP.

6.2.4 Log File Name
For real time logging, there is no need to specify the log file name as it will be
assigned automatically by the software, according to the following naming convention:
Example: 2007-10-31-09-55-45-180-1.log
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where:
2007 -----Year: 2007
10---------Month: October
31---------Day: 31
09---------Hour: 9
55---------Minute: 55
45---------Second: 45
180--------Millisecond: 180
1-----------Data Logger Window No.: 1
.log--------File Extension
The above time stamp corresponds to the first data point captured in the data logger
window. The logged data will be automatically written to the hard disk once the
number of data points per trace exceeds 32767 (configurable via
[Setting]>[Display]>”Data Logger”>”Number of records per log file”). A new log file
will be created automatically afterwards to continue the logging process. Note that
the logged data will be lost if the DDP configuration is changed before the data in
memory are saved to the hard disk. If you do not want to lose the data, you should
perform “Data Logger Export” or “Data Logger Copy As Text” command first.
When you close the data logger window, the logged data points that are still in the
computer memory will be automatically written to the hard disk.
The log file name is always displayed in the title bar of the data logger window. A “*”
sign will be displayed on the right of the log file name if the log file has not been
persisted in the hard disk yet. This is to indicate that it is a real-time log file (e.g.
2020-07-22-23-29-51-878-2.log*). Otherwise, it is a historical log file (e.g. 2020-0722-23-29-51-878-2.log).
Pressing the “File Open” button in the Configuration dialog will allow you to select
and load a historical log file for review. Clicking the “Logging” checkbox will switch
it back to the real-time logging mode.
The log file is a Comma Separated Variable (CSV) TXT file. It has the following
format which is self-explanatory. All data are logged with an accuracy of 1
millisecond.
No., Time(s),
Max_A(V),
Min_A(V),
Mean_A(V)
1, 2007-10-31 12:04:52:021, -0.0132446, -0.0142517, -0.0137236
2, 2007-10-31 12:04:53:022, -0.0132751, -0.0144348, -0.0139354
……

6.3 Context Menu
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Data Logger does not have its own menu and view parameter toolbar. Its functions are
accessed via its context menu. The context menu pops up when you right click
anywhere within the data logger window.
6.3.1 X Scale

The X Scale dialog can be accessed via the context menu or by double clicking on X
axis of the window. You can specify the span of X axis, the default value is 10 s. If
the data spans a larger time range, then a horizontal scrollbar will appear at the bottom
of the window to allow you to scroll over the full time range.
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During real time logging, the screen will automatically scroll to show the latest data
as new data are continuously fed into the right of the window.
“Display Relative Time” option is used to display time difference relative to the
starting time of current log file rather than the absolute time. It is ticked by default.
6.3.2 Y Scale

The Y Scale dialog can be accessed via the context menu or by double clicking on Y
axis. You can specify the range of Y axis and choose between linear or logarithmic
scales. Note that the software will disallow logarithmic scale if the range covers
negative or zero values.
6.3.3 Chart Options
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Same as Oscilloscope, except that you can also specify a title here.
6.3.4 Copy As Bitmap
Same as Oscilloscope
6.3.5 Copy As Text
Same as Oscilloscope
6.3.6 Export
Same as Oscilloscope
6.3.7 Print
Same as Oscilloscope
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6.4 Cursor reader and Markers
Similar to those in the Oscilloscope, except that the cursor reader can read out the
measurement points for all traces (up to 8) and the markers mark the point exactly at
the point of mouse click rather than sticking to the nearest measurement point.
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7 Spectrum 3D Plot
7.1 Overview
Spectrum 3D Plot is used to trace the spectrum variation with time. It is a very useful
tool for time-frequency analysis. Two types of plots are provided: waterfall plot and
spectrogram. Two processing modes are supported: Inter-frame and Intra-frame. Two
analyzing modes are available: STFT (Short-Time Fourier Transform) and CSD
(Cumulative Spectral Decay).
The Spectrum 3D Plot can be generated by multiple frames of data (Inter-frame Mode)
or one single frame of data (Intra-frame Mode). The former supports STFT only
while the latter supports both STFT and CSD.
The following figure shows a waterfall plot, with an adjustable tilt angle of T axis, an
adjustable height of Y axis, and selectable color palettes.

The following figure shows a spectrogram, with selectable color palettes and a
smoothing option.
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The toggle button
in the Instrument Toolbar is used to open or close the Spectrum
3D Plot. The button is enabled only when the Spectrum Analyzer is under Amplitude
Spectrum mode, because the spectral profiles are fed from the Spectrum Analyzer
under that mode. All intra-frame processing options set in the Spectrum Analyzer are
applicable to the Spectrum 3D Plot too.
You can also close the Spectrum 3D Plot window by clicking the "Close" button at its
upper right corner.

7.2 View Parameters

View parameters determine how the collected data are analyzed and displayed.
7.2.1 Frequency Range (F)
Same as Amplitude Spectrum display in the Spectrum Analyzer.

7.2.2 Channel A Display Range
Same as Amplitude Spectrum display in the Spectrum Analyzer.
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7.2.3 View Type
Two types of views are supported: Waterfall Plot and Spectrogram.

7.2.4 Channel B Display Range
Same as Amplitude Spectrum display in the Spectrum Analyzer.

7.2.5 Number of Spectral Profiles (T axis)

This parameter determines the maximum number of spectral profiles to be displayed
in one graph. All spectral profiles are computed and fed by the Spectrum Analyzer
through either inter-frame processing or intra-frame processing. The oldest spectral
profile will be dropped when a new spectral profile comes in.
This parameter is available for selection from the above options under inter-frame
mode, while under intra-frame mode, its value will be automatically determined by
the software and thus prohibited from user selection.
7.2.6 Tilt Angle of T Axis

The Tilt Angle of T axis is the angle between T axis and the vertical axis. It can be
adjusted from 0 degree to a maximum value (less than 90 degrees) which is
determined by the Height Percentage of Y axis.
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This parameter is only applicable to the Waterfall Plot and is not applicable to the
Spectrogram.
7.2.7 Height Percentage of Y Axis

The Height Percentage is the ratio of the height of Y axis to the height of the plot area.
It can be adjusted from 5% to 90%. Lowering the Height Percentage will cause the
tilt angle of T axis go down accordingly if the tilt angle exceeds its upper limit
determined by the Height Percentage.
7.2.8 Processing Mode

Two processing modes are supported: inter-frame mode and intra-frame mode.

7.2.8.1 Inter-frame Mode

Under the inter-frame mode, the Spectrum Analyzer derives one spectrum profile per
oscilloscope data frame and feed it into the Spectrum 3D Plot. Multiple consecutive
oscilloscope data frames are required in order to fill up the entire Spectrum 3D Plot.
The inter-frame mode supports only STFT.

7.2.8.2 Intra-frame Mode
Under the intra-frame mode, the Spectrum Analyzer splits an oscilloscope data frame
into multiple FFT segments, derives one spectrum profile per FFT segment, and fill
up the entire Spectrum 3D Plot in one shot. Two analyzing modes are supported:
STFT and CSD.
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7.2.8.2.1 Short-Time Fourier Transform (STFT)

Short-Time Fourier Transform (STFT) is a time-frequency analysis technique suited
for non-stationary signals. It uses a short-time data window to perform Fourier
transform in order to get the spectrum profile during that period. The spectral contents
are considered quasi-stationary inside the data window. Spectral variation with time
can be obtained by sliding or hopping the window along the time axis. This can be
realized through either the intra-frame processing or the inter-frame processing
described previously.
When conceiving your own time-frequency analysis strategy, the uncertainty principle
should be noted. There exists a trade-off between time and frequency resolution in
STFT. Although a narrow-width window results in a better resolution in time domain,
it generates a poor resolution in frequency domain, and vice versa.
The number of FFT segments is automatically determined by the software as follows:
[Number of FFT segments] =
([Record Length]-[Overlap Size]) / ([FFT Size]-[Overlap Size])
where [Overlap Size]= [FFT Size]×[Window Overlap Percentage]).
Note that:
(1) If [Record Length]<[FFT Size], then the number of spectrum profiles will be
forced to 1.
(2) The maximum number of spectrum profiles allowed is 2000. Data used for the
Spectrum 3D Plot will be truncated if this maximum number is exceeded.
(3) No inter-frame processing is allowed in the Spectrum Analyzer.
(4) Window Overlap Percentage should generally be set to a value less than 99%.
The following figure illustrates how to use Spectrum 3D Plot to perform reverberation
analysis. The sound pressure decay data were recorded using the interrupted noise
method introduced previously. The parameters are as follows: [Sampling
Frequency]=48kHz, [Record length]=254400, [FFT Size]=1024, [Window Overlap
Percentage]=85%, [Overlap Size]=1024×85%=870. The number of spectrum profiles
is then: (254400-870)/[1024-870]=1646. The time length of a FFT segment is

www.virtins.com

376 Copyright © 2006-2022

Virtins Technology

VIRTINS Multi-Instrument 3.9 Manual

Virtins Technology

1024/48000=0.021333s. The time interval between two consecutive spectrum profiles
is (1024-870)/48000=0.003208s. Hann window is used in the Spectrum Analyzer and
the X scale of the Spectrum 3D Plot is set to 1/1 octave.

The data in the above figure can be exported to EXCEL for further analysis. The
exported data can be either time-sliced or frequency-sliced. The following figure
shows the sound pressure level decay in the 1kHz 1/1 octave band using the exported
frequency-sliced data.
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7.2.8.2.2 Cumulative Spectral Decay (CSD)

Cumulative Spectral Decay (CSD) is similar to STFT. However, unlike STFT, CSD
does not use a fixed-size window and does not move the entire window. Instead, it
anchors the end side of the data window at the end of the useful part of the signal, and
only moves the start side of the data window along the time axis. As the window
width decreases, the frequency resolution, which is equal to 1/[window width],
becomes coarser, the unresolvable low frequency region of the spectrum becomes
wider. This is often reflected by the boundary line along the low frequency end in the
CSD graph. In contrast to STFT where the actual number of samples used in a FFT
segment must be a power of 2 and no zero-padding is applied, CSD does not impose
such a restriction and zero-padding is used when necessary.
CSD is often used when the signal duration is too short to have space for STFT
window sliding. It is true that the signal can be recorded for a longer duration to solve
this problem. However, this usually means more noises will be incorporated into the
analysis as the signal may have already decayed significantly. Using CSD prevents
the incorporation of the noise where the signal-to-noise ratio becomes bad. Due to
this reason, CSD is mainly used to analyze loudspeaker impulse response which spans
a very short duration. It is a useful tool for loudspeaker resonance detection.
The number of FFT segments in CSD is automatically determined by the software as
follows:
[Number of FFT segments] = 1+[Sweep Range] / ([FFT Size]-[Overlap Size])
where:
[Sweep Range] = min([FFT Size],[Record Length]) × [Sweep Percentage]
[Overlap Size] = [FFT Size] × [Window Overlap Percentage]
In the CSD of this software, the FFT size determines the initial data window width.
The moving range of the start side of the data window is called Sweep Range, which
is equal to the product of the FFT size or Record Length, whichever is smaller, and
the Sweep Percentage. The Sweep Percentage can be specified by the users and is
90% by default.
Note that:
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(1) The number of spectrum profiles will be forced to be at least 1.
(2) The maximum number of spectrum profiles allowed is 2000. Data used for the
Spectrum 3D Plot will be truncated if this maximum number is exceeded.
(3) No inter-frame processing is allowed in the Spectrum Analyzer.
(4) Window Overlap Percentage should generally be set to a value greater than
95%.
In Multi-Instrument, the window function is applied to the real samples in a FFT
segment. If the signal is very much “left aligned”, which is usually the case for an
impulse response, then the useful information will be significantly tapered by a nonrectangle window function. To carter for the special need of CSD, a composite
window function is used (see figure below). The window function consists of three
parts: rising edge, flat top, and falling edge. The rising edge and falling edge are
formed respectively by the left and right parts of the window function selected in the
Spectrum Analyzer. The widths of the rising and falling edges are equal, fixed and
configurable. The width of the flat top portion of the composite window decreases as
the start side of the window moves along the time axis.

The following figure shows a CSD waterfall plot of an impulse response of a
loudspeaker box, with the following parameters: [Record Length]=6314, [Sampling
Frequency]=44100Hz, [FFT Size]=1024, [Window Function]=Hann, [Window
Overlap Percentage]=99%, [Rise Time]=0.35ms, [Sweep Percentage]=90%. Then we
have: [Sweep Range] = 1024 × 90% =921, [Overlap Size] = 1024 × 99% =1013. The
number of spectrum profiles is then: 1 + 921 / (1024-1013) = 84.
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7.2.9 Analyzing Mode

Two analyzing modes are available: STFT and CSD, as described previously.

7.3 Menu
Spectrum 3D Plot has its own menu and additional functions can be accessed through
the menu items in each submenu.
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7.3.1 File SubMenu

This submenu provides access to the file operation and printing functions, and is
similar to that of the Oscilloscope.
7.3.2 Setting SubMenu

This submenu provides access to various setting functions, and is similar to that of the
Oscilloscope, except the following items.
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7.3.2.1 Spectrum 3D Plot Processing (Setting SubMenu) (ALT-S-G)

Under the Processing Tab, the Sweep Percentage and Rise Time of CSD can be
configured. These two parameters have been introduced previously.

7.3.2.2 Spectrum 3D Plot X Scale (Setting SubMenu) (ALT-S-X)
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X axis (or F axis) can be set to linear, log, or 1/1~1/96 octave scale. The “Start
Frequency” option allows you to specify the start frequency of the X axis. If it is not
used, the start frequency will be determined by the software automatically.
This function can also be accessed by double clicking on X axis.

7.3.2.3 Spectrum 3D Plot Y Scale (Setting SubMenu) (ALT-S-Y)
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There is only one display mode for the vertical axis (Y): Absolute Mode. All spectral
data points are plotted based on their absolute values, in V(rms), dBV, dBu, dB, or
dBFS. “Shift Display Range by (dB)” option is enabled when the unit of Y axis is
dBV, dBu, dB or dBFS. It is used to modify the display range of Y axis. For example,
if the original display range is 120dB~20dB and “-10dB” is selected in this option,
then the display range will be changed to 110dB~10dB. In effect, the display is
“amplified” by 10dB. This function can be more conveniently manipulated by the
axis magnifying glass introduced in the Oscilloscope chapter.
This function can also be accessed by double clicking on Y axis.

7.3.2.4 Spectrum 3D Plot Chart Options (Setting SubMenu) (ALT-S-O)
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Six color palettes are available for the Waterfall Plot: No Color, Rainbow, Bluish,
Yellowish, Grayscale, Inverted Grayscale. Note that except the first option, the rest
options may slow down the process a bit, but you can choose to dye the waterfall plot
after you stop the data acquisition.
Five color palettes are available for the Spectrogram: Rainbow, Bluish, Yellowish,
Grayscale, Inverted Grayscale. The “Smoothing” option can make the spectrogram
look more “continuous” in space, as illustrated as follows.

7.3.3 Instrument SubMenu
Same as Oscilloscope.
7.3.4 Window SubMenu
Same as Oscilloscope.
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7.3.5 Help SubMenu
Same as Oscilloscope.

7.4 Context Menu

The above context menu will be shown when right clicking anywhere within the
Spectrum 3D Plot. It provides additional convenience to you. All menu items in the
context menu can also be found in the Spectrum 3D Plot main menu except the
following items: Copy As Bitmap, Copy As Text, AutoScaling, Display Ch.A Only,
Display Ch.B Only, Display All.

7.5 3D Cursor Reader
The Waterfall Plot and the Spectrogram have different 3D cursor readers.

7.5.1 3D Cursor Reader for Waterfall Plot
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The cursor reader will be shown when you left click anywhere within the plot area of
the bottom plane (X-T). The contour of the spectrum profile with a time stamp nearest
to the point of mouse click will be highlighted (thus T is determined). This profile
will also be projected onto the front plane (X-Y) so that it can be easily viewed
against the X and Y scales. Within this profile, the cursor reader will point to the
measurement point with a frequency nearest to the point of mouse click (thus X is
determined). With T and X determined, Y is thus determined from the measurement
results. The cursor reader always appears as a pair, one for each channel. The
cursor’s (X, Y, T) readings for both channels are displayed on the top the graph. Their
difference in Y is also shown.
7.5.2 3D Cursor Reader for Spectrogram
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The cursor reader will be shown when you left click anywhere within the
Spectrogram (X-T). The spectrum profile with a time stamp nearest to the point of
mouse click will be extracted and displayed at the bottom of the Spectrogram (thus T
is determined). Within this profile, the cursor reader will point to the measurement
point with a frequency nearest to the point of mouse click (thus X is determined).
With T and X determined, Y is thus determined from the measurement results. The
cursor reader always appears as a pair, one for each channel. The cursor’s (X, Y, T)
readings for both channels are displayed on the top the graph. Their difference in Y is
also shown.

7.6 Time Stamp
The time stamp of the latest spectral profile is displayed at the bottom of the 3D graph,
and the time stamp of the oldest spectral profile is displayed on the top the 3D graph.
The time axis labels are marked with a time offset relative to the time of the oldest
spectrum profile.

7.7 Ordering of Output Data
When outputting data using either “Export” or “Copy As Text” command, the
message “Press YES to slice data by Time, or press NO to slice data by Frequency”
will pop up. The former outputs spectrum profiles at particular times one by one,
while the latter output time variation profiles at particular frequencies one by one.
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8 Device Test Plan
8.1 Overview

Device Test Plan provides a mechanism for you to configure and conduct your own
device test steps. It takes the advantage of the sound card’s (or other ADC/DAC
hardware’s) capability of simultaneous input and output, to generate a stimulus to the
Device Under Test (DUT) and acquire the response from that device at the same time.
Different stimuli can be generated and the response can be analyzed in different ways.
The DUT can be marked as Pass or Fail after a sequence of test steps and a test report
can be generated. Device Test Plan supports 25 instructions with corresponding
parameters. Test results (e.g. Gain vs Frequency, Phase vs Frequency, etc.) can be
plotted in up to 8 X-Y plots and reported in one textual log window in real time.
Device Test Plan supports connection with external systems through serial
communication.
Device Test Plan can also be used to perform other functions such as data file batch
processing, batch signal event capturing and storing, etc.
The toggle button
in the Instrument Toolbar is used to open or close the Device
Test Plan panel. You can also close it by clicking the "Close" button at its upper right
corner.
Device Test Plan includes User Defined Plan and Dedicated Test Plan (e.g. LCR
Meter). Unlike the User Defined Plan which is fully configurable by the user, the
Dedicated Test Plan has some built-in non-configurable algorithm dedicated for
testing certain types of devices. Only the User Defined Plan will be described in this
chapter.
The screen layout of the Device Test Plan panel is divided into four parts: Control Bar,
Result/Option Area, Process Viewer, and Step Editor.
www.virtins.com
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8.2 Step Editor

A device test plan consists of a number of test steps. Step Editor is used to configure
each single step. A test step consists of a number of parameters. Instruction is the key
parameter in any test step, because it determines what other parameters are required
for that step.
8.2.1 Insert A Step
Pressing the “Insert” button will insert a step in the Process Viewer (described later).
If no step is selected (highlighted) in the Process Viewer, the new step will be added
at the end of the plan, otherwise it will be added just before the selected (highlighted)
step.
8.2.2 Modify A Step
Pressing the “Modify” button will overwrite the entire content of the selected
(highlighted) step in the Process Viewer (described later). Nothing will happen if no
step is selected (highlighted) in the Process Viewer.
8.2.3 Delete A Step
Pressing the “Delete” button will delete the entire content of the selected (highlighted)
step in the Process Viewer (described later). Nothing will happen if no step is
selected (highlighted) in the Process Viewer.
8.2.4 Clear All
Pressing the “Clear All” button will delete all steps in the current plan.
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8.2.5 Instruction

25 instructions are supported. They are described as follows.
8.2.5.1 SIO
SIO (Synchronized Input & Output) is used to command the Signal Generator to
generate the specified stimulus to the DUT and use the DAQ-related instruments (e.g.
Oscilloscope, Spectrum Analyzer, Multimeter ……) to acquire and analyze the
response from the DUT.
Title in Process Viewer
Step
Description

Title in Step Editor
N.A.
Description

Description
Step number is assigned automatically.
You can enter a description that best describes
this step. The default description is
“Synchronized Input & Output”.
In addition to the description, it is possible to
add optional parameters for this instruction. All
these parameters should be put within a single
pair of “{“ and “}”. Each parameter should also
be surrounded by its own identification character
pair. The supported optional parameters are:
[TimeoutStepNo]: specifies Step No. to go to
when timeout error occurs. TimeoutStepNo must
be surrounded by a pair of “[” and “]”. A
number without a sign indicates an absolute
jump, while a number with a preceding negative
or positive sign indicates a backward or forward
relative jump respectively. Step Label can also
be used.
Examples:
“3”: jump to Step 3
“+3”: jump 3 steps forwards
“-3”: jump 3 steps backwards
“(abc)”: jump to Step Label “abc” regardless of
which Step No. “abc” is at.
By default, the plan will pop up a message and
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stop upon timeout error unless this parameter is
specified.
<TimeoutSeconds>: specifies the timeout
seconds. TimeoutSeconds must be surrounded
by a pair of “<” and “>”. It is in additional to the
instruction’s duration. By default, 10 seconds
will be used, unless this parameter is specified.

Instruction
Duration(s)

Instruction
Duration(s)

Delay(s)

Delay(s)

A-Waveform

A-Waveform

Example: Synchronized Input & Output
{[5]<20>}
SIO
It defines how long the specified signal will last.
The value must be a multiple of 0.1 second.
It defines the idle time between the end of the
signal output and the start of the next step. The
value must a multiple of 0.1 second.
Waveform to be generated in Channel A,
available options are: None, Sine, Rectangle,
Triangle, Saw Tooth, White Noise, Pink Noise,
MultiTones, WFLibrary, MLS. For those
parameters that cannot be set on the Step Editor,
e.g. the duty cycle for Rectangle waveform and
length for MLS, the values set before the
opening of the Device Test Plan (if any) or
otherwise the default values will be used.
Loading a Panel Setting File in the test plan will
also update these values.
For MultiTones and WFLibrary, you will be
prompted to select a file name, and you can also
check/uncheck the flag “+1” on the right of the
File Name edit box. This flag takes effect only
when this step is within a repetition loop. The
file name will “plus” one automatically in every
repetition during runtime. To make it function
correctly, The file name should have at least one
numerical digit at the end before the file
extension, e.g. xxx0.xxx, xxx888.xxx, etc.

A-Frequency(Hz)

A-Amplitude(V)

B-Waveform

B-Frequency(Hz)

A-Frequency(Hz)

A-Amplitude(V)

B-Waveform

B-Frequency(Hz)

This parameter is ignored when the Overwrite
checkbox is not selected.
Frequency to be generated in Channel A. It can
be a real number or variable (x1~x5).
This parameter is ignored when the Overwrite
checkbox is not selected.
Amplitude to be generated in Channel A. It can
be a real number or variable (x1~x5).
This parameter is ignored when the Overwrite
checkbox is not selected.
Same as that of Channel A.
This parameter is ignored when the Overwrite
checkbox is not selected.
Frequency to be generated in Channel B. It can
be a real number or variable (x1~x5).
This parameter is ignored when the Overwrite
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checkbox is not selected.
Amplitude to be generated in Channel B. It can
be a real number or variable (x1~x5).

B-Amplitude(V)

Phase
(Degree)

Difference

This parameter is ignored when the Overwrite
checkbox is not selected.
Phase difference between the signals to be
generated in Channel A and Channel B.
Applicable only if none of the waveforms in
Channel A and Channel B is None, White Noise,
Pink Noise, MultiTones, WFLibrary, or MLS,
and the frequencies in both Channel are equal. It
can be a real number or variable (x1~x5).
This parameter is ignored when the Overwrite
checkbox is not selected.
DC offset of Channel A. Applicable only to
those DAC devices that support DC offset
adjustment. It can be a real number or variable
(x1~x5).

A-DC(V)

This parameter is ignored when the Overwrite
checkbox is not selected.
DC offset of Channel B. Applicable only to
those DAC devices that support DC offset
adjustment. It can be a real number or variable
(x1~x5).

B-DC(V)

N.A.
They are configured
from the Result/Options
Area instead.

This parameter is ignored when the Overwrite
checkbox is not selected.
They define the DDPs to be obtained from the
DAQ-related instruments after the response
from the DUT is captured. The values of the
DDPs will be displayed in these fields at
runtime. In case the value is not available due to
any reason (e.g. incorrect settings), then “NA”
will be filled instead.

If the “No Trigger” checkbox is not selected, the Oscilloscope’s Trigger Mode will be
forced to Single mode, and its Record Length will be forced to be half of the stimulus
signal duration if it is greater than [Duration-0.05] second. In other words, the
stimulus signal must last at least 50ms longer than the Record Length. The
Oscilloscope will be commanded to start after 4/5 of [Duration - Record Length]
elapses. This is to compensate the latency between the time when the Signal
Generator is commanded to start and the time when the generated signal is received at
the input, and also to ensure that the DUT reaches its stable state after being excited
by the stimulus. The timing diagram is shown as follows.
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x+y in the above figure accounts for 1/5 of [Duration – Record Length]. The trigger
condition should be set properly such that y is greater than zero. If you set the Trigger
Edge to “DF”, Trigger Level to “0” and Trigger Delay to “0”, then x will be 0.
Difference DUT and ADC/DAC device have different latency and require different
time to get stable, thus designing a correct timing scheme is critical for the SIO
instruction.
If the Oscilloscope remains un-triggered for [10 seconds+2  RecordLength] after the
signal duration elapses due to any reasons, a time out error will be generated and the
test plan will be stopped.
The rest parameters for the DAQ-related instruments will be kept as they were before
the opening of the Device Test Plan (if any) or otherwise the system default values
will be used. Loading a Panel Setting File in the test plan will also update these
values. It is recommended to load a properly configured Panel Setting File in the
beginning of each test plan to ensure all settings are in good shape.
When the Overwrite checkbox is not selected, the signal generator parameters
(waveform, frequency, amplitude, phase difference between the two channels, DC
offset) on the Signal Generator panel will be kept as they are and will not be
overwritten by the parameters here. This feature is useful if you want to load a Panel
Setting File and then execute the SIO command without changing the above
parameters.
If the “No Trigger” checkbox is selected, the Oscilloscope’s Trigger Mode will be
forced to Auto mode. The “No Trigger” option allows the SIO command to measure
a DC voltage, which does not contain an edge triggering point. Moreover, it supports
inter-frame peak hold or linear average for a specified number of frames in the
Spectrum Analyzer. The Oscilloscope will stop automatically after the specified
inter-frame processing is done. In these cases, the duration parameter in the SIO
command is for one frame only. Under any other situations, only one frame of data
will be acquired before the Oscilloscope stops automatically.
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If the “Plot” checkbox is unticked, then no “data to be captured” will be logged and
displayed in the X-Y Plots. This option helps to differentiate between trial and actual
measurements.

8.2.5.2 OUT
OUT (Signal Output) is used to command the Signal Generator to generate the
specified signal. Unlike SIO, the DAQ will not be started under this instruction.
Title in Process Viewer
Step
Description

Title in Step Editor
N.A.
Description

Instruction
Duration(s)

Instruction
Duration(s)

Delay(s)

Delay(s)

A-Waveform

A-Waveform

Description
Step number is assigned automatically.
You can enter a description that best describes
this step. The default description is “Output”.
OUT
It defines how long the specified signal will last.
The value must be a multiple of 0.1 second.
It defines the idle time between the end of the
signal output and the start of the next step. The
value must a multiple of 0.1 second.
Waveform to be generated in Channel A,
available options are: None, Sine, Rectangle,
Triangle, Saw Tooth, White Noise, Pink Noise,
MultiTones, WFLibrary, MLS. For those
parameters that cannot be set on the Step Editor,
e.g. the duty cycle for Rectangle waveform and
length for MLS, the values set before the
opening of the Device Test Plan (if any) or
otherwise the default values will be used.
Loading a Panel Setting File in the test plan will
also update these values.
For MultiTones and WFLibrary, you will be
prompted to select a file name, and you can also
check/uncheck the flag “+1” on the right of the
File Name edit box. This flag takes effect only
when this step is within a repetition loop. The
file name will “plus” one automatically in every
repetition during runtime. To make it function
correctly, The file name should have at least one
numerical digit at the end before the file
extension, e.g. xxx0.xxx, xxx888.xxx, etc.

A-Frequency(Hz)

A-Amplitude(V)

B-Waveform

A-Frequency(Hz)

A-Amplitude(V)

B-Waveform

This parameter is ignored when the Overwrite
checkbox is not selected.
Frequency to be generated in Channel A. It can
be a real number or variable (x1~x5).
This parameter is ignored when the Overwrite
checkbox is not selected.
Amplitude to be generated in Channel A. It can
be a real number or variable (x1~x5).
This parameter is ignored when the Overwrite
checkbox is not selected.
Same as that of Channel A.
This parameter is ignored when the Overwrite
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checkbox is not selected.
Frequency to be generated in Channel B. It can
be a real number or variable (x1~x5).

B-Frequency(Hz)

This parameter is ignored when the Overwrite
checkbox is not selected.
Amplitude to be generated in Channel B. It can
be a real number or variable (x1~x5).

B-Amplitude(V)

Phase
(Degree)

Difference

A-DC(V)

B-DC(V)

N.A.

This parameter is ignored when the Overwrite
checkbox is not selected.
Phase difference between the signals to be
generated in Channel A and Channel B.
Applicable only if none of the waveforms in
Channel A and Channel B is None, White Noise,
Pink Noise, MultiTones, WFLibrary, or MLS,
and the frequencies in both channels are equal. It
can be a real number or variable (x1~x5).
This parameter is ignored when the Overwrite
checkbox is not selected.
DC offset of Channel A. Applicable only to
those DAC devices that support DC offset
adjustment. It can be a real number or variable
(x1~x5).
This parameter is ignored when the Overwrite
checkbox is not selected.
DC offset of Channel B. Applicable only to
those DAC devices that support DC offset
adjustment. It can be a real number or variable
(x1~x5).
This parameter is ignored when the Overwrite
checkbox is not selected.
N.A.

8.2.5.3 STI
STI (Single Triggered Input) is used to command the DAQ to start in Single trigger
mode if the “No Trigger” checkbox is not selected, or in Auto trigger mode if that it is
selected. The rest parameters for the DAQ-related instruments will be kept as they
were before the opening of the Device Test Plan (if any) or otherwise the system
default values will be used. Loading a Panel Setting File in the test plan will also
update these values.
The step finishes after a frame of data is captured.
This instruction can be used together with other instructions to capture and store a
sequence of events automatically.
Title in Process Viewer
Step
Description
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Title in Step Editor
N.A.
Description

Description
Step number is assigned automatically.
You can enter a description that best describes
this step. The default description is “Single
Triggered Input”.
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In addition to the description, it is possible to
add optional parameters for this instruction. All
these parameters should be put within a single
pair of “{“ and “}”. Each parameter should also
be surrounded by its own identification character
pair. The supported optional parameters are:
[TimeoutStepNo]: specifies Step No. to go to
when timeout error occurs. TimeoutStepNo must
be surrounded by a pair of “[” and “]”. A
number without a sign indicates an absolute
jump, while a number with a preceding negative
or positive sign indicates a backward or forward
relative jump respectively. Step Label can also
be used.
Examples:
“3”: jump to Step 3
“+3”: jump 3 steps forwards
“-3”: jump 3 steps backwards
“(abc)”: jump to Step Label “abc” regardless of
which Step No. “abc” is at.
By default, this instruction will wait until
success, unless this parameter is specified.
<TimeoutSeconds>: specifies the timeout
seconds. TimeoutSeconds must be surrounded
by a pair of “<” and “>”. It is in additional to the
sampling duration. By default, 10 seconds will
be used unless this parameter is specified.

Instruction
Duration(s)
Delay(s)
A-Waveform
A-Frequency(Hz)
A-Amplitude(V)
B-Waveform
B-Frequency(Hz)
B-Amplitude(V)
Phase Difference(D)
DDPs to be captured

Instruction
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
They are configured
from the Result/Options
Area instead.

Example: Single Triggered Input {[5]<20>}
STI
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
They define the DDPs to be obtained from the
DAQ-related instruments after a frame of data is
captured. The values of the DDPs will be
displayed in these fields at runtime. In case the
value is not available due to any reason (e.g.
incorrect settings), then “NA” will be filled
instead.

If the “Plot” checkbox is unticked, then no “data to be captured” will be logged and
displayed in the X-Y Plots.
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8.2.5.4 RPT
RPT (Repeat) is used to control the execution of steps in a test plan. It can be used to
repeat a range of steps for a specified number of times. Note that a repetition loop
should not contain or overlap with another repetition loop.
Title in Process Viewer
Step
Description

Title in Step Editor
N.A.
Description

Instruction
Duration(s)

Instruction
Step No.

Delay(s)

Repeat Times

A-Waveform

N.A.

A-Frequency(Hz)
A-Amplitude(V)
B-Waveform
B-Frequency(Hz)
B-Amplitude(V)
Phase Difference(D)
DDPs to be captured

N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.

Description
Step number is assigned automatically.
You can enter a description that best describes
this step. The default description is “Repeat Step
No. x for y times”.
RPT
It specifies the Step No. to jump to. Only
backward jump is allowed. A number without a
sign indicates an absolute jump while a number
with a preceding negative sign indicates a
backward relative jump. Step Label can also be
used.
Examples:
“3”: jump to Step 3
“-3”: jump 3 steps backwards
“(abc)”: jump to Step Label “abc” regardless of
which Step No. “abc” is at.
It specifies the number of times to repeat
(exclusive of the very first time). Note that a
zero value means “repeat forever”.
This field will be used to indicate the number of
times that has been repeated during runtime. It
will be cleared after the repetition process
finished.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.

8.2.5.5 LDP
LDP (Load Panel Setting File) is used to load a pre-stored Panel Setting File, in order
to preset the parameters for DAQ and data analysis. When it is selected in the
Instruction combo box, a File Open window will pop up requesting for the path and
name of the Panel Setting File. It can also be set using the File Name button.
Title in Process Viewer
Step
Description

Title in Step Editor
N.A.
Description

Instruction
Duration(s)

Instruction
File Name

Delay(s)

+1
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Description
Step number is assigned automatically.
You can enter a description that best describes
this step. The default description is “Load Panel
Setting”.
LDP
It specifies the path and name of the Panel
Setting File to be loaded.
This flag takes effect only when this step is
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A-Waveform
A-Frequency(Hz)
A-Amplitude(V)
B-Waveform
B-Frequency(Hz)
B-Amplitude(V)
Phase Difference(D)
DDPs to be captured

N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
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within a repetition loop. The file name will
“plus” one automatically in every repetition
during runtime. To make it function correctly,
The file name should have at least one numerical
digit at the end before the file extension, e.g.
xxx0.xxx, xxx888.xxx, etc.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.

8.2.5.6 LDF
LDF (Load File) is used to load a time-domain data file, either in WAV format or in
TXT format (must has a file extension of txt), for analysis. It is usually used together
with the exporting instructions for bath file processing. When it is selected in the
Instruction combo box, a File Open window will pop up requesting for the path and
name of the file. It can also be set using the File Name button.
Title in Process Viewer
Step
Description

Title in Step Editor
N.A.
Description

Instruction
Duration(s)

Instruction
File Name

Delay(s)

+1

A-Waveform
A-Frequency(Hz)
A-Amplitude(V)
B-Waveform
B-Frequency(Hz)
B-Amplitude(V)
Phase Difference(D)
DDPs to be captured

N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.

Description
Step number is assigned automatically.
You can enter a description that best describes
this step. The default description is “Load WAV
File”.
LDF
It specifies the path and name of the timedomain data file to be loaded.
This flag takes effect only when this step is
within a repetition loop. The file name will
“plus” one automatically in every repetition
during runtime. To make it function correctly,
The file name should have at least one numerical
digit at the end before the file extension, e.g.
xxx0.xxx, xxx888.xxx, etc.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.

8.2.5.7 SVF
SVF (Save File) is used to save a WAV file. The file path and name can be specified
by using the File Name button and/or the File Name edit box. If the specified file
already exists, it will be overwritten without any warning message at runtime.
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Title in Process Viewer
Step
Description

Title in Step Editor
N.A.
Description

Instruction
Duration(s)

Instruction
File Name

Delay(s)

+1

A-Waveform
A-Frequency(Hz)
A-Amplitude(V)
B-Waveform
B-Frequency(Hz)
B-Amplitude(V)
Phase Difference(D)
DDPs to be captured

N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.

Virtins Technology

Description
Step number is assigned automatically.
You can enter a description that best describes
this step. The default description is “Save WAV
File”.
SVF
It specifies the path and name of the WAV file
to be saved.
This flag takes effect only when this step is
within a repetition loop. The file name will
“plus” one automatically in every repetition
during runtime. To make it function correctly,
The file name should have at least one numerical
digit at the end before the file extension, e.g.
xxx0.xxx, xxx888.xxx, etc.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.

8.2.5.8 OET
OET (Oscilloscope Export TXT file) is used to export the data in the Oscilloscope to
a TXT file. It is the same as the Export command in the Oscilloscope. The file path
and name can be specified by using the File Name button and/or the File Name edit
box. If the specified file already exists, it will be overwritten without any warning
message at runtime.
Title in Process Viewer
Step
Description

Title in Step Editor
N.A.
Description

Instruction
Duration(s)

Instruction
File Name

Delay(s)

+1

A-Waveform
A-Frequency(Hz)
A-Amplitude(V)
B-Waveform
B-Frequency(Hz)
B-Amplitude(V)
Phase Difference(D)
DDPs to be captured

N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
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Description
Step number is assigned automatically.
You can enter a description that best describes
this step. The default description is
“Oscilloscope Export TXT File”.
OET
It specifies the path and name of the TXT file to
be exported.
This flag takes effect only when this step is
within a repetition loop. The file name will
“plus” one automatically in every repetition
during runtime. To make it function correctly,
The file name should have at least one numerical
digit at the end before the file extension, e.g.
xxx0.xxx, xxx888.xxx, etc.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
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8.2.5.9 SET
SET (Spectrum Analyzer Export TXT file) is used to export the analysis result in the
Spectrum Analyzer to a TXT file. It is the same as the Export command in the
Spectrum Analyzer. The file path and name can be specified by using the File Name
button and/or the File Name edit box. If the specified file already exists, it will be
overwritten without any warning message at runtime.
Title in Process Viewer
Step
Description

Title in Step Editor
N.A.
Description

Instruction
Duration(s)

Instruction
File Name

Delay(s)

+1

A-Waveform
A-Frequency(Hz)
A-Amplitude(V)
B-Waveform
B-Frequency(Hz)
B-Amplitude(V)
Phase Difference(D)
DDPs to be captured

N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.

Description
Step number is assigned automatically.
You can enter a description that best describes
this step. The default description is “Spectrum
Analyzer Export TXT File”.
SET
It specifies the path and name of the TXT file to
be exported.
This flag takes effect only when this step is
within a repetition loop. The file name will
“plus” one automatically in every repetition
during runtime. To make it function correctly,
The file name should have at least one numerical
digit at the end before the file extension, e.g.
xxx0.xxx, xxx888.xxx, etc.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.

8.2.5.10 DLY
DLY (Delay) is used to pause the execution of the plan for a specified number of
seconds.
Title in Process Viewer
Step
Description

Title in Step Editor
N.A.
Description

Instruction
Duration(s)

Instruction
Duration(s)

Delay(s)

N.A.

A-Waveform
A-Frequency(Hz)
A-Amplitude(V)
B-Waveform
B-Frequency(Hz)

N.A.
N.A.
N.A.
N.A.
N.A.
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Description
Step number is assigned automatically.
You can enter a description that best describes
this step. The default description is “Delay x
Second (s)”.
DLY
It specifies the number of seconds to wait before
executing the next step. The value must be a
multiple of 0.1 second.
This field will be used to indicate the number of
seconds that has been delayed during runtime. It
will be cleared after the step is finished.
N.A.
N.A.
N.A.
N.A.
N.A.
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B-Amplitude(V)
Phase Difference(D)
DDPs to be captured

N.A.
N.A.
N.A.

Virtins Technology

N.A.
N.A.
N.A.

8.2.5.11 JMP
JMP (Jump) is used to redirect the execution of the plan from the current step to a
specified step.
Title in Process Viewer
Step
Description

Title in Step Editor
N.A.
Description

Instruction
Duration(s)

Instruction
Step No.

Delay(s)
A-Waveform
A-Frequency(Hz)
A-Amplitude(V)
B-Waveform
B-Frequency(Hz)
B-Amplitude(V)
Phase Difference(D)
DDPs to be captured

N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.

Description
Step number is assigned automatically.
You can enter a description that best describes
this step. The default description is “Jump to
Step No. x”.
JMP
It specifies the Step No. to jump to. A number
without a sign indicates an absolute jump, while
a number with a preceding negative or positive
sign indicates a backward or forward relative
jump respectively. Step Label can also be used.
Examples:
“3”: jump to Step 3
“+3”: jump 3 steps forwards
“-3”: jump 3 steps backwards
“(abc)”: jump to Step Label “abc” regardless of
which Step No. “abc” is at.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.

8.2.5.12 CHK
CHK (Check) is used to evaluate the value of a specified Derived Data Point (refer to
the relevant section in the chapter for Data Logger) against a preset value. If the
specified condition is met, then jump to the specified Step, otherwise continue to
execute the next step.
Title in Process Viewer
Step
Description

Title in Step Editor
N.A.
Description

Instruction
Duration(s)

Instruction
Derived Data Point

www.virtins.com

Description
Step number is assigned automatically.
You can enter a description that best describes
this step. The default description is “Check a
derived data point. If the condition is TRUE,
jump to Step No. x”.
CHK
It specifies the Derived Data Point to be
evaluated with the following exception:
1. TimeStamp, current date and time (s).
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2.

Delay(s)

Comparison Operator:
>, >=, <, <=, ==, !=

A-Waveform
A-Frequency(Hz)

Value
Step No.

A-Amplitude(V)
B-Waveform

Pass/Fail
N.A.

B-Frequency(Hz)

N.A.

B-Amplitude(V)
Phase Difference(D)
DDPs to be captured

N.A.
N.A.
N.A.

UserInput, latest text input by the user using
IPT instruction.
3. UserName, current user priority
4. TestResult, current test result: DONE=0,
PASS=1, FAIL=-1
5. VolatileInt1~VolatileInt5
and
NonVolatileInt1~NonVolatileInt5
6. ReceivedBytes_Array[?], an indexed byte in
the received bytes by RCM instruction. “?”
should be replaced by the actual array index
starting from 0.
7. x1~x5
>: greater than
>=: greater than or equal to
<: less than
<=: less than or equal to
==: equal to
!=: not equal to
It specifies the value to be compared with
It specifies the Step No. to jump to if the
condition is met. A number without a sign
indicates an absolute jump, while a number with
a preceding negative or positive sign indicates a
backward or forward relative jump respectively.
Step Label can also be used.
Examples:
“3”: jump to Step 3
“+3”: jump 3 steps forwards
“-3”: jump 3 steps backwards
“(abc)”: jump to Step Label “abc” regardless of
which Step No. “abc” is at.
If ticked, a Pass/Fail check will be performed.
The actual value of the specified Derived Data
Point will be shown in this field at runtime.
“Pass” will be indicated in this field if the
specified condition is true, Otherwise “Fail” will
be indicated.
N.A.
N.A.
N.A.

If the Derived Data Point is not available due to any reason (e.g. the settings are
incorrect, etc.), the step will fail.
8.2.5.13 LOG
LOG is used to generate one textual record in the Device Test Plan Log window or a
specified text file.
Title in Process Viewer
Step
Description

Title in Step Editor
N.A.
Description

Description
Step number is assigned automatically.
You can enter a description that best describes
this step. The default description is “Log the
Title, Derived Data Point Value, Comment”.
In addition to the description, it is possible to
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add optional parameters for this instruction. All
these parameters should be put within a single
pair of “{“ and “}”. Each parameter should also
be surrounded by its own identification character
pair. The supported optional parameters are:
[FileName]: specifies the path and name of the
log file. Both an absolute path, e.g. C:\log\1.log,
and a path relative to the software’s root
directory, e.g. log\1.log, are supported. File
Name must be surrounded by a pair of “[” and
“]”. By default, the Device Test Plan Log
window will be used for output, unless this
parameter is specified. The following formats
are supported:
(1)[FileName]: a fixed file name. FileName can
also be “Panel1”, “Panel2”, or “Panel3” which
represents a textual display area in the Result
window on the panel.
(2)[FileName, Date and Time Format, xxx] or
[FileName, Date and Time Format]:
a file name that changes automatically with date
and time. Date and Time Format supported are:
“YYYY-MM-DD-HH”,
“YYYY-MM-DD”,
“YYYY-MM” and “YYYY”. The date and time
will be automatically added at the end of the
FileName but before “.” if any. New files will
be automatically created as time progresses. If
the new file does not contain any header lines,
then xxx should be “0” which means that the
new file can start from the current step. If the
new file contains 1 header line, then only for the
header line, xxx should be “1”; for non-header
lines, xxx should not be specified. If the new file
contains N header lines, for header line 1, xxx
should be “1-N”; for header line 2, xxx should
be “2-N”; for header line N, xxx should be “NN”; for non-header lines, xxx should not be
specified. If the new file contains 1 header line
and it also shows up every N lines, then xxx
should be “1/N”. If a non-header line needs to
show up every N lines, then xxx should be “/N”.
The above mechanism ensures that every new
file automatically created according to date and
time starts from a correct position automatically
in a test plan.
(3)[FileName, UserInput] or [FileName,
UserInput, xxx]: a file name that changes with
UserInput. UserInput must be “UserInput”. xxx
can be used if it shows up every N lines. In this
case, xxx should be “/N”. Header lines should
not be defined through xxx as the test plan
should know which step to create a new file.
(4)[FileName, UserName] or [FileName,
UserName, xxx]: a file name that changes with
UserName. UserName must be “UserName”.

www.virtins.com

404 Copyright © 2006-2022

Virtins Technology

VIRTINS Multi-Instrument 3.9 Manual

Virtins Technology

xxx can be used if it shows up every N lines. In
this case, xxx should be “/N”. Header lines
should not be defined through xxx as the test
plan should know which step to create a new
file.
(5) [FileName, (any combination of Date and
Time Format, UserInput and UserName)] or
[FileName, (any combination of Date and Time
Format, UserInput and UserName), xxx], e.g.
[C:\log\1.log,
UserName-UserInput-YYYYMM,1-3]
(Date and Time Format): Year:YYYY or YY;
Month: MM; Day: DD; Hour:HH; Minute: mm;
Second: SS. Date and Time format must be
surrounded by a pair of “(” and “)”. By default,
the Date and Time Format is “YYYY-MM-DD
HH:mm:SS”, unless this parameter is specified.
<Record Separator>: specifies the separator
between two consecutive records. Record
Separator is surrounded by a pair of “<” and
“>”. By default, “Carriage Return” is used,
unless this parameter is specified.
‘RedValue, GreenValue, BlueValue’: specifies
the RGB values for the color of the texts when
the target of this command (i.e. FileName) is
“Panel1”, “Panel2”, or “Panel3”. RedValue,
GreenValue, BlueValue must be surrounded by
a pair of “’” and “’” Each value ranges from 0 to
255. For example, ‘0,0,0’ represents black.
‘255,0,0’ represents red.
|CodePage|: specifies the code page of the texts.
Its value ranges from 1~7. 1-ANSI, 2Macintosh, 3-OEM, 4-Symbol, 5-Current
Thread’s ANSI, 6-UTF-7, 7-Unicode. CodePage
must be surrounded by a pair of “|” and “|”. By
default, UTF-8 is used, , unless this parameter is
specified.
/EngineeringUnit/: specifies the engineering unit
of the DDP to be logged. EngineeringUnit must
be surrounded by a pair of “/” and “/”. By
default, it is assigned by the software
automatically, unless ths parameter is specified.
Use “//” if you do not want to log the unit.
Example: Log the Title, Derived Data Point
Value,
Comment
{[C:\log\1.log]
(YYYYMMDDHHmmSS)< >}

Instruction
Duration(s)
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Instruction
Title

If the file does not exist, a new file will be
created with new content. If the file exists, new
content will be appended at the end of the
existing file.
LOG
It is just a textual description, usually the title of
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Delay(s)

Derived Data Point

A-Waveform
A-Frequency(Hz)
A-Amplitude(V)
B-Waveform
B-Frequency(Hz)
B-Amplitude(V)
Phase Difference(D)
DDPs to be captured

Comment
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.

Virtins Technology

the DDP.
It specifies the Derived Data Point whose value
to be logged with the following exception:
1. TimeStamp, current date and time.
2. UserInput, latest text input by the user using
IPT instruction.
3. UserName, current user name
4. TestResult, current test result: DONE,
PASS, FAIL
5. VolatileInt1~VolatileInt5
and
NonVolatileInt1~NonVolatileInt5
6. x1~x5
Any comment can be put here.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.

8.2.5.14 END
END (End) is used to mark the end of a plan. It is especially useful when you want to
conditionally end the plan in the middle of steps.
Title in Process Viewer
Step
Description

Title in Step Editor
N.A.
Description

Instruction
Duration(s)
Delay(s)
A-Waveform
A-Frequency(Hz)
A-Amplitude(V)
B-Waveform
B-Frequency(Hz)
B-Amplitude(V)
Phase Difference(D)
DDPs to be captured

Instruction
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.

Description
Step number is assigned automatically.
You can enter a description that best describes
this step. The default description is “End”.
END
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.

8.2.5.15 IPT
IPT (Input) is used to get the user input through a pop-up dialog box containing only
one text input field. The dialog box will be closed automatically, if the number of
characters entered is within the range specified, upon receiving a Carriage Return.
The input text can be accessed through the extended DDP point “UserInput”. It is
especially useful when you want to read a DUT’s barcode with a barcode reader.
Title in Process Viewer
Step
Description
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Title in Step Editor
N.A.
Description

Description
Step number is assigned automatically.
You can enter a description that best describes
this step. The default description is “Get user
input”.
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Instruction
Duration(s)
Delay(s)
A-Waveform
A-Frequency(Hz)
A-Amplitude(V)
B-Waveform
B-Frequency(Hz)
B-Amplitude(V)
Phase Difference(D)
DDPs to be captured

Instruction
From (A)
To (A)
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.

Virtins Technology

IPT
Minimum number of characters
Maximum number of characters
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.

8.2.5.16 SEL
SEL (Selection) is used to get the user selection, Yes or No, through a pop-up dialog
box. If Yes is selected, then jump to the specified Step, otherwise continue to execute
the next step.
Title in Process Viewer
Step
Description

Title in Step Editor
N.A.
Description

Instruction
Duration(s)

Instruction
Step No.

Delay(s)
A-Waveform
A-Frequency(Hz)
A-Amplitude(V)
B-Waveform
B-Frequency(Hz)
B-Amplitude(V)
Phase Difference(D)
DDPs to be captured

N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.

Description
Step number is assigned automatically.
You can enter a description that best describes
this step. The default description is “Popup for
user selection, Y or N. If Y, jump to Step No.
x”. The description will be shown in the popup
dialog.
SEL
It specifies the Step No. to jump to if Yes is
selected. A number without a sign indicates an
absolute jump, while a number with a preceding
negative or positive sign indicates a backward or
forward relative jump respectively. Step Label
can also be used.
Examples:
“3”: jump to Step 3
“+3”: jump 3 steps forwards
“-3”: jump 3 steps backwards
“(abc)”: jump to Step Label “abc” regardless of
which Step No. “abc” is at
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.

8.2.5.17 OPT
OPT (Operation) is used to perform mathematic operation on 5 volatile integer
variables
(VolatileInt1~VolatileInt5),
5
non-volatile
integer
variables
(NonVolatileInt1~NonVolatileInt5) and 5 volatile floating-point variables (x1~x5).
These variables can be used for various purposes such as controlling a loop, counting
PASS and FAIL, varying frequencies, amplitudes and phases, etc.
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VolatileInt1~VolatileInt5 are volatile integers. They are initialized to zero at the start
of a test plan. NonVolatileInt1~NonVolatileInt5 are non-volatile integers. They are
initialized through a CSV text file named “NonVolatile.txt” under the “\dtp” directory.
If the file does not exist, then they will be initialized to zero in the beginning. After
that, any change of these non-volatile integers will be persisted in the file
“NonValatile.txt” and only the Reset button can be used to manually reset them to
zeros.
Title in Process Viewer
Step
Description

Title in Step Editor
N.A.
Description

Instruction
Duration(s)

Instruction
Derived Data Point

Delay(s)

Value

A-Waveform
A-Frequency(Hz)
A-Amplitude(V)
B-Waveform
B-Frequency(Hz)
B-Amplitude(V)
Phase Difference(D)
DDPs to be captured

N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.

Description
Step number is assigned automatically.
You can enter a description that best describes
this step. The default description is
“Volatile/Non-Volatile variable +, -, *, /, or =
x”.
OPT
Only
volatile
integers:
VolatileInt1~
VolatileInt5,
non-volatile
integers:
NonVolatileInt1~ NonVolatileInt5, and volatile
floating-point variables: x1~x5 are allowed
Five operations are allowed:
(1) +x
(2) –x
(5) *x
(6) /x
(7) =x
where x is an integer or floating-point number. x
can also be a DDP or extended DDP point, e.g
[RMS_A(EU)]
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.

8.2.5.18 CLR
CLR (Clear) is used to clear the intermediate test results such as PASS and FAIL,
captured DDP values, etc., in the Process Viewer or Device Test Plan Log window.
After this command, the Process Viewer will resume to the status when a plan is just
loaded, and the Device Test Plan Log window will be cleared. The content in the
window can be stored in a file on the hard disk before it is cleared.
Title in Process Viewer
Step
Description

Title in Step Editor
N.A.
Description

Description
Step number is assigned automatically.
You can enter a description that best describes
this step. The default description is “Clear test
results”.
In addition to the description, it is possible to
add optional parameters for this instruction. All
these parameters should be put within a single
pair of “{“ and “}”. Each parameter should also
be surrounded by its own identification character
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pair. The supported optional parameters are:
[Target]: specifies the target on which the clear
command is performed. If Target =“Log”, then
the texts in the Device Test Plan Log window
will be cleared. By default, the process viewer
is the target and the test results in it will be
cleared, unless this parameter is specified.
(FileName): specifies the path and name of the
file in which the texts in the Device Test Plan
Log window will be appended. Both an absoute
path, e.g. C:\log\1.log, and a path relative to the
software’s root directory, e.g. log\1.log, are
supported. File Name must be surrounded by a
pair of “(” and “)”.

Instruction
Duration(s)
Delay(s)
A-Waveform
A-Frequency(Hz)
A-Amplitude(V)
B-Waveform
B-Frequency(Hz)
B-Amplitude(V)
Phase Difference(D)
DDPs to be captured

Instruction
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.

The above two options can be used together to
store the texts in the Device Test Plan Log
window into a file on the hard disk and then
clear the window.
CLR
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.

8.2.5.19 OEB
OEB (Oscilloscope Export BMP file) is used to export the graph in the Oscilloscope
to a BMP file. It is the same as the Export command in the Oscilloscope. The file path
and name can be specified by using the File Name button and/or the File Name edit
box. If the specified file already exists, it will be overwritten without any warning
message at runtime.
Title in Process Viewer
Step
Description

Title in Step Editor
N.A.
Description

Description
Step number is assigned automatically.
You can enter a description that best describes
this step. The default description is
“Oscilloscope Export BMP File”.
In addition to the description, it is possible to
add optional parameters for this instruction. All
these parameters should be put within a single
pair of “{“ and “}”. Each parameter should also
be surrounded by its own identification character
pair. The supported optional parameters are:
(GraphToExport): specifies the graph to export.
GraphToExport must be surrounded by a pair of
“(” and “)”.
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GraphToExport:
0: Screen occupied by Multi-Instrument

Instruction
Duration(s)

Instruction
File Name

Delay(s)

+1

A-Waveform
A-Frequency(Hz)
A-Amplitude(V)
B-Waveform
B-Frequency(Hz)
B-Amplitude(V)
Phase Difference(D)
DDPs to be captured

N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.

Example: {(0)}
OEB
It specifies the path and name of the BMP file to
be exported.
This flag takes effect only when this step is
within a repetition loop. The file name will
“plus” one automatically in every repetition
during runtime. To make it function correctly,
The file name should have at least one numerical
digit at the end before the file extension, e.g.
xxx0.xxx, xxx888.xxx, etc.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.

8.2.5.20 SEB
SEB (Spectrum Analyzer Export BMP file) is used to export the graph in the
Spectrum Analyzer to a BMP file. It is the same as the Export command in the
Spectrum Analyzer. The file path and name can be specified by using the File Name
button and/or the File Name edit box. If the specified file already exists, it will be
overwritten without any warning message at runtime.
Title in Process Viewer
Step
Description

Title in Step Editor
N.A.
Description

Description
Step number is assigned automatically.
You can enter a description that best describes
this step. The default description is “Spectrum
Analyzer Export BMP File”.
In addition to the description, it is possible to
add optional parameters for this instruction. All
these parameters should be put within a single
pair of “{“ and “}”. Each parameter should also
be surrounded by its own identification character
pair. The supported optional parameters are:
(GraphToExport): specifies the graph to export.
GraphToExport must be surrounded by a pair of
“(” and “)”.
GraphToExport:
0: Screen occupied by Multi-Instrument

Instruction
Duration(s)
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Instruction
File Name

Example: {(0)}
SEB
It specifies the path and name of the BMP file to
be exported.
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Delay(s)

+1

A-Waveform
A-Frequency(Hz)
A-Amplitude(V)
B-Waveform
B-Frequency(Hz)
B-Amplitude(V)
Phase Difference(D)
DDPs to be captured

N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.

Virtins Technology

This flag takes effect only when this step is
within a repetition loop. The file name will
“plus” one automatically in every repetition
during runtime. To make it function correctly,
The file name should have at least one numerical
digit at the end before the file extension, e.g.
xxx0.xxx, xxx888.xxx, etc.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.

8.2.5.21 RCM
RCM (Read Communication port) is used to open, configure and read a
communication port. If the command contains configuration parameters and the
communication port has not been opened yet, then the port will be opened and
configured, and then read, otherwise the command will read the port only. Once the
port is opened, it will be closed only when the test plan is stopped or errors occur. The
receiving buffer of the communication port will be purged first each time the
command is executed. If the command is successful, the received data can be
accessed through the extended DDP point “ReceivedBytes_Array[?]”.
Title in Process Viewer
Step
Description

Title in Step Editor
N.A.
Description

Description
Step number is assigned automatically.
You can enter a description that best describes
this step. The default description is “Read
Communication Port”.
In addition to the description, it is possible to
add optional parameters for this instruction. All
these parameters should be put within a single
pair of “{“ and “}”. Each parameter should also
be surrounded by its own identification character
pair. The supported optional parameters are:
(Port No., Baud Rate, Stop Bits, Partiy, Byte
Size): contains the communication port
configuration parameters. They must be
surrounded by a pair of “(” and “)” and the
parameters must be separated by “,”.
Stop Bits: 1,5,2 represent 1, 1.5 and 2 stop bits
respectively.
Parity: 0~4 represent no, odd, even, mark, space
parity respectively.
<BytesToReceive>: specifies the number of
bytes to receive. BytesToReceive must be
surrounded by a pair of “<” and “>”. This is a
compulsory parameter.
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|TimeoutMiniSeconds,
TimeoutStepNo|:
specifies Timeout in ms and Step No. to go to
when timeout error occurs. These two
parameters must be surrounded by a pair of
“|”and “|” and separated by “,”.
TimeoutStepNo: A number without a sign
indicates an absolute jump, while a number with
a preceding negative or positive sign indicates a
backward or forward relative jump respectively.
Step Label can also be used.
Examples:
“3”: jump to Step 3
“+3”: jump 3 steps forwards
“-3”: jump 3 steps backwards
“(abc)”: jump to Step Label “abc” regardless of
which Step No. “abc” is at.
'CheckSum': specify the CheckSum type.
“CRC” represents CRC-16. If the checksum of
the received message is incorrect, the test plan
will jump to TimeoutStepNo specified in the
Timeout parameter session. CheckSum must be
surrounded by a pair of “'” and “'”.

Instruction
Duration(s)
Delay(s)
A-Waveform
A-Frequency(Hz)
A-Amplitude(V)
B-Waveform
B-Frequency(Hz)
B-Amplitude(V)
Phase Difference(D)
DDPs to be captured

Instruction
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.

Example:
Read
Communication
{(3,19200,1,0,8)<1>}
RCM
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.

Port

8.2.5.22 WCM
WCM (Write Communication port) is used to open, configure and write a
communication port. If the command contains configuration parameters and the
communication port has not been opened yet, then the port will be opened and
configured, and then write, otherwise the command will write the port only. Once the
port is opened, it will be closed only when the test plan is stopped or errors occur. The
transmitting buffer of the communication port will be purged first each time the
command is executed.
Title in Process Viewer
Step
Description

Title in Step Editor
N.A.
Description

Description
Step number is assigned automatically.
You can enter a description that best describes
this step. The default description is “Write
Communication Port”.
In addition to the description, it is possible to
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add optional parameters for this instruction. All
these parameters should be put within a single
pair of “{“ and “}”. Each parameter should also
be surrounded by its own identification character
pair. The supported optional parameters are:
(Port No., Baud Rate, Stop Bits, Partiy, Byte
Size): contains the communication port
configuration parameters. They must be
surrounded by a pair of “(” and “)” and the
parameters must be separated by “,”.
Stop Bits: 1,5,2 represent 1, 1.5 and 2 stop bits
respectively.
Parity: 0~4 represent no, odd, even, mark, space
parity respectively.
[BytesToSend]: specifies the bytes to send. Each
byte is represented by two HEX characters.
Multiple bytes are separated by empty spaces.
BytesToSend must be surrounded by a pair of
“[” and “]”. This is a compulsory parameter.
'CheckSum': specify the CheckSum type.
“CRC” represents CRC-16. If this parameter is
specified, the checksum byte(s) will be
calculated and automatically appended at the
end of the BytesToSend. CheckSum must be
surrounded by a pair of “'” and “'”.

Instruction
Duration(s)
Delay(s)
A-Waveform
A-Frequency(Hz)
A-Amplitude(V)
B-Waveform
B-Frequency(Hz)
B-Amplitude(V)
Phase Difference(D)
DDPs to be captured

Instruction
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.

Example:
Write
Communication
{(3,19200,1,0,8)[01 F1 A0]}
WCM
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.

Port

8.2.5.23 PRT
PRT (Print) is used to print screen, or the graph in the Oscilloscope or Spectrum
Analyzer.
Title in Process Viewer
Step
Description

Title in Step Editor
N.A.
Description

Description
Step number is assigned automatically.
You can enter a description that best describes
this step. The default description is “Print”.
In addition to the description, it is possible to
add optional parameters for this instruction. All
these parameters should be put within a single
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pair of “{“ and “}”. Each parameter should also
be surrounded by its own identification character
pair. The supported optional parameters are:
(GraphToPrint): specifies the graph to print.
GraphToPrint must be surrounded by a pair of
“(” and “)”.
GraphToPrint:
0: (Default) Screen
Instrument
1: Oscilloscope
2: Spectrum analyzer

Instruction
Duration(s)
Delay(s)
A-Waveform
A-Frequency(Hz)
A-Amplitude(V)
B-Waveform
B-Frequency(Hz)
B-Amplitude(V)
Phase Difference(D)
DDPs to be captured

Instruction
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.

occupied

by

Multi-

Example: {(1)}
PRT
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.
N.A.

8.2.5.24 SIR
SIR (Set Input Range) is used to set the input range of the ADC device.
Title in Process Viewer
Step
Description

Title in Step Editor
N.A.
Description

Instruction
Duration(s)
Delay(s)
A-Waveform
A-Frequency(Hz)
A-Amplitude(V)

Instruction
N.A.
N.A.
N.A.
N.A.
A-Amplitude(V)

B-Waveform
B-Frequency(Hz)
B-Amplitude(V)

N.A.
N.A.
B-Amplitude(V)

Phase Difference(D)
DDPs to be captured

N.A.
N.A.

Description
Step number is assigned automatically.
You can enter a description that best describes
this step. The default description is “Set Input
Range”.
SIR
N.A.
N.A.
N.A.
N.A.
Input Range to be set in Channel A. It can be a
real number or variable (x1~x5).
N.A.
N.A.
Input Range to be set in Channel B. It can be a
real number or variable (x1~x5).
N.A.
N.A.

8.2.5.25 SOR
SOR (Set Output Range) is used to set the output range of the DAC device.
Title in Process Viewer
Step
Description

www.virtins.com

Title in Step Editor
N.A.
Description

Description
Step number is assigned automatically.
You can enter a description that best describes

414 Copyright © 2006-2022

Virtins Technology

VIRTINS Multi-Instrument 3.9 Manual

Instruction
Duration(s)
Delay(s)
A-Waveform
A-Frequency(Hz)
A-Amplitude(V)

Instruction
N.A.
N.A.
N.A.
N.A.
A-Amplitude(V)

B-Waveform
B-Frequency(Hz)
B-Amplitude(V)

N.A.
N.A.
B-Amplitude(V)

Phase Difference(D)
DDPs to be captured

N.A.
N.A.

Virtins Technology
this step. The default description is “Set Output
Range”.
SOR
N.A.
N.A.
N.A.
N.A.
Output Range to be set in Channel A. It can be a
real number or variable (x1~x5).
N.A.
N.A.
Output Range to be set in Channel B. It can be a
real number or variable (x1~x5).
N.A.
N.A.

8.2.6 Multi-Step Generation

For SIO and OUT instructions, the Step Editor provides a way to generate multiple
steps in one shot if frequency or amplitude is the only parameter that varies among
them. You need to enter the number of steps to be generated first in the “Steps” field,
and then choose either frequency or amplitude as the variable, specify its varying
range and incrementing method (linear or logarithmic) for each channel, press the
“Insert” button in the end.
8.2.7 No Spectral Leakage
If this option is selected, you can further specify the Sampling Frequency of the
Oscilloscope and the FFT size of the Spectrum Analyzer. The only use of these two
parameters are to fine tune the output signal frequency to the nearest integer multiple
of [Sampling Frequency of the Oscilloscope] / [FFT Size of the Spectrum Analyzer],
in order to avoid the spectrum leakage issue. For example, if the signal frequency you
specify is 1 kHz, the Sampling Frequency of the Oscilloscope is 48 kHz, and the FFT
Size of the Spectrum Analyzer is 16384, then the signal frequency will be changed to
999.0234375 Hz. Combing this option with the Multi-Step Generation function would
be very useful if you want to design the test frequencies for THD vs Frequency plot.

8.3 Process Viewer
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Process Viewer is used to view a test plan during its editing and running process. The
first 12 columns are fixed and the rest of columns are used for the Derived Data
Points to be captured, which are configurable and only applicable to SIO and STI
instructions. From the 4th column to the 12th column, each column may have different
meanings for different instructions, and the displayed titles of these columns are only
applicable to SIO instruction. Please refer to the instructions described previously for
the actual meanings.
During the execution of a test plan, the current running step will be highlighted.
8.3.1 Context Menu

Process Viewer has its own context menu where additional functions can be accessed.
The context menu pops up when you right click a step in the Process Viewer if the
Device Test Plan is not running. There are three menu items in the context menu.


Run From Here
Unlike the Run/Stop button for plan execution which always starts from Step 1,
this option allows you to start from any step chosen.



Mark as PASS
This option is available only if the step has already been marked as FAIL, e.g. as a
result of a CHK instruction. You can overwrite the automated test result and mark
it as PASS according to your own judgement using this command.



Edit Step Label
This option allows you to add, edit or remove Step Label. Step Label is used to
label a particular step. Unlike Step No., it does not change when you add or delete
a step in the test plan. It can be used in those instructions that have a Step No. as
its parameter, such as CHK, JMP, and RPT. A dialog window with an edit box for
input will pop up once this option is selected. You can then enter a label
consisting of any characters. Each Step Label must be unique in a test plan. The
Step Label will be automatically bracketed and put right behind the Step No. You
do not need to enter the pair of brackets “(” and “)” manually. The Step Label will
be removed if nothing is entered.

8.4 Result/Options Area

The left most read-only edit box (Result window) is used to display the test result,
such as: “Pass”, “Fail”, “Done”, “…” (in progress). During a test plan execution, it
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will be marked as “…”. If the plan contains one or more Pass/Fail checks, the final
result will be marked as “Pass” only if all the Pass/Fail checks succeed, otherwise it
will be marked as “Fail”. If the plan contains no Pass/Fail check, it will be marked as
“Done” after the plan is finished.
You can specify the Derived Data Points to be captured in a test plan and they are
only applicable to those DAQ-related steps (i.e. SIO and STI). The values of these
DDPs will be displayed in the Process Viewer from the 15th column onwards. You
can also assign an alias for the DDP to make it more understandable. The alias will
appear in the column title in the Process Viewer as well as the axis title in the X-Y
Plot. Pressing “->” button will add the selected DDP into the list of data to be
captured. Pressing “<-” button will remove the selected DDP from that list.
On the right hand side, there are two buttons: “Save Current Panel Setting as Default”
and “Save Current Panel Setting”. The functionality of these two buttons is the same
as that of the “Save Current Panel Setting as Default” and “Save Current Panel
Setting” menu item described previously, except that the Device Test Plan panel will
be automatically launched with the current device test plan loaded when the saved
Panel Setting File is loaded.
8.4.1 User Log In / Off
It is possible to configure a user database and then allow user log in and log off. The
user database is just a text file containing three comma separate variables for each
user entry. The three variables are: user name, password, priority. The first two
variables can consist of any characters, but the latest one can only be a character from
“0” to “9”, with “0” being the highest priority. Each line in the file contains one user
entry only. The file should be put in the software’s root directory and named as
“Users.udb”. It can be edited by any text editor such as Windows Notepad and should
be managed by the administrator. The following illustrates the format of the file.
NS3390,1234,0
NS3391,5678,0
NS3392,90ab,0
…

If the user database file (User.udb) exists and it contains at least one user entry, then
the edit boxes for “User” and “Password” and the button for “Log In / Off” will
become visible at the lower right corner of the Result/Options area.
If the user database file (User.udb) exists, then only a user with a priority equal to “0”
is allowed to edit a plan and reset those non-volatile integers.
8.4.2 Non Volatile Variable Reset
The Reset button is used to reset those non-volatile integers (NonVolatile1~
NonVolatile5) persisted in the CSV text file “NonVolatile.txt” under “\dtp” diretory.
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8.4.3 Expanded Result Window at Runtime
The Result window will expand to the right at runtime in order to allow more space
for programmed display. It is split into four areas as shown below: Panel, Panel1,
Panel2 and Panel3. The texts and their colors in Panel1, Panel2 and Panel3 are
controllable by the instruction LOG. Each Panel can accommodate one line only.
Concatenation of texts can be achieved using a <Record Separator> rather than the
default Line Feed + Carriage Return.

8.5 Control Bar
The above control bar contains (from left to right):


Four radio boxes allow you to choose to show Control, show Control+Result,
show Control+Result+Process, or show Control+Result+Process+Editor.



File Open button
is used to load a device test plan. The path and file name of
the plan will be displayed in the title bar of the Device Test Plan panel.



File Save button
is used to save the current device test plan. Not only the
content of the device test plan but also the parameters of the X-Y plots and Device
Test Plan Log will be saved.



File Save & Lock
button is used to save the current device test plan as a
locked plan. A locked plan is not editable when reloaded and the “Editor” radio
box will be disabled. This feature is useful when the test plan is configured by an
engineer and operated by an operator.



X combo box for selecting the variable for X axis.

The first five variables (i.e. Frequency of Channel A, Amplitude of Channel A,
Frequency of Channel B, Amplitude of Channel B, Phase difference between
Channel A and Channel B) are pre-fixed and are always available for selection.
www.virtins.com
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The rest variables will be shown in the list only if they are configured in the “data
to be captured” list.


Y combo box for selecting the variable for Y axis.

The available variables in the list are the same as those in the X combo box.


X-Y Plot button
is used to open a new X-Y plot window. Maximum eight XY Plot windows can be opened. And these plots will be updated in real time.



Device Test Plan Log button
is used to open the Device Test Plan Log
window. One line of texts will be logged into this window each time when the
instruction LOG is executed.



Windows Recording Control button



Windows Volume Control button



Pause button



Single Step button



Run/Stop button

for plan execution
for plan execution
for plan execution

8.6 X-Y Plot
X-Y Plot is used to display the result of a test plan. It can be opened before, in the
middle, or after the execution of the test plan. An X-Y Plot can be generated even
when variables (x1~x5) instead of actual numbers are used in the output frequencies,
amplitudes or phases.
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8.6.1 Context Menu

X-Y Plot does not have its own menu and view parameter toolbar. Its functions are
accessed via its context menu. The context menu pops up when you right click
anywhere within the X-Y Plot window.

8.6.1.1 X Scale

The X Scale dialog can be accessed via the context menu or by double clicking on X
axis of the plot. You can specify the range of X axis and choose between linear or
logarithmic scales. Note that the software will disallow logarithmic scale if the range
covers negative or zero values.

8.6.1.2 Y Scale
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The Y Scale dialog can be accessed via the context menu or by double clicking on Y
axis. You can specify the range of Y axis and choose between linear or logarithmic
scales. Note that the software will disallow logarithmic scale if the range covers
negative or zero values.

8.6.1.3 Chart Options
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Same as Oscilloscope, except that you can also specify a title for the X-Y Plot here.

8.6.1.4 Reference

Same as Oscilloscope except that only one channel of data is available.

8.6.1.5 Copy As Bitmap
Same as Oscilloscope

8.6.1.6 Copy As Text
Same as Oscilloscope
8.6.1.7 Export
Same as Oscilloscope
8.6.1.8 Print
Same as Oscilloscope
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8.6.2 Cursor Reader and Marker
Similar to those in the Oscilloscope, except that the cursor reader and marker mark
the point exactly at the point of mouse click rather than sticking to the nearest
measurement point.
8.6.3 Sticky Move

“Sticky Move” option can be accessed by clicking the icon at the upper left corner of
the Device Test Plan panel. It is ticked by default. With this option selected, all X-Y
Plots will move together if you drag the title bar of the Device Test Plan panel.

8.7 Device Test Plan Log

Device Test Plan Log can be used to log the test results or generate a test report. It
should be used with the instruction LOG.
Two buttons are available at the bottom of the log:


File Save
To save the logged data.
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Run/Stop button for plan execution
It has the same functionality as the one in the Device Test Plan main window.

8.8 Device Test Plan Examples
Some sample test plans are provided in the DTP directory of the software and can be
used as templates. The following are a few examples.
8.8.1 Transfer Function Measurement using Frequency Stepped Sine Signal
The following figure illustrates the transfer function (i.e. Gain and Phase Plot, or
Bode Plot) of a 5513 Hz second order Butterworth low pass filter, measured using a
frequency stepped sine stimulus, with the stimulus data stored in Channel B and the
response data stored in Channel A. It shows that the gain maintains at nearly 0 dB
from 0 Hz to about 5513 Hz, and then start to drop down very quickly, meanwhile the
phase changes gradually from 0 degree at 0 Hz towards –180 degree as the frequency
goes to infinity. At the cutoff frequency 5513 Hz, the gain is about –3dB and the
phase is about –90 degree.
The sample DTP files are at:
1) \dtp\SteppedSineFrequencyResponseMeasurement.dtp
2) \dtp\SteppedSineFrequencyResponseMeasurement_Demo.dtp
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8.8.2 Pass/Fail Test
The following figure illustrates a Pass/Fail test on magnitude frequency response
using a stepped sine signal. The measured RMS voltage values (blue) at the specified
frequencies are checked against the preset high and low limits at those frequencies in
order to determine “Pass” or “Fail”. The high (red) and low (black) limits are also
loaded as reference in the X-Y Plot. The final result is displayed as “Pass” only if all
limit checks have been passed.
The sample DTP file is at: \dtp\HighLowLimit.dtp.

8.8.3 THD+N, THD, SNR, Magnitude vs Frequency Plots
The following figure shows the THD+N, THD, SNR, Magnitude vs Frequency Plots
measured using frequency stepped sine signals. The frequency of the test signal
increases step by step logarithmically from 20 Hz to 20 kHz while its amplitude is
kept constant such that the input peak level is at around –1 dBFS. The test frequencies
are fine tuned using the aforementioned “No Spectral Leakage” option to avoid the
spectral leakage issue. The THD calculation range is set to 10 Hz ~ 20 kHz and up to
the 5th harmonic frequencies is taken into account in THD. This means that, for the
fundamental frequency 20 Hz, only its harmonic frequencies 40 Hz, 60 Hz, 80Hz and
100 Hz are used in the THD calculation; for the fundamental frequency 4 kHz, only
its harmonics frequencies 8 kHz, 12 kHz, 16 kHz and 20 kHz are used; but for a
fundamental frequency higher than 4 kHz, only those harmonic frequencies less than
20 kHz, i.e. less than the 5th order, are used. Therefore only the THDs in the
frequency range from 20 Hz to 4 kHz are comparable because the same order of
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harmonic frequencies is used in their THD calculation. On the other hand, THD+N
values are comparable in the full frequency range from 20 Hz to 20 kHz. The plot at
the upper left corner is the THD+N vs Frequency plot; the plot at the upper right
corner is the THD vs Frequency plot; the plot at the bottom left corner is the SNR vs
Frequency plot; the plot at the bottom right corner is the Magnitude vs Frequency plot.
Note that, although the magnitude of the signal output towards the DUT is kept
constant, the magnitude of the response signals output by the DUT may vary with
frequency. Therefore the Magnitude vs Frequency plot actually reflects the magnitude
frequency response of the DUT.
The sample DTP is at: \dtp\THD+N_THD_SNR_Magnitude_vs_Frequency.dtp.

8.8.4 THD+N, THD vs Magnitude, Power Plots
The following figure shows the THD+N, THD, vs Magnitude, Power Plots measured
using amplitude stepped sine signals. The amplitude of the test signal increases step
by step linearly from 0.1 V to 1 V while its frequency is kept constant at 999.0234375
Hz. The frequency is fine tuned using the aforementioned “No Spectral Leakage”
option to avoid the spectral leakage issue. The THD calculation range is set to 10 Hz
~ 20 kHz. The plot at the upper left corner is the THD+N vs RMS voltage plot; the
plot at the upper right corner is the THD vs RMS voltage plot; the plot at the bottom
left corner is the THD+N vs Power plot; the plot at the bottom right corner is the THD
vs Power plot. Note that, the power value is obtained from the Derived Data Point
PWR_A(W), which is equal to [RMS Voltage]2 / [Load Factor], where the load factor
is set via [Setting]>[Calibration]> “Load Factor for Power Calculation”. For better
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measurement accuracy, it is recommended the input peak level should not be lower
than –20 dBFS during the amplitude sweep.
The sample DTP is at: \dtp\THD+N_THD_vs_Magnitude_Power.dtp.

8.8.5 SMPTE IMD vs Magnitude, Power Plots
The following figure shows the SMPTE IMD vs Magnitude, Power Plots measured using
amplitude stepped SMPTE sine signals (60 Hz + 7kHz, Amplitude Ratio 4: 1). The amplitude of
the test signal increases step by step linearly from 0.1 V to 1 V. The upper plot is the SMPTE
IMD vs RMS voltage plot; the lower plot is the SMPTE IMD vs Power plot. Note that, the power
value is obtained from the Derived Data Point PWR_A(W), which is equal to [RMS Voltage] 2 /
[Load Factor], where the load factor is set via [Setting]>[Calibration]> “Load Factor for Power
Calculation”. For better measurement accuracy, it is recommended the input peak level should
not be lower than –20 dBFS during the amplitude sweep.
The sample DTP is at: \dtp\SMPTE_IMD_vs_Magnitude_Power.dtp.
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8.8.6 Crosstalk vs Frequency Plots
The following figure shows the Crosstalk vs Frequency Plot measured using frequency stepped
sine signals. The frequency of the test signal increases step by step logarithmically from 20 Hz to
20 kHz while its amplitude is kept constant such that the input peak level is at around –1 dBFS.
The test frequencies are fine tuned using the aforementioned “No Spectral Leakage” option to
avoid the spectral leakage issue. .
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The sample DTP is at: \dtp\Crosstalk_vs_Frequency.dtp.
8.8.7 Automated Audio Parameter Test
The test is to measure THD, THD+N, THD+N (A-Weighted), SNR, SNR (AWeighted), SMPTE IMD, DIN IMD, CCIF2 IMD, CCIF3 IMD, Crosstalk, and -3dB
Bandwidth automatically through a sequence of automated steps. The test results will
be summarized in the log window. The following criteria are used to evaluate the
results. The test can be used to evaluate a sound card’s own audio performance
through the loopback test. It can also be used to measure a device’s audio parameters
automatically when the test setup’s own audio performance is one order better than
the device under test.

THD
THD+N
THD+N (AWeighted)
SNR
SNR (AWeighted)
SMPTE IMD
DIN IMD
CCIF2 IMD
CCIF3 IMD
Crosstalk

Excellent
<=0.003%
<=0.005%
<=0.004%

Very Good
<=0.03%
<=0.05%
<=0.04%

Good
<=0.3%
<=0.5%
<=0.4%

Average
<=3%
<=5%
<=4%

Poor
<=10%
<=20%
<=15%

Very Poor
>10%
>20%
>15%

>=110 dB
>=115 dB

>=90 dB
>=95 dB

<=70 dB
<=75 dB

>=50 dB
>=55 dB

>=30dB
>=35dB

<30dB
<35dB

<=0.003%
<=0.003%
<=0.003%
<=0.003%
<=-110 dB

<=0.03%
<=0.03%
<=0.03%
<=0.03%
<=-90 dB

<=0.3%
<=0.3%
<=0.3%
<=0.3%
<=-70 dB

<=3%
<=3%
<=3%
<=3%
<= -50 dB

<=10%
<=10%
<=10%
<=10%
<=-30 dB

>10%
>10%
>10%
>10%
>-30 dB
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The sample DTPs are at: \dtp\AudioParameter_SR44100_A.dtp
\dtp\AudioParameter_SR44100_AB.dtp
\dtp\AudioParameter_SR48000_A.dtp
\dtp\AudioParameter_SR48000_AB.dtp
8.8.8 Magnitude Frequency Response Measurement using Variable Based
Frequency Stepped Sine Signal
The following figure shows the magnitude frequency response measured using
variable based frequency stepped sine signal. The test frequencies in this example are
not specified explicitly in the device test plan. Instead, they are generated
dynamically by manipulating the variable x1 during the execution of the plan. The
following shows the related pseudo codes. It can be seen that using variables can
greatly reduce the number of steps and increase the flexibility.
Step 1:
Step 2:
Step 3:
Step 4:
Step 5:
Step 6:

OPT x1 = 15.625; //Initialize x1
SIO (x1); //Output frequency x1
OPT x1 = x1*1.25992105; //Increase by 1/3 octave, 2^(1/3)=1.25992105
CHK x1 > 20159, goto Step 6 //Exit if x1 is greater than 20159
JMP to Step 2; //Repeat
END
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9 LCR Meter
9.1 Overview

LCR Meter is one of the dedicated test plans. It is used to measure the value of an
inductor, a capacitor or a resistor, or the impedance of a network of them. Two types
of external connections are supported:



Serial connection for high impedance measurement
Parallel connection for low impedance measurement

An external reference resistor Rr is required in both cases. In the former one, the
reference resistor Rr is in series to the sound card input impedance Zsc, and in the
latter one, Rr is parallel to Zsc.
The screen layout of the LCR Meter is similar to that of the Device Test Plan and the
difference will be described in the following sections.

9.2 Step Editor
By default, the LCR Meter will load predefined locked dedicated test plans, therefore
the Step Editor will always be disabled. However, you are allowed to save a locked
test plan as an unlocked test plan and subsequently load it for editing. In such case,
the Step Editor will be shown.

9.3 Progress Viewer
As a dedicated test plan, the LCR Meter has unique content in the Progress Viewer
from the 13th column onwards. They are:
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Column Title
Zsc (k)
Rr1 (k)
Zx1 (k)
Vi1 (V)
PeakPercent1
Rr2 (k)
Zx2 (k)
Vi2 (V)
PeakPercent2

Virtins Technology

Description
Sound Card Input Impedance (kΩ)
Reference Resistor Value (kΩ) used in Step 1
Always be zero (kΩ) because Zx should not be connected in this step
RMS voltage (V) measured in Channel A in Step 1
Peak level percentage measured in Channel A in Step 1
Reference Resistor Value (kΩ) used in Step 2
Measured impedance value (kΩ) in Step 2
RMS voltage (V) measured in Channel A in Step 2
Peak level percentage measured in Channel A in Step 2

The above columns will be filled with the actual values by the software automatically
as the process goes. However, if there are exceptions encountered, they will be filled
with one of the following texts instead:
“NA”-----Not Available/Not Applicable
“BAD”---The quality of the test tone is considered as bad if the peak level measured
in Channel A exceeds 99.9% or the THD value measured in Channel A
exceeds 3%, in which case, you should adjust the output level, the reference
resistor value, or the input gain.
If the value is currently unknown and is to be measured, then the field will be filled
with “?”.
The meaning of each of the above columns will be further explained in the following
sections.

9.4 Result/Options Area
The left most read-only edit box (Result window) is used to display the test result. In
Step 1 (Set test tone reference level), it displays the peak level percentage at each test
frequency. In Step 2 (Test with DUT), it displays the measured impedance value of
the DUT. You can choose to display the impedance as inductance, capacitance, or
resistance, by selecting the corresponding radio boxes “L”, “C”, “R”. The
measurement range is also indicated. Adjusting the reference resistor value will
change the measurement range.
In the right part of this area, you can choose between High Impedance Measurement
method or Low Impedance Measurement method. The corresponding mimic
connection diagram will then be enabled. Details of these two methods will be
described later.

9.5 Control Bar
Same as that in the Device Test Plan. The File Open, File Save, File Save & Lock
buttons are still enabled to allow advanced users to modify the default LCR test plans.
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However, it should be noted that the LCR meter may function incorrectly if a nonLCR test plan is used.

9.6 High Impedance Measurement
High Impedance Measurement uses the sound card input impedance as one of the
reference resistor. Thus, to enable this type of measurement, the sound card input
impedance, which is sound card dependent, must be calibrated first. After calibration,
the LCR Meter will be able to display the measurement range based on the reference
resistor value and the test frequency used. The software uses 1% and 99% variation
from the test tone reference level to suggest the measurement range, within which
good measurement accuracy can be achieved. This is similar to the case of resistor
measurement using an analog multimeter whereby the middle region of the swing of
the needle has good measurement accuracy.
The procedure to make a LCR measurement is also similar to the procedure to
measure a resistor using an analog multimeter, as shown as follows.
Step

Description

LCR Meter Implementation

0

Choose
a
measurement range

1

Set the test tone reference
level
such
that
the
maximum allowable level
is reached to ensure
sufficient
measurement
accuracy

2

Connect the DUT and make
the measurement. You can
repeat this step to test other
DUTs as long as there is no
need
to
change
the
measurement range.

proper

By connecting a proper
reference resistor Rr and enter
the corresponding value in the
Rr combo box on the screen.
Then start the plan.
By shorting the two test leads
and then adjusting the output
level via Windows Volume
Control, and/or the input gain
via
Windows
Recording
Control. A peak level above
85% is recommended.
By connecting the DUT
between the two test leads and
choose Step 2 radio box on the
screen

Analog
Multimeter
Implementation
Via the switch which
switches to a corresponding
reference resistor inside the
multimeter
By shorting the two test leads
and then adjusting the
zeroing potentiometer such
that the needle points to zero
ohms.

By connecting the DUT
between the two test leads

9.6.1 Connection for High Impedance Measurement
The connection diagram for high impedance measurement is shown as follows.
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Channel A

where:
Rr is the reference resistor.
Zx is the impedance to be measured.
Zsc is the sound card input impedance
Vo is the output RMS voltage.
Vi is the input RMS voltage.
Rr, Zx and Zsc form a voltage divider and thus we have Vi/Vo=Zsc/(Rr+Zx+Zsc).
This connection should be used for high impedance measurement where Zx is
comparable to or higher than Zsc. It should be noted that the sound card output
impedance, which typically ranges from nearly zero ohm to a few ohms for
Speaker/Headphone Out, is ignored in the above formula. This simplification
has negligible effect on the measurement accuracy as long as the output
impedance is negligibly small compared with the value of Rr+Zx+Zsc, which
holds true in almost all cases. It can be taken into account by simply adding its
value (if it is known) to the value of Rr.
Zsc is typically in the range of 600 Ω ~ 50 kΩ, depending on the sound card and
channels (MIC In or Line In) used. It must be calibrated before you can start the real
LCR measurements. The calibration data can be saved so that you do not have to
calibrate it again as long as the same sound card is used. In the Zsc combo box, two
options are available: “?” and “Zsc”. Choose “?” if you want to conduct Zsc
calibration, and choose “Zsc” if you want to conduct a normal LCR measurement.
Only “?” will be available if the software cannot find any calibration data in the
current software directory. This is to force you to conduct Zsc calibration first.
Rr is an external reference resistor. You need to find the resistor and make the
connection by yourself. An easier way is to use two VIRTINS Sound Card
Oscilloscope Probes (P601), one connected to the input jack of the sound card and the
other connected to the output jack of the sound card. Then you can connect the
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inductor/capacitor/resistor to be measured between them easily (see figure below, you
do not have to connect the ground lead if they are connected within the sound card
itself.). The impedance of the probes will act as the reference resistor. Note that for
VIRTINS Sound Card Oscilloscope Probe (P601), the input impedance is 1 k, 201k
and 10.001M for switch position 1, 2 and 3 respectively. In the Rr combo box, you
should enter the actual value (in k) you used. Different test steps or different
measurement ranges desired may require different resistor values.

Some pre-configured resistance values are available for selection, most of them are
relevant to the case where two VIRTINS Sound Card Oscilloscope Probes (P601) are
used as both the test leads and reference resistor.
Options
0
1_[P1]

Resistance (k)
0
1

2_[P1+P1]

2

201_[P2]

201

202_[P2+P1]

202

402_[P2+P2]

402

10001_[P3]

10001

10002_[P3+P1]

10002

10202_[P3+P2]

10202

20002_[P3+P3]

20002

Description
Two zero-resistance test leads are used.
One VIRTINS Sound Card Oscilloscope Probe and one zeroresistance test lead are used. The probe is in Position 1.
Two VIRTINS Sound Card Oscilloscope Probes are used. Both
of them are in Position 1.
One VIRTINS Sound Card Oscilloscope Probe and one zeroresistance test lead are used. The probe is in Position 2.
Two VIRTINS Sound Card Oscilloscope Probes are used, one
in Position 2 and the other in Position 1.
Two VIRTINS Sound Card Oscilloscope Probes are used. Both
of them are in Position 2.
One VIRTINS Sound Card Oscilloscope Probe and one zeroresistance test lead are used. The probe is in Position 3.
Two VIRTINS Sound Card Oscilloscope Probes are used, one
in Position 3 and the other in Position 1.
Two VIRTINS Sound Card Oscilloscope Probes are used, one
in Position 3 and the other in Position 2.
Two VIRTINS Sound Card Oscilloscope Probes are used. Both
of them are in Position 3.

If you are not using the above values, then you have to enter the resistance value
manually. For advanced users, if you have your own set of reference resistors, you
can modify the TXT file named “ResistorRef1.txt” under the software root directory
so that your can have your own set of reference resistor values available in the Rr
combo box. In the following sections, to simplify the explanation of the measurement
procedure, we will assume that two VIRTINS Sound Card Oscilloscope Probes are
used. But bear in mind that you can always use your own test leads and reference
resistors.
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Zx is the impedance to be measured. When “?” is chosen in the Zsc combo box, the
Zx combo box will always display “0”, which means during Zsc calibration, Zx
should not be connected. When “Zsc” is chosen in the Zsc combo box, the Zx combo
box will display “0” for Step 1 and “?” for Step 2. In other word, only the last step of
the actual LCR measurement requires Zx to be connected.
9.6.2 Calibration of Sound Card Input Impedance
The software does not assume Zsc is a constant with regard to frequency. Thus the
value of Zsc should be calibrated against a number of frequencies covering the entire
range within which the test frequencies will be chosen. During the actual LCR
measurement, the actual Zsc values at the actual test frequencies will be interpolated
from the calibration result. To avoid the interpolation error, use the same frequencies
during calibration and actual measurement.
The procedure to calibrate Zsc is similar to the procedure to make a LCR
measurement. You need to take two steps to complete the calibration.

9.6.2.1 Step1---Set Test Tone Reference Level

To start the calibration, you need to choose “?” in the Zsc combo box. It is
automatically chosen if this is the first time you conduct the calibration. Then, a
locked dedicated test plan named Zscdefault.dtp will be automatically loaded (see
figure above). By factory default, this plan will measure the Zsc values at 50 Hz, 100
Hz, 200 Hz, 500 Hz, 1000 Hz, 2000 Hz, 5000 Hz, 10000 Hz, 20000Hz.
“Step 1-Set test tone reference level” should be selected. The purpose of this step is to
set the test tone reference level which is similar to the zeroing step when you want to
measure a resistor using an analog multimeter. The reference level should be set as
high as possible in order to get sufficient measurement accuracy provided no signal
clipping occurs.
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Before you start the test plan, make sure the test loop is connected correctly and the
Rr value in the Rr combo box corresponds to the actual value used. For this step, a
relatively low (compared with the one in the next step) Rr value should be used. The
value can be zero. In the example, we used 2_[P1+P1] (=2 kΩ) for convenience
purpose.
Zx is bypassed and its value is zero.
Once the test plan is started, it will generate each test frequency one by one and
display the corresponding peak level in the PeakPercent1 column as well as the Result
window. After finishing the last test frequency, it will go back to the first test
frequency again and repeat this process until the plan is stopped manually. During this
process, you should adjust the output level and input gain using the Windows Volume
Control and Recording Control such that the maximum peak level among all test
frequencies is close to 100% without any clipping. You may have to change the Rr
value if the peak levels are too low.
Having set the desired test tone level, press the Start/Stop button to stop the plan.

9.6.2.2 Step2---Test with DUT (Zsc)

Keep the test tone reference level intact, then choose “Step 2-Test with DUT”. The
DUT in this step is in fact Zsc. The value of Rr must be changed in this step. In the
example, we changed it to 202_[P2+P1] (=202 kΩ).
Once the test plan is started, it will generate each test frequency one by one and
display the corresponding Zsc value measured in the Zsc column as well as the Result
window. After finishing the last test frequency, it will go back to the first test
frequency again and repeat this process until the plan is stopped manually. The output
level and input gain set in the previous step must be maintained in this step.
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beside “Zsc” to save the calibration result

9.6.2.3 Save, Save As, Open a Zsc calibration file
The File Open button
file (*.zsc).

beside “Zsc” can be used to load a sound card impedance

The File Save button
beside “Zsc” is used to save the current calibration data to
the default sound card impedance file named default.zsc. The LCR Meter refers to
this file for the value of Zsc by default. You can use the File Open button to load a
non-default Zsc calibration file if necessary.
The File Save As button
beside “Zsc” is used to save the current calibration data
to a specified sound card impedance file.
The path and name of the current sound card impedance file in use, if any, is
displayed below the above three buttons.

9.6.3 Make a LCR Measurement
As described previously, the procedure to make a LCR measurement is similar to the
procedure to measure a resistor using an analog multimeter. You need to take two
steps to complete a measurement at first, and then the first step can be skipped if the
measurement range has not been changed.
9.6.3.1 Step1--- Set Test Tone Reference Level
To start the actual measurement, you need to choose “Zsc” in the Zsc combo box.
Then, a locked dedicated test plan named LCRdefault.dtp will be automatically
loaded (see figure below). By factory default, this plan will measure the Zx values at
1000 Hz only.
Then choose a proper measurement range by connecting a proper reference resistor Rr
and enter the corresponding value in the Rr combo box on the screen. Then short the
two test leads to bypass Zx, select Step 1, start the plan and adjust the output level via
Windows Volume Control, and/or the input gain via Windows Recording Control, in
order to set the test tone reference level such that the maximum allowable level is
reached to ensure sufficient measurement accuracy. A peak level above 85% is
recommended. Stop the plan after the test tone reference level is set.
In the following example, we used 2_[P1+P1] (=2 kΩ) for Rr and the peak level at the
test frequency (1000 Hz) was set to 97.02%.
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9.6.3.2 Step2---Test with DUT
Keep the test tone reference level intact, connect the DUT (Zx) between the two test
leads, select Step 2 and start the plan. The impedance value measured will then be
displayed in the Result window and Zx2 column.
In the following example, we used 200 kΩ resistor with a tolerance value of 1% for
Zx, and the measured value was 199.484 kΩ, which is very accurate. Note that the
sound card input and output impedance here were about 50 kΩ and 100 Ω
respectively and the output impedance was ignored without any compensation.

If Zx is a capacitor with the same impedance value at 1000 Hz, then the capacitance
would be 797.831 pF.
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If Zx is an inductor with the same impedance value at 1000 Hz, then the inductance
would be 31.749 H.

9.7 Low Impedance Measurement
Low Impedance Measurement is used to measure impedance in a lower range. The
reference resistor is placed in parallel to the sound card input impedance, and if its
value is much lower than the sound card input impedance, which holds true in most of
cases, the sound card input impedance can be ignored. Thus, it is not necessary to
calibrate the sound card input impedance before measurement. However, if the default
sound card input impedance file exists or a sound card input impedance file has been
loaded, the sound card input impedance will be automatically taken into account for
better accuracy.
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The LCR Meter will be able to display the measurement range based on the reference
resistor value and the test frequency used. The software uses 1% and 99% variation
from the test tone reference level to suggest the measurement range, within which
good measurement accuracy can be achieved. This is similar to the case of resistor
measurement using an analog multimeter whereby the middle region of the swing of
the needle has good measurement accuracy.
The procedure to make a LCR measurement is also similar to the procedure to
measure a resistor using an analog multimeter, as described previously.

9.7.1 Connection for Low Impedance Measurement
The connection diagram for low impedance measurement is shown as follows.

Channel A

where:
Rr is the reference resistor.
Zx is the impedance to be measured.
Zsc is the sound card input impedance.
Vo is the output RMS voltage.
Vi is the input RMS voltage.
(Rr|Zsc) and Zx form a voltage divider and thus we have
Vi/Vo=(Rr|Zsc)/((Rr|Zsc)+Zx), where (Rr|Zsc) is the resultant resistance when Rr and
Zsc are connected in parallel. It should be noted that the sound card output
impedance, which typically ranges from nearly zero ohm to a few ohms for
Speaker/Headphone Out, is ignored in the above formula. This simplification has
negligible effect on the measurement accuracy as long as the output impedance is
negligibly small compared with the value of Zx+(Rr|Zsc), which holds true in
most of the cases.
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Rr is an external reference resistor. You need to find the resistor and make the
connection by yourself. In the Rr combo box, you should enter the actual value (in
k) you used. Different measurement ranges requires different reference resistor
values. Some pre-configured resistance values are available for selection: 0.01 k, 0.1 k,
1.0 k.
If you are not using the above values, then you have to enter the resistance value
manually. For advanced users, if you have your own set of reference resistors, you
can modify the TXT file named “ResistorRef2.txt” under the software root directory
so that your can have your own set of reference resistor values available in the Rr
combo box.
Zx is the impedance to be measured. The Zx combo box will display “0” for Step 1
and “?” for Step 2. In other word, in Step 1, Zx should be bypassed and in Step 2, Zx
should be connected.
9.7.2 Make a LCR Measurement
As described previously, the procedure to make a LCR measurement is similar to the
procedure to measure a resistor using an analog multimeter. You need to take two
steps to complete a measurement at first, and then the first step can be skipped if the
measurement range has not been changed.
9.7.2.1 Step1--- Set Test Tone Reference Level
Choose a proper measurement range by connecting a proper reference resistor Rr and
enter the corresponding value in the Rr combo box on the screen. Then, short the two
test leads to bypass Zx, select Step 1, start the plan and adjust the output level via
Windows Volume Control, and/or the input gain via Windows Recording Control, in
order to set the test tone reference level such that the maximum allowable level is
reached to ensure sufficient measurement accuracy. A peak level above 85% is
recommended. Stop the plan after the test tone reference level is set.
In the following example, we used a 1kΩ resistor for Rr and the peak level at the test
frequency (1000 Hz) was set to 98.33%.
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9.7.2.2 Step2---Test with DUT
Keep the test tone reference level intact, connect the DUT (Zx) between the two test
leads, select Step 2 and start the plan. The impedance value measured will then be
displayed in the Result window and Zx2 column.
In the following example, we used 20 Ω resistor with a tolerance value of 1% for Zx,
and the measured value was 20.064 kΩ, which is very accurate. Note that the sound
card input and output impedance here were about 50 k Ω and 100 Ω respectively and
the output impedance was ignored without any compensation.

9.8 Measurement Accuracy
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The following points should be noted in order to achieve high accuracy in LCR
measurements:





High-precision reference resistor should be used.
Use a sound card with low output impedance.
Set measurement range correctly. Change the reference resistor value or the test
frequency will change the range of measurement. The highest measurement
accuracy is expected if the peak level in Step 2 is half of that in Step 1 and the
peak level in Step 1 is close to 100%. This is similar to the case of measuring a
resistor using an analog multimeter whereby the middle of the needle swing range
has the highest measurement accuracy.

On the other hand, the frequency response of the sound card does not affect the
accuracy in LCR measurements. Also, calibration of the sound card input and output
channels is not required here.

9.9 Measurement with Multiple Test Frequencies
If you configure a LCR test plan with multiple test frequencies in multiple test steps,
the averaged resistance, capacitance or inductance value will be displayed in the
Result window. Some sample LCR test plans beside the default one for LCR
measurements are provided under the DTP (Device Test Plan) directory of the
software. These test plans (with prefix “LCR” in their file names) are configured with
different test frequencies which allow you the set different measurement ranges
without changing the reference resistor.
The following figure shows a measurement of a capacitor using multiple test
frequencies. The X-Y Plot illustrates its impedance variation with regard to frequency.
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10 Derived Data Point (DDP) Viewer
10.1 Overview

DDP viewer is used to display the value of a DDP (Derived Data Point) in a dedicated
window with a bigger font size. It is also possible to specify the DDP’s high-high,
high, low, low-low limits for alarming and the number of decimal places for display.
Different alarm sounds can be configured for different types of alarms. Alarm
acknowledgement is supported. Up to 24 DDP viewers can be opened. These DDP
viewers can also be used to define and display UDDPs (User Defined Data Points)
The push button
in the Instrument Toolbar is used to open a new DDP viewer
window. You can close it by clicking the "Close" button at the upper right corner of
the window.
DDP array viewer is used to display arrays of DDPs. It can be launched from a DDP
viewer’s configuration dialog box. Only one DDP array viewer is supported in the
software.

10.2 Configuration
10.2.1 Settings for both DDP and UDDP
Whenever the “DDP Viewer” button in the Instrument Toolbar is clicked, a new DDP
Viewer window will be opened. A configuration dialog box (see figure below) will
pop up on the top of the DDP Viewer window to allow you to enter the configuration
first. Parameters to be configured include the DDP to be viewed, the alias of the DDP
which will be displayed in the title bar of the DDP Viewer, the high-high, high, low,
low-low limits for alarming and their respective background colors. The alarms will
be enabled only if the respective checkboxes are ticked. The number of decimal
places will be set according to the DDP’s source precision by default. You can change
it thereafter.
Every alarm limit can be assigned with a particular alarm sound. The alarm sound can
be defined using a WAV file. If no WAV file is configured, a default alarm sound will
be used. The alarm sound can be configured to play once or cyclically when alarm
occurs. If the alarm output is enabled, it will be activated when the alarm limit is
broken. High-High Limit alarm has a higher priority than High Limit alarm. LowLow Limit alarm has a higher priority than Low Limit alarm. To prevent different
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types of alarm sounds from toggling too frequently, a 3 seconds’ hysteresis is used
internally. If the alarm sound is configured to play cyclically, a speaker icon will
appear at the lower right corner of the DDP viewer when the alarm occurs, clicking
that icon will acknowledge the alarm and stop the alarm sound. The alarm sound will
be played cyclically until it is acknowledged even though the actual DDP value has
returned to normal.
The alarm statuses of all opened DDP viewers are summarized into one DDP:
OverallPassFailCheck. It is evaluated by the software after all DDPs and UDDPs
have already been updated. It has three values: “Nil”, “Pass”, “Fail”. If none of the
opened DDP viewer is configured for alarm checking, “Nil” will be displayed (=0). If
any opened DDP viewer has an alarm, “Fail” will be displayed (<0, the absolute value
represents the number of fails). If no alarm in all the opened DDP viewers, then
“Pass” will be displayed (>0, the absolute value represents the number of passes).
10.2.2 Define a UDDP
A UDDP is usually a function of certain DDPs. It gets updated after all DDPs are
updated. Each DDP Viewer can be used to define and display one UDDP. For
example, DDP Viewers 1 and 16 can be used to define and display UDDP1 and
UDDP16 respectively. UDDPs are updated in a predefined order with UDDP1 being
the first and UDDP16 being the last. The earlier-updated UDDPs can be used as
variables in the functions that define the later-updated UDDPs.

A UDDP can be expressed as a function of DDPs and earlier-updated UDDPs. The
mathematical expression may consist of constants, DDPs, UDDPs, mathematical
operators, and mathematical functions. Spaces and Carriage Returns in the expression
will be ignored.
Constants must be written in the forms of -x, -x.x, x, or x.x, e.g. –25, -49.55, 38, 71.45.
Constants expressed in exponential forms such as 2E10 are not accepted.

www.virtins.com

447 Copyright © 2006-2022

Virtins Technology

VIRTINS Multi-Instrument 3.9 Manual

Virtins Technology

DDPs or UDDPs must be referred to using their names bracketed by “[]”, e.g.
[Max_A(EU)], [RMS_B(EU)], [UDDP1_(UU)].
Mathematical operators supported are: +, -, *, /, ^, where * represents  and ^ is used
to raise a number to the power of an exponent (number ^ exponent). Parentheses “()”
can be used to specify the order of operation. Arbitrary nesting of parentheses is
allowed.
Mathematical functions supported are listed in the following table. The variables of a
function can be constants, DDPs, UDDPs, or functions. A function can be called
recursively.
No.
1
2
3
4
5
6
7
8
9
10
11
12

Function
SIN(x)
COS(x)
TAN(x)
SUM(x1,x2,…xn)
LOG(x)
LOG10(x)
ABS(x)
MAX(x1,x2,…xn)
MIN(x1,x2,…xn)
POW(x,y)
SQRT(x)
IFGT(x,y,z,w)

13

IFGE(x,y,z,w)

14

IFLT(x,y,z,w)

15

IFLE(x,y,z,w)

16

IFEQ(x,y,z,w)

17

IFNE(x,y,z,w)

18

IFIN(x,l,h,z,w)

19
20
21

ASIN(x)
ACOS(x)
ATAN(x)
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Description
Sine of x, where x is in radians
Cosine of x, where x is in radians
Tangent of x, where x is in radians
Sum of x1, x2, ...xn
Base-e logarithm of x
Base-10 logarithm of x
Absolute value of x
Maximum value of x1, x2, ...xn
Minimum value of x1, x2, ...xn
X raised to a power of y
Square root of x
If x>y, return z, otherwise return w.
z and w can be either a number or a ASCII character
string enclosed in “”.
If x≥y, return z, otherwise return w.
z and w can be either a number or a ASCII character
string enclosed in “”.
If x<y, return z, otherwise return w.
z and w can be either a number or a ASCII character
string enclosed in “”.
If x≤y, return z, otherwise return w.
z and w can be either a number or a ASCII character
string enclosed in “”.
If x=y, return z, otherwise return w.
z and w can be either a number or a ASCII character
string enclosed in “”.
If x≠y, return z, otherwise return w.
z and w can be either a number or a ASCII character
string enclosed in “”.
If l≤x≤h, return z, otherwise return w.
z and w can be either a number or a ASCII character
string enclosed in “”.
Arc sine of x, where -1≤x≤1
Arc cosine of x, where -1≤x≤1
Arc tangent of x
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A UDDP can also be set by an external ActiveX automation client program via
SetUDDP(). No definition is required for the UDDP in this case. Please refer to MultiInstrument_Automation_Server_Interfaces.pdf in the subdirectory \AutomationAPIs
for details.
The unit of a UDDP can be specified by the user. The UDDP function greatly expands
the software’s capability in direct measurements of various parameters. Some UDDP
definition examples are shown in the following sections.

10.2.2.1 Calculate Total dBV from 8 User Defined Frequency Bands
Settings:
 [Spectrum Analyzer Y Scale]: Vrms
 [Spectrum Analyzer Processing]: Energy in User Defined Frequency Bands
UDDP1:
20*LOG10(SQRT(SUM([fBand1RMS_A(EU)]^2,[fBand2RMS_A(EU)]^2,
[fBand3RMS_A(EU)]^2,[fBand4RMS_A(EU)]^2,[fBand5RMS_A(EU)]^2,
[fBand6RMS_A(EU)]^2,[fBand7RMS_A(EU)]^2,[fBand8RMS_A(EU)]^2)))

10.2.2.2 DTMF Decoder in a Noisy Background
Settings:
[Spectrum Analyzer Processing]: Peaks with [DeadBand]=50, [Number of Peaks]=6
It is assumed that the dual tone peaks are among the detected 6 frequency peaks.
UDDP1:
IFIN([f1Freq_A(Hz)],692,702,1,0) +
IFIN([f1Freq_A(Hz)],765,775,2,0) +
IFIN([f1Freq_A(Hz)],847,857,3,0) +
IFIN([f1Freq_A(Hz)],936,946,4,0) +
IFIN([f1Freq_A(Hz)],1204,1214,10,0) +
IFIN([f1Freq_A(Hz)],1331,1341,20,0) +
IFIN([f1Freq_A(Hz)],1472,1482,30,0) +
IFIN([f1Freq_A(Hz)],1628,1638,40,0) +
IFIN([f2Freq_A(Hz)],692,702,1,0) +
IFIN([f2Freq_A(Hz)],765,775,2,0) +
IFIN([f2Freq_A(Hz)],847,857,3,0) +
IFIN([f2Freq_A(Hz)],936,946,4,0) +
IFIN([f2Freq_A(Hz)],1204,1214,10,0) +
IFIN([f2Freq_A(Hz)],1331,1341,20,0) +
IFIN([f2Freq_A(Hz)],1472,1482,30,0) +
IFIN([f2Freq_A(Hz)],1628,1638,40,0) +
IFIN([f3Freq_A(Hz)],692,702,1,0) +
IFIN([f3Freq_A(Hz)],765,775,2,0) +
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IFIN([f3Freq_A(Hz)],847,857,3,0) +
IFIN([f3Freq_A(Hz)],936,946,4,0) +
IFIN([f3Freq_A(Hz)],1204,1214,10,0) +
IFIN([f3Freq_A(Hz)],1331,1341,20,0) +
IFIN([f3Freq_A(Hz)],1472,1482,30,0) +
IFIN([f3Freq_A(Hz)],1628,1638,40,0) +
IFIN([f4Freq_A(Hz)],692,702,1,0) +
IFIN([f4Freq_A(Hz)],765,775,2,0) +
IFIN([f4Freq_A(Hz)],847,857,3,0) +
IFIN([f4Freq_A(Hz)],936,946,4,0) +
IFIN([f4Freq_A(Hz)],1204,1214,10,0) +
IFIN([f4Freq_A(Hz)],1331,1341,20,0) +
IFIN([f4Freq_A(Hz)],1472,1482,30,0) +
IFIN([f4Freq_A(Hz)],1628,1638,40,0) +
IFIN([f5Freq_A(Hz)],692,702,1,0) +
IFIN([f5Freq_A(Hz)],765,775,2,0) +
IFIN([f5Freq_A(Hz)],847,857,3,0) +
IFIN([f5Freq_A(Hz)],936,946,4,0) +
IFIN([f5Freq_A(Hz)],1204,1214,10,0) +
IFIN([f5Freq_A(Hz)],1331,1341,20,0) +
IFIN([f5Freq_A(Hz)],1472,1482,30,0) +
IFIN([f5Freq_A(Hz)],1628,1638,40,0) +
IFIN([f6Freq_A(Hz)],692,702,1,0) +
IFIN([f6Freq_A(Hz)],765,775,2,0) +
IFIN([f6Freq_A(Hz)],847,857,3,0) +
IFIN([f6Freq_A(Hz)],936,946,4,0) +
IFIN([f6Freq_A(Hz)],1204,1214,10,0) +
IFIN([f6Freq_A(Hz)],1331,1341,20,0) +
IFIN([f6Freq_A(Hz)],1472,1482,30,0) +
IFIN([f6Freq_A(Hz)],1628,1638,40,0)
UDDP2:
IFEQ([UDDP1(UU)],24,1,0) +
IFEQ([UDDP1(UU)],11,2,0) +
IFEQ([UDDP1(UU)],21,3,0) +
IFEQ([UDDP1(UU)],31,4,0) +
IFEQ([UDDP1(UU)],12,5,0) +
IFEQ([UDDP1(UU)],22,6,0) +
IFEQ([UDDP1(UU)],32,7,0) +
IFEQ([UDDP1(UU)],13,8,0) +
IFEQ([UDDP1(UU)],23,9,0) +
IFEQ([UDDP1(UU)],33,10,0) - 1
UDDP1 is an intermediate variable. UDDP2 will display the decoded DTMF
character “0” ~ “9”. “-1” will be displayed otherwise.
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10.2.2.3 Amplitude Modulation Index Measurement

To measure the amplitude modulation index (or amplitude modulation depth), the
modulated signal needs to be demodulated first. Then the modulation index can be
obtained as follows:
[Modulation Index] = 0.5×(Max-Min)/Mean
where Max, Min and Mean are the maximum, minimum and mean values of the
demodulated signal. One issue with the above formula is that the Max and Min values
are sensitive to noise and the boundary effect of the demodulation process. A low
pass filter after demodulation can be used to alleviate this issue. However, here we
use the following formula instead. It can be derived from the above formula.

The above formula is more robust as it uses RMS value instead of Max and Min. For
amplitude modulation using a sine wave, the crest factor is 1.414.
Prerequisite: For comparison purpose, the input channels A and B are fed with the
same amplitude-modulated signal. Modulating frequency is 10Hz.
Settings:
[Oscilloscope Processing]: AM Demodulation and applied to Ch. B only.
[Oscilloscope Processing]: 100Hz low pass filter and applied to Ch. B only.
UDDP1:
1.414*SQRT(([RMS_B(EU)]/[Mean_B(EU)])^2-1)
The following figure shows a measurement example. The carrier used is 1kHz sine
wave. Other carriers such as white noise and pink noise can also be used.
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10.2.3 Inter-frame Processing
The DDP value will be refreshed accordingly when a new frame of data is sampled.
Three options are available for the inter-frame processing of the DDP: None, Linear
Average and Exponential Average. It should be noted that the inter-frame processed
DDP value is only local to the specific DDP viewer and is not accessible by any other
instrument such as Data Logger and Device Test Plan. The number of frame averaged
can be accessed through DDP: NumberOfFrames.
10.2.3.1 Linear Average
If Linear Average is selected, the DDP viewer will keep track of the DDP values and
only display the averaged value of the specified number of data frames acquired most
recently. The number of frames averaged will be displayed in the title bar of the DDP
viewer. The average is simply an arithmetic mean.
You can specify the number of contiguous frames to be processed. The available
options are: 2, 3, 4, 5, 6, 7, 8, 9, 10, 20, 30, 40, 50, 60, 70, 80, 90, 100, 120, 140, 160,
180, 200 and forever. You can also enter any number between 1 and 200 manually.
When “Forever” is selected, you can reset the process using the Reset button when
necessary.
10.2.3.2 Exponential Average
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Unlike Linear Average where all data frames used for average are given equal
weights, in Exponential Average, the weighting factor for each data frame decreases
with time exponentially, giving much more importance to recent observations while
still not discarding older observations entirely. The degree of weighting decrease is
expressed as a constant  in percentage. The greater the , the faster the decrease.
Alternatively,  may be expressed in terms of N, where  = 2/(N+1), and N  [time
interval between the start times of two adjacent data frames] is called the time
constant.
10.2.3.3 Max
The Max option is similar to the Linear Average option. However, instead of
displaying the linearly averaged value, it displays the maximum value during the
specified period.
10.2.3.4 Min
The Min option is similar to the Linear Average option. However, instead of
displaying the linearly averaged value, it displays the minimum value during the
specified period.

10.3 Context Menu

DDP Viewer does not have its own menu and view parameter toolbar. Its functions
are accessed via its context menu. The context menu pops up when you right click
anywhere within the DDP Viewer window. There are three menu items in the context
menu:


DDP Viewer Configuration
It has been described in the previous section.



DDP Viewer Copy As Text
This command copies the data in all opened DDP Viewers to the clipboard.
They can be subsequently pasted out into other programs such as Microsoft
Excel.



DDP Viewer Export
This command exports the data in all opened DDP Viewers to a text file.

10.4 DDP Array Viewer
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There are a few DDP arrays defined in Multi-Instrument, such as
fnFreq_A(Hz)_Array[?],
fnRMS_A(EU)_Array[?],
fnPhase_A(D)_Array[?],
oBandRMS_A(EU)_Array[?] for Channel A. It is possible to use the DDP viewer to
view an element of an array. However, if you want to view the whole array, or a
combination of a few arrays, then DDP array viewer should be used instead. To open
the DDP array viewer, click the “DDP Viewer” button in the Instrument Toolbar, and
then in the pop-up DDP viewer configuration dialog box, click “DDP Array Viewer”.
The following configuration dialog box will pop up.
10.4.1 Configuration

A report consists of one or more DDP arrays and/or derived arrays from them. There
are 12 preconfigured reports available for selection. It is possible to assign an alias to
the report title.
10.4.2 Reports
10.4.2.1 Reports for Harmonic Frequencies, RMS, Phases
Three reports are available for Channel A, Channel B and Channels A&B respectively:
(1) A-Harmonic Frequencies, RMS, Phases
(2) B-Harmonic Frequencies, RMS, Phases
(3) A&B-Harmonic Frequencies, RMS, Phases
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Using the above report for Channel A as an example, the five columns are: Order of
harmonics, Frequency of harmonics, RMS values of harmonics, Normalized harmonic
amplitudes with respect to that of the fundamental (in percentage), Phases of
harmonics (of a sine function).
10.4.2.2 Report for RMS values in Octave Bands
Three reports are available for Channel A, Channel B and Channels A&B respectively:
(1) A-Octave Bands, RMS
(2) B-Octave Bands, RMS
(3) A&B-Octave Bands, RMS
Using the following report for Channel A as an example, the two columns are: Octave
band center frequencies and RMS values of the octave bands.

10.4.2.3 Report for Peak Frequencies, RMS, Phases
Three reports are available for Channel A, Channel B and Channels A&B respectively:
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(1) A-Peak Frequencies, RMS, Phases
(2) B-Peak Frequencies, RMS, Phases
(3) A&B-Peak Frequencies, RMS, Phases
These reports are similar to those harmonic reports described previously except that
the peak frequencies here are not necessary to be harmonically related.
10.4.2.4 Report for RMS values in User Defined Frequency Bands
Three reports are available for Channel A, Channel B and Channels A&B respectively:
(1) A-Frequency Bands, RMS
(2) B-Frequency Bands, RMS
(3) A&B-Frequency Bands, RMS
These reports are similar to those reports for RMS values in octave bands described
previously except that the frequency bands here are defined freely by the users.

10.4.2.5 Report for Reverberation / Speech Intelligibility
Four reports are available: Two for Channel A and two for Channel B.
(1)
(2)
(3)
(4)

A-Reverberation / Speech Intelligibility (1/1 Octave)
A-Reverberation / Speech Intelligibility (1/3 Octave)
B-Reverberation / Speech Intelligibility (1/1 Octave)
B-Reverberation / Speech Intelligibility (1/3 Octave)

These reports have been introduced in the Oscilloscope chapter.
10.4.3 Context Menu
DDP Array Viewer does not have its own menu and view parameter toolbar. Its
functions are accessed via its context menu. The context menu pops up when you
right click anywhere within the DDP Array Viewer window.



DDP Array Viewer Configuration
This has been described in the previous section.



DDP Array Viewer Copy As Text
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This command copies the data in the report to the clipboard. They can be
subsequently pasted out into other programs such as Microsoft Excel. Note
the data in the clipboard is Tab separated.


DDP Array Viewer Export
This command exports the data in the report to a text file which can be
imported into third party software such as Microsoft Excel for further
processing and analysis.



DDP Array Viewer Export As Multi-Tone Configuration File
This option will be enabled in the harmonic / peak analysis reports. It exports
the data in the report to a Tone Configuration File (*.tcf) which can be
imported into the Multitone Configuration dialog box in order to generate a
multitone from the Signal Generator. In other words, a signal can be
decomposed into a series of single frequency components, with only their
amplitudes and phases recorded in the Tone Configuration File (much smaller
in size compared with a WAV file). It can be then reconstructed from that file
and regenerated from the Signal Generator.
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11 Derived Data Curve (DDC)
11.1 Overview
Derived Data Curve (DDC) is used to derive a dedicated data curve from one or
multiple frames of sampled data and display it in a dedicated graph window. The push
button
in the Instrument Toolbar is used to open a new DDC window. You can
close it by clicking the "Close" button at the upper right corner of the window. Up to
8 DDC windows can be opened. The supported DDCs include:
(1)
(2)
(3)
(4)
(5)
(6)
(7)
(8)

Energy Time Curve (Log-Squared)
Energy Time Curve (Envelop)
Energy Time Curve (dBSPL)
Impulse Response Schroeder Integration Curve
Step Response Curve (via Impulse Response Integration)
Frequency Time Curve
X-Y Plot
Shock Response Spectrum

11.2 DDC Processing
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Whenever the “DDC” button in the Instrument Toolbar is clicked, a new DDC
window will be opened. The above Processing dialog box will pop up on the top of
the DDC window to prompt you to configure the processing parameters first, which
includes:


Type
It specifies the DDC to be generated.



Channel
It specifies the input channel from which the DDC is generated.



Frequency Band (applicable to DDC Type 1~4 only)
It specifies the band pass filter to be applied to the data before the DDC is
generated. The supported band pass filter includes: broadband (i.e. not
filtered), 1/1 octave band filters (63Hz, 125Hz, 250Hz, 500Hz, 1kHz, 2kHz,
4kHz, 8kHz), 1/3 octave band filters (50Hz, 63Hz, 80Hz, 100Hz, 125Hz,
160Hz, 200Hz, 250Hz, 315Hz, 400Hz, 500Hz, 630Hz, 800Hz, 1kHz, 1.25Hz,
1.6kHz, 2kHz, 2.5kHz, 3.15kHz, 4kH, 5kHz, 6.3kHz, 8kHz, 10kHz).









Max. Number of Points (applicable to X-Y Plot only)
DDP for X axis (applicable to X-Y Plot only)
DDP alias for X axis (applicable to X-Y Plot only)
DDP for Y axis (applicable to X-Y Plot only)
DDP alias for Y axis (applicable to X-Y Plot only)
Reset Button (applicable to X-Y Plot only)
Sort by X (applicable to X-Y Plot only)






Frequency Range (Hz) (applicable to Shock Response Spectrum)
Frequency Resolution (applicable to Shock Response Spectrum)
Damping Ratio (applicable to Shock Response Spectrum)
Amplitude Type (applicable to Shock Response Spectrum)

11.3 DDC Types
11.3.1 Energy Time Curve (Log-Squared)
Energy Time Curve (ETC) (Log-Squared) shows the energy variation with time,
where the individual samples in the Oscilloscope are squared and then plotted on a
logarithmic scale in dB. The following figure shows such an example.
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This DDC is derived from one frame of Oscilloscope data.
11.3.2 Energy Time Curve (Envelop)
Energy Time Curve (ETC) (Envelop) shows the energy variation with time, where an
envelop of the data in the Oscilloscope is constructed by the analytic function through
Hilbert Transform and then plotted on a logarithmic scale in dB. The method is
similar to the amplitude demodulation method introduced previously in the
Oscilloscope chapter. This representation of ETC is often referred to as Heyser ETC.
The following figure shows such an example.
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This DDC is derived from one frame of Oscilloscope data.
11.3.3 Energy Time Curve (dBSPL)
Energy Time Curve (ETC) (dBSPL) shows the sound energy variation with time,
where the sound energy values in dBSPL are derived from the RMS values over a
local integration time. The software determines the integration time automatically
based on the band pass filter selected. The integration process serves as a low pass
filter in effect and makes the curve smooth. This DDC forms the basis for deriving the
reverberation parameters using the interrupted noise method, as introduced previously
in the Oscilloscope chapter. The following figure shows such an example.
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This DDC is derived from one frame of Oscilloscope data.
11.3.4 Impulse Response Schroeder Integration Curve
Impulse Response Schroeder Integration Curve serves as the basis for deriving the
reverberation parameters using the integrated impulse response method, as introduced
previously in the Oscilloscope chapter. The following figure shows such an example.
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This DDC is derived from one frame of Oscilloscope data.
11.3.5 Step Response Curve (via Impulse Response Integration)
Step Response shows the reaction of a system to a step stimulus. It is obtained here by
integrating the impulse response against time. The following figure shows such an
example.
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This DDC is derived from one frame of Oscilloscope data.
11.3.6 Frequency Time Curve
Frequency Time Curve shows the instantaneous frequency variation with time. It is
obtained using the frequency demodulation method introduced previously in the
Oscilloscope chapter. The following figure shows the frequency time curve of a
frequency linearly swept sine signal.
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This DDC is derived from one frame of Oscilloscope data.
11.3.7 X-Y Plot
X-Y Plot shows the variation of one DDP with another DDP. Both DDPs can be
selected in the DDC Processing page described previously. Each DDP can be
assigned with an alias which is used as the axis label. Each oscilloscope data frame
generates only one point (a pair of X and Y values) on the X-Y plot. Multiple
consecutive oscilloscope data frames are required in order to plot a curve. The Max.
Number of Points is set to 2000 by default and can be changed in the DDC Processing
page. Once the max. number is reached, the oldest point will be dropped whenever a
new point comes. The plotting process can be reset by clicking the Reset button in the
DDC Processing page or restarting the oscilloscope. The number of collected points is
displayed at the bottom right corner of the plot. No point will be added if any one of
the two DDPs is invalid. It is possible to sort the collected points according to their X
values by ticking the “Sort by X” checkbox.
11.3.8 Shock Response Spectrum
Shock Response Spectrum (SRS) is a graphical representation of an arbitrary transient
acceleration input, such as a shock, in terms of how a Single Degree Of Freedom
(SDOF) system (like a mass on a spring) would respond to that input. The horizontal
axis shows the natural frequency of a hypothetical SDOF system, and the vertical axis
shows the peak acceleration which this SDOF system would undergo as a
consequence of the shock input. Given the time history of a transient acceleration
input, a series of SDOF systems with different natural frequencies and the same
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damping ratio can be used to calculate its SRS. In Multi-Instrument, the natural
frequencies used for SRS calculation are chosen with the specified octave or
fractional octave spacing within the specified frequency range. As the peak
acceleration in the response signal is essentially a time domain quantity, the highest
natural frequency used in SRS calculation should be generally equal to or less than
1/10 of the sampling rate to ensure sufficient accuracy. The damping ratio is
configurable, typically 5% should be used. Three amplitude types are supported:
Maximax (Maximum Absolute), Max+ (Maximum Positive) and Max- (Maximum
Negative). The time record of the transient acceleration input should be long enough
to be able to accommodate the important part (which contains the Maximum Positive
and Maximum Negative) of the response of any of the SDOF systems used in the
calculation. Usually, 1/6 octave spacing is used for the natural frequencies when the
damping ratio is in the range of 0.02~0.1, while 1/12 and 1/3 octave spacings are used
when the damping ratio is below and beyond that range respectively.
The following figure shows the Shock Response Spectrum of a half-sine pulse with a
duration of 11 ms and a peak acceleration of 50g. The damping ratio used is 5% (i.e.
Q=10).

11.4 Context Menu
DDC does not have its own menu and view parameter toolbar. Its functions are
accessed via its context menu. The context menu (see figure below) pops up when
you right click anywhere within the DDC window.
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The above menu items and their associated functions are the same as those of the X-Y
Plot in the Device Test Plan, except [X-Y Plot Processing], which is only applicable
to DDC. Its function has been described previously.

www.virtins.com

467 Copyright © 2006-2022

Virtins Technology

VIRTINS Multi-Instrument 3.9 Manual

Virtins Technology

12 Samples and Templates
Different categories of samples and templates are provided in different subdirectories
under the main installation directory of the software. Although these samples and
templates are provided mainly for sound card based systems, they can be applied to
other hardware systems with or without modifications.
Subdirectory
\dtp

File Name
..

Description
Default directory for device test plans

AudioParameter_SR44100_A.dtp

Single channel audio parameter test plan
using a sampling rate of 44100 Hz. It can be
used to conduct loop back test for sound
card itself.
Dual channel audio parameter test plan
using a sampling rate of 44100 Hz. It can be
used to conduct loop back test for sound
card itself.
Single channel audio parameter test plan
using a sampling rate of 48000 Hz. It can be
used to conduct loop back test for sound
card itself.
Dual channel audio parameter test plan
using a sampling rate of 48000 Hz. It can be
used to conduct loop back test for sound
card itself.
Magnitude response against high and low
limits.
Frequency response measurement demo
using stepped sine. Note that for demo
purpose, a 5513 Hz second order
Butterworth low pass digital filter is applied
to Channel A by the software, and Channel
A and Channel B should be fed with the
same signal in order to obtain the frequency
response of the low pass filter.
Frequency response measurement test plan
using stepped sine.
THD+N, THD, SNR, Magnitude vs
Frequency Plots measured using frequency
stepped sine signals.
THD+N, THD, vs Magnitude, Power Plots
measured using amplitude stepped sine
signals.
SMPTE IMD vs Magnitude, Power Plots
measured using amplitude stepped dualsinewave signals.
Crosstalk vs Frequency Plot measured using
frequency stepped sine signal.
“Happy Birth Day” music.
Magnitude frequency response measurement
using frequency sweep at one third octave
center frequencies
Empty test plan loaded as the default user
defined plan.
Default sound card input impedance test
plan.

AudioParameter_SR44100_AB.dtp

AudioParameter_SR48000_A.dtp

AudioParameter_SR48000_AB.dtp

HighLowLimit.dtp
SteppedSineFrequencyResponseMea
surement_Demo.dtp

SteppedSineFrequencyResponseMea
surement.dtp
THD+N_THD_SNR_Magnitude_vs_
Frequency.dtp
THD+N_THD_vs_Magnitude_Powe
r.dtp
SMPTE_IMD_vs_Magnitude_Power
.dtp
Crosstalk_vs_Frequency.dtp
HappyBirthDay.dtp
MagnitudeFrequencyResponseBySw
eepAtOneThirdOctave.dtp
UDTdefault.dtp
Zscdefault.dtp
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LCRdefault.dtp
LCR_50-10000Hz.dtp

Default LCR test plan.
LCR test plan with test frequencies ranging
from 50Hz to 10000Hz.
LCR test plan with test frequency at 50 Hz.
LCR test plan with test frequency at 100 Hz.
LCR test plan with test frequency at 200 Hz.
LCR test plan with test frequency at 500 Hz.
LCR test plan with test frequency at 2000
Hz.
LCR test plan with test frequency at 5000
Hz.
LCR test plan with test frequency at 10000
Hz.
Default directory for data export
Default
directory
for
frequency
compensation files.
A weighting frequency compensation file.
B weighting frequency compensation file.
C weighting frequency compensation file.
ITU-R468
weighting
frequency
compensation file.
Recording RIAA frequency compensation
file
Reproducing RIAA frequency compensation
file
ITU-R ARM frequency compensation file
10Hz-20kHz Z weighting frequency
compensation file
20Hz-20kHz band width limiting frequency
compensation file
Default directory for frequency response
files.
Frequency response file for 1 k~2 kHz band
pass digital filter
Frequency response file for 20~80 Hz band
stop digital filter
Frequency response file for 1 kHz high pass
digital filter
Frequency response file for 1 kHz low pass
digital filter
Frequency response file for recording RIAA
Frequency response file for reproducing
RIAA
Frequency response file for male speech
transmission index measurement
Frequency response file for female speech
transmission index measurement
Default directory for IIR coefficient files.

LCR_50Hz.dtp
LCR_100Hz.dtp
LCR_200Hz.dtp
LCR_500Hz.dtp
LCR_2000Hz.dtp
LCR_5000Hz.dtp
LCR_10000Hz.dtp
\export
\fcf

..
..
A_Weighting.fcf
B_Weighting.fcf
C_Weighting.fcf
ITU-R468_Weighting.fcf
RecordingRIAA.fcf
ReproducingRIAA.fcf
ITU_R_ARM_Weighting.fcf
Z_Weighting_10Hz-20kHz.fcf

\frf

BandWidthLimiting_20Hz20kHz.fcf
..
BandPass_1k-2kHz.frf
BandStop_20-80Hz.frf
HighPass_1kHz.frf
LowPass_1kHz.frf
RecordingRIAA.frf
ReproducingRIAA.frf
SpeechMale.frf
SpeechFemale.frf

\iir

..
BandPass_551311025Hz_SR44100Hz_Butterworth_
IIR_Order12.iir
BandPass_551311025Hz_SR44100Hz_Chebyshev_I
IR_Order12.iir
LowPass_5513Hz_SR44100Hz_Butt
erworth_IIR_Order2
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IIR coefficient file for the 12th order
Butterworth 5513~11025 Hz band pass
digital IIR filter, sampled at 44100 Hz.
IIR coefficient file for the 12th order
Chebyshev 5513~11025 Hz band pass
digital IIR filter, sampled at 44100 Hz.
IIR coefficient file for the 2th order
Butterworth 5513 Hz low pass digital IIR
filter, sampled at 44100 Hz.
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LowPass_5513Hz_SR44100Hz_Butt
erworth_IIR_Order12
LowPass_5513Hz_SR44100Hz_Che
byshev_IIR_Order12
LowPass_5513Hz_SR44100Hz_Park
s-McClellan_FIR_Order34.iir
HighPass_5513Hz_SR44100Hz_Butt
erworth_IIR_Order12
HighPass_5513Hz_SR44100Hz_Che
byshev_IIR_Order12.iir
C_Weighting_SR44100Hz_IIR_Orde
r4.iir
C_Weighting_SR48000Hz_IIR_Orde
r4.iir
C_Weighting_SR96000Hz_IIR_Orde
r4.iir
C_Weighting_SR192000Hz_IIR_Or
der4.iir
MovingAverageTap2.iir
MovingAverageTap4.iir
MovingAverageTap8.iir
MovingAverageTap16.iir
MovingAverageTap32.iir
MovingAverageTap64.iir
MovingAverageTap128.iir
MovingAverageTap256.iir
RecordingRIAA_SR44100Hz_IIR_O
rder2.iir
RecordingRIAA_SR48000Hz_IIR_O
rder2.iir
RecordingRIAA_SR88000Hz_IIR_O
rder2.iir
ReproducingRIAA_SR44100Hz_IIR
_Order2.iir
ReproducingRIAA_SR48000Hz_IIR
_Order2.iir
ReproducingRIAA_SR88000Hz_IIR
_Order2.iir
ReproducingRIAA_SR96000Hz_IIR
_Order2.iir
ReproducingRIAA_SR192000Hz_II
R_Order2.iir
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IIR coefficient file for the 12th order
Butterworth 5513 Hz low pass digital IIR
filter, sampled at 44100 Hz.
IIR coefficient file for the 12th order
Chebyshev 5513 Hz low pass digital IIR
filter, sampled at 44100 Hz.
IIR coefficient file for the 34th order ParksMcClellan 5513 Hz low pass digital FIR
filter, sampled at 44100 Hz.
IIR coefficient file for the 12th order
Butterworth 5513 Hz high pass digital IIR
filter, sampled at 44100 Hz.
IIR coefficient file for the 12th order
Chebyshev 5513 Hz high pass digital IIR
filter, sampled at 44100 Hz.
IIR coefficient file for the 4th order C
weighting digital IIR filter, sampled at
44100 Hz.
IIR coefficient file for the 4th order C
weighting digital IIR filter, sampled at
48000 Hz.
IIR coefficient file for the 4th order C
weighting digital IIR filter, sampled at
96000 Hz.
IIR coefficient file for the 4th order C
weighting digital IIR filter, sampled at
192000 Hz.
IIR coefficient file for 2-Tap Moving
Average FIR filter
IIR coefficient file for 4-Tap Moving
Average FIR filter
IIR coefficient file for 8-Tap Moving
Average FIR filter
IIR coefficient file for 16-Tap Moving
Average FIR filter
IIR coefficient file for 32-Tap Moving
Average FIR filter
IIR coefficient file for 64-Tap Moving
Average FIR filter
IIR coefficient file for 128-Tap Moving
Average FIR filter
IIR coefficient file for 256-Tap Moving
Average FIR filter
IIR coefficient file for Recording RIAA at
Sampling Rate 44100Hz
IIR coefficient file for Recording RIAA at
Sampling Rate 48000Hz
IIR coefficient file for Recording RIAA at
Sampling Rate 88000Hz
IIR coefficient file for Reproducing RIAA at
Sampling Rate 44100Hz
IIR coefficient file for Reproducing RIAA at
Sampling Rate 48000Hz
IIR coefficient file for Reproducing RIAA at
Sampling Rate 88000Hz
IIR coefficient file for Reproducing RIAA at
Sampling Rate 96000Hz
IIR coefficient file for Reproducing RIAA at
Sampling Rate 192000Hz
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..
..
MagnitudeFrequencyResponse_Line
arSweptSine(20~20kHz)_SingleChan
nel.psf
MagnitudeFrequencyResponse_LogS
weptSine(20~20kHz)_SingleChannel
.psf
MagnitudeFrequencyResponse_Multi
Tone_OCT3_SingleChannel.psf
MagnitudeFrequencyResponse_Perio
dicWhiteNoise.psf
MagnitudeFrequencyResponse_Swep
tSine(20~22050Hz,300s)_PeakHold.
psf
MagnitudeFrequencyResponse_Whit
eNoise(InterframeAverage).psf

MagnitudeFrequencyResponse_Whit
eNoise(IntraframeAverage).psf

SteppedSineFrequencyResponseMea
surement.psf
SteppedSineFrequencyResponseMea
surement_Demo.psf
Zscdefault.psf

LCRdefault.psf
ViewWindowFunction_24Bit_1024P
t.psf
NoiseLevel.psf
NoiseLevel_A-Weighting.psf
THD_FFT16384_SR44100.psf

THD_FFT16384_SR44100_AWeighting.psf
THD_FFT16384_SR48000.psf

THD_FFT16384_SR48000_AWeighting.psf
THD_FFT16384_SR48000_FifthOrd
er.psf
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Log file directory for Data Logger
Default directory for panel setting files.
Panel setting file for magnitude frequency
response measurement using 20~20kHz
frequency linearly swept sine.
Panel setting file for magnitude frequency
response measurement using 20~20kHz
frequency logarithmically swept sine.
Panel setting file for magnitude frequency
response measurement using MultiTones
aligned to 1/3 octave bands.
Panel setting file for magnitude frequency
response measurement using periodic white
noise.
Panel setting file for magnitude frequency
response measurement using 300-second
20~22050Hz swept sine together with peak
hold function in Spectrum Analyzer.
Panel setting file for magnitude frequency
response measurement using white noise
together with inter-frame average function in
Spectrum Analyzer.
Panel setting file for magnitude frequency
response measurement using white noise
together with intra-frame average function in
Spectrum Analyzer.
Panel setting file for frequency response
measurement using stepped sine. To be used
with the corresponding test plan.
Panel setting file for frequency response
measurement demo using stepped sine. To
be used with the corresponding test plan.
Panel setting file for sound card input
impedance measurement. To be used with
the corresponding test plan.
Panel setting file for LCR measurement. To
be used with the corresponding test plan.
Panel setting file viewing the characteristics
of various Window functions.
Panel setting file for noise level
measurement when there is no input signal.
Panel setting file for A weighted noise level
measurement when there is no input signal.
Panel setting file for THD, THD+N
measurement with FFT size = 16384 and
Sampling Frequency = 44100 Hz.
Panel setting file for A weighted THD,
THD+N measurement with FFT size =
16384 and Sampling Frequency = 44100 Hz.
Panel setting file for THD, THD+N
measurement with FFT size = 16384 and
Sampling Frequency = 48000 Hz.
Panel setting file for A weighted THD,
THD+N measurement with FFT size =
16384 and Sampling Frequency = 48000 Hz.
Panel setting file for THD, THD+N
measurement with FFT size = 16384 and
Sampling Frequency = 48000 Hz. THD is
calculated to the fifth order.
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THD_FFT16384_SR96000.psf

THD_FFT16384_SR96000_AWeighting.psf
THD_FFT16384_SR192000.psf

THD_FFT16384_SR192000_AWeighting.psf

THD_FFT16384_FifthOrder.psf

THD_FFT16384_A-Weighting.psf

THD_FFT16384.psf
THD_FFT32768_SR44100.psf

THD_FFT32768_SR44100_AWeighting.psf
THD_FFT32768_SR48000.psf

THD_FFT32768_SR48000_SingleC
hannel.psf

THD_FFT32768_SR48000_AWeighting.psf
THD_FFT32768_SR48000_AWeighting_SingleChannel.psf

THD_FFT32768_SR48000_FifthOrd
er.psf

THD_FFT32768_SR96000.psf

THD_FFT32768_SR96000_AWeighting.psf
THD_FFT32768_SR192000.psf

THD_FFT32768_SR192000_AWeighting.psf
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Panel setting file for THD, THD+N
measurement with FFT size = 16384 and
Sampling Frequency = 96000 Hz.
Panel setting file for A weighted THD,
THD+N measurement with FFT size =
16384 and Sampling Frequency = 96000 Hz.
Panel setting file for THD, THD+N
measurement with FFT size = 16384 and
Sampling Frequency = 192000 Hz.
Panel setting file for A weighted THD,
THD+N measurement with FFT size =
16384 and Sampling Frequency = 192000
Hz.
Panel setting file for THD, THD+N
measurement with FFT size = 16384. THD
is calculated to the fifth order.
Panel setting file for A weighted THD,
THD+N measurement with FFT size =
16384.
Panel setting file for THD, THD+N
measurement with FFT size = 16384.
Panel setting file for THD, THD+N
measurement with FFT size = 32768 and
Sampling Frequency = 44100 Hz.
Panel setting file for A weighted THD,
THD+N measurement with FFT size =
32768 and Sampling Frequency = 44100 Hz.
Panel setting file for THD, THD+N
measurement with FFT size = 32768 and
Sampling Frequency = 48000 Hz.
Panel setting file for THD, THD+N
measurement with FFT size = 32768 and
Sampling Frequency = 48000 Hz. Single
Channel only.
Panel setting file for A weighted THD,
THD+N measurement with FFT size =
32768 and Sampling Frequency = 48000 Hz.
Panel setting file for A weighted THD,
THD+N measurement with FFT size =
32768 and Sampling Frequency = 48000 Hz.
Single Channel only.
Panel setting file for THD, THD+N
measurement with FFT size = 32768 and
Sampling Frequency = 48000 Hz. THD is
calculated to the fifth order.
Panel setting file for THD, THD+N
measurement with FFT size = 32768 and
Sampling Frequency = 96000 Hz.
Panel setting file for A weighted THD,
THD+N measurement with FFT size =
32768 and Sampling Frequency = 96000 Hz.
Panel setting file for THD, THD+N
measurement with FFT size = 32768 and
Sampling Frequency = 192000 Hz.
Panel setting file for A weighted THD,
THD+N measurement with FFT size =
32768 and Sampling Frequency = 192000
Hz.
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THD_FFT32768_FifthOrder.psf

THD_FFT32768_A-Weighting.psf

THD_FFT32768.psf
\Pro\THD_FFT65536_SR44100.psf

\Pro\THD_FFT65536_SR44100_AWeighting.psf
\Pro\THD_FFT65536_SR48000.psf

\Pro\THD_FFT65536_SR48000_AWeighting.psf
\Pro\THD_FFT65536_SR48000_Fift
hOrder.psf

\Pro\THD_FFT65536_SR96000.psf

\Pro\THD_FFT65536_SR96000_AWeighting.psf
\Pro\THD_FFT65536_SR192000.psf

\Pro\THD_FFT65536_SR192000_AWeighting.psf

\Pro\THD_FFT65536_FifthOrder.psf

\Pro\THD_FFT65536_AWeighting.psf
\Pro\THD_FFT65536.psf
IMD_CCIF2_19kHz(1)_20kHz(1)_F
FT32768.psf
IMD_CCIF3_13kHz(1)_14kHz(1)_F
FT32768.psf
IMD_CCIF3_14kHz(1)_15kHz(1)_F
FT32768.psf
IMD_CCIF3_15kHz(1)_16kHz(1)_F
FT32768.psf
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Panel setting file for THD, THD+N
measurement with FFT size = 32768. THD
is calculated to the fifth order.
Panel setting file for A weighted THD,
THD+N measurement with FFT size =
32768.
Panel setting file for THD, THD+N
measurement with FFT size = 32768.
Panel setting file for THD, THD+N
measurement with FFT size = 65536 and
Sampling Frequency = 44100 Hz.
Panel setting file for A weighted THD,
THD+N measurement with FFT size =
65536 and Sampling Frequency = 44100 Hz.
Panel setting file for THD, THD+N
measurement with FFT size = 65536 and
Sampling Frequency = 48000 Hz.
Panel setting file for A weighted THD,
THD+N measurement with FFT size =
65536 and Sampling Frequency = 48000 Hz.
Panel setting file for THD, THD+N
measurement with FFT size = 65536 and
Sampling Frequency = 48000 Hz. THD is
calculated to the fifth order.
Panel setting file for THD, THD+N
measurement with FFT size = 65536 and
Sampling Frequency = 96000 Hz.
Panel setting file for A weighted THD,
THD+N measurement with FFT size =
65536 and Sampling Frequency = 96000 Hz.
Panel setting file for THD, THD+N
measurement with FFT size = 65536 and
Sampling Frequency = 192000 Hz.
Panel setting file for A weighted THD,
THD+N measurement with FFT size =
65536 and Sampling Frequency = 192000
Hz.
Panel setting file for THD, THD+N
measurement with FFT size = 65536. THD
is calculated to the fifth order.
Panel setting file for A weighted THD,
THD+N measurement with FFT size =
65536.
Panel setting file for THD, THD+N
measurement with FFT size = 65536.
Panel setting file for IMD CCF2 (19 kHz +
20 kHz, 1:1) measurement with FFT size =
32768
Panel setting file for IMD CCF3 (13 kHz +
14 kHz, 1:1) measurement with FFT size =
32768
Panel setting file for IMD CCF3 (14 kHz +
15 kHz, 1:1) measurement with FFT size =
32768
Panel setting file for IMD CCF3 (15 kHz +
16 kHz, 1:1) measurement with FFT size =
32768
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IMD_DIN_250Hz(4)_8kHz(1)_FFT3
2768.psf
IMD_SMPTE_60Hz(4)_7kHz(1)_FF
T32768.psf
CrosstalkAB_FFT32768_SR44100.p
sf
CrosstalkAB_FFT32768_SR48000.p
sf
CrosstalkAB_FFT32768_SR96000.p
sf
CrosstalkAB_FFT32768_SR192000.
psf
CrosstalkBA_FFT32768_SR44100.p
sf
CrosstalkBA_FFT32768_SR48000.p
sf
CrosstalkBA_FFT32768_SR96000.p
sf
CrosstalkBA_FFT32768_SR192000.
psf
Octave1.psf
Octave3.psf
Octave6.psf
Octave12.psf
Octave24.psf
Octave3_PeriodicPinkNoise.psf
\Pro\Octave48.psf
\Pro\Octave96.psf
\Pro\BodePlot_WhiteNoise.psf

\Pro\BodePlot_LinearSweptSine(20~
20kHz).psf

\Pro\BodePlot_LogSweptSine(20~20
kHz).psf

\Pro\BodePlot_PeriodicWhiteNoise.p
sf
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Panel setting file for IMD DIN (250 Hz + 8
kHz, 4:1) measurement with FFT size =
32768
Panel setting file for IMD SMPTE (60 Hz +
7 kHz, 4:1) measurement with FFT size =
32768
Panel setting file for Crosstalk A->B
measurement with FFT size = 32768 and
Sampling Frequency = 44100 Hz
Panel setting file for Crosstalk A->B
measurement with FFT size = 32768 and
Sampling Frequency = 48000 Hz
Panel setting file for Crosstalk A->B
measurement with FFT size = 32768 and
Sampling Frequency = 96000 Hz
Panel setting file for Crosstalk A->B
measurement with FFT size = 32768 and
Sampling Frequency = 192000 Hz
Panel setting file for Crosstalk B->A
measurement with FFT size = 32768 and
Sampling Frequency = 44100 Hz
Panel setting file for Crosstalk B->A
measurement with FFT size = 32768 and
Sampling Frequency = 48000 Hz
Panel setting file for Crosstalk B->A
measurement with FFT size = 32768 and
Sampling Frequency = 96000 Hz
Panel setting file for Crosstalk B->A
measurement with FFT size = 32768 and
Sampling Frequency = 192000 Hz
1/1 Octave Analysis with pink noise
1/3 Octave Analysis with pink noise
1/6 Octave Analysis with pink noise
1/12 Octave Analysis with pink noise
1/24 Octave Analysis with pink noise
1/3 Octave Analysis with periodic pink
noise
1/48 Octave Analysis
1/96 Octave Analysis
Bode Plot (transfer function or frequency
response) measurement using white noise,
with stimulus fed into Channel B and
response from DUT fed into Channel A.
Bode Plot (transfer function or frequency
response) measurement using frequency
linearly swept sine, with stimulus fed into
Channel B and response from DUT fed into
Channel A.
Bode Plot (transfer function or frequency
response) measurement using frequency
logarithmically swept sine, with stimulus fed
into Channel B and response from DUT fed
into Channel A.
Bode Plot (transfer function or frequency
response) measurement using periodic white
noise, with stimulus fed into Channel B and
response from DUT fed into Channel A.
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\Pro\BodePlot_PeriodicPinkNoise.ps
f

THD+N_THD_SNR_Magnitude_vs_
Frequency.psf
THD+N_THD_vs_Magnitude_Powe
r.psf
SMPTE_IMD_vs_Magnitude_Power
.psf
AudioParameter_SR48000_A.psf
Polarity_Tester.psf
Polarity_Tester_WithCrestFactorChe
ck.psf
PowerFactory_FFT32768_SR48000.
psf
\pro\UnweightedPeakWowAndFlutte
r_10s.psf
\pro\WeightedPeakWowAndFlutter_
10s.psf
\pro\UnweightedPeakWowAndFlutte
rFrequenceCounter_10s.psf
\pro\WeightedPeakWowAndFlutterF
requenceCounter_10s.psf
\pro\Loudness.psf
VTDSO\Impedance_MultiTones_FF
T32768_2810E.psf
VTDSO\Impedance_MultiTones_Oct
ave24_2810E.psf
VTDSO\Impedance_LogSweptSine_
Octave96_2810E.psf
\Pro\Impedance_MultiTones_FFT65
536_SoundCard.psf
\Pro\Impedance_MultiTones_Octave
24_SoundCard.psf
Pro\Impedance_LogSweptSine_Octa
ve96_SoundCard.psf
\Pro\GedLeeMetric_FFT32768_SR4
8000_SingleChannel.psf
\Pro\GedLeeMetric_FFT32768_SR4
8000.psf
\Pro\Harmonic_FFT32768_SR48000
_SingleChannel
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Bode Plot (transfer function or frequency
response) measurement using periodic pink
noise, with stimulus fed into Channel B and
response from DUT fed into Channel A.
Open the device test plan: THD+N_THD_
SNR_Magnitude_vs_Frequency.dtp.
Open
the
device
test
plan:
THD+N_THD_vs_Magnitude_Power.dtp.
Open
the
device
test
plan:
SMPTE_IMD_vs_Magnitude_Power.dtp.
Open
the
device
test
plan:
AudioParameter_SR48000_A.dtp.
Speaker, microphone and amplifier polarity
tester
Speaker, microphone and amplifier polarity
tester with crest factor check to confirm the
presence of test tone
Power factor calculation by measuring the
voltage and current simultaneously
Unweighted Peak Wow and Flutter
Measurement (Average frequency measured
by Spectrum Analyzer)
Weighted Peak Wow and Flutter
Measurement (Average frequency measured
by Spectrum Analyzer)
Unweighted Peak Wow and Flutter
Measurement (Average frequency measured
by Frequency Counter)
Weighted Peak Wow and Flutter
Measurement (Average frequency measured
by Frequency Counter)
Loudness , Loudness Level and Sharpness
Measurement
VT
DSO-2810E/2820E/2A10E/2A20E
impedance measurement with 32768-point
FFT MultiTone stimulus
VT
DSO-2810E/2820E/2A10E/2A20E
impedance measurement with 1/24 octave
MultiTone stimulus
VT
DSO-2810E/2820E/2A10E/2A20E
impedance measurement with frequency
logarithmically swept sine stimulus
Sound Card impedance measurement with
65536-point FFT MultiTone stimulus
Sound Card impedance measurement with
1/24 octave MultiTone stimulus
Sound Card impedance measurement with
frequency logarithmically swept sine
stimulus
GedLee Metric measurement in Ch. A with
FFT size = 32768 and Sampling Frequency
= 48000 Hz
GedLee Metric measurement in Ch. A & B
with FFT size = 32768 and Sampling
Frequency = 48000 Hz
Harmonic analysis for Ch. A with FFT size
= 32768 and Sampling Frequency = 48000
Hz
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\Pro\Harmonic_FFT32768_SR48000

\Pro\MagnitudeFrequencyResponse_
LogSweptSine_Octave96.psf

THD_FFT32768_ResidualComparis
on.psf
J-Test_16Bit.psf
J-Test_24Bit.psf
RT60InterruptedNoise5s.pdf

DIM30_FFT131072_SR192000.psf
DIM100_FFT262144_SR384000.psf
\Pro\CEA-2010-20Hz.psf
\Pro\CEA-2010-25Hz.psf
\Pro\CEA-2010-31.5Hz.psf
\Pro\CEA-2010-40Hz.psf
\Pro\CEA-2010-50Hz.psf
\Pro\CEA-2010-63Hz.psf
\Pro\ImpulseResponse_Acoustic_Lo
gSweptSine(10~24kHz)_SingleChan
nel.psf
\Pro\ImpulseResponse_Acoustic_ML
S_CrossCorrelation_SingleChannel.p
sf
\Pro\ImpulseResponse_Acoustic_Per
iodicPinkNoise_SingleChannel.psf
\Pro\ImpulseResponse_Acoustic_Per
iodicWhiteNoise_SingleChannel.psf
\Pro\ImpulseResponse_Acoustic_Per
iodicWhiteNoise_CrossCorrelation_
SingleChannel.psf
\Pro\ImpulseResponse_Acoustic_Wh
iteNoise_CrossCorrelation_SingleCh
annel.psf
\Pro\ImpulseResponse_LogSweptSin
e(10~24kHz)_SingleChannel.psf
ImpulseResponse_MLS_CrossCorrel
ation_SingleChannel.psf
\Pro\ImpulseResponse_PeriodicPink
Noise_SingleChannel.psf

www.virtins.com

Harmonic analysis for Ch. A&B with FFT
size = 32768 and Sampling Frequency =
48000 Hz
Panel setting file for magnitude frequency
response measurement using 10-second
5~21000Hz logarithmic swept sine + 1/96
octave analysis.
1kHz sinewave compared with its duplicate
with fundamental attenuated by 120 dB via
FIR
16-bit J-Test
24-bit J-Test
Reverberation time measurement using
interrupted noise
method, Sampling
Duration =5s
DIM30 measurement with FFT size=131072
and Sampling Frequency = 192 kHz
DIM100 measurement with FFT size =
262144 and Sampling Frequency=384 kHz
20Hz subwoofer max. output test according
to CEA-2010
25Hz subwoofer max. output test according
to CEA-2010
31.5Hz subwoofer max. output test
according to CEA-2010
40Hz subwoofer max. output test according
to CEA-2010
50Hz subwoofer max. output test according
to CEA-2010
63Hz subwoofer max. output test according
to CEA-2010
Acoustic impulse response measurement
with frequency logarithmically swept sine
using single-channel method
Acoustic impulse response measurement by
cross-correlation of MLS using singlechannel method
Acoustic impulse response measurement
with periodic pink noise using singlechannel method
Acoustic impulse response measurement
with periodic white noise using singlechannel method
Acoustic impulse response measurement by
cross-correlation of periodic white noise
using single-channel method
Acoustic impulse response measurement by
cross-correlation of white noise using singlechannel method
Impulse response measurement with
frequency logarithmically swept sine using
single-channel method
Impulse response measurement by crosscorrelation of MLS using single-channel
method
Impulse response measurement with
periodic pink noise using single-channel
method
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\Pro\ImpulseResponse_PeriodicWhit
eNoise_SingleChannel.psf
ImpulseResponse_PeriodicWhiteNoi
se_CrossCorrelation_SingleChannel.
psf
ImpulseResponse_WhiteNoise_Cross
Correlation_SingleChannel.psf
psf\pro\RT60InterruptedNoise5s.psf
psf\pro\RT60STIImpulseResponse5s.psf

\export

Pdf\VTDSO\StepResponseSR100M
Hz.psf
..
DacFs200kHz2vMultiTonesAligned
ToAdc50kHzFFT32768.txt
DacFs200kHz2vMultiTonesAligned
ToAdc50kHzOctave24.txt
DacFs200kHz1(6)vLogSweptSineAd
c50kHzOctave96.txt

\ref

..
HighLimitRef.ref
LowLimitRef.ref
RecordingRIAA.ref
ReproducingRIAA.ref
CEA-2010-20Hz.ref
CEA-2010-25Hz.ref
CEA-2010-31.5Hz.ref
CEA-2010-40Hz.ref
CEA-2010-50Hz.ref
CEA-2010-63Hz.ref

\tcf

..
IMD_CCIF2_19kHz(1)_20kHz(1).tc
f
IMD_CCIF3_13kHz(1)_14kHz(1).tc
f
IMD_CCIF3_14kHz(1)_15kHz(1).tc
f
IMD_CCIF3_15kHz(1)_16kHz(1).tc
f
IMD_DIN_250Hz(4)_8kHz(1).tcf
IMD_SMPTE_60Hz(4)_7kHz(1).tcf
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Impulse response measurement with
periodic white noise using single-channel
method
Impulse response measurement by crosscorrelation of periodic white noise using
single-channel method
Impulse response measurement by crosscorrelation of white noise using singlechannel method
Reverberation Time RT60 measurement
using interrupted noise method
Reverberation Time RT60 and Speech
Transmission Index STI measurement using
impulse response method
Step Response Analysis
Default directory for output files
VT
DSO-2810E/2820E/2A10E/2A20E
impedance measurement reference Vo with
32768-point FFT MultiTone stimulus
VT
DSO-2810E/2820E/2A10E/2A20E
impedance measurement reference Vo with
1/24 octave MultiTone stimulus
VT
DSO-2810E/2820E/2A10E/2A20E
impedance measurement reference Vo with
frequency logarithmically swept sine
stimulus
Default directory for reference files
High limit reference file
Low limit reference file
Recording RIAA reference file
Reproducing RIAA reference file
20Hz subwoofer max. output test reference
file according to CEA-2010
25Hz subwoofer max. output test reference
file according to CEA-2010
31.5Hz subwoofer max. output test reference
file according to CEA-2010
40Hz subwoofer max. output test reference
file according to CEA-2010
50Hz subwoofer max. output test reference
file according to CEA-2010
63Hz subwoofer max. output test reference
file according to CEA-2010
Default directory for tone configuration files
Tone configuration file for IMD CCIF2 (19
kHz + 20 kHz, 1:1) measurement.
Tone configuration file for IMD CCIF3 (13
kHz + 14 kHz, 1:1) measurement.
Tone configuration file for IMD CCIF3 (14
kHz + 15 kHz, 1:1) measurement.
Tone configuration file for IMD CCIF3 (15
kHz + 16 kHz, 1:1) measurement.
Tone configuration file for IMD DIN (250
Hz + 8 kHz, 4:1) measurement.
Tone configuration file for IMD SMPTE (60
Hz + 7 kHz, 4:1) measurement.
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OCT1_MultiTone_11.tcf
OCT3_MultiTone_32.tcf
OCT6_MultiTone_63.tcf
OCT12_MultiTone_125.tcf
DIM30_SharplyBandLimited.tcf
DIM30_SinglePole_LowpassFiltered
.tcf
DIM100_SharplyBandLimited.tcf

\wav

DIM100_SinglePole_LowpassFiltere
d.tcf
..
TextFileImport_SingleChannel.txt
TextFileImport_DualChannel.txt
\window

DacFs200kHz2vMultiTonesAligned
ToAdc50kHzFFT32768.wav

\wfl

DacFs48kHzMultiTonesAlignedToA
dc48kHzFFT65536.wav
..
heartbeat.wfl
sine.wfl
sinepulse.wfl
square.wfl
triangle.wfl
sawtooth.wfl
InvertedSawtooth.wfl
sinc1.wfl
sinc2.wfl
J-Test_16Bit.bpl
J-Test_24Bit.bpl
SineAtOneFourthFs_16Bit.bpl
SineAtOneFourthFs_24Bit.bpl
DC_16Bit.bpl
DC_24Bit.bpl
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Tone configuration file for 1/1 octave bands
for frequency response measurement
Tone configuration file for 1/3 octave bands
for frequency response measurement
Tone configuration file for 1/6 octave bands
for frequency response measurement
Tone configuration file for 1/12 octave
bands for frequency response measurement
DIM30 test signal configuration with a
30kHz ideal low-pass filter
DIM30 test signal configuration with a
30kHz first-order low-pass filter
DIM100 test signal configuration with a
100kHz ideal low-pass filter
DIM100 test signal configuration with a
100kHz first-order low-pass filter
Default directory for WAV files as well as
TXT files of raw data
A sample TXT file containing raw data of a
single channel for File Import command.
A sample TXT file containing raw data of
two channels for File Import command.
This directory contains the 24-bit 1024-point
WAV files for 60 window functions. These
wave files can be used to evaluate the
characteristics of these window functions.
VT
DSO-2810E/2820E/2A10E/2A20E
32768-point FFT MultiTone stimulus for
impedance measurement
Sound Card 65536-point FFT MultiTone
stimulus for impedance measurement
Default directory for waveform library
A sample arbitrary waveform library file
Sine-shaped waveform library file
Sine-pulse-shaped waveform library file
Square-shaped waveform library file
Triangle-shaped waveform library file
Sawtooth-shaped waveform library file
Inverted Sawtooth-shaped waveform library
file
SINC (contains more than 10 peaks)
waveform library
SINC (contains about 10 peaks) waveform
library
16 bit J-Test BitPerfect library
24 bit J-Test BitPerfect library
16 bit, ¼ sampling frequency sine wave
BitPerfect library
24 bit, ¼ sampling frequency sine wave
BitPerfect library
16 bit Full-Scale (positive) DC signal
24 bit Full-Scale (positive) DC signal
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13 User Customization and Development
Multi-Instrument provides the following user customizable features:
1. You can save a frequently used panel setting as a Panel Setting File via
[Setting]>[Save Current Panel Setting], and load it via [Setting]>[Load Panel
Setting] when you need it.
2. You can save your default pane setting via [Setting]>[Save Current Panel Setting
as Default]. It will be loaded automatically the next time after software startup. If
you do not want unauthorized users to change this default setting, tick “Lock
Panel Setting after startup” in the Display Setting dialog box which is opened via
[Setting]>[Display], and set a password for unlocking panel setting via
[Setting]>[Change Password].
If you tick “Save Current Panel Setting on exit” in the Display Setting dialog box,
then the software will save the panel setting as default on exit, and load it the next
time after software startup.
3. You can configure your frequently use Panel Setting Files in the Hot Panel Setting
Toolbar, so that they can be loaded at one single mouse click. If you do not want
unauthorized users to change these pre-configured settings, tick “Lock Panel
Setting after startup” in the Display Setting dialog box which is opened via
[Setting]>[Display], and set a password for unlocking panel setting via
[Setting]>[Change Password]. In this way, the unauthorized users are only
allowed to use these pre-configured panel settings.
4. You can configure, save and load your own device test plan and LCR meter. If
you want to load a device test plan automatically at software startup, open the
Device Test Plan panel, load the device test plan and press “Save Current Panel
Setting as Default” in the Device Test Plan panel.
5. You can hide the toolbars via [Setting]>[Display] and tick the respective
checkboxes.
Multi-Instrument provides the following software development features:
1. Multi-Instrument can work as an ActiveX automation server so that an external
program can access the data and functions that Multi-Instrument exposes. You can
integrate Multi-Instrument into your own software seamlessly via the ActiveX
automation server interfaces exposed by Multi-Instrument.
Please refer to: Multi-Instrument Automation Server Interfaces
Download link:
http://www.virtins.com/Multi-Instrument-Automation-Server-Interfaces.pdf
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The above document and the sample automation client programs in Visual C++,
Visual Basic, Visual C# and Python can be found in the AutomationAPIs
directory of the software.
2. You can use the vtDAQ and vtDAO interface DLLs supplied in this software to
allow your own back-end software to interface to sound cards, NI DAQmx cards,
VT DSOs, VT RTAs, VT IEPE, VT CAMP, etc.. You can also develop your own
vtDAQ and vtDAO compatible DLLs to allow Multi-Instrument to interface to
your own hardware.
Please refer to: vtDAQ and vtDAO_Interfaces
Download link:
http://www.virtins.com/vtDAQ-and-vtDAO-Interfaces.pdf
The above document and the sample DAQ and DAO back-end programs in Visual
C++, Visual C# and LabVIEW can be found in the DAQDAOAPIs directory of
the software.
3. Virtins Technology’s Signal Processing and Analysis (vtSPA) Application
Programming Interfaces (APIs) provides a suite of generic APIs for data
processing and analysis. It contains some unique features / algorithms originated
and only available from Virtins Technology.
Please refer to: Signal Processing and Analysis (vtSPA) Interfaces
Download link:
http://www.virtins.com/Signal-Processing-and-Analysis-APIs.pdf
The above document and the sample programs in Visual C++ and Visual C# can
be found in the DAQDAOAPIs directory of the software.

Furthermore, Multi-Instrument is well prepared to be rebranded for OEM services. Its
look and feel can be readily changed through configuration without even
reprogramming. Contact Virtins Technology if interested.
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3. VIRTINS Sound Card Oscilloscope Probe Manual
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http://www.virtins.com/Virtins-Sound-Card-Oscilloscope-Probe-Manual.pdf

4. Basic Oscilloscope, Spectrum Analyzer, Multimeter and Signal Generator
Functional Tests using Multi-Instrument and Pocket Multi-Instrument with Sound
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http://www.virtins.com/doc/D1001/Basic_Oscilloscope_Spectrum_Analyzer_Multimeter_and_Sig
nal_Generator_Functional_Tests_using_Multi-Instrument_and_Pocket_MultiInstrument_with_Sound_Cards_D1001.pdf

5. FFT Basics and Case Study using Multi-Instrument
Download link:
http://www.virtins.com/doc/D1002/FFT_Basics_and_Case_Study_using_MultiInstrument_D1002.pdf

6. Evaluation of Various Window Function using Multi-Instrument
Download link:
http://www.virtins.com/doc/D1003/Evaluation_of_Various_Window_Functions_using_MultiInstrument_D1003.pdf

7. EMU Tracker Pre Test Report using Multi-Instrument
Download link:
http://www.virtins.com/doc/D1004/EMU_Tracker_Pre_Report_D1004.pdf

8. M-Audio Mobile TrackerPre Test Report using Multi-Instrument
Download link:
http://www.virtins.com/doc/D1005/M-Audio_MobilePre_Report_D1005.pdf

9. VT XLR-to-USB Pre Test Report using Multi-Instrument
Download link:
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http://www.virtins.com/doc/D1006/VT_XLR-to-USB_Pre_Report_D1006.pdf

10. EMU 0204 Test Report using Multi-Instrument
Download link:
http://www.virtins.com/doc/D1007/EMU_0204_Report.pdf

11. Signal Processing and Analysis (vtSPA) Intefaces
Download link:
http://www.virtins.com/Signal-Processing-and-Analysis-APIs.pdf
12. Polarity Check for Speakers, Microphones and Amplifiers using Multi-Instrument
Download link:
http://www.virtins.com/doc/Polarity-Check-for-Speakers-Microphones-andAmplifiers-using-Multi-Instrument.pdf
13. Focusrite Scarlett Solo Test Report using Multi-Instrument
Download link:
http://www.virtins.com/doc/Focusrite-Scarlett-Solo-Test-Report-using-MultiInstrument.pdf
14. Wow and Flutter Measurement using Multi-Instrument
Download link:
http://www.virtins.com/doc/Wow-and-Flutter-Measurement-using-MultiInstrument.pdf
15. Measurement of Total Harmonic Distortion and Its Related Parameters using
Multi-Instrument
Download link:
http://www.virtins.com/doc/Measurement-of-Total-Harmonic-Distortion-and-ItsRelated-Parameters-using-Multi-Instrument.pdf
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15 FAQ
1. For a sound card based system, is there any test lead or probe associated with
the software? How to make the connection to external devices?
The dedicated sound card oscilloscope probe can be purchased separately from us.
However, if you want to make the probe by yourself, please refer to Section
“Input & Output Connection” in the first chapter.
2. For a sound card based system, how to calibrate the input channel and output
channel?
The simplest way is to use a multimeter. Please refer to Section “Calibration” in
the Oscilloscope chapter for detail. If VIRTINS Sound Card Oscilloscope Probes
are used, then you also need to refer to the manual of the probe.
3. Can I use all instruments such as Oscilloscope, Spectrum Analyzer and Signal
Generator simultaneously?
Yes. For example, you can use the Signal Generator to generate a test signal to a
Device Under Test (DUT), then capture and analyze the response from that device
via the Oscilloscope and Spectrum Analyzer simultaneously.
4. Does the software support external USB sound cards?
Yes. It supports any Windows compatible sound cards. You can select the sound
card via [Setting]>[ADC Device] or [DAC Device].
5. Does the software support multiple sound cards in one computer?
Yes. Each instance of the software supports the selection of one sound card for
input and one for output. The selection is done via [Setting]>[ADC Device] or
[DAC Device]. If you run multiple instances of the software, you can use
multiple sound cards or multiple channels of one sound card simultaneously.
6. Can I see the generated signal in the Oscilloscope in real time?
Yes, you can. Different types of loopback modes are provided in the Signal
Generator. Please refer to Section “Loopback Mode” in the Signal Generator
chapter for detail.
7. Can I analyze data that are not directly acquired from the ADC device?
Yes. You can use the software to analyze any WAV data or TXT data as long as
the required format is followed. Please refer to Sections “Open” and “Import” in
the Oscilloscope chapter for detail.
8. Can it measure DC signal with a sound card?
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It depends on the sound card used. Most of sound card inputs are AC-coupled.
There is normally a capacitor in series at the input, which blocks DC and verylow-frequency components.
9. Can it output DC signal with a sound card?
Generally No. Almost all sound cards are AC-coupled at their output.
10. How to make the software accessible by different limited user accounts and
administrator accounts under Windows NT/2000/XP/2003/Vista/7/8/8.1/10/11?
The software must be installed and then unlocked by an administrator. It can be
accessed by any users including restricted users afterwards.
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